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Preface
Welcome to GIS Tutorial 1 for ArcGIS® Pro. This step-by-step workbook focuses on ArcGIS Pro but also
covers ArcGIS OnlineSM and some of its major apps for mobile computing, including Esri® Story Maps,
Operations Dashboard for ArcGIS®, and Collector for ArcGIS®.

ArcGIS Pro is Esri’s next-generation, 64-bit desktop software with an intuitive user interface for creating,
using, and analyzing professional 2D and 3D maps. ArcGIS Pro’s tasks, ModelBuilder models, and apps also
allow you to build operational systems that help organizations use GIS on a daily basis. You create tasks to
guide complex workflows, and you build models to automate multiple geoprocessing steps, all without
computer coding. The apps provide GIS results and capabilities to all who need them.

ArcGIS Online is a complete cloud-based mapping platform for making, using, analyzing, and sharing
maps. You can easily publish maps authored in ArcGIS Pro to ArcGIS Online and integrate them with maps
from Esri’s Living Atlas of the World, available in ArcGIS Online. The Living Atlas, curated by Esri, is the
world’s foremost collection of ready-to-use maps. With your finished maps stored in ArcGIS Online, they are
easily shared in ArcGIS Online apps.

Esri Story Map apps allow you to incorporate text, charts, and other content with interactive maps to tell a
story or to make a report on a GIS project. Want to see the story map that you’ll build in chapter 3? Open
http://arcg.is/2n17PX0 in your browser on your computer, tablet, or smartphone (look for an information
button on your tablet or smartphone to see nonmap content). Operations Dashboard monitors an
organization’s demands for services and performance with maps, statistics, charts, lists, and queries. Collector
allows for collecting and updating spatial and attribute data in the field using mobile computing devices.

This book is a complete learning system for GIS, including features we have evolved in more than 25 years
of teaching GIS using Esri products and writing tutorials. Our books are used successfully by students in
classes as well as by self-learners. We’ve taught high school students, in-career professionals, undergraduate
students, master’s students, PhD students, and distance-learning students across many disciplines. We teach
using a combination of lectures and lab sessions, and we always include student-designed GIS projects as a
final requirement in our courses. Our interactions with students are important sources of ideas and feedback
for our books.

This book includes wide-ranging real-world data and GIS applications that require integration of different
GIS processing steps and workflows to solve realistic problems. This book addresses many topical issues,
including these examples:
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Accessing urgent-care health clinics by low-income populations
Finding employment prospects in arts fields across US cities, including the size of arts communities,
average incomes, and cost of living
3D modeling of city buildings using lidar data for city planning
Building a system for scheduling and routing of graffiti removal in a city
Location analyses

Placing defibrillators outdoors to resuscitate heart attack victims in a city
Locating farmers markets as part of a city’s solution to its “food desert” problem

Digitizing a university campus’s buildings and walkways from satellite images for use in master
planning
Data mining crime patterns in a city for insights into criminal behavior

The book presents essential concepts at the start of each chapter or at the start of tutorials. Sections on
concepts are separated from tutorial steps to ensure continuous, hands-on computer work.

Short chunks of step-by-step tutorials are illustrated with screen captures and brief comments when
helpful. We try to limit these short sections to a maximum of 10 steps each to help you stay focused. These
small chunks facilitate learning and retention, and provide a sense of accomplishment.

In Your Turn assignments within tutorials, you will repeat steps just taken but in slightly modified ways.
These short assignments help you begin to internalize steps and workflows.

On the book’s web resource page (esri.com/gist1arcgispro), you will find related assignments to help you
apply each chapter’s concepts and workflows independently. The tutorial steps expose you to GIS and serve as
a reference, while the assignments provide additional resources for more in-depth learning. In the classroom,
instructors will likely ask you to turn in assignments for grading.

The four parts of this book are organized in a sequence that best motivates and facilitates your learning of
GIS.

In part 1, “Using, making, and sharing maps,” the first three chapters of the book introduce you to the
ArcGIS user interface through finished maps. You will symbolize a range of map types using cartographic
principles and build map layouts and Esri Story Maps to present your results.

The five chapters in part 2, “Working with spatial data,” prepare you for finding and understanding spatial
data. You will store and process spatial data in file geodatabases, geoprocess spatial data for mapping and
analysis, digitize your own spatial data, and geocode tabular data for mapping.

The three chapters in part 3, “Applying advanced GIS technologies,” focus on analyzing spatial data and
maps to solve problems. You will apply a number of unique GIS methods for analyzing spatial relationships,
including buffers, service areas, facility location, and data clustering. You will use raster GIS (which works
with satellite images and other continuous data) to analyze demand for services. Part 3 concludes with an
exploration of 3D GIS to model urban redevelopment projects.

In part 4, “Managing operational systems with GIS,” the final two chapters of the book provide hands-on
experience in building operations management systems. In chapter 12, you create tasks and a ModelBuilder
model to prepare and publish weekly graffiti location data on a map. You also create an operation view using

8

http://esri.com/gist1arcgispro


Operations Dashboard with the published data for police to use in preventing graffiti by serial artists. In
chapter 13, you build three ModelBuilder models for a public works supervisor to use in scheduling and
routing graffiti removal. You will also create a Collector app for the supervisor to enter assessments on graffiti
removal on a mobile device while in the field.

GIS is our favorite subject to teach and a favorite class for our students to take. If you have any questions
or feedback, you can reach us via email at gorr@cmu.edu or kurland@cmu.edu. Bon voyage!
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PART
1
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sharing maps
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CHAPTER 1

The ArcGIS platform
LEARNING GOALS

Get an introduction to the ArcGIS® platform.
Get an introduction to the ArcGIS® Pro user interface.
Learn to navigate maps.
Work with tables of attribute data.
Get an introduction to symbolizing and labeling maps.
Work with side-by-side 2D and 3D maps.
Publish a map to ArcGISSM Online.
Configure maps in ArcGIS Online.
Use Explorer for ArcGIS® on a mobile device.

Introduction
The ArcGIS platform is an integrated collection of GIS software packages and apps developed by Esri that
work seamlessly across desktop computers, the Internet, and mobile devices. The tutorials in this first chapter
will familiarize you with some major components of this platform: ArcGIS Pro, ArcGIS Online, and
Explorer for ArcGIS. You’ll use additional ArcGIS apps and packages in other chapters.

ArcGIS Pro, the major package taught in this book, is a 64-bit desktop GIS application that uses the
Microsoft ribbon interface for 2D and 3D map authoring, analysis, and web publishing. The interface makes
relevant tools visible and available for whatever work you’re doing in GIS. ArcGIS Online is Esri’s cloud
solution for interactive web mapping and spatial data sharing. Maps that you create in ArcGIS Pro can be
published to ArcGIS Online. Then, once in ArcGIS Online, maps can be accessed in web browsers and in
mobile-device apps. Explorer for ArcGIS is a simple interactive viewer for your online maps.

In this chapter, you will work with a finished map that has the locations of urgent health care clinics in
Allegheny County, Pennsylvania. These clinics are federally qualified health centers (FQHCs) that provide
subsidized health care for underserved populations and MedExpress clinics that provide private health care. In
part, both FQHCs and MedExpress centers are low-cost alternatives to hospital emergency rooms. You will
examine the finished map’s components while navigating through user interfaces and around mapped features.

13



In the process, you’ll learn that both the publicly funded and private-sector urgent health care clinics are well-
located in interesting spatial patterns.
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Tutorial 1-1: Overview of ArcGIS Pro
You must have ArcGIS Pro and the data for this book installed on your computer for this tutorial and the rest
of the book. If you are taking a GIS class in a college or university, your instructor will provide access to
ArcGIS Pro on computer lab computers or your own computer. If you are not in a class or organization that
licenses ArcGIS, you can sign up for a free trial at http:pro.arcgis.com. The first time you start ArcGIS Pro,
you will be prompted to license the software. To license the software, you must have an ArcGIS Online or
Portal for ArcGIS account (http://pro.arcgis.com/en/pro-app/get-started/install-and-sign-in-to-arcgis-
pro.htm).

Before starting work on your computer, take time to review some key terminology for ArcGIS Pro
projects and spatial data.

A project is a file, with the extension .aprx, that contains one or more maps and related items. For example,
you’ll open project Tutorial1-1.aprx in ArcGIS Pro after this introduction. The project has two maps, Health
Care Clinics and Health Care Clinics_3D, plus other project items.

A project has a home folder of your choice. The home folder of Tutorial1-1.aprx is Chapter1\Tutorials.
If you installed this book’s data on the C drive of your computer, the location of the Tutorial1-1.aprx
project is C:\EsriPress\GIST1Pro\Chapter1\Tutorials\Tutorial1-1.aprx.
A file geodatabase is a folder, with the extension .gdb, that stores one or more feature classes, rasters,
and other related files. Although there are many other file formats for storing spatial data, the file
geodatabase is a preferred Esri format. The data used in Tutorial1-1.aprx is in the file geodatabase
Chapter1.gdb, stored in the Chapter1\Tutorials folder on your computer. A project does not store
spatial data used to make maps but instead stores connections to spatial data, such as a file
geodatabase, that is stored elsewhere on your computer, ArcGIS Online, or other locations.
A feature class is composed of spatial data and is the basic building block of GIS for storing features
that can be graphically displayed on a map. Feature classes have corresponding attribute data for each
feature. For example, Chapter1.gdb has a feature class named FQHC that has point locations for all
FQHCs in Allegheny County, along with attribute data including the FQHC name and address.
Chapter1.gdb has many more feature classes, one of which is Municipality, which has boundaries for
all municipalities in the county (including the City of Pittsburgh). Yet another feature class is Streets,
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which has center lines for all streets in the county.
A raster dataset (or raster) is the other major type of spatial data for mapping. Quite often, a raster is a
stored image made up of pixels—square areas with assigned colors so small that you can’t see them
individually until you zoom close in. In general terms, a raster is a rectangular table with numbers in
cells (the pixels), with cells referenced to geographic coordinates. For images, the stored numbers
correspond to assigned colors.
A map layer is a feature class or raster as visualized in a map, and a map is a composition of map layers
overlaying each other. The layers are chosen and symbolized by you to serve a given purpose.

It’s important to understand that an ArcGIS Pro project is a file that stores your maps, but the spatial data
(feature classes and rasters) that comprises maps is stored elsewhere on your computer, a local area network, or
in the cloud on the Internet.

Open the Tutorial 1-1 project
This book’s tutorials have prebuilt projects that you open and use or modify to learn lessons. So you’ll start by
opening ArcGIS Pro and then opening a project.

1. Navigate to esri.com/gist1arcgispro to download the tutorial data for the book, and extract the files to
C:\.

2. Open ArcGIS Pro on your computer.

3. Sign in with your ArcGIS account user name and password.

4. Click Open another project, browse on your computer to
C:\EsriPress\GIST1Pro\Chapter1\Tutorials, and double-click Tutorial1-1.aprx. If you don’t see
the Open another project link, you can widen the ArcGIS Pro window. The project opens and
displays a map, Health Care Clinics, which includes 14 symbolized map layers. You can turn layers
on and off by selecting and clearing the check boxes by their names. Only one layer is selected,
Population Density. You’ll select more momentarily. If you do not see the Contents pane, you’ll open
that pane in the next step.
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5. If the Contents pane is open, close it by clicking the X button in the upper-right corner of the pane.

6. On the View tab in the Windows group, click Contents to open the Contents pane. The Contents
pane normally docks on the left. Optionally, you can float any pane (you will open several other panes
later in this chapter) by right-clicking the top of the pane and clicking Float or by clicking and
dragging the top of the pane outward. You can experiment right-clicking the top of the pane and
clicking Dock to redock the Contents pane on the left.

7. On the Map tab in the Navigate group, click the Full Extent button . Clicking the Full Extent
button zooms the map to the full extent of the data in the view, if the view is not already displayed
that way. If the map was zoomed into a small area, clicking the Full Extent button would display the
entire map.

8. On the Project tab, click Save As, navigate to Chapter1\Tutorials, and save as Tutorial1-
1YourName.aprx (substitute your name for YourName). You’ll generally save provided projects this
way, so that if you make a major mistake, you can start again with the original project.

Add and remove a basemap
A basemap is a layer that helps orient the map user to the location. Map designers place additional feature
classes on top of a basemap to provide specific information for visualization, analysis, or solving a problem.
Although you can create your own basemap, Esri provides the basemaps that you’ll use in this book as map
web services from the Esri web portal, ArcGIS Online. By default, new projects created using ArcGIS Pro
have the topographic basemap added to the bottom of the Contents pane. Additional base-maps are
available.
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1. On the Map tab in the Layer group, click Basemap. You will see a variety of basemaps. Many of the
maps you’ll build in this book will use the Light Gray Canvas basemap because you’ll reserve color for
feature classes that are the subject of the map. Basemaps in the background will provide spatial
context for the locations of subject features.

2. Click the Streets basemap to add the basemap to your map. The Population Density map covers most
of the Streets basemap. Because the areas of the basemap are visible, outside of Allegheny County, do
not match Population Density, or otherwise add useful information, you will remove the basemap for
now.

3. If necessary, scroll to the bottom of the Contents pane, right-click World Street Map, and click
Remove.
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YOUR TURN
The Your Turn assignments in this book will ask you to repeat the steps just completed, but with some
modifications. These assignments will help you retain the workflows in the steps. Often, you will need to
complete the Your Turn assignments so you can use their results in the next tutorial steps, so be sure not
to skip Your Turn assignments.

For this Your Turn assignment, add and remove several basemaps of your choice. You will notice
that some basemaps, such as the light- and dark-gray canvases, add a labeling layer at the top of the
Contents pane. When you remove the last basemap, be sure to remove the labeling layer, if necessary.

Turn layers on and off
The order of drawing by ArcGIS Pro is from the bottom up in the Contents pane. So feature classes that
cover areas, such as Population Density, must go on the bottom, and other feature classes that could be
covered up, such as FQHC Clinic points, must go higher up and on top of other feature classes.

1. In the Contents pane, scroll down to see the legend for Population Density. The check mark on the
left of Population Density indicates that the feature class is turned on. This feature class represents
persons per square mile in 2010 by census tracts in numeric classes, with uniform widths of 1,000
people per square mile. Census tracts are statistical areas intended to represent neighborhoods with
about 4,000 people, although population tracts can vary widely in population.

2. Continuing in the Contents pane, select the small boxes to the left of MedExpress Clinics, FQHC
Clinics, and Poverty Risk Area. The three feature classes you just turned on are the subject of this
map and show the locations of urgent health care clinics relative to poor areas. Right away, you can
see that the subsidized FQHCs are concentrated in high-population density (urban) and poverty risk
areas, whereas the private-sector MedExpress clinics are mostly spread out in low-population density
areas (suburbs). Areas inside the Poverty Risk Area polygons have high proportions of poor
populations.

3. Turn on feature classes that provide the spatial context of where subject features are located:
Allegheny County, Rivers and Water Features, and Streets. Streets, an important spatial context
feature class, will not display until the map is zoomed into a small area (you’ll learn about zooming
later in this chapter). Streets are too many and detailed for viewing at full extent. Next, to make the
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point that ArcGIS Pro draws from the bottom up in the Contents pane, you’ll temporarily drag
Population Density up to cover other feature classes.

Move feature classes in the Contents pane

1. Drag Population Density to the top of the Contents pane under Health Care Clinics. Now this
feature class covers all other feature classes in the map.

2. Drag Population Density back to just above the Poverty Index feature class.

3. Click the Save button . The map, composed of feature classes currently displayed, has useful
information that could be shared with others by publishing the map to ArcGIS Online. From there,
the map could be viewed on a mobile device using Explorer for ArcGIS. You’ll publish a map similar
to this one in tutorial 1-4, and then use the published map with Explorer in tutorial 1-5.

Examine the Catalog pane, and open and export a map layout
The Catalog pane provides access to all components of an ArcGIS Pro project.

1. If the Catalog pane is not already open, click the View tab, click the arrow under the Project button 

, and click the Catalog pane. The Catalog pane opens. If the pane is not docked to the right side of
the ArcGIS Pro window, double-click its top to dock it. You will see that buttons, such as the Project
button, that have an arrow at the bottom have drop-down menus with two or more menu items to
choose from. If you click one of these buttons without clicking the arrow, the first drop-down menu
item opens by default.

2. In the Catalog pane, click the arrows to the left of the Maps and Layouts folders to expand the folders
—revealing what’s been built so far for this project. You are viewing the Health Care Clinics map,
but you will also view a 3D version of the same map later in this chapter. Next, you will open the
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layout for FQHC and MedExpress Clinics. You’ll learn about the other project components
(toolboxes, databases, and so on) later in this book as needed.

3. In the Catalog pane under Layouts, double-click FQHC and MedExpress Clinics. ArcGIS Pro
displays the layout on a new tab. The map is the main element of a layout, which also includes map
surrounds such as the title, legend, and graphic map scale. These elements make the map suitable for
use as a figure in a report or on a slide in a presentation. You’ll learn how to create layouts from maps
in chapter 3.

4. At the top right of the Catalog pane, click the Options button and the Auto Hide button  to
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temporarily hide the pane. You can restore and hide the Catalog pane as needed by clicking its
Project button.

5. On the Layout tab in the Navigate group, click the Full Extent button . Next, you’ll export the
map as an image file.

6. On the Share tab in the Export group, click Layout, and navigate to Chapter1\Tutorials.

7. Change the file name to HealthClinics, select JPEG (*.jpg) for Save as type, type 300 DPI (dots per
inch) for Resolution, and click Export. Using Windows Explorer or File Explorer, open the output
image file in a photo viewer (just double-click HealthClinics.jpg). At 300 DPI, this is a high-quality
image that you could print or insert into a Microsoft Word document or PowerPoint presentation.
For use in a website or mobile device, the recommended resolution is much lower (72 DPI) to keep
file sizes small and therefore loading times fast.

8. Close the FQHC and MedExpress Clinics tab to close the layout, and then click the Save button to
save your project. With the layout closed, on the remaining tab, the Health Care Clinics map
displays.

YOUR TURN
Turn on the FQHC Buffer and MedExpress Buffer feature classes. The buffers are one-mile radius
circles constructed with health care clinics at their centers. The rationale for choosing a one-mile buffer
radius is that this radius is commonly used to determine accessibility to grocery stores in urban areas.
You can assume that what works for grocery store accessibility also works for health care facilities. Notice
that the buffers are partly transparent so that you can see the population density below them. Next, open
the layout. ArcGIS Pro automatically adds the newly displayed feature classes to the layout’s map and
legend. As stated earlier, the FQHCs appear well located within poverty and densely populated areas,
while the MedExpress facilities are mostly scattered in suburbs surrounding Pittsburgh. Why do you
think these patterns exist? When finished, close the layout and save your project.
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Tutorial 1-2: Navigate ArcGIS Pro
Map reading in GIS depends on varying location and scale (where and how far you are zoomed in) and using
the attribute data of spatial features. You can zoom in to any part of a map, drag (pan) the map to a different
location, and zoom back out. You can set some feature classes to display only when they are zoomed in to a
certain scale and beyond, such as streets, and you can clear the display for other feature classes. You can go to
preset locations and scales using spatial bookmarks. You can read the attribute data of any feature by clicking
the feature to get a pop-up window. Last, you can search for features by using attribute values such as the
name of a street.

Open the Tutorial 1-2 project

1. Click the Project tab.

2. Click Open and browse to Chapter1\Tutorials.

3. Open Tutorial1-2.aprx, and save the tutorial as Tutorial1-2YourName.aprx in Chapter1\Tutorials.

4. Click Full Extent to zoom the map.

Use a pop-up window

1. Click the Map tab on the ribbon.

2. On the map, click the MedExpress Clinic farthest to the left (west). A pop-up window appears with
attribute data for that feature.

3. Click the pop-up’s website hyperlink, and when you finish, close your browser.
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4. Drag the pop-up away from your map.

5. Point to each of the three buttons on the bottom right of the pop-up window to read what they do,
and click the Zoom to this feature button  several times. The map centers and zooms in on the
Coraopolis MedExpress Clinic. If you zoom in close enough, the buffers and population density
displays turn off, the streets display turns on, and the MedExpress clinic gets labeled. If you zoom in
even farther, the streets get labeled. These feature classes and labels have visibility ranges for which
they are visible.

6. Close the pop-up, and zoom to full extent.

Zoom in

1. Position the cursor over the point where the three rivers join in the middle of the map, and use your
mouse scroll wheel to zoom into the map, stopping several times before zooming in more. If you do
not have a mouse, use your plus key (+) to zoom in and minus key (−) to zoom out.

2. Scroll up and down in the Contents pane. Feature classes not drawing at this scale have gray check
marks, whereas feature classes that display have black check marks. You’ll learn how to set visibility
thresholds for controlling the scale at which feature classes display in chapter 3.
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3. Click and drag (pan) the map to a new location. Your cursor is automatically in panning mode with

the Explore button  selected on the Map tab of the Navigate group of the ribbon. If you do not
have a mouse, use arrow keys to move about (pan) the map. If you have a touch screen, tap and slide
the map to pan.

4. On the Map tab in the Navigate group, click the Previous Extent button  a couple of times.
Clicking this button moves you back through the sequence of zooming steps you have taken. There’s
also a Next Extent button  for the other direction.

5. Zoom to full extent.

Zoom into a raster feature class
All but one of the map layers in the Health Care Clinics map, Poverty Index, have vector data, made up of
points (for example, MedExpress Clinics), lines (streets), or polygons (closed areas such as the census tracts
that display population density). GIS does not store images of vector feature classes but instead draws them on
the fly from stored points and drawing instructions, including how the map designer wants them symbolized
(such as the brown square symbols for MedExpress clinics). Rasters, however, are stored using image data
formats (for example, JPEG and TIFF) and rendered pixel by pixel as stored. However, as a map designer,
you can change the colors of certain kinds of rasters that are not pictures, such as the Poverty Index that you
are about to use.

1. Turn on and off feature classes so that these feature classes are on: Tract Centroids (center points),
Pittsburgh, Allegheny County, Streets, and Poverty Index.

Hint: Press Ctrl, and click a check box for a feature class to turn all feature classes on or off. Then make
adjustments for the desired map.

The raster feature class, which you will create in chapter 10, is rectangular, as are all raster feature classes.
In this case, the boundaries are defined by the centroid points farthest to the north, east, south, and west
of the tract centroids used to create the raster.
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2. Click to clear Tract Centroids. Zoom into the center of the map until you can see the pixels of
Poverty Index.

3. Zoom to full extent, and turn on all feature classes except Tract Centroids, Municipalities, and
Poverty Index.

Use bookmarks
Spatial bookmarks allow you to zoom to preset map views.

1. On the Map tab in the Navigate group, click the Bookmarks button. Three bookmarks are available
for the open map: Allegheny County, Poverty Areas, and Pittsburgh East End. Also available are
three bookmarks for a 3D map that you’ll use in tutorial 1-4.
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2. Click the Poverty Areas bookmark. The map zooms to that area. Your map may have different
feature classes displayed or not displayed, depending on the size of your computer’s screen and map
window, because the thresholds that switch feature class displays on and off depend on the ratio of
feature sizes on the screen to actual feature sizes on the ground. You will learn more about map scale
in chapter 3.

3. In the lower-right corner of the graphic, zoom and pan into the poverty risk area until streets appear.
An alternative is to press the Shift key, and then drag a rectangle around the area desired for viewing.

4. On the Map tab in the Navigate group, click Bookmarks > New Bookmark.

5. In the Create Bookmark window, type McKeesport Poverty Area for the Bookmark Name, and click
OK.

6. Zoom to the Allegheny County bookmark, and try out your new bookmark.

7. Click Bookmarks > Manage Bookmarks.

8. In the Bookmarks pane, alphabetize the Health Care Clinics bookmarks by dragging them in order.

9. Close the Bookmarks pane.

10. Zoom to full extent.

Search for a feature
Next, you will use ArcGIS Pro’s query builder for structured query language (SQL) queries. SQL is the
standard language for querying tabular data. In this quick preview, you’ll search for locations on the basis of
their attribute data values. Chapter 4 reviews SQL search criteria in more depth.

1. In the Contents pane, clear the Population Density check box, and select the Municipalities check
box.
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2. Right-click Municipalities to open the menu, and click the Attribute Table. Every vector feature class
has an attribute table, and each feature (point, line, or polygon) of a feature class has a record or row
of data.

3. On the Map tab in the Selection group, click the Select by Attributes button . The Geoprocessing
pane opens. Municipalities is already selected as the input feature class.

4. Click the Add Clause button .

5. Make your selections as seen in the graphic. There’s no need to remember or type anything. Just
select from drop-down lists for needed inputs.

6. Click Add, and then click the Run button. When the run completes, close the Geoprocessing pane.
The result is that the McKees Rocks record and feature are selected. You will complete the next two
steps to see the record and feature.

7. At the bottom of the Municipalities table, click the Show Selected Records button .

8. In the Contents pane, right-click Municipalities, point to Selection, and click Zoom to Selection.

9. At the top of the table, click the Clear Selection button .

10. Clear the Municipalities check box, and select the Population Density check box.

YOUR TURN
Search for an FQHC, the Braddock Health Center, and zoom to the center. When you finish, close the
Geoprocessing window and any open tables, clear selections, and zoom to full extent. Save your project.
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Tutorial 1-3: Work with attribute data
Attributes play a major role in GIS. Besides providing data needed to solve a problem or investigate spatial
patterns, attributes allow you to search for useful information and mapped features, as seen in the previous
tutorial. Attributes also enable sophisticated symbolization and labeling, as you’ll see later in this chapter.

Open the Tutorial 1-3 project

1. Open and save Tutorial1-3.aprx as Tutorial1-3YourName.aprx.

2. Zoom to full extent.

Open and sort attribute tables
You’ll start with a closer look at feature attribute tables.

1. In the Contents pane, right-click MedExpress Clinics, and click Attribute Table. The table shows 15
MedExpress clinics with name and address data available, along with latitude and longitude
coordinates, hyperlink URLs, and other information.
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2. If necessary, adjust the column widths in the table so that you can read the full cell contents by
positioning the cursor between columns on the top row with column names until the cursor becomes
a two-headed arrow, and then click and adjust by moving left or right. You can also double-click
when you see the two-headed arrow to automatically resize the column widths.

3. In the table, drag the Website column after ZIP Code.

4. Right-click the City column heading, and click Sort Ascending. Now, records are sorted by city
name. If you scroll down, you can see that eight of the MedExpress clinics are in Pittsburgh.

5. Right-click City, and click Custom Sort. With this option, you can sort more than one column. Next,
you’ll sort by city and then an address within city.

6. In the Custom Sort window, make the selections as shown.

7. Click OK, and scroll down to the Pittsburgh records. If there were many records, you could now
easily find a Pittsburgh MedExpress by address because street numbers are in order, sorted as text.
Note that numbers stored and sorted as text are ordered by individual digits instead of numeric value.
For example, 11 appears before 2 because the first “1” of 11 is smaller than the 2.
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8. Close the MedExpress Clinics table, and save the project.

YOUR TURN
Open the attribute table for Population Density. GeoID is a geocode (unique identifier or primary key)
assigned to census tracts by the US Census Bureau. Attributes of interest are Pop (2010 population),
Area (square miles), and PopDensity = Pop/Area (persons per square mile). Using sorting, find the tract
with the highest population density, 29,835 persons per square mile. Select that record (click the gray
square on its left) and find it on the map (cyan area in the middle of the map). To get a better look at the
selected census tract, zoom partway to that polygon, to the extent that Population Density’s display stays
on. Click the Clear Selection button at the top, middle of the table. Close the table when finished, and
zoom to full extent.

Work with the field view of an attribute table
You can change the order of attributes (columns) in a table, change the names and displayed names (aliases) of
attributes, see the data type of attributes, and make only certain attributes visible to the user—all using the
field view of a table.

1. In the Contents pane, turn on Tract Centroids.

2. Open this feature class’s attribute table. Four attributes of this feature class are indicators of poverty:
FemHseHld is the number of female-headed households with children, Unemp is the number of
unemployed persons age 16 and older who are in the workforce, PopNHighSc is the population age
24 or older that did not attain a high school education, and PopPov is the number of persons below
the income poverty level.

3. In the upper-right corner of the table, click the Options button , and click Fields View. A new tab
opens with the fields of Tract Centroids and their properties.
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4. Type these aliases:

FemHseHld has alias Female Headed Households.

Unemp has alias Unemployed Population.

PopNHighSc has alias High School Non-Graduates.

PopPov has alias Poverty Population.

5. Drag the PopPov row to just below GeoID.

6. On the Fields tab in the Changes group, click the Save button, and close the Fields view. The Tract
Centroids table reflects the changes you just made.

7. Close the Tract Centroids table, and turn off its feature class.

YOUR TURN
In the Municipalities table, turn off visibility for all attributes except Name. Save changes, and close the
Fields view and the table. Note that to publish this map to ArcGIS Online, you must select the visibility
check box for Shape.

Select records and features of a map feature class

1. Open the attribute table for FQHC Clinics.

2. In the table on the left of row 1, click the square gray cell, press and hold your mouse button, and drag
down through row 6. The result is that you have selected six of the 26 FQHC clinic records in the
table and highlighted their point symbols on the map (with the cyan selection color), demonstrating
the linkage between records and features. Many GIS functions work with selected subsets of records
and features.
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3. At the top of the attribute table, click the Clear Selection button.

4. At the top of the Contents pane, click the List By Selection button .

5. In the Selection section, clear the check boxes as needed so that only the MedExpress and FQHC
Clinics are turned on. Now when you click the map, you can select only clinics and not mistakenly
select other features.

6. At the top of the Contents pane, click the List By Drawing Order button .
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7. On the Map tab in the Selection group, click the Select button .

8. Press the Shift key, and on the map individually select any five FQHCs. You will see five
corresponding records selected in the table.

9. At the bottom left of the table, click the Show Selected Records button . Now you will see only the
selected records.

10. Click the Show All Records button .

11. At the top of the table, click the Switch Selection button . Now the complement of the five
FQHCs originally selected are selected instead.

12. Clear the selection.

YOUR TURN
Using the selection tool, drag a rectangle around some FQHCs on the map. All FQHCs within the
rectangle get selected. Press and hold the Shift key, and drag a different rectangle. More FQHCs are
added. Press and hold the Ctrl key and click an already selected FQHC. That FQHC gets deselected
while all other selected FQHCS remain selected. Press and hold the Shift key, and reselect the FQHC
you just deselected. That FQHC gets added back to the selection. Clear the selections, and close the
table. This assignment showed that you can select any subset of features.

Get summary statistics using a tool
ArcGIS has hundreds of tools, each with inputs and algorithms that transform the inputs into outputs. You
can easily search for a tool, fill out its form to specify inputs, set parameters that control algorithm behavior,
and name and specify where to store outputs. The Summary Statistics tool computes common statistics (for
example, minimum, maximum, mean, and standard deviation) and writes results to a new table. Obtaining
and studying summary statistics for attributes of interest are among the first steps of any analysis.

1. On the Analysis tab, click the Tools button .

2. In the Geoprocessing pane, click the Toolboxes link.

3. Expand Analysis Tools > Statistics.
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4. Double-click the Summary Statistics tool.

5. In Summary Statistics, choose your selections as shown in the following figure to get the statistics for
PopDensity of the Population Density feature class. ArcGIS Pro automatically chooses your project’s
default file geodatabase, Chapter 1.gdb, for the output table and a name for the table,
AllCoTracts_Statistics. Make sure that the Case field is clear. If it’s not clear, point to the left of the
field and click the red X.

6. Click the Run button.
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7. When the run completes, close the Geoprocessing pane.

8. In the Contents pane, scroll down, and open the AllCoTracts_Statistics table. You will find the
results in the table as shown in the next graphic. You can see that at least one tract has no population,
the mean population density is 4,628 persons per square mile, the maximum is 29,835, and the
standard deviation is 4,110.

9. Close the table, and save your project.
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Tutorial 1-4: Symbolize maps
This tutorial will introduce you to symbolizing maps. You’ll change the point symbol of feature classes,
including type of symbol, color, and size. You’ll label features with their name, choose a font and size, and
place a halo around labels to improve readability. You’ll add map feature classes to the map from your hard
drive, symbolize them, and remove them from your map. Finally, you’ll add aerial imagery to your map from
ArcGIS Online as a map service. Chapter 2 goes into depth on symbolization.

Open the Tutorial 1-4 project

1. Open and save Tutorial1-4.aprx as Tutorial1-4YourName.aprx.

2. Use the Allegheny County bookmark.

Symbolize feature classes
Now take a look at how ArcGIS Pro lets you choose symbols for vector feature classes.

1. In the Contents pane, right-click FQHC Clinics, and click Symbology. The Symbology pane opens.
Here you see that symbology is Single Symbol, the current symbol is a green circle with a dark-gray
boundary, and you see fields for typing a new label and description for the Contents pane and layout
legend if desired.

2. In the Symbology pane, click the current symbol (the green circle). A gallery of symbols opens.

3. Click Circle 4. The FQHC symbols on the map immediately change to Circle 4.

4. At the top of the Symbology pane, click Properties.

5. In the Symbology pane under Appearance, change the color to Leaf Green (seventh column, fifth
row), change size to 8 pt, click Apply, and close the Symbology pane.
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YOUR TURN
Symbolize Poverty Risk Area with a 1.5 pt line and Poinsettia red color (second column, fourth row).
Close the Symbology pane when finished.

Label a feature class
Next, you will label a feature class using one of its attributes.

1. In the Contents pane, turn off Population Density, and turn on Municipalities.

2. Click Municipalities. Because you selected this feature class, its Contextual tab, Feature layer, appears
on the ribbon to give you access to functionality for modifying or enhancing the feature class. If you
don’t see the Feature layer tab, widen your ArcGIS Pro window.

3. Under Feature layer, click Labeling.

4. Click the Label button  to turn labeling on for Municipalities. Municipalities are automatically
labeled with their Name attribute. Next, you’ll make the labels less prominent.

5. Click the Text Symbol button , change the font to size 7, and select a dark-gray color. If you don’t
see the Text Symbol button, make the ArcGIS Pro window wider.

6. Click the Text Symbol button again, and in the lower-right corner of the text window, click the
Dialog Launcher button .
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7. In the Label Class pane, scroll down if necessary, click Halo > the white square for Halo, symbol > No
Color for Outline color, and for Halo size type 0.75 pt.

8. Click Apply, and close the Label Class panel. In effect, the halo erases nearby features so that the full
label is easy to read.

9. Zoom into the western part of the county centered on the river there.

10. Turn Municipalities off, turn Population Density on, and zoom to full extent.

Add and remove feature classes

1. On the Map tab in the Layer group, click the Add data button . Note that under Project in the left
panel of the Add Data window is Folders, which provides direct links to certain folders.

2. Click Folders to see connections to the Chapter1 folder and the Tutorials (Chapter1\Tutorials)
folders. Some chapters have a Data (Chapter1\Data) folder from which you will need to add data to
your map. In that case, use the Chapterx (where x = 1, 2, and so on) folder connection. Most times,
however, you can use the Tutorials connection, which gives you direct access to the default file
geodatabase, Chapter1.gdb in this case. Note that if your project does not have a useful connection,
you can always use the Computer portion of the left panel of the Add Data pane and browse in the C
or other letter drive to the location of the needed data.

3. Double-click the Tutorials connection, double-click Chapter1.gdb, and double-click Parks. Doing
that adds Parks to the Contents pane of your map and displays the layer with an arbitrary color fill.

4. In the Contents pane, click the Parks symbol (rectangle under Parks) to open the Symbology pane.

5. In the Symbology pane, in the Gallery, scroll down, and double-click the Park symbol (light green
with no boundary).
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6. Close the Symbology pane.

7. Turn off the buffer and Population Density feature classes to get a better look at Parks.

8. Use the Pittsburgh East End bookmark, and zoom in more if streets do not appear. Most often you
can symbolize physical features, such as rivers and parks, with colors that you’d expect for them—for
example, blue for water and green for features such as wooded areas or parks.

9. In the Contents pane, right-click Parks, and click Remove.

10. Zoom to full extent, and save your project.

Arrange 2D and 3D maps side by side
The Tutorial 1-4 project file has a 3D version of Population Density, with population density extruded
vertically by census tract that you’ll use next. The variation in population density in an urban area is so wide
that it’s difficult to appreciate its variation with color coding alone in a choropleth map. In 3D, the differences
are impressive. In this exercise, you’ll view the 2D and 3D maps of Population Density side by side and will be
able to appreciate the added information of the 3D map over the 2D map.

1. Turn on only the Allegheny County and Population Density layers.

2. In the Catalog pane, expand Maps, double-click Health Care Clinics_3D to open the 3D map, and
then close the Catalog pane.

3. Right-click the Health Care Clinics_3D tab, and click New Vertical Tab Group. Both the 2D and
3D maps appear in separate, same-size windows.

4. Click View > Link Views > Center and Scale. Now when both the 2D and 3D maps are displayed side
by side, you can pan, zoom, or tilt one map, and the other map will follow in the same way. If your
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two maps are not yet synchronized, resize and move one of the maps.

Navigate 2D and 3D maps side by side

1. Place the cursor at the center of the 3D map, hold your scroll wheel down, and move the cursor
straight up a bit to tilt the map. Now you can see the tremendous differences in population density
using the 3D map. If you don’t have a mouse, press V + arrow keys to tilt and rotate the 3D map.
Furthermore, using the View help button (question mark at the top right of the ArcGIS Pro
window), search for “keyboard shortcuts” and view the help document, “Keyboard shortcuts for
navigation—ArcGIS Pro.”

2. Click the Map tab, and zoom and pan with either map. Both maps move together.

3. Position the cursor on the bottom of the 3D map, hold your scroll wheel down, and move your mouse
on its pad to the right to rotate the 3D map (or use V + arrow keys).

4. Keep experimenting, panning and rotating the map to any viewing. The figure shows the 3D map
viewed from the north.

5. Press the N key on your keyboard to reorient the map with north up.

6. Save your project.
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Tutorial 1-5: Publishing maps to ArcGIS Online
Generally, you’ll use ArcGIS Pro as your map authoring package. With feature classes prepared and added,
symbolization completed, and so on, you can share your interactive map with others. You can simply click a
button and publish your map to ArcGIS Online. Once online, you can modify your map’s configuration as
well as use many map navigation and query tools. You can keep your map private or share your map with a
group or publicly for anyone to view.

Share your map online
Maps for publishing to ArcGIS Online must have a basemap added. Also, feature classes for publication
benefit from having a particular coordinate system (projection)—WGS 1984 Web Mercator Auxiliary Sphere
—which is the one used in ArcGIS Online. The maps for sharing in this chapter all have the Web Mercator
coordinates. Using this projection guarantees that feature classes will work online. Chapter 5 reviews map
coordinates and projections.

1. Open Tutorial1-5. The map has only essential map feature classes for sharing with others. Also, the
original Streets feature class stored on your computer is not included because it has a very large file
size. Instead of uploading and adding that feature class to your Esri account, Streets is now the
basemap provided by an Esri web server. When you zoom in, more detailed streets will appear.
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2. Right-click MedExpress Clinics, and click Properties.

3. In the Layer Properties: MedExpress Clinics window, click Source. In the table under Data Source,
you will see the Database row. The source is a feature class, MedExpress, stored in Chapter1.gdb, a
file geodatabase on your computer. You’ll upload MedExpress and other feature classes to your
account in ArcGIS Online.

4. Scroll down and expand Spatial Reference to see that the feature class’s projection is WGS 1984 Web
Mercator Auxiliary Sphere.

5. Click Cancel.

6. Using steps 2–4, look at the source for World Street Map. An Esri website provides the ArcGIS map
service. The map service projection is Web Mercator.

7. On the Share tab in the Share As group, click the Web Map button .

8. In the Share Web Map pane, replace Your_Name, as seen in the graphic that follows, with your
name or student ID. This form is already filled out, but in the future with new maps you’ll have to fill
the form out yourself. Note that if you are in a class sharing an organizational account, all web maps
published to ArcGIS Online must have unique names. So if another person in your class has the same
name, add your middle initial or name so that your name is unique.
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9. In the Share Web Map pane, scroll down if necessary, and click Analyze. You can ignore the one
warning.

10. Click Share, and leave the Share Web Map pane open. Because you are logged into your ArcGIS
account, ArcGIS Pro knows where to publish your map and web layers; namely, to the My Content
folder of your ArcGIS Online account. Your map may take a few minutes to publish. When ArcGIS
Pro finishes, you will get a message that you successfully shared your web map.

Open your map in ArcGIS Online

1. In the Share Web Map pane, at the bottom, click Manage the web map to open ArcGIS Online in
your web browser.

2. Sign in with your ArcGIS organizational account and click My Content. You’ll see your published
web map, Health_Care_Clinics, with your name added at the end.

Share and open your map
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1. Select the check boxes on the left of the three lines with your Health_Care_Clinics files.

2. At the top of the list of files, click the Share button > Everyone (public) > OK. Notice that the Shared
column of the list now has Everyone entered. Now, anyone can search for and use your map.

3. In the first row of the list with type, Web Map, click the arrow on the right of
Health_Care_Clinics_Your_Name, and click Open in map viewer. Your interactive map,
Health_Care_Clinics, opens in your browser. Each published feature class is now called a feature
layer.

Review functionality available for feature layers

1. With the Show contents of map button  selected, in the Contents pane, point to each button that
appears below the selected MedExpress Clinics feature layer, and read the descriptions that appear
for each button. The buttons include Show legend, Show Table, Change Style (symbology), Filter,
Perform Analysis, and More Options.

2. Click the More Options button . Clicking the More Options button opens a menu that provides
you many choices, as seen in the graphic.
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Rename a feature layer

1. For MedExpress Clinics, click More Options > Rename.

2. Rename the feature class MedExpress Urgent Care, and click OK.

Configure pop-ups

1. For MedExpress Urgent Care, click More options > Configure Pop-up.

2. In the Configure Pop-up pane in the Pop-up Contents section, for Display, click the arrow and select
A list of field attributes.

3. In the Pop-up Contents section, click Configure Attributes.

4. In the Configure Attributes window, select the check boxes for all rows except ObjectID.

5. Select the Name row, and using the up arrow on the right of the list, move Name to the top of the list.

6. Move Hyperlink to the bottom of the list.

7. Select Latitude, change the format to 6 decimal places, and do the same for Longitude.

8. Click OK.

9. In the Configure Pop-up pane, click OK.

10. On the ribbon, click the Save Map button, and select Save.
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Use a pop-up

1. Click the westmost MedExpress Urgent Care facility to see its pop-up.

2. In the pop-up, next to Website, click More info (hyperlink). The MedExpress website opens.

3. When you finish exploring the website, close the MedExpress web page and the pop-up.

YOUR TURN
Configure pop-ups for the FQHC Clinics feature class using the previous directions. This layer does not
have a Hyperlink attribute, so skip the step referencing that attribute.

Change style

1. In the Contents pane, for MedExpress Urgent Care, click the Change Style button .

2. For Select a drawing style, click Options.

3. In the Change style pane, click Symbols.

4. Click the orange square symbol in the fourth row, change the size to 14, and click OK.

5. In the Change Style pane, click OK > Done.

YOUR TURN
Change the outline for Poverty Risk Area to a darker red.

Label a feature layer

1. For FQHC Clinics, click More options > Create labels. If you do not see the option to create labels,
you can use Manage Labels. ArcGIS Online automatically selects Name for the label.
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2. In the Label Features pane, make sure that Label Features is on.

3. Change the size to 11, change the color to sienna (fourth column, second row from the bottom row of
color chip array), and make sure that Halo is on.

4. Click OK.

Show an attribute table

1. In the Contents pane, for Population Density, click the Show Table button .

2. In the table, click the PopDensity heading, and click Sort descending.

3. Select the top row, with 29835.13 population density. Selecting this row also selects the tract on the
map with maximum population density in Allegheny County.

4. Using your mouse scroll wheel or the + and – buttons, zoom into the center of your map so that you
can see the tract boundary (in selection color) selected in the table. The map has visibility ranges,
which cause some layers to turn on and off depending on how far you are zoomed in or out. If you
zoom in too far, the Tracts layer turns off. If you zoom in too far, zoom back out until the Tracts
layer reappears.

5. Close the table, and click the Default Extent button .

Use your map

1. Click the Show Legend button .

2. Click the Manage Bookmarks button , and use the McKeesport Poverty Area bookmark.

3. Zoom further in to the McKeesport Family Health Center FQHC along Lysle Boulevard.

4. Click the Basemap button, and select Imagery.
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5. Change the basemap back to Streets, and zoom to the default extent.

6. Save your map, and close your browser.
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Tutorial 1-6: Use Explorer for ArcGIS on your tablet or smartphone
Suppose that you have prepared the map with FQHCs for a nonprofit organization that promotes inexpensive
health care for disadvantaged populations in Allegheny County and that now you must provide the map to
staff members of all FQHCs. How would you get the map to them in interactive form? Assuming that you
have an email distribution list for FQHC staff members, you could easily email a link to use or install the free
Explorer for ArcGIS app as a simple map viewer that you’ll use in this tutorial. The app, which is available
from the Apple App Store, Google Play, and Amazon Appstore, provides access to your ArcGIS Online
maps. If you have an iPhone, iPad, iPod touch device, Android phone, or Android tablet, you will use these
instructions to install and use Explorer for ArcGIS. You’ll finish the tutorial by sending yourself an email with
the link to your map.

Install and start using Explorer

1. Install Explorer for ArcGIS on your smartphone or tablet.

2. Open Explorer for ArcGIS, and sign in using your ArcGIS account user name and password.
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Open your map

1. Select the menu (three horizontal lines).

2. In the Account section, select My maps, select your user ID, and select your Health_Care_Clinics
map.

3. Using usual gestures, zoom into your map. The map has visibility ranges, so if you zoom in close
enough, the Population Density display turns off and the Streets display turns on.

Various tools will help you change the basemap, draw, measure distances or areas, select the
legend, select and clear layers to turn them on and off, use bookmarks, show your location, search,
and share the map or add the map to favorites.

YOUR TURN
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Try out all the buttons just described. When you get to sharing, send yourself an email message with the
link to the map. When you open the message, you’ll have the option to open the map in Explorer, install
Explorer, or open the map in ArcGIS Online. You can also share the map through a message. When you
want to share a map, Explorer offers many good options. When you finish, close Explorer.

Assignments
Now that you’ve successfully worked through this chapter’s tutorials and Your Turn assignments, you can try
out your new knowledge and skills in the assignments found on this book’s resource web page at
esri.com/gist1arcgispro. Two assignments and their ArcGIS projects and data are available for download:

Assignment 1-1: Analyze the change in population from 2000 to 2010 by county in the United States.
Assignment 1-2: Produce a neighborhood block watch crime map.
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CHAPTER 2

Map design
LEARNING GOALS

Symbolize maps using qualitative attributes and labels.
Use definition queries to create a subset of map features.
Symbolize maps using quantitative attributes.
Learn about 3D maps.
Symbolize maps using graduated and proportional point symbols.
Create normalized maps with custom scales.
Create density maps.
Create group layers and layer packages.

Introduction
In this chapter, you’ll learn how to design and symbolize thematic maps. A thematic map strives to solve or
investigate a problem, such as analyzing access to urgent health care facilities in a region, as you did in chapter
1. A thematic map consists of a subject layer or layers (the theme) placed in spatial context with other layers,
such as streets and political boundaries.

Choosing map layers for a thematic map requires answering two straightforward questions:

1. What layer or layers are needed to represent the subject?

2. What spatial context layers are needed to orient the map reader to recognize locations and
patterns of the subject features?

Quite often, the subjects of thematic maps are vector map layers (points, lines, or polygons), because such
layers often have rich quantitative and qualitative attribute data that is essential for analysis. Of course, the
subject can be a raster layer (in chapter 10, for example, you will create a risk-index raster map to identify
poverty areas of a city, and poverty is the subject of the map). Spatial context layers can be vector, such as
streets and political boundaries. These layers also can come in both raster or vector formats, including many
basemap layers provided by Esri map services.

The major map design principle for thematic maps is to make the subject prominent while placing spatial
context layers in the background. For example, if the subject is a map layer with points and you want to give
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them focus, you might give the point symbols a black boundary and bright color. These subject features are
known as “figure” and are the main composition of the map. Everything that is not figure is known as
“ground.” For example, if a context layer has polygons that are not the focus of the map, you might give the
polygons a gray boundary and no color, thereby placing them in the background.

Symbolization is easy for vector maps because ArcGIS Pro can use attribute values to automate drawing.
For example, ArcGIS Pro could draw all food pantry facilities in a city by using unique values with a square
point symbol of a certain size and color. Continuing, the software could draw all soup kitchen facilities with a
circle of a certain size and different color by using an attribute with type-of-facility code values (including
“food pantry” and “soup kitchen”).

In this chapter, you will learn to use good cartographic (symbolization) principles as you build several
vector-based thematic maps.
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Tutorial 2-1: Choropleth maps for qualitative attributes
Placing objects of all kinds into meaningful classes or categories is a major goal of science. Classification in
tabular data is accomplished using attributes with codes that have mutually exclusive and exhaustive qualitative
values. For example, a code for size could have the values “low,” “medium,” and “high.” Any instance of the
features with this code is displayed in only one of the classes (the values are mutually exclusive). Moreover,
there are no more size classes (the values are exhaustive). In this tutorial, you learn how to symbolize mapped
features—points, lines, and polygons—by class membership as available in code attributes.

Open the Tutorial 2-1 project

1. Open Tutorial2-1.aprx from Chapter2\Tutorials, and save the project as Tutorial2-1YourName.aprx.
A New York City Zoning and Land Use map opens showing Neighborhoods and a light-gray raster
basemap. Two other layers, ZoningLandUse and Water, are available but not visible yet. None of the
vector layers is properly symbolized yet.
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2. Use the Lower Manhattan bookmark. The subject of this map, zoning and land use, is best viewed
and studied at approximately this zoomed scale or even closer, because the geographic zones are
relatively small in area. You must get close enough to distinguish them from one another.

Display polygons using a single symbol
The Neighborhoods and Water polygon layers provide spatial context. Such layers should be displayed using
outlines with no color fill, with water features being an exception and generally given a blue color and no
outline. Context layers are easy to symbolize. You can start with Neighborhoods.

1. In the Contents pane, under Neighborhoods, click the white color box to modify the symbol.

2. In the Format Polygon Symbol pane, under Properties, change Color to No Color.

3. Change the Outline color to Gray (60 percent), and click Apply.

YOUR TURN
Turn on the Water layer and symbolize the layer with a blue polygon symbol. Hint: On the Gallery tab,
search for Water and click one of the Water (area) symbols.

Display polygons using unique value symbols
The last layer to symbolize, Zoning Land Use, is the subject of the map, displayed by Unique Values on
primary land-use code. Land-use maps use muted colors, which you’ll create next.

1. Turn on ZoningLandUse, right-click the layer, and click Symbology.

2. In the Symbology pane, for Symbology, choose Unique Values.

3. In the Value field for Field 1, choose Landuse2. This step adds random colors for six land uses (your
colors may be different from those shown in the figure).

59



Next, you’ll assign colors used by the New York City Planning Department. You’ll start by changing the
outlines of all polygons from black to light gray. When you view land-use polygons, their black outlines often
take up too much of your map and attention, and also distract from the symbolized color. A gray color will
soften this interference and still show boundaries.

4. In the Symbology pane, click More > Symbols > Format all symbols.

5. In the Format Polygon Symbols pane, click Properties, and change Outline Color to Gray 20
percent.

6. Click Apply and the back button  to go back to the Symbology pane.

7. For Landuse2, click the symbol for Commercial, and change the color to Rose Quartz (first row,
second column).

8. Click Apply, the Back button, and apply these colors for the remaining land uses:

Manufacturing: Lepidolite Lilac (first row, 11th column)

Park: Apple Dust (seventh row, sixth column)

Residential: Yucca Yellow (first row, fifth column)

Residential/Lt Mfg.: Soapstone Dust (seventh row, third column)

Waterfront: Atlantic Blue (ninth row, ninth column)
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9. In the ZoningLandUse pane, click More, and clear Show all other values. All polygons have land-use
code values, so this option is not needed. If left on, other values would be entered in the legend in the
Contents pane and perhaps confuse the map reader.

10. Close the Symbology pane, and save your project. You can see all boundaries of primary land uses
with their gray outlines.
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Tutorial 2-2: Labels
Labels created from attributes such as neighborhood names are an important part of cartography and an
integral and informative component of a map. You must specify the elements of font, size, color, placement,
and visibility ranges to make labels easy to read.

Open the Tutorial 2-2 project
In this exercise, you will label all three layers of the map. Each layer will have its own label properties and
label placements.

1. Open Tutorial2-2.aprx from Chapter2\Tutorials, and save the project as Tutorial2-2YourName.aprx.

2. Use the West Village bookmark. To maintain visual clarity, labels for a detailed layer such as
ZoningLandUse are most useful when zoomed into the neighborhood level or similar larger scale
because of the number of small polygons.

Change label properties

1. In the Contents pane, click Zoning Land Use. The Feature Layer contextual tab appears on the
ribbon with the tabs Appearance, Labeling, and Data highlighted.

2. On the Labeling tab in the Label Class group, click the Field named Zone.

The field in this map has detailed zoning codes known by developers, planners, and other members of the
user community.

3. In the Layer group, click Label . Wait for the labels to appear; when they appear, the labels will get
defaults and should be customized to better suit the purpose of the map.
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4. Make these changes in the Text Symbol group:

Text Symbol Font Size: Choose 8.

Text Symbol Color: Choose Gray 50 percent.

5. In the Visibility Range group, for Out Beyond, choose <Current>. This step sets the visibility range
for zoning labels so that they do not display when zoomed beyond the current scale. Your scale will
not necessarily match the scale of the next figure, because scale varies with monitor resolution and
how the application is arranged.

6. Zoom in and out to see that the labels are on only when zoomed in closer than the West Village
bookmark. Note the map scale when the labels turn on or off.

YOUR TURN
Use the Lower Manhattan bookmark. Label the Neighborhoods layer using Name, Arial font, Bold,
Size 7, and a white halo. Finally, on the ribbon, on the Labeling tab in the Label Placement group, click
Label Placement > Land Parcel.

Label the Water layer using Landname. Use font Times New Roman, Italic, Size 12, and the color
Atlantic Blue.

Set the Neighborhoods and Water labels to turn off when zoomed out beyond the Lower Manhattan
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bookmark. Try out the labels by zooming in and out and using bookmarks.

Remove duplicate labels
Labels for some water polygons might overlap with redundant and unnecessary labels. Removing duplicate
labels will unclutter the map. You will do so using another menu option to set label properties.

1. In the Contents pane, right-click Water > Labeling Properties.

2. In the Label Class pane, click Position near the top of the pane, and then click the Conflict
Resolution button .

3. Expand Remove duplicate labels, and click Remove all.

4. Close the Label Class pane. The map will now show just one label for each water feature.

5. Save your project.
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Tutorial 2-3: Definition queries
Often, a map layer has more features than you want to display. If so, you can use a definition query to display
the desired subset of features from the larger collection, on the basis of values in the feature attribute table.
For example, the point features in this tutorial start with point features for all facilities in New York City
(food, health care, fire and police, schools, senior centers, and so on). You will want to display the features for
food facilities only, including food pantries and soup kitchens. Query definitions allow you to select and
display just these features. A definition query is different from the Select by Attributes in chapter 1. The
definition query is used to filter the display of a layer rather than selecting a temporary subset of features to
work with, even though they both use a similar SQL interface.

Open the Tutorial 2-3 project

1. Open Tutorial2-3.aprx from Chapter2\Tutorials, and save the project as Tutorial2-3YourName.aprx.
A NYC Food Pantries and Soup Kitchens map opens showing Boroughs, several other spatial context
layers, and the many facilities operated by the city government.

2. Zoom to full extent.
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Create a definition query
In this exercise, you will create a query to display a subset of more than 20,000 government and nonprofit
facilities in New York City. Facilities is a point layer of locations for services that the city provides. The map
needs only three out of more than 100 classes. Classes have both a numeric code (Facility_T) and a
corresponding description (Factype_1), and the three needed facility classes are 4901 = Soup Kitchen, 4902 =
Food Pantry, and 4903 = Joint Soup Kitchen and Food Pantry. Showing the location of these facilities could
help the directors of New York City’s food banks determine whether they are well located relative to poverty
areas of the city.

1. In the Contents pane, right-click Facilities > Properties.

2. In the Layer Properties: Facilities window, click Definition Query.

3. Click Add Clause, Facility_T as the field, Is Equal to as the logical operator, 4901 as the value, and
click Add. Currently, the definition query contains a single logical condition. Only records that satisfy
this condition will display.
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4. Click Add Clause, Or as the logical operator, Facility_T as the field, Is Equal to 4902, and click Add.
Now you have two single conditions connected with an Or to make a compound condition. Any
record satisfying one of the two simple conditions will be displayed. If you were to use the And
connector here, no records would be selected. A facility cannot have both code values 4901 and 4902.

5. Repeat step 3 with Facility_T equal to 4903. The final compound condition displays a subset of the
original table of facilities, which have one of the three included values. This example extends to any
definition query for selecting subsets of a finite collection of objects classified by a code such as
Facility_T. If you click the SQL button, you can see the SQL code that the definition query
generates and is run by ArcGIS Pro: Facility_T = 4901 Or Facility_T = 4902 Or Facility_T = 4903.
Because the three needed codes happen to be in numerical sequence, it’s also possible to generate an
alternative, equivalent compound criterion, Facility_T > = 4901 And Facility_T < = 4903, but this is a
special case.
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6. Click OK. The resulting map is a subset (631) of the original 20,000-plus facilities showing just Food
Pantries, Soup Kitchens, and joint Soup Kitchen and Food Pantries. You can verify this is true by
opening the attribute table for Facilities.

Symbolize figure and ground features
The subject of the map, Food Facilities, is figure, and all other layers are ground. Figure features get
accentuated with bright colors, and ground gets shades of gray.

1. Use the Manhattan bookmark. Someone using this map would not study the map with so many point
features at full extent but would zoom in, as shown with this bookmark.

2. In the Contents pane, click Facilities, and type Food Facilities as the name.

3. In the Contents pane, right-click Food Facilities > Symbology.

4. In the Symbology pane, for Symbology, click Unique Values.

5. Click Factype_1 as the value field. This field provides descriptions for the facility codes.

6. Drag the Soup Kitchen value to the top, Food Pantry to the middle, and Joint Soup Kitchen and
Food Pantry to the bottom. The legend in the Contents pane will then read Soup Kitchen, Food
Pantry, and Joint Soup Kitchen and Food Pantry.

Next, you’ll symbolize the three types of facilities. In this example, varying shape and color for unique point
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symbols is good practice. Color-blind people can use shape to identify facility classes; also facilities will remain
distinguishable in black-and-white photocopies of such symbolization. The majority of people who can see
color get the full effect of shape and color for seeing patterns of food facilities.

7. Use the Symbology Gallery and Properties to change these symbols:

Soup Kitchen: Square 3, Mars Red Color, Size 8 pt.

Food Pantry: Circle 3, Cretan Blue Color, Size 8 pt.

Joint Soup Kitchen and Food Pantry: Cross 3, Solar Yellow Color, Size 10 pt.

8. Click More, turn off Show all other values, and close the Symbology pane. Now the food facilities are
sharply in figure with contrasting bright colors and shapes. For example, you can easily see that
Manhattan has many more soup kitchens than the neighboring boroughs and that the northern part
of Manhattan and the adjoining Bronx have a large cluster of food pantries.

YOUR TURN
A policy decision-maker might want to know the streets where food facilities are located and doesn’t
want the details of a basemap. Turn off the World Light Gray basemap, and turn on Manhattan Streets.
Display Manhattan Streets as a ground feature using gray (20 percent) with width 0.5 pt. Zoom to a few
blocks in Manhattan and experiment with various label properties. Save your project.
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Tutorial 2-4: Choropleth maps for quantitative attributes
Showing continuous variation in numerical attributes is not possible when you use the attributes to symbolize
points or polygons on a map. The human eye simply cannot make distinctions unless there are relatively large
changes in graphic elements. You must break a numeric attribute up into relatively few classes (roughly three
to nine), similar to how you create a bar chart for a numeric attribute. Each class has minimum and maximum
attribute values. The minimum value is included in the class, but the maximum goes in the next classification
to the right. To symbolize map features, you need only the set of maximum values for classes, called “break
points.”

Open the Tutorial 2-4 project

1. Open Tutorial2-4.aprx from Chapter2\Tutorials, and save the project as Tutorial2-4YourName.aprx.
A NYC Food Stamps/SNAP Households by Neighborhood map opens showing boroughs,
neighborhoods, and water features.

2. Zoom to full extent.

Create a choropleth map of households receiving food stamps
A choropleth map uses color in polygons to represent numeric attribute values. Generally, increasing color
value (darkness of a color) in a color scheme represents increasing (higher) values. In this exercise, you will use
US Census data aggregated to New York City neighborhoods to create choropleth maps for households with
persons over age 60 receiving food stamps/SNAP (Supplemental Nutrition Assistance Program).

Choropleth maps use classification methods to display the data, and methods will vary depending on the
data and intent of the map. The default classification method is Natural Breaks (Jenks). This method uses an
algorithm to cluster values of the numeric attribute into groups, with the boundaries of the groups (break
points) defining classes. The Natural Breaks method may be suited for some applications in the natural
sciences. However, Quantile classification is often a better starting point, because the method is easily
understood and provides information about the shape of a distribution. The Quantile method breaks a
distribution into classes—each with the same percentage of data points. For example, each quartile (quantiles
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with four classes) has 25 percent of the data observations, with the middle break point being the median.

By studying quantile break points, you can determine whether a distribution is roughly uniform (has
equally spaced quantiles) or is skewed to the right (has intervals defined by break points that become
progressively larger with larger values). The former become good candidates for the Defined Interval method
(uniform distribution with easily read numbers for break points) and the latter for the Geometric Interval
method (for an increasing-width intervals distribution of break points). Many attributes have skewed
distributions.

1. In the Contents pane, click Neighborhoods, and type Over age 60 receiving food stamps to rename
the layer.

2. Open the Symbology pane for this layer, and use these guidelines to symbolize the layer:

Symbology: Graduated Colors

Field: O60_Food

Method: Quantile

Classes: 5

Color scheme: Gray (5 classes)

3. Click the Histogram view button . You can see that neighborhoods with the highest quintile
(quantile with five classes) tend to cluster. The interval sizes generally increase in this case, so a
geometric method is an alternative to the quantile method that you will test in Your Turn.
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4. Close the Symbology pane. The map clearly shows neighborhoods with a high number of households
with persons over age 60 who receive food stamps/SNAP.

YOUR TURN
Change the symbology method for the choropleth map from Quantile to Geometric Interval. The break
points become larger to provide more detail for the long tail of the distribution. The break points for the
quantile method were 830, 1620, 2970, 4831, and 11595. Those for the geometric method are 881,
2201, 4181, 7148, and 11595. Reselect the Gray (5 Classes) color scheme if necessary.

Try the Defined Interval method with an interval size of 2500. Although perhaps not the best method
for this skewed data, this uniform distribution is easy to read, having “nice” numbers, multiples of 2500,
with equal intervals.

Change the method back to five quantiles, close the Symbology pane, and save your project.
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Extrude a 3D choropleth map
You will learn much more about 3D data and scenes in chapter 11, but you can easily convert a 2D choropleth
map into a 3D scene to better visualize data. In particular, the map reader can get a better appreciation of
extreme values relative to other values, which are not readily apparent by looking at only the color shading of
choropleth maps. In 3D, features and layers are often physical features such as buildings, trees, topography,
and so on, but you can display any numeric data as 3D. Here, you will learn how to convert a 2D map to a 3D
scene and display neighborhood polygon features as 3D.

1. On the View tab, in the View group, click Convert . A 3D map automatically opens with
categories for 3D and 2D layers.

2. In the Contents pane, drag Over age 60 receiving food stamps directly under the 3D Layers category.
Next, you will begin extruding neighborhood polygons to 3D features using the numeric attribute
O60_FOOD as the “extrusion” height.

3. On the Feature Layer contextual tab, click the Appearance tab, and in the Extrusion group, click
Type > Base Height. Clicking Base Height sets the base of the extruded polygons to zero. Next, you
will set the extrusion height to the attribute O60_FOOD.

4. In the Extrusion group, for Extrusion Expression, choose [O60_Food].

Your features and food stamp recipient data are now displayed in 3D.

5. Drag the middle button on the mouse to tilt the view.

6. Zoom in to better see the extruded neighborhoods.
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YOUR TURN
Zoom by scrolling the mouse wheel, and pan by dragging the map. You will learn much more about 3D
map navigation in chapter 11. Save your project.
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Tutorial 2-5: Map using graduated and proportional point symbols
Using ArcGIS Pro, you can display polygon data using point symbols in the center (centroid) of each polygon.
In the next exercise, you will create a map showing the number of food pantries and soup kitchens in New
York City neighborhoods as graduated size point symbols. The larger the symbol, the more food resources in
each neighborhood. You can also display data as proportional symbols that are similar to graduated symbols
but represent values as unclassified symbols whose size is based on a specific value.

Open the Tutorial 2-5 project

1. Open Tutorial2-5.aprx from Chapter2\Tutorials, and save the project as Tutorial2-
5YourName.aprx. The map opens showing New York City neighborhoods, boroughs, and
neighborhoods with households and persons over 60 receiving food stamps, which is already classified
using quantiles.

2. Zoom to full extent.

Create a map of graduated size points
The map of this exercise uses two copies of the Neighborhoods polygon layer. One copy displays household
data as a choropleth map. The other layer displays the number of facilities using graduated point symbols.
Using two copies of the same layer is a way to show two attributes of a polygon layer in the same map.

1. In the Contents pane, rename the first Neighborhoods layer as Number of food banks/soup kitchens.

2. In the Symbology pane, use these guidelines to symbolize the layer.

Symbology: Graduated Symbols

Field: Food_Facil

Method: Quantile

Classes: 5

Notice that the interval width is uniform, 2, except for the last class, so this attribute may be a good
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choice for the Defined Interval method (uniform distribution). An interval width of 5 is a good choice to

include the maximum value of 25. Equal-width intervals are the easiest to read and are, of course, best
suited for uniform distributions, but this distribution is not essential. Another possible method is defined
interval, which allows you to use easily read numbers such as 1, 2, or 5 times 10 to a power (for example,
0.1, 1.0, and 10).

3. Change Method to Defined Interval. You may need to resize the Symbology pane to see the options.

4. Click the Template symbol (circle), and choose Solar Yellow as the color.

5. Click Apply and the Back button. Your symbology should match what is shown in the figure.

6. Close the Symbology window, and zoom to full extent. The finished map shows the number of food
resources compared with the number of households with over age 60 receiving food stamps. The food
pantries and soup kitchens appear concentrated in areas with poor populations, for the most part, as
indicated by the map.
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YOUR TURN
Turn on and rename the second Neighborhoods layer as Under 18 receiving food stamps. Use
Proportional Symbols, U18_Food as the Field, a shade of purple as the color, 2 as the Minimum size,
and 20 as the Maximum size. Use the Bronx and Brooklyn bookmarks to study the relationship of food
banks, soup kitchens, and persons over 60 and under 18 receiving food stamps in one map. Save your
project.
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Tutorial 2-6: Normalized population map with custom scales
A choropleth map showing population, such as the number of persons receiving food stamps, is useful for
studying needs, such as the demand for goods and services. For example, delivery of food services for the poor
requires capacities to match populations, including budgets, facilities, materials, and labor.

Choropleth maps of normalized population data have different uses than choropleth maps of populations.
Dividing (normalizing) a segment of the population by the total population provides information about the
makeup of areas. For example, areas with high proportions of total population receiving food stamps may be
better candidates for food pantries and soup kitchens than those with low proportions, because the high-
proportion areas are likely poor in many ways, including having poor geographic access to grocery stores and
urgent health care.

In this tutorial, you will normalize the number of female-headed households (single mothers) with
children under the age of 18 receiving food stamps by the total number of households in each neighborhood.
You will find the same information for male-headed households (single fathers) with children under the age
of 18 receiving food stamps and compare the two populations using a custom scale.

Open the Tutorial 2-6 project

1. Open Tutorial2-6.aprx from Chapter2\Tutorials, and save the project as Tutorial2-6YourName.aprx.
The map opens showing New York City neighborhoods (female-and male-headed households
receiving food stamps), boroughs, and water features.

2. Zoom to full extent.

Create a choropleth map with normalized population and custom scale
You will create a custom classification, which often is easier to read than other classifications. The Geometric
Interval method works well for representing the long tails of distributions skewed to the right, but the break
points of this method do not follow a pattern that can be read easily. The custom classification of this exercise
has intervals that double in width (and therefore forms a geometric progression), which is read easily.
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1. Symbolize Female headed households receiving food stamps using these guidelines:

Symbology: Graduated Colors

Field: U18FHHFood

Normalization: TOT_HH

Method: Quantile

Classes: 5

Color scheme: Orange-Red (5 classes)

These settings show the fraction of single mothers with children under 18 receiving food stamps. Next,
you will show the values as a percentage.

2. Click the Symbology Options button  > Advanced > expand Format labels.

3. In the Category menu, choose Percentage.

4. For Percentage, click “Number represents a fraction…”, and for Rounding, choose 0 for Decimal
places.

5. Click the Back button, and click the Histogram view button. The classification will now show the
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percentage of single mothers who receive food stamps. Expressed as percentages and rounded, the
quantile break values are 1 percent, 2 percent, 6 percent, 10 percent, and 26 percent. Next, you will
create custom classes using the mathematical progression 2 percent, 4 percent, 8 percent, 16 percent,
and 26 percent, and the last value is the maximum.

6. Change the method to Manual Interval.

7. Click the Label View button .

8. In the Class breaks panel, click the cell for the first Upper value, type 0.02, and press Enter. This
makes the first class 2 percent.

9. Continue selecting break points, and enter 0.04, 0.08, 0.16, and 0.26 (the maximum value rounded
to two decimal places).

10. Click the Histogram view button. Notice that this set of break points has wider intervals for low
values than quantiles, which allows an additional value (0.16) for high values, thereby providing more
information about high values.
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The numerical sequence of the custom break points has both increasing interval widths as desired for the
long-tailed distribution and a recognized and easy set of values to read.

Import symbology and use swipe to compare features
To easily compare two maps, especially normalized segments of the same total population, you will use the
same numerical and color scales for both maps. ArcGIS Pro allows you to easily import symbology. Next,
you’ll import and reuse the symbology of the female-headed households for the male-headed households. You
will see many fewer male-headed households receiving food stamps.

1. Open the Symbology pane for Male-headed households receiving food stamps, click the Options
button  > Import symbology.

2. In the Geoprocessing pane, make the selection as shown:

82



3. Click Run, and when it finishes, close the Geoprocessing and Symbology panes.

4. In the Contents pane, click Female headed households receiving food stamps.

5. On the Appearance tab under Effects, click Swipe, and drag the cursor vertically or horizontally to
reveal the layer underneath. This step allows you to see the values of the male-headed household
receiving food stamps layer without having to turn off the layer above it. You can see the same spatial
patterns in both maps, but with much lower percentages for male-headed households receiving food
stamps.

6. On the Map tab, click the Explore button to deactivate swipe.

7. Save your project.
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Tutorial 2-7: Density maps
Density maps divide populations and other variables by their polygon areas, yielding a measure of spatial
concentration. If you divide a population by its polygon areas, the resulting population density (for example,
persons per square mile) can provide information related to congestion or how people are distributed across an
area.

A neighborhood with a high density of households receiving food stamps but a low density of food banks
and soup kitchens may help determine potential locations for new food banks or kitchens.

Open the Tutorial 2-7 project

1. Open Tutorial2-7.aprx from Chapter2\Tutorials, and save the project as Tutorial2-7YourName.aprx.
The map opens with neighborhoods added but not yet classified.

2. Zoom to full extent.

Create the density map

1. Using these guidelines, symbolize Food bank/soup kitchens (SQ MI):

Symbology: Graduated Colors

Field: Food_Facil

Normalization: Area_SQMI

Method: Manual Interval

Classes: 5

Color scheme: Blue-Purple (five classes)

Break points: 2, 4, 8, 16, 29
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2. Close the Symbology pane. You can readily see where there are high densities of food banks and soup
kitchens.

YOUR TURN
Create a density map for “Persons below poverty level receiving food stamps (SQ MI)” using
(POV_Food) normalized by Area_SQMI. Use Graduated Symbols; 4 classes, Manual Interval with
upper values 300, 900, 2700, and 13000; circle 3 with Solar Yellow color; and a symbol size range from 4
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to 12. Zoom and pan the map. Do you see any gaps with high population densities but low food facilities

densities? Save your project.
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Tutorial 2-8: Group layers and layer packages
You can place layers together into groups to manage them more easily. For example, you can change the
visibility of an entire group layer with one click. You can also save a group layer (or any single layer) as a layer
package (a file with an .lpkx extension). A layer package is one file with all data sources and symbology
included. You can share this package with others, including in ArcGIS Online. In this tutorial, you will create
group layers for populations and facilities in New York City by administrative and political features, including
fire companies and police precincts. You will then create layer packages from layer groups.

Open the Tutorial 2-8 project

1. Open Tutorial2-8.aprx from Chapter2\Tutorials, and save the project as Tutorial2-8YourName.aprx.
The map opens with the layers Boroughs, Police stations, Police precinct population per sq mile, Fire
houses, and Fire company population per sq mile already symbolized.

2. Zoom to full extent.

Create police group layer
There are two ways to create group layers. The first way is to create an empty group layer, and then add layers
to the group layer. The second way is to select existing layers in the Contents pane and create a group layer of
the selection. You will use the first method to create a group layer for police.

1. In the Contents pane, right-click the map NYC Facilities and Population, and click New Group
Layer. A new layer, called New Group Layer, is created. Next, you will rename the layer.

2. Right-click New Group Layer > Properties.

3. In the Layer Properties window, on the General tab, for Name, type NYC Police.

4. On the Metadata tab, fill in the information:

Title: NYC Police
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Tags: NYC, Police Stations, Precincts, Population

Summary: NYC Police Stations and Precinct Populations

Description: Same as Summary

5. Click OK.

6. In the Contents pane, drag the layer Boroughs just below the new layer group NYC Police.

7. Expand the layer group, and drag Police stations and Police precinct populations by sq mile below
Boroughs.

8. Expand NYC Police to see the group layer’s member layers. These layers are indented below the layer
group name NYC Police.

Create fire group layer
Here you use a shortcut to create a group layer using selected layers.

1. In the Contents pane, press and hold the Shift key, and select layers Fire houses and Fire company
population per sq mile.

2. Right-click either layer, and click Group.

3. In the Layer Properties window, rename the new group NYC Fire.

4. On the Metadata tab, fill in the information and click OK:

Title: NYC Fire

Tags: NYC, Fire Houses, Companies, Population

Summary: NYC Fire Houses and Company Populations

Description: Same as Summary

5. Copy and paste the Boroughs layer from the NYC Police group layer to the NYC Fire group layer.

6. Rearrange the order of the layers in the group layer as shown.
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7. In the Contents pane, click the NYC Police group layer.

8. On the Appearance tab, under Effects, drag the transparency from 0 to 100%. Drag the transparency
back to 0. This is an alternative to swipe that is not available in a layer group. If transparency is set to
100 percent, it will be at 100 percent in the layer package, and the features won’t show up when the
package is added to the new map until transparency is reduced.

9. Collapse both groups to one line each, NYC Police and NYC Fire, and expand both groups to show
all layers.

Create and add a layer package
A layer package is a portable file with data and symbolization for all layers in a group or for a single layer that
you can share or upload to ArcGIS Online. In addition to creating layer packages, you can also create and
share individual layers as layer packages.

1. In the Contents pane, right-click NYC Police, and click Share As Layer Package.

2. Make selections or type as shown, saving the layer package file to Chapter2\Tutorials. Note that you
cannot have spaces in the layer package name.
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3. Click Analyze and then Package, and wait for the layer package to be prepared. You will see a
message stating that the layer package was successfully created. Your new layer package can be used in
another map, shared with another ArcGIS user, or uploaded to ArcGIS Online.

4. Insert a new map, and add NYC Police from Chapter2\Tutorials. The layers will appear as a group
and be already classified.

YOUR TURN
Create and add a layer package for NYC Fire to a new map, and save your project.

Assignments
This chapter has four assignments to complete that you can download from this book’s resource web page, at
esri.com/gist1arcgispro:

Assignment 2-1: Analyze accessibility to charter schools in New York City.
Assignment 2-2: Study K-12 population versus school type densities.
Assignment 2-3: Analyze military sites for closures by congressional district.
Assignment 2-4: Analyze US veteran unemployment status.
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CHAPTER 3

Map outputs for GIS projects
LEARNING GOALS

Learn about alternatives for sharing maps and information from GIS projects.
Build map layouts.
Add visibility ranges for interactive map use.
Build story maps.
Make professional-quality tables and charts in Microsoft® Excel (optional).

Introduction
Map outputs start with the interactive maps that you have been creating and using in ArcGIS Pro in chapters
1 and 2. Those maps are fine for you and may be all you need personally, but what about others who need
spatial information—your friends, your boss or clients, a group to which you belong, stakeholders in a public
policy issue, or simply the public at large? What if they do not have ArcGIS Pro, and if they do, what if they
don’t have your GIS files? This chapter focuses on providing maps that others can access, even users who may
have no GIS knowledge or software. In addition to accessibility, this chapter also introduces GIS outputs,
including map outputs that have nonmap elements to enable map reading and interpretation.

Consider the problem, addressed in this chapter, of college students about to get their undergraduate
degrees from fine arts programs. They love their particular field of art, but it’s difficult to find good-paying
jobs in fine arts, or in some cases, any jobs at all. They’re willing to relocate to a new city if they can find their
dream jobs.

Suppose that a national organization for promoting fine arts education wants you to complete a GIS
project—namely, to build a tool for arts students that lets them explore employment possibilities. The tool is
an interactive map that displays the number of employees and average incomes in the arts field by state and
city in the United States. The tool also addresses the complex but essential issue of cost of living. For example,
is a $60,000-a-year job in New York City better financially than a $30,000-a-year job in Columbus, Ohio,
after cost of living is factored in? It’s not, if the cost of living in New York City is more than twice that of
Columbus, assuming that all income is spent on living expenses.

Suppose further, that you’ve already collected the data and have maps built in ArcGIS Pro. How can you
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get the results into the hands of arts students across the United States and around the world? In the days
before ArcGIS Online and apps such as Esri® Story Maps (that you’ll learn to use in this chapter), there was
no easy answer to this question. Now, there are good answers, with a range of old and new options available
depending on your map audience’s needs.

In general, to share maps from a GIS project, the map outputs must be accessible and readable, and they
must also tell a story, to wit:

1. Be accessible: Make your maps available in hard-copy documents, in emailed electronic
documents or links, from a website, or from an app. Each form of output is valuable for
different circumstances. A lay audience may be best served with static maps (images), printed in
a document or on a presentation slide. That form of output does not require an audience to
learn how to navigate an interactive map, and the author controls the desired message, with
maps designed to share information. More sophisticated users might want to explore spatial
information on their own, focusing on items and areas of interest to them (and unpredictable by
you in advance) in an interactive app.

2. Be readable: Include titles, legends, scales, and other elements that allow direct interpretation of
maps. These elements, called map surrounds, are essential.

3. Tell a story: Explain as needed the context, sources and quality of data, problem addressed, map
solution, analysis, and limitations of the solution. GIS projects include stories that have one or
more maps at the center, but the projects also may need text, data tables, charts, images, and
hyperlinks.

One solution is to publish maps in ArcGIS Online and make them publicly available in an app such as
Explorer for ArcGIS®. Then anyone can search for and interactively use your maps, or you can send anyone
the URLs of the maps. That solution takes care of most accessibility and readability issues, and you already
know how to publish maps online.

Another option is to create map layouts that include one or more maps and surrounds for interpretation.
Then you can export a layout as an image file (for example, JPEG) and paste the file in a Microsoft Word
document report or a PowerPoint slide in a presentation. You also can embed a layout in a web page to cover
all three issues noted earlier, albeit with static maps. You’ll learn how to create a layout in this chapter.

A third option is to use one or more maps you published in ArcGIS Online in a story map. Esri Story
Maps include many apps that not only have one or more interactive maps but also allow you to include map
surrounds, text, images, hyperlinks, and other materials. Story maps require little or no knowledge of website
hosting, publishing, or underlying web programing.

This chapter includes two additional, supporting topics for you to use in GIS outputs. The first topic is
visibility ranges, which enhance interactive map output for complex or detailed maps. The basic idea of
visibility ranges is simple. When zoomed far out or at full extent (at small scales), you can automatically have
major map layers turned on but detailed layers turned off. Then when you zoom in (to large scales), you can
have detailed layers turned on when you need to see them. The second topic focuses on creating tables and
charts in Microsoft Excel for use in Story Maps. Tutorial 3-4 is optional for those who do not have Microsoft
Excel skills and want to make professional tables and charts, and then save them as screen captures to be used
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as resources in building story map content.
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Tutorial 3-1: Layouts
In this tutorial, you will build a map layout with two maps. Once you learn this skill, you can build any kind of
layout, with one, two, or several maps, plus other elements. The purpose of the layout you will build next is to
provide state-level information on the location of jobs in the arts field and average annual wages.

The layout you’ll build doesn’t have a layout title (at the top such as “Maps showing arts employment,
2015”). The reason is because this layout, like most you’ll produce, is destined to be used as a figure in a
report, a slide in a presentation, or an image in a website. The layout title is better created in a word processer
as a figure caption, in a presentation package as a slide title, or on a website.

Open the Tutorial 3-1 project
Both maps for which you will need to build a layout already exist and are ready for use in the Tutorial 3-1
project file that you are about to open.
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1. Open Tutorial3-1.aprx from Chapter3\Tutorials, save it as Tutorial3-1YourName.aprx, and zoom to
full extent.

2. Open the second map, Arts Employment, and zoom to full extent.

Create a new layout
A layout starts as a blank canvas to which you can add one or more maps, surrounds, and other elements of
your choice and design. Although it’s possible to add images of tables and charts to layouts, tables and charts
are better placed in reports, presentations, and websites as separate tables and figures. Therefore, you can keep
your layouts fairly simple and just include maps, legends, and other common map surround elements.

1. On the Insert tab, click the New Layout button  > Letter 8.5” × 11”. You can widen your ArcGIS
Pro window if you don’t see the New Layout button.
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2. In the Catalog pane, rename the layout as Arts Employment Layout.

Add maps to the layout

1. In the Contents pane, right-click Arts Employment Layout, and click Zoom to Page.

2. On the Insert tab, click the Map Frame arrow , and select the Arts Employment map. This step
adds the Arts Employment per 1,000 Population map to the layout.

3. Likewise, insert the Arts Employment map from the second row.

Resize and place the two maps
Next, you must resize the two maps in the same dimensions, and then set their positions. Setting the
dimensions is not an exact determination, except that the maps should be the largest elements in the layout.
Planning and trial and error are involved in getting a layout to look right. This exercise simply provides a set
of dimensions and placement locations to save you time and to ensure your results match those of the finished
layout shown at the start of this tutorial. In a later exercise to add legends to the layout, you’ll use an
alternative, graphic method of sizing and locating layout elements.

1. Right-click the Arts Employment per 1,000 Population map (blue color scheme), and click
Properties.

2. In the Format pane, click the Placement button , and type 5.5 for width and 3.5 for height, type
0.5 in. for X and 5.75 in. for Y, and then press Tab.

3. With the Format pane still open, click the second map (Arts Employment, green color scheme), type
its dimensions to be the same (5.5 by 3.5), and type 0.5 in. for X and 1.50 in. for Y. Close the Map
Frame pane.

Next, you’ll change both maps in the layout to full extent.

4. On the Layout tab in the Map group, for each map click the Full Extent button, and click the Fixed
Zoom-In button  once so that the maps fill their frames.

5. Save your project.
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Add guides
In this exercise, you’ll use guides to position objects in a layout (legends, in this case). The guides are available
from the horizontal and vertical rulers bordering the layout. When you drag objects, such as a map frame, they
snap to guides. If there are intersecting vertical and horizontal guides, you can snap a corner of an object to
the intersection.

1. If your layout does not have horizontal and vertical rulers, right-click in the white area of the layout
and select Rulers and Guides.

2. Right-click the vertical ruler at 5, and click Add Guide. Do the same at 8 (you may have to count tick
marks to find the “8” and other locations on the ruler). Finally, do the same at 9.25 (at two tick marks
above 9, because each tick mark is 1/8 of an inch).

3. Right-click the horizontal ruler at 6.25 (two tick marks to the right of 6), and click Add Guide, and
then do the same for 8. You’ll place legends within the guides and bottoms of maps.

99



Insert legends
Using ArcGIS Pro, you’ll build a legend for all layers of a map that are turned on (all layers are turned on, in
this case). The legend is dynamic: if you change symbolization on the map, turn on or off layers, and so on,
the legend automatically updates in the layout.

1. Click the top map to make it active.

2. On the Insert tab in the Map Surrounds group, click the Legend button , and then drag a rectangle
with the upper-left corner at the intersection of the 9.25 horizontal and 6.25 vertical guides and the
lower-right corner at the 8 in. vertical guide and bottom of the top map. ArcGIS Pro creates and
draws the legend, but it does not draw completely as indicated by the red dots in parentheses. The
labeling for the choropleth map for the legend is too wide to fit in the layout. In the next exercise,
you’ll fix this problem so that the entire legend is visible.
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3. Click the bottom map in the layout, and create its legend as shown. This legend’s labels are not too
wide, so the legend draws completely within the available space.

Modify legends
Next, you will convert the top legend to a static graphic, ungroup legend elements, edit them to be narrower,
and regroup them.

1. Click the top legend, drag a grab handle on its right side to the right beyond the edge of the layout,
and release the handle so that the entire legend draws.

2. Right-click in the top legend, and click Zoom to Selected.

3. Right-click the top legend again, and click Convert to Graphics. This action causes the legend to be
static so that it no longer automatically updates if you turn layers on or off on maps or make other
changes to the map. Ensure that you complete step 4 next so that step 5 works.

4. Click anywhere in the white area outside of the legend to deselect the legend.
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5. Right-click the top legend again, and click Ungroup.

6. Right-click and click Ungroup again so that each legend line is a separate graphic.

7. In the top part of the legend, click States, and press Delete.

8. Click Employment per 1,000 Population, and press Delete.

9. Double-click the Employment Arts/Population (Thousands) text box, and in the Format Text pane,
click the Options button .

10. In the Text box, place your cursor after Employment Arts, press Shift and Enter, and close the
Format Text pane.

11. Finally, select all elements of the legend by dragging a rectangle, right-click the selection, and click
Group. Now the legend is back to being one graphic.

YOUR TURN
Modify the bottom legend, deleting the USStates and Employment text boxes. Move the top half of the
legend down a bit to eliminate the extra space between the two halves. Regroup the legend. Zoom to
Page when you finish. Save your project.
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Insert text
Next, you’ll insert text, titling each map (but not the whole layout).

1. On the Insert tab in the Text group, click the Text button .

2. Click above the top left corner of the top map.

3. Double-click the new text element to open Format Text.

4. Under Text, click in the text box, and type Arts employment per 1,000 population, press Shift and
Enter, and type and annual average wages.

5. In the Format Text pane, click text symbol > Appearance. Change the size to 16 pt, and click Apply.

6. Move the text to right above its map and left aligned to the map.
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YOUR TURN
Insert text for the bottom map. Type Arts employment, press Shift and Enter, and type and annual
average wages. Change the font to 16 pt. To finish up, press the Shift key, select both text boxes and the
two maps (but not the legends), right-click the selection, click Align > Align Left. Close the Format
Text pane, and save your project.
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Tutorial 3-2: Visibility ranges
This tutorial will show you how to set visibility ranges for map layers and feature labels. GIS uses visibility
ranges to automatically turn map layers on and off, depending on how far you’re zoomed in or out of your
map. Before you work with visibility ranges, you will learn about map scale, the underlying measure that
controls visibility ranges.

Suppose that you have two points on your map, A and B, which are one inch apart on your computer
screen. Map scale is the ratio of the distance between A and B (1 inch) on your computer screen divided by the
distance between the same two points in inches on the ground. An example scale for displaying the lower 48
states is 1:50,000,000, meaning that one inch on your computer’s map corresponds to 50,000,000 inches on
the ground. Map scale is unitless, being a ratio that divides out units, so for example 1:50,000,000 can also
mean 1 foot on your map equals 50,000,000 feet on the ground. Any distance unit can be used. The map
terms “small scale” and “large scale” are counterintuitive, so understanding the next three sentences is
important. The scale 1:50,000,000 is called “small scale” because the ratio 1/50,000,000 is small, even though
the map shows a large area. And the scale 1:24,000 is considered “large scale,” because its ratio is relatively
large, even though the map shows a small area. All map scales are considerably less than 1 because 1:1 is life
size, and all maps represent land areas much larger than the maps themselves.

Next, you’ll set visibility ranges to view arts employment at the state level when the map opens at full
extent, so when you zoom in close enough, employment at the metropolitan (city) level will turn on. First, you
will work on arts employment across the United States, and then you can zoom in to a state of interest to get
employment in a metropolitan area.

Open the Tutorial 3-2 project

1. Open Tutorial3-2.aprx. The project opens with all layers turned on and in a jumble. You’ll set a
visibility scale to automatically turn off the metropolitan points at the full map extent.
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2. Save the project as Tutorial3-2YourName.aprx in the Tutorials folder.

Set visibility ranges for map layers
Map scale depends on the size of your computer screen and the size of your map view (the larger your map
view, the larger the map scale), so the steps that follow cannot use specific map scales for triggering visibility
ranges. Instead, the project has spatial bookmarks you’ll use to get appropriate map scales for your particular
screen.

1. Use the Arizona bookmark. At this map scale (1:8,600,131 in the figure that follows but different on
your computer) and further zoomed in, you’ll set visibility ranges to display the Employment point
layer and turn off the display of Wages. You can turn off Wages when you zoom in, because if you
were the map user, you’d already know Arizona’s average wages in the arts industry from the map of
the 48 states, which is the starting view. If you were to add up the metropolitan arts employment
points from Arizona, you’d get a total of 29,570. The difference, 30,930 −29,570 = 1,360, is
nonmetropolitan arts employment. Most of the arts employment, 74 percent, is in the Phoenix area
with 16 percent in Tucson, accounting for 90 percent of the state’s arts employment.
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2. In the Contents pane, right-click the Employment Layer, and click Properties.

3. On the General tab in the Visibility range section, click the Out beyond (minimum scale) arrow,
select <Current>, and click OK. So, when you’re zoomed out beyond the current scale of the Arizona
bookmark and up to full extent, Employment will be turned off. If you zoom in closer than the
Arizona bookmark, the layer will turn on.

4. In the Contents pane, right-click the Wages layer, and click Properties.

5. On the General tab, in the Visibility range section, click the In beyond (maximum scale) arrow, select
<Current>, and click OK. Now Wages will display when zoomed out farther than the Arizona
bookmark and turn off when zoomed closer in than the bookmark. Next, you’ll test the two visibility
ranges.

6. Zoom to full extent. Employment Arts has no visibility range and so is always on. Wages is on
because you’re zoomed out from Arizona, but Employment is turned off for the same reason.
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7. Use the Indiana bookmark. Indiana is smaller than Arizona (while filling the computer screen,
Indiana has the larger map scale of 1:6,880,105 in the next figure compared with Arizona’s
1:8,600,131); therefore, Indiana has Employment points turned on and Wages turned off.

8. Zoom to full extent, and save your project.

Set a visibility range for labels
You can turn a feature layer’s labels on and off using visibility ranges, too. For example, when at full extent, it’s
helpful to have state names displayed as labels, but when zoomed in, the labels are no longer needed and
amount to a small amount of clutter.
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1. Use the Arizona bookmark. The objective is to turn off the state name labels when zoomed in closer
than Arizona.

2. In the Contents pane, select the Employment choropleth map. The Feature layer contextual tab for
this layer appears at the top of the ArcGIS Pro application.

3. On the Feature Layer contextual tab, click Labeling. This label already has labeling on and
configured but so far does not have a visibility range.

4. For In Beyond in the Visibility Range group of the Labeling tab, select <Current>.

5. Zoom to full extent. The state labels are on.

6. Zoom to Indiana. The state labels are off, even though the Employment choropleth layer remains on.

7. Save your project.

YOUR TURN
Open the Cost of Living Index map. For now, it’s sufficient to say that certain West and East Coast
places are a lot more expensive to live in than other parts of the country, as seen on the map that follows.
Here your tasks are to set visibility ranges similar to those you just did. Turn on Cost of Living Index for
cities and turn off Wages when zoomed in to Arizona and beyond. Turn off state name labels when
zoomed in closer than Arizona. Save your project when finished.
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Tutorial 3-3: Story maps
The Esri® Story Maps apps have different configurations, including one or more interactive maps. Story maps
also allow you to include map surrounds, paragraphs of text with extensive formatting, images, hyperlinks, and
other content. The maps in story maps are fully interactive, including the usual navigation, plus pop-ups and
visibility ranges that you create in ArcGIS Pro.

You will use this plan for building a story map on arts employment.

1. You’ll publish two of the three arts employment maps that you’ve been using in this chapter to
your ArcGIS Online account. Left out will be the Employment per 1,000 population map,
which does not play a major role.

2. You’ll use a Story Maps app for presenting the two maps, the Side Accordion layout of the Esri®

Story Map SeriesSM app. This layout allows you to have large amounts of nonmap content for
each map. The content expands like an accordion and has scroll bars.

3. With the maps in place, you’ll copy and paste text and images (for telling the story) that are
already written and created, and available in your Chapter3 folder data files.

In general, you will use this workflow for building a story map:

You’ll author your maps in ArcGIS Pro, providing aliases for attributes, adding and symbolizing map
layers, and creating visibility ranges.
You’ll share, or publish, your maps in your ArcGIS Online account where you configure pop-ups and
do some labeling.
You’ll launch an online wizard to guide you through the construction of a Story Maps app, which
includes adding maps from your ArcGIS Online account, and adding nonmap content.

The next guidelines will help you successfully publish your ArcGIS Pro story maps to ArcGIS Online.
Some of these guidelines use material from chapters 4 and 5, so you can refer to this paragraph after you finish
those chapters and whenever you create story maps.

Keep ObjectID and Shape fields visible in all layers (open Fields View and ensure those fields are
checked). See chapter 4.
Make your joins of tables to maps permanent (right-click the layer with a join, click Data > Export
Features, and use the result for mapping). See chapter 4.
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Share your map and any resources (for example, JPEG images) with everyone. In ArcGIS Online,
navigate to My Content, select all files included in your story map, and click Share > Everyone
(public).
Although not essential, it’s a good idea to give your maps and all feature classes the WGS 1984 Web
Mercator (Auxiliary Sphere) projection. This projection will guarantee that your map layers display
online and will publish your map faster online. Use the Project tool to change projection of a map. See
chapter 5.
Also, although not essential, you can make a new map layer using the Feature To Point tool to map
center points of polygons if you are symbolizing center points of polygons (for example, with
graduated size point symbols for a quantitative attribute). This process will speed up rendering your
map online. Check the Inside option to make all centroids lie inside their polygons. See chapter 4.

Open the Tutorial 3-3 project

1. Open Tutorial3-3.aprx. This tutorial has two of the maps from the finished tutorial 3-2, with
visibility ranges added to maps.

2. Save the project as Tutorial3-3YourName.aprx in the Tutorials folder.

3. Right-click each layer in the Contents pane, and click Disable Pop-ups for all map layers of the Arts
Employment map. Pop-ups slow the map-sharing process you are about to carry out next. You’ll
configure pop-ups in ArcGIS Online after the map is published.

4. Similarly, click Disable Pop-ups for the Cost of Living Index map.

5. Save your project.

Create label fields for use online
Your maps need labels for metropolitan areas that combine data from more than one field. Next is an example
of the Metropolitan Employment layer of the Arts Employment map:

Cleveland-Elyria, OH, Employment = 10890, Wages = $46150

Here “Cleveland-Elyria, OH” is from the Name field, 10890 is from the employment field, and “46150” is
from the Wages field of Metropolitan Employment. All characters not mentioned in the previous sentence are
hardwired text that are constant. The Python scripting language expression that creates the label value, stored
in a field named Label, is as follows:

The + sign is the concatenation operator that concatenates (or adds together) text from different sources to
create a new text value. Any string of text enclosed in exclamation points, such as !NAME!, retrieves values
from a field—the Name field, in this case. Any string of text enclosed in double quotes is constant. It’s only
possible to concatenate text values, but Employment and Wages are floating point numbers. The int()function
converts floating point values to integers (to eliminate decimal places), and the str()function converts numeric
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values to text. You’ll label layers in ArcGIS Online, where it’s convenient to have data for a label already

assembled in a field, so you’ll calculate label fields before publishing web layers.

1. Open the Arts Employment map and the attribute table for Metropolitan Employment. This table
already has a text attribute named Label with the correct labels computed, and a second text attribute
named LabelPractice, in which you will re-create the labels for practice.

2. In the table, right-click the LabelPractice heading, and click Calculate Field.

3. Create the expression as shown in the figure. You can add fields by double-clicking in the Fields
panel and clicking the + from the list of operators, but you must type everything else including spaces
as seen in the figure.

4. Run the Calculate Field tool. If you get an error message, review your expression carefully. If needed,
you will correct the errors and run it again. You should see values such as the values shown in the
figure.

5. Close the Geoprocessing pane, and close the table.
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YOUR TURN
Open the Cost of Living Index map, and compute these values for the LabelPractice field of the
Metropolitan Cost of Living Index map layer:

Label already has the values from the expression computed, but recomputing them in LabelPractice is
good practice.

Share maps in ArcGIS Online
You must first share (publish) maps for use in Story Maps (and other ArcGIS Online apps) in ArcGIS
Online. You have two maps to share: Arts Employment and Cost of Living Index.

1. In Windows or File Explorer, navigate to Chapter3\Tutorials\Resources, and double-click
StoryMapManuscript.docx to open that document in Microsoft Word. The document starts with
text for you to copy and paste into ArcGIS Pro when you share the employment maps. Additional
text is for the content that accompanies maps that you’ll use in the next tutorial for creating a story
map. Each section for copying and pasting is numbered for easy reference. Note that it is common
practice to compose content in Microsoft Word, and then copy and paste the content to apps or
websites. If you have collaborators, it’s helpful to use Word’s Review capabilities to collect feedback,
corrections, additions, and so on.

2. With the Arts Employment map open, click Share > Web Map.

3. Zoom your map to full extent. This step is necessary at this point so that the default extent for the
map in ArcGIS Online will be full extent.

4. Add your name after Arts_Employment (for example, Arts_Employment_Mary_Smith). All maps
stored in an organizational account must have unique names, and if your work is being graded in a
class, adding your name makes it easy for an instructor to identify your work as well as make your
map’s name unique.

5. Copy and paste the summary text from item 1 of the Word document into the Item Description
Summary text box.

6. Type the tags as seen in item 1 into the Item description tags, pressing Enter after typing each tag.
Copy and paste does not work for tags, so you must type them in.

7. Under My Content, for sharing options, select Everyone. You must share your maps and all other
resources used in a story map with everyone; otherwise, only you will be able to view your story map.
If you have an organizational account, you can share only with your organization instead of the
general public. Note that instead of Carnegie Mellon University as seen in the figure, your sharing
options include the name of the organizational account you are using.
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8. Click Analyze. No problems are anticipated in uploading the map.

9. Click Share. Publishing the map could take a few minutes.

YOUR TURN
Similarly, share the Cost of Living Index map, copying and pasting text from item 2 of the
StoryMapManuscript.docx. Remember to click Share > Web Map, then zoom to full extent, and then
fill out the Share As Web Map pane.

Move online maps to a new folder
You’ll publish more maps in future tutorials and assignments, so to avoid clutter in My Content in ArcGIS
Online, you’ll create a new folder for all the maps and resources of the Arts Employment story map. Then
you’ll move the three maps published online to the new folder. Note that even though you’ll have files in
different folders, all files stored in your organizational account must have unique names (including files of
other users in the same organizational account). In contrast, files in different folders in your Windows file
system can have the same names.

1. Open ArcGIS Online (arcgis.com) in a browser, and sign in.
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2. Go to My Content, click the New Folder button , type Arts Employment Story Map Your Name
for the folder name, and click Create. Notice that the new folder is added to the upper-left corner of
My Content.

3. Select the check boxes on the left of the six Arts_Employment_YourName and
Cost_of_Living_Index_YourName files in the item list.

4. Click the Move button  > ArtsEmploymentStoryMapYourName.

5. Click the ArtsEmploymentStoryMapYourName folder. Your six files are there.

Add labeling
Next, you’ll use one of the Label fields created in ArcGIS Pro to label a map layer.

1. Open the Arts_Employment web map in the map viewer.
If you are not happy with the default extent of this map or your other map, you can change it online.
Go to My Content, and click the web map in question to open its details pages. On the top banner,
you can click Edit and click the Settings tab. Click Set Extent. You can either type extent coordinates
(useful if you want two or more maps to match extents exactly) or draw an extent. Then click OK and
Save. Click the Overview tab, and click the Open in Map Viewer button.

2. Zoom and pan into Southern California so that the Metropolitan Employment layer becomes visible.
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3. In the Contents pane, click Metropolitan Employment, and then click its More Options button  >
Create Labels.

4. Select Label as Text, change the font size to 11, and click OK.

5. Click OK.
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6. Click the Default Extent button  to zoom to full extent.

7. In the Contents pane, click State Employment.

8. Click State Employment’s More Options button, click Create Labels, for Text select Name, change
the font size to 11, and click OK.

9. Save the map.

YOUR TURN
Open the Cost_of_Living_Index map. Label the State Cost of Living layer with Name and a size 11
font. Label the Metropolitan Cost of Living Index, also with Name and a size 11 font. Save your map.

Configure pop-ups

1. Open the Arts_Employment web map in the map viewer.

2. In the Contents pane, click State Employment, and then click its More Options button > Configure
pop-up.

3. In the Configure pop-up panel, click Configure attributes, and toggle Display so that all attributes
are cleared.

4. Select the rows with these field aliases (scroll far down to get Population): Name, Population,
Employment Arts, Wages Arts.

5. Click OK > OK.

6. Click any state to try out the pop-up.

7. Save the map.

YOUR TURN
Configure pop-ups for the Cost_of_Living map. For State Cost of Living Index, use Name,
Employment Arts Wage Arts, and Index. Use 0 decimal places as the format for Index. Save your map.

Create a story map
The maps are ready to use, so next you’ll build a story map, add the maps to it, and then add nonmap content.
You’ll remain in ArcGIS Online with My Content open and have your ArtsEmploymentStory Map folder
open.
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1. Open a browser, and go to https://storymaps.arcgis.com/en/app-list/. This web page is a catalog of all
available Story Maps apps.

2. Scroll to Presenting a Series of Maps, and for the Story Map Series side accordion layout, click the
Build button.

3. Type Arts Employment in the United States by Your Name as the title, and click the Next button .

4. In the Add Entry window, type Arts Employment as the title, click Select or create a map > Select a
map.

5. With My Content selected, select Arts Employment, and then select the Legend check box > Add.
The Map Series Builder adds your map to the accordion layout. The left pane of the layout has an
editor for adding and formatting content, including text, numbered or bulleted lists, hyperlinks,
images, and video. For now, you’ll leave this area blank and later copy and paste content into it.

6. Click Save. The story map is saved in My Content in the home folder.

YOUR TURN
Click the Add button (lower-left corner of window), add the Cost_of_Living_Index map with the title
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Cost of Living Index. Ensure that Legend is selected. Try clicking both numbered panes on the left. If

the maps are not both the same size and position, click the Home button for each map. If you made a
mistake and want to start over with a map or change the order of maps, click the Organize button at the
bottom left of the page. Save the story map.

Copy text to map 1
Text and other content are already created and available in StoryMapManuscript.docx. Note that when you
build your own story map, you should write content in Microsoft Word first, and then copy and paste it into
the web editor, just as you are doing here. Likewise, you should create tables and charts in an external
package, such as Microsoft Excel (see optional tutorial 3-4 on how to create tables and charts in Excel and
save them as images).

1. In StoryBookManuscript.docx, select all of item 3, Map 1 Arts Employment, from “Where are the
jobs in the Arts Field?” up to and including “Copy and paste Table 2 from
Chapter3\Tutorials\Resources\ArtsTables.xlsx”.

2. Press Ctrl+C to copy the selected material to the clipboard.

3. Click 1 Arts Employment in the Map Series Builder, click in the “Add text, links, and small graphics
here” pane, and press Ctrl+V to paste the content.
This step pastes all the text as well as much of the formatting from Word. Nevertheless, there is some
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touching up to do with the formatting, which is what you’ll do next.

Edit and format the copied text
The trick to using the editor in the Map Series Builder is to scroll down, select text in need of formatting,
scroll back to the top, make the needed format change, and scroll back down to see the results.

1. Select the URL in the first paragraph (http://www.bls.gov/soc/2010/soc270000.htm), and press
Ctrl+X to cut that text. You’ll use the URL to create a hyperlink in the next step.

2. Select the text, “broadly speaking,” click the Link button , press Ctrl+V to paste the URL, and click
OK. That step turns the text, “broadly speaking,” into a hyperlink.

3. Place your cursor after the end of the first paragraph (ending with the word “prospects”), and press
Enter to add a blank line between the two paragraphs.

4. Put a blank line before the Disclaimer heading and before all headings in the text.

5. Under the Map use and Navigation section, select the bulleted text, scroll to the top, and click the
Bulleted List button . Scroll down and delete the original bullets.

6. In the section, “About the data on maps,” create hyperlinks for “Arts, Design, Entertainment,
Sports, and Media Occupations” and “subgroups” using the URLs that follow each link text.

7. In Windows or File Explorer, navigate to Chapter3\Tutorials\Resources, and double-click
ArtsEmploymentTables.xlsx to open the workbook in Microsoft Excel. This workbook has four tabs,
each containing data exported from ArcGIS Pro, and then sorted and limited to the top (or bottom)
10 states or metropolitan areas. Next, you’ll copy and paste the tables directly from Microsoft Excel to
Map Series Builder to create tables there.

8. Click the Table 1 tab, copy the highlighted rows and columns, paste where instructed in the map 1
text, and delete the instruction. If you need to make columns wider, you will do that in Microsoft
Excel before copying. Also widen your browser window to widen the content column that you are
editing in your story map. You can delete copied material and try pasting again if needed.

9. Similarly, copy and paste Table 2 where indicated, leaving the Microsoft Excel workbook open.
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10. Save your story map.

YOUR TURN
Copy and paste the map 2 text (item 4) from StorybookManuscript.docx to the map 2 section of the
story map. Use the URL there to create an appropriate hyperlink, and replace the bullets with bullets
from the Story Map editor. Copy and paste tables 3 and 4 as directed in the text. You’ll finish up map 2
in the next exercise.

Copy text to map 2 and add images
The Story Map editor, of course, does not have capacity to generate charts, but you can always create a chart
in another package, take a screen capture (a JPEG picture) with the Windows Snipping Tool (search Help in
Windows or work through tutorial 3-4) or one of the many other similar tools, and upload the image. The bar
chart, CostOfLivingWeights.jpg in Chapter3\Tutorials\Resources, was created using Microsoft Excel and
saved as a screen capture. You’ll insert that image at the bottom of the content for map 2.

1. In your story map, go to the bottom of content for map 2 and delete the instruction to add the
CostOfLivingWeights.jpg image.

2. With the cursor at the bottom of the content, scroll up and click the Insert Image button .

3. In the Insert An Image, Video Or web page window, click Upload, click browse for an image, browse
to Chapter3\Tutorials\Resources, select CostOfLivingWeights.jpg, and click Open.

4. Edit the Image caption to Cost of Living Weights.

5. Click Apply.

6. Scroll in the content to see the inserted image.

YOUR TURN
Find a place in map 1 to insert ArtsWagesChart.jpg from Chapter3\Tutorials\Resources, and type some
appropriate text describing the chart; for example, the mode of wages is interesting to know for this
distribution, $40K to $50K (the mode of a bar chart is the highest bar). Save your story map when you
finish.

Share and check your story map
If you finish and close your story map and then need to edit your work, you can open your story map from My
Content (View application) and click the Edit button  at the top of the application.

1. In the Story Map builder, click the Share button and select Public.
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2. Copy the story map’s URL, and use it to open the story map in a web browser. Of course, you can
share the URL with anyone, and then they can use your story map.

3. Try every map, legend, pop-up, visibility range, and hyperlink, making notes of any problems and
correcting them if needed. You can use the Story Maps app in edit mode to make corrections.

4. Close the Story Maps app and your browser.
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Tutorial 3-4: Making charts for feature attribute data in Microsoft® Excel
(optional tutorial)

Microsoft Excel works well in story maps for creating charts and tables to report project results. If you need
these skills, the next tutorial will help you create professional-quality tables and charts. You’ll learn how to
export attribute data from a map layer in ArcGIS Pro; import the data to Excel; clean up and sort the data;
make bar and scatter plots; and screen print the charts as images using the Microsoft Snipping tool for
insertion into a Word document, PowerPoint slides, website, or story map.

Open the Tutorial 3-4 project

1. Open Tutorial3-4.aprx in Chapter3\Tutorials and save it as Tutorial3-4YourName.aprx.

2. Use the Lower 48 states bookmark.

Export data from ArcGIS Pro

1. Open the USStates WageArts attribute table.

2. Click the Options button > Export.

3. Click the Browse button of the Output Table and browse to Chapter3\Tutorials.

4. For Name, type USStates.txt, and click Save > Run. The text table, USStates.txt, is exported.

Import data to Microsoft Excel
Next, you’ll import USStates.txt to Excel.

1. Launch Microsoft Excel.

2. Click File > Open, and browse to Chapter3\Tutorials\Resources.
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3. In the Open window, select All Files to the right of File name at the bottom, select USStates (not
USStates. txt), and click Open.

4. In the Text Import wizard, ensure that the Delimited Option button is selected, and click Next.

5. Select the Comma check box > Finish. The table is imported into the USStates tab of the Microsoft
workbook.

6. Click File > Save As > in the folder under Current folder, change the Save As type to Excel workbook,
and click Save.

Delete unneeded columns
You will need only three columns of data: Name, WageArts, and Index. So you’ll delete unneeded columns to
make further processing simple.

1. Click in the A column heading cell, press and hold the Shift key, and click the B column heading cell
to select those two columns.

2. Right-click in the selection and press Delete.

3. Click the B column heading cell (which now has the ObjectID attribute), scroll to the right to the BF
column (which has EmpArts data), press the Shift key, click the BF column heading cell to select the
range from B to BF, right-click in the selection, and press Delete.

4. Likewise, delete all additional unneeded columns, keeping only the three columns as shown. If you
make a mistake and delete a needed column, you can click the Undo button at the top of the Excel
window.

Sort the table
Creating a bar chart from raw data requires manual work, but it is not too difficult. The preparation process
requires sorting data by the column being used to make the chart, taking notes, counting frequencies, and
typing some information.

1. Select columns A, B, and C. You must select all columns of a table when you sort; otherwise you’ll
destroy the data.

2. Click Data > Sort.
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3. Ensure that you select the “My data has headers” check box, and then select WageArts as the Sort by
Column. Click OK.

Create a bar chart

1. Now count the frequencies in these WageArts classes: $35,000–$40,000, $40,000–$45,000, $80,000–
$85,000. Counting is not actually needed in this case because those statistics are available in the bar
chart to save you time. The left side of each class (for example, the $35,000 in $35,000–$40,000) is
included in the class if there are any states with that value, but the right side ($40,000) is not. The
$40,000 is in the next class, $40,000–$45,000.

2. To create a new spreadsheet, click the + to the right of the USStates tab at the bottom left of the
spreadsheet.

3. Double-click the tab, Sheet1, and rename it Bar Chart.

4. Type the data into the Bar chart sheet as shown.

5. Select all the data in the Bar chart sheet: click in cell A1, press the Shift key, and click in cell B12.

6. Click Insert > the Insert Column Chart button  > the first 2D chart. This step creates the chart as
shown.
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Create a scatterplot
You can easily create a scatterplot with two attributes by ordering the columns of the attributes from left to
right in the spreadsheet so that the horizontal axis attribute appears first. Your objective here is to investigate
if the higher cost of living (Index attribute) correlates with higher wages for workers in the arts field
(WageArts attribute), so it’s natural to place the cost of living index on the horizontal axis. You’ll move the
Index attribute to the left of the WageArts attribute.

1. At the bottom of the Microsoft Excel window, click the USStates tab.

2. Select column B (with Wages Arts data), right-click in the selection, and click Insert. This step
creates a new blank column, now B, to the left of WageArts data, which is now in column C.

3. Select column D (with Index data), right-click in the selection, and click Cut.

4. Select column B, right-click in the selection, and click Paste. Now the columns are ordered Name,
Index, and WageArts.

5. Select data in the range B1 to C50.

6. Click Insert > the Insert Scatter Plot button  > the first chart type. This step produced the chart,
which needs some refinements.

Modify the scatterplot axis ranges
Next, you will limit the ranges of the vertical axis and horizontal axis to those of the data so that you can see
its pattern more clearly.

1. Right-click any vertical axis number (such as the 40000), and click Format Axis.

2. Change Bounds Minimum to 35000 and Bounds Maximum to 90000. Close the Format Axis panel.

3. Right-click any horizontal axis number, and click Format Axis.

4. Change Bounds Minimum to 80 and Bounds Maximum to 150. Close the Format Axis panel.
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5. Adjust the size of the chart so that it’s about square.

Format an axis

1. Right-click any vertical axis number, and click Format Axis.

2. In the Format Axis panel, click Number (you may have to scroll down), select Currency for Category,
and type 0 for Decimal Places. Close the Format Axis panel.

Label each axis
Your user interface may vary from the one used in this exercise, depending on your Microsoft Excel version.

1. Click anywhere in the chart.

2. Click the Chart Elements button , select Axis Titles, and deselect Chart Title.

3. Edit the axis labels so that the horizontal axis is Cost of Living Index and the vertical axis label is
Average Arts Income.

Modify the point symbol

1. Click anywhere in the chart, and under Chart Tools, click Format, and under File on the upper left,
select Series “WageArts.”

2. Click Format selection under Series “WageArts.”

3. Click the Fill and Line button  > Marker in the Format Data Series pane.

4. Expand Fill, click Solid Fill, and black for the color.

5. Expand Border and select No Line. Close the Format data series pane. This step completes the chart,
which is now informative as well as professional looking in appearance. You can see that wages in the
arts profession increase when the cost of living increases, and even at an increasing rate for states with
a higher cost of living. The chart has no title because it’s better to type the title as a figure with
number and caption in a report or as a slide title in a presentation.

127



6. Save your Microsoft Excel workbook.

Screen print each chart
You can directly copy and paste Microsoft Excel tables and charts into Microsoft Word or PowerPoint files.
For some destinations, however, such as Story Maps, you’ll need to capture images of charts and paste the
images. You can use the Windows Snipping Tool for that purpose, which is available on every Windows
computer.

1. On your computer, search for Snipping Tool, and launch the program.

2. Drag a rectangle around your chart in Excel.

3. In the Snipping Tool, click File, and click Save As to your chapter 3 tutorial folder with the name
ScatterPlot and the JPEG file type.

4. Click the Bar Chart tab in Microsoft Excel, click New in the Snipping Tool, snip the chart, and save
as BarChart. You can easily paste one or both charts into a Word document or PowerPoint
presentation.

5. Close the Snipping Tool, save your changes to Microsoft Excel, and then close Excel.

Assignments
This chapter has four assignments to complete that you can download from this book’s resource web page,
esri.com/gist1arcgispro:

Assignment 3-1: Build a layout with income versus educational attainment in Washington, DC.
Assignment 3-2: Build a map layout for comparing 2D and 3D maps for urgent health care clinics in
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Pittsburgh.
Assignment 3-3: Build a story map for locating charter schools in New York City.
Assignment 3-4: Build a story map for income versus educational attainment in Washington, DC.
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2
Working with spatial
data
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CHAPTER 4

File geodatabases
LEARNING GOALS

Import data into file geodatabases.
Modify attribute tables and fields.
Use Python expressions to calculate fields.
Join tables.
Get an introduction to SQL query criteria.
Carry out attribute queries.
Aggregate point data to polygon summary data.

Introduction
A database is a container for all the data of an organization, project, or other undertaking for record keeping,
decision-making, analysis, or research. A file geodatabase is Esri’s simplified database for geospatial data,
including feature classes and raster datasets, and for processing by single users or small groups. In terms of
data format, a file geodatabase is simply a file folder with .gdb at the end of its name that contains a number of
files. A .gdb is not a file extension but just part of the folder name. Processing of data in a file geodatabase is
done using ArcGIS Pro’s Catalog pane, geoprocessing tools, and user interface.

For example, FoodDesertsChicago.gdb could be the name of a file geodatabase that stores spatial data for
analyzing residents’ access to grocery stores in Chicago, starting with feature classes for grocery stores, streets,
and population in census blocks in Chicago. The workflow for estimating the number of Chicago residents
who live in food deserts (that is, live a mile or more from the nearest grocery store) would have you create
additional feature classes and tables, also output and stored in FoodDesertsChicago.gdb. Chapter 9 provides
the workflow and spatial analysis tools (buffers or service areas of grocery stores) for carrying out such a
workflow.

Although file geodatabases have a simple format, they nevertheless are powerful spatial data containers.
For example, file geodatabases have no practical limits on numbers and sizes of feature classes and raster
datasets stored in them; they are optimized for data processing and storage in ArcGIS Pro, and they allow
data tables to be related and joined (essential database processes).
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In this chapter, you will learn about working with file geodatabases in these ways:

Importing spatial data into file geodatabases
Modifying data
Joining tables
Aggregating data on individual points to group-level data in polygons
Querying data using attribute criteria
Building a spatial join (which is unique to GIS)
Using ArcGIS Pro’s Catalog pane for utility work on file geodatabases

In this chapter, you must work tutorials 4-1 through 4-3 sequentially, because tutorial 4-2 uses results
from tutorial 4-1, and tutorial 4-3 uses results from tutorial 4-2.

132



 

Tutorial 4-1: Import data into a file geodatabase
When you create a new ArcGIS Pro project, the software automatically creates a file geodatabase for you as
the project’s default spatial data container. In this tutorial, you’ll create a new project, and then you’ll import
data from external sources into the new project’s file geodatabase.

Create a new ArcGIS Pro Project

1. Open ArcGIS Pro.

2. Under Create a new project, click Blank, and make or type the selections as shown. Ensure that you
clear the Create a new folder for this project check box, because the Chapter4 folder already exists.

3. Click OK, and close the Catalog pane. ArcGIS Pro creates the new project, Chapter4.aprx, as well as
a Chapter4.gdb file geodatabase and Chapter4.tbx toolbox. Next, you’ll save the project with the
name Tutorial4-1, to follow the naming convention for projects in this book. Note that every new
feature class, table, and other files that you create are saved by default to the project’s file geodatabase,
Chapter4.gdb in this case.

4. On the Project tab, click Save as, and browse to the Chapter4\Tutorials folder.

5. For Name, type Tutorial4-1.aprx, and click Save.

6. Open File or Windows Explorer, and delete Chapter4.aprx from the Chapter4/Tutorials folder.

7. In ArcGIS Pro, on the Project tab, click Options. In the Options window on the Current Settings
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tab, you can see that the project, Tutorial4-1, has as its home folder Chapter4\Tutorials, and its
default geodatabase is the newly created Chapter4.gdb.

8. Click Cancel, and click the back arrow button .

9. On the Insert tab in the Project group, click New Map. The new map opens with the topographic
basemap showing North America.

Set up a folder connection
When you created the Chapter4.aprx project (which you just renamed Tutorial4-1.aprx), ArcGIS Pro also
created a folder connection to the folder in which you created the project, Chapter4\Tutorials. It’s also useful
to have a connection to the Chapter4 folder because it has the Data folder within it (Chapter4\Data), which
has shapefiles and other spatial data that you’ll need to access conveniently (without browsing from C:\ to
C:\EsriPress to C:\EsriPress\GIST1 and to C:\EsriPress\GIST1\Chapter4). You will create connections in
the Catalog pane.

1. Open the Catalog pane.

2. Expand Folders > Tutorials. Here, you will see the contents of the Tutorials folder except for the
project files (such as Tutorial4-1.prx). When you need to add data in the future, you can click the
Tutorials folder and have direct access to its Chapter4.gdb file geodatabase instead of having to
browse along the path C:\ EsriPress\GIST1\Chapter4.

3. Right-click Folders, and click Add Folder Connection.

4. Browse to EsriPress\GIST1Pro, click the Chapter4 folder, and click OK. ArcGIS Pro adds the
Chapter4 folder connection.

5. In the Catalog pane, expand the Chapter4 folder. Here, you will see that Chapter4 has three
subfolders: Tutorials, Assignments, and Data. Now, if you need data from the Data folder, you can
click Folders and click the Chapter4 connection to get quick access to it.

6. Hide the Catalog pane.
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Import shapefiles and a data table into a file geodatabase
A shapefile is an Esri spatial data format, dating to the 1990s, for a single map layer. Although no longer
Esri’s preferred spatial data format, shapefiles are still used by many spatial data suppliers. For example, the
US Census Bureau is the source of shapefiles used in this exercise. You will learn more about shapefiles and
other spatial data formats in chapter 5, but for now, understand that ArcGIS Pro allows you to import
shapefiles and other map layer formats into file geodatabases. When stored in a file geodatabase, a map layer
is called a “feature class.” When displayed as part of a map, it’s a “map layer.”

1. On the Analysis tab, click Tools, and in the Geoprocessing pane, search for and open the Feature
Class to Feature Class tool. For inputs, this tool can use a feature class from a file geodatabase, a
shapefile, or a coverage (one of Esri’s earliest spatial data formats). For outputs, the tool can copy a
feature class to a different file geodatabase, convert a feature class into a shapefile, convert a shapefile
or coverage into a feature class, or convert a coverage into a shapefile.

2. For Input Features, click the Browse button.

3. In the Input Features window under Project, click Folders, double-click the Chapter4 connection,
click the Data folder, click the MaricopaCounty folder, select tl_2010_04013cousub10.shp, and click
OK.

4. For Output Feature Class, type Cities. The input shapefile, for county subdivisions (cities, towns, and
so on), was downloaded from census.gov, as was tl_2010_04013_cousub10.shp (census tracts). The
new feature class, Cities, is automatically stored in the default file geodatabase, Chapter4.gdb.

5. Click Run, and when the run finishes, close the tool. The imported feature class is automatically
added to your map as the Cities map layer.

6. Open the Catalog pane, and expand Databases > Chapter4.gdb to see that the feature class, Cities,
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was created.

7. On the Catalog pane, click the Auto Hide button , and then click the Auto Hide button again to
hide. You can now click the Project button to unhide the Catalog pane when needed.

YOUR TURN
Import shapefile tl_2010_04013.tract10.shp from Chapter4\Data\MaricopaCounty to create the feature
class, Tracts, in Chapter4.gdb. Close the Geoprocessing pane when finished. Save your project.

Import a data table into a file geodatabase
Next, you’ll import a data table with some 2010 census tract data for Maricopa County. The table is in a
common format for data sharing, comma-separated values, or CSV file (.csv). The first row of the table has
attribute names, and subsequent rows have data with values separated by commas to delineate columns. A
nonprinting line-feed character is at the end of each row, signaling the end of the row. The figure shows some
rows of the table you are about to import, where GEOid is the Census Bureau’s ID number for census tracts,
and the other attributes are census data. Note that if the table you want to import is in a Microsoft Excel
workbook, you can save the table as a CSV file, and then import that version of the table. Comma-separated
values data has the advantage of being easily imported into ArcGIS Pro; whereas, depending on how your
computer is set up, Excel workbook tables may not be recognized by ArcGIS Pro.

1. Search for and open the Table to Table tool.

2. For Input Rows, browse to Chapter4\Data\MaricopaCounty, select CensusData.csv, and click OK.
For Output Table type CensusData.

136



3. Click Run.

4. Close the Geoprocessing pane, and save your project.

Use database utilities of the Catalog pane
You can create, copy, rename, and delete file geodatabases in the Catalog pane. You can do the same with
feature classes and tables. Suppose that you’d like to share the Tracts feature class and CensusData table with
others. Next, you’ll create a new file geodatabase for sharing, copy the spatial data you want to share to it, and
rename the feature class and table.

1. Click the Project button to open the Catalog pane.

2. Expand Databases to see Chapter4.gdb.

3. Right-click Databases, and click New File Geodatabase, and browse to open the Chapter4\Tutorials
folder.

4. For Name, type MaricopaTracts, and click Save. MaricopaTracts.gdb is added to Databases.

5. Expand Chapter4.gdb, right-click its Tracts feature class, and click Copy.

6. Right-click MaricopaTracts.gdb, click Paste, and expand MaricopaTracts.gdb. You can see that
MaricopaTracts now has a copy of the Tracts feature class.

7. Copy the CensusData table from Chapter4.gdb to MaricopaTracts.gdb.

8. In MaricopaTracts.gdb, right-click CensusData, and rename it TractsIncomeData. Now, you have
just the tracts feature class and corresponding data table repackaged in the MaricopaTracts.gdb file
geodatabase, which you could share with others. You don’t need this file geodatabase for any further
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processing in this chapter, so next you’ll delete it.

9. In the Catalog pane, right-click MaricopaTracts.gdb, and click Delete > Yes.
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Tutorial 4-2: Modifying an attribute table
Much of what gets processed or displayed in a GIS depends on attributes—columns in tables. To get tables in
the desired form, you must know how to delete, create, and modify attributes.

Get started

1. Save your Tutorial4-1 project as Tutorial4-2 in Chapter4\Tutorials.

2. Right-click Tracts, and click Zoom to layer.

3. Create a bookmark named Maricopa County.

4. Symbolize Tracts and Cities with no color and Cities with a wider and darker gray outline than
Tracts.

5. Change the basemap to Light Gray Canvas, and then remove the World Light Gray reference layer
from the Contents pane.

Delete unneeded columns
Many feature classes have extra or unnecessary attributes from the user’s point of view that you do not need
and can delete.

1. In the Contents pane, right-click Tracts, and click Design > Fields. This view allows you to modify
and create attributes in a table. You cannot delete the primary key, ObjectID, or the Shape,
Shape_Length, and Shape_Area attributes because they are essential. These fields are dimmed,
meaning that you can’t modify them. GeoID10 is the tract geocode that you need later in this chapter
for joining the CensusData table to the tracts map layer, but all other fields are candidates for deletion
for the purposes of this chapter.

2. One group at a time, press and hold the Shift key, and select rows crossed out in the figure by clicking
the first and then the last row in the group, and then right-click within a group, and click Delete.
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ArcGIS Pro crosses out the fields but does not delete them until you click Save. Review selections for

deletion before actually deleting. If you decide to keep any of these fields, you can right-click and
click Restore deleted item.

3. On the Fields tab, click Save.

4. Close Fields design, and examine the Tracts table. Only the needed fields remain.

YOUR TURN
Delete all fields from Cities except for the dimmed fields, GEOID10, and Name10. Type City for
Name10’s alias. Open this map layer’s table and see the remaining fields and the alias for Name10.

Examine geocodes in tables to be joined
In the next exercise, your work will prepare for joining a data table (CensusData) to the attribute table of the
Tracts feature class on a one-to-one basis: each row or record in the table has one and only one matching
record in Tracts. Joining two one-to-one tables makes a wider table (increases the number of columns) while
leaving the number of rows the same, and is common in GIS. Joining two tables together requires each table
to have an attribute with the matching values stored as the same data type (for example, numeric or text). For
census tract data, the matching values are in census tract geocodes, GEOID10 in Tracts and GEOid in
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CensusData.

Joining tables involving census data makes sense because it is impractical to store the thousands of census
tract attributes in the Tracts attribute table. The attribute table for Tracts, as downloaded from the Census
Bureau’s website, has just the tract geocode and a few GIS attributes and no census data. To map census data,
you will select the variables you need from the Census Bureau website (see chapter 5), download a
corresponding table (which includes tract geocodes), and join the table to the tracts attribute table.

The geocodes in CensusData and Tracts would match one to one, except that GEOID10 in Tracts has a
text data type whereas GEOid in Census Data has a numeric data type (as downloaded). The remedy is to
create a new attribute in Tracts, say GEOID10Num, that is numeric and has the values of GEOID10
transformed from text to numbers. Tract geocodes that are text can have leading zeros dropped when
converted to numeric data format. Because GEOid is numeric, it has leading zeros dropped, so the only
recourse for getting matching values is to drop leading zeros in GEOID10 as well by converting it from text
to numeric.

1. In the Contents pane, right-click CensusData, and click Design > Fields. You can see that GEOid
has a numeric data type, Double (15 digits in length).

2. Close the CensusData Fields design view, and open the Tracts Fields design view. GEOID10 has
the Text data type.

3. Close the Tracts Fields design view, open Tracts’s attribute table to see data values, and sort
GEOID10 ascending. The first row’s value for GEOID10 has the text value 04013010101.
CensusData has a corresponding numeric value, 4013010101, without the leading zero. If you created
a new text attribute in CensusData, named GEOidText, its corresponding value would remain
4013010101, without the leading zero. You could add the leading zero, but it would be complicated.
It is easier to create a new numeric attribute in Tracts that automatically drops any leading zeros.
Then you’ll have geocodes that match.

Create a new attribute and populate it using the Calculate Field tool
Next, you’ll create the new numeric attribute in the Tracts table, and then use the Calculate Field tool to
transform and copy data to it.

1. With the Tracts attribute table open, click its Option button and select Fields view.

2. At the bottom of the Fields view, click “Click here to add a new field.”

3. Type GEOID10Num for the Field name, and select Double as its data type.

4. On the Fields tab, click Save.

5. Close the Fields view. Notice that the values for GEOID10Num are <Null>, which signifies that data
cells are empty and no data has been added as yet. These values are called “null values.”
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6. Right-click GEOID10Num in the Tracts table, and click Calculate Field.

7. In the Fields pane, double-click GEOID10 in the Fields panel to create the expression
GEOID10Num = !GEOID10!. The expression’s syntax is from the Python programming language,
requiring attribute names on the right side to be identified using the exclamation point delimiters.

8. Click Run.

9. Close the Geoprocessing pane, and take a look at the results. The new attribute, GEOID10Num, has
GEOID10 values transformed to numeric format without the leading zeros, and will match perfectly
with the geocode in CensusData.

10. Close the Tracts table and the Geoprocessing pane.

YOUR TURN
Next, you’ll use data in the CensusData table to make a choropleth map for Maricopa County that
compares incomes of Hispanics to those of whites. The CensusData table has population and per capita
income for the total population, whites, Native Americans, and Hispanics. Desired for mapping are two
ratios of per capita income for Hispanics and Native Americans divided by per capita income for whites.
To get started, create two new attributes in the CensusData table, RatioHispanicWhiteIncome and
RatioNativeWhiteIncome, both with the Float data type. When finished, close the Fields design view.

Calculate the ratio of two fields
When you calculate ratios, ensure that you do not divide by zero, which is an undefined operation in
mathematics. In ArcGIS Pro, you can select rows in which the divisor is not zero, and then the Calculate
Field tool will include only the selected rows, thus avoiding division by zero.

1. Open the CensusData table.

2. On the Map tab in the Selection group, click the Select By Attributes button .

Next, you’ll create the condition needed for selecting table rows in which the divisor, WhtPCIncome, is
greater than 0. In tutorial 4-4, you’ll learn a lot more about attribute queries.

3. In the Geoprocessing pane, click Add Clause, and make the selections as shown. You can click the
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Values button, drop the list below it to display all existing values in the WhtPCIncome field, and
then click a value (such as the zero needed here) to complete the query criterion expression. Using the
drop list has the advantage of correctly formatting data values for use in queries, which works well for
date and text attributes.

4. Click Add, and then click Run. ArcGIS Pro selects 908 out of 913 tracts, all with positive values for
WhtPCIncome.

5. Close the Geoprocessing pane.

6. Right-click the heading for the RatioNativeWhiteIncome field, and click the Calculate field.

7. Create the expression as seen in the figure by double-clicking fields and clicking the division
operator.

8. Click Run. If you get an error message, it’s likely because you don’t have records selected with
nonzero WhtPCIncome.

9. In the table, right-click RatioNativeWhiteIncome, and click Sort Descending. The figure has the
results for a half dozen sorted rows sorted by RatioNativeWhiteIncome. In some tracts, Native
American income is more than four times higher than whites, but in most tracts, the ratios are less
than 1.
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YOUR TURN
With the 908 rows of CensusData with positive WhtPCIncome still selected, create and run the
following expression:

Clear the selection, close the table, and close the Geoprocessing pane when finished. Save your project.
In the figure, you will see the first half-dozen records, sorted descending for the results.

Extract substring fields and concatenate string fields
If you sort the Tracts attribute table ascending for GEOID10, the first value is 04013010101. This unique
identifier for a census tract is composed of three parts:

04 is the ANSI (American National Standards Institute) code for Arizona,
013 is the ANSI code for Maricopa County, and
010101 is the ANSI identifier for a census tract.

The census tract is further broken down to tract number—(the first four digits (0101) and an optional
two-digit suffix (01) with an implied decimal point between the number and suffix. Formally written, the
corresponding census tract name for Maricopa County, Arizona, is Census Tract 0101.01. Using GEOID10
as the input, in this exercise you’ll compute this formal representation of tracts.

1. In the Tracts attribute table, create three new text fields: TractNumber (length = 4), TractSuffix
(length = 2), and TractName (Length = 20).

2. Calculate the TractNumber field with the expression . To understand the confusing
Python language syntax of this expression, consider the case of tract 04013123456. The characters
stored (digits, in this case) of any field are indexed 0, 1, 2, …, from left to right, so the positions of
the 04 for Arizona are 0 and 1. The notation [0:2] extracts the indexed first digit and up to but not
including the third digit, “0,” So 04 is extracted. For the case of extracting TractNumber and the
example of 04013123456, the 5 of !GEOID10![5:9] corresponds to the sixth position (1) and the 9 to
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the 10th position (5), which is not included. So [5:9] extracts 1234.

3. Calculate the TractSuffix field with the expression . This expression extracts the
ninth digit up to but not including the 11th character, 01.

4. Finally, calculate TractName with the expression:

Note that there is a space after Census Tract and before the closing double quote mark. The plus sign (+)
concatenates or combines two text values into one. “Census Tract” and “ . ” in double quote marks are
constants, the same for every row of data. !TractNumber! and !TractSuffix! with exclamation point
delimiters denote field names, which vary by row. Sorted ascending by TractName, the figure shows the
first six finished values.

YOUR TURN
An example value for GEOID10 in the Cities attribute table is 0401390459. The first two digits are the
state, the next three digits are the county, and the remaining five digits are the city. Create two new text
attributes, CityNumber (length = 5) and CityNameNumber (length = 50), in the Cities attribute table.
Extract the last five digits of GEOID10 in CityNumber, and then concatenate the City field and
CityNumber to compute values for CityNameNumber, such as Buckeye = 90459. Put a space on both
sides of the equals sign. Sorted ascending by CityNameNumber, sample values are shown next.
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Tutorial 4-3: Joining tables
The next table join you will do adds the columns of the CensusData table to the attribute table of Tracts by
matching values of GEOid from the CensusData table to GEOID10Num of Tracts. In this one-to-one join,
each record of both tables finds a single matching record.

Each time you open a project with a table join, the join is re-created on the fly. To make a permanent
Tracts and Census Data table join, you can export the Tracts feature class to a new feature class. Then the
joined attributes are permanent in the new feature class. If you want to publish a feature class with a table join
in ArcGIS Online, you must make the join permanent.

Get started

1. Save your Tutorial4-2 project as Tutorial4-3 in Chapter4\Tutorials.

2. Use the Maricopa County bookmark.

Join a data table to a feature class attribute table
Next, you will join the CensusData table to the Tracts feature class.

1. In the Contents pane, right-click Tracts, and click Joins and relates > Add Join.

2. In the Geoprocessing pane, make the selections as shown (ignore the warning message).
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3. Click Run, and when the tool finishes, close the Geoprocessing pane.

4. Open the Tracts attribute table, scroll to the right in the table, and verify that ArcGIS Pro joined the
CensusData table to the Attributes of Tracts table.

5. Close the Tracts table.

Export a feature class to make a join permanent
This exercise turns the join attributes of CensusData into permanent attributes of the Tracts attribute table by
exporting the Tracts feature class. Also, you’ll clean up the attributes of the exported feature class.

1. In the Contents pane, right-click Tracts, and click Data > Export Features.

2. In the Geoprocessing pane, change the Output feature class’s name from Tracts_CopyFeatures to
MaricopaIncome, and click Run.

3. Close the Geoprocessing pane.

4. Remove Tracts from the Contents pane.

5. Open the Field design view of MaricopaIncome. Notice that ArcGIS Pro has qualified each field
name with its source table’s name as a prefix.

YOUR TURN
Delete these fields from the MaricopaIncome attribute table: Tracts_GEOID10,
CensusData_ObjectID, and CensusData_GEOid. Edit field names to delete table name prefixes (for
example, edit Tracts_GeoID10Num to GeoID10Num). Delete the Field Name prefixes, Tracts_ and
CensusData_, from each field. Note that to change field names for the two ratio fields, copy and paste
from the Alias column or type, which is necessary for long names. Now you can answer the question:
Are there places in Maricopa County where Hispanics typically have higher per capita income than
whites? Symbolize MaricopaIncome with graduated colors for symbology, RatioHispanicWhiteIncome
as the field, Standard deviation for method, 1 standard deviation for interval size, and red to green for
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color scheme. Label and move Cities to the top of the Contents pane. You can see many places
throughout Phoenix and Chandler where Hispanics earn more than whites. The tracts that have a white
color are the ones for which no data was available on income for Hispanics. Save your project.
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Tutorial 4-4: Attribute queries
One of the major innovations of GIS technology nearly 50 years ago was linking tabular data to the graphic
features in feature classes. This linkage makes it easy to symbolize maps using the attribute values found in
tables and also allows attribute queries to show only features of interest.

Attribute queries are based on structured query language (SQL), the de facto standard query language of
database packages and many application software packages, including ArcGIS Pro. This tutorial introduces
the query criteria part of SQL. For further study and to learn full SQL commands, you can find free
interactive SQL tutorials on the Internet. A good one is at w3schools.com. The next two tutorials use crime
data and queries commonly made by police crime analysts. The example queries ask some of the standard
query questions of “who,” “what,” “where,” “when,” and “how.”

A simple SQL criterion has this form:

“Attribute name” is any attribute column heading or field name in an attribute table. Several logical
operators are available, including the familiar ones such as =, >, >=, <, and <=. “Attribute value” is related to
the values you seek. For example, this simple criterion selects all crimes that are robberies where Robbery is a
value of the Crime attribute:

Text values, such as Robbery, must be enclosed in single or double quote marks.

You can use queries to select points in a feature class or set the definition query properties of a feature
class. A point that is selected appears highlighted in the selection color, both in the attribute table and on the
map, and all points of the map layer remain visible. A definition query, on the other hand, displays only the
points that satisfy the query criteria (and without the need for highlighting).

Compound criteria are made up of two or more simple criteria connected with either an AND or an OR
connector. AND means that both connected simple criteria must be true for corresponding features (records)
to be selected. For example, for SQL to select features for the compound query,

the DateOccur values must be greater than or equal to August 1, 2016, and less than or equal to August 28,
2016. SQL will select a feature with the date August 5, 2016, for example, but it will exclude August 31,
2016. The date values in the criteria are in the format ArcGIS Pro requires for use in queries. You don’t have
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to remember such formats because the ArcGIS Pro query builder helps you get the values (and in the right
format) you need in queries, as you will see in the next tutorial.

The OR connector is used to select a subset of features on the basis of classification, such as crime types in
the Crime attribute. Although a single criminal incident may have one or more criminal offenses (for example,
homicide and robbery in which a person was robbed and murdered), data reported by police departments to
the FBI have only the most serious offense reported (homicide, in this case), so each crime has only one
reported crime type. To query this kind of data for homicides and aggravated assaults, you might simply say,
“I want all homicides and aggravated assaults,” but in SQL, the expression is “homicides OR aggravated
assaults.” Given FBI reporting practices, it is impossible for an offense to be both a homicide and an
aggravated assault because only one crime type is recorded for each offense. So, the proper SQL criteria in this
case are:

Despite occasional exceptions to this rule, you will almost always need to place OR in parentheses (as
shown) if the criteria are combined with other criteria, such as a date range:

The use of parentheses (just as with algebraic expressions) is because logical expressions are executed one
pair at a time for simple expressions, generally working from left to right but with certain logical operators
going first. For example, SQL executes AND comparisons before OR comparisons regardless of order, which
can result in incorrect information unless you use parentheses to control the order of execution. SQL executes
comparisons in parentheses first. For example, if you leave the parentheses out of the previous query, you’d
retrieve all homicides in August 2015 but also all aggravated assaults in the database regardless of the month.
Checking input data and the output results will give you experience and guidance in making compound
queries.

Police need three primary kinds of attribute queries to analyze crimes, and you can combine and use these
queries creatively in these ways:

The most fundamental attribute query is by crime type and data interval (the what and when). Such
queries often combine several crime types with the use of logical operators.
The second type of attribute query adds criteria, such as time of day or day of the week—for example,
weekday versus weekend crime (a refinement of when). Clearly, crime patterns can differ as a result of
the time of day or the day of the week.
The third type of attribute query adds criteria based on the attributes of the people (the who) or the
objects (the what), such as vehicles, involved in a crime and can include modus operandi attributes (the
how), such as “Enters through an open window,” if available.

Open the Tutorial 4-4 project

1. Open Tutorial4-4 in Chapter4\Tutorials, and save it as Tutorial4-4YourName.
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2. Use the Pittsburgh bookmark. The map of Pittsburgh has Crime Offenses, which has all criminal
offenses for June through August 2015, Streets, and Neighborhoods. Note that the crime data,
although real, has been modified to protect privacy, including changing the year of crimes. Also note
that Pittsburgh is a relatively low-crime city, and that crime data plotted in any city would likely look
similar to the crime data you will plot in this tutorial.

Create a date-range selection query
Queries for event locations, such as crimes, almost always use date-range criteria. A selection by attributes
identifies the subset of features in a map layer that meet the query criteria and gets the selection color both in
the table and on the map. Once you select the features, you can do additional processing of selected outputs.
For example, you could export the selected features to a new feature class.

1. On the Map tab in the Selection group, click Select By Attributes.

2. In the Geoprocessing pane, for Layer Name, select Crime Offenses, click Add Clause, and make the
selections as shown.

Ensure that you click in the cell with the date, and select the date from the drop list.

3. Click Add and the Verify button . The Verify button ensures that there are no syntax errors but
does not check for logic errors.
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4. Click Add Clause and make the selections as shown.

5. Click Add and the Verify button.

6. Click Run, and leave the Geoprocessing pane open. All crime offenses remain on the map, but the
points for July 2015 are now displayed in the selection color. Next, you’ll save the query so that it can
be reused.

7. In the Geoprocessing pane, click the Save Expression button , and save the expression as
qryDateRange in Chapter4\Tutorials. In the next exercise, you’ll reload this query for a definition
query. The “qry” prefix is a standard prefix for database queries to denote them as queries.

8. Open the Crime Offenses attribute table, and then click the Show Selected Records button .
Notice that 3,924 out of 11,500 features are selected.

9. Close the attribute table and the Geoprocessing pane.

10. Clear the selection.

Reuse a saved query to create a definition query

1. Right-click Crime Offenses, and click Properties > Definition query > Load expression button ,
and double-click qryDateRange.exp. The saved expression reloads.
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2. Click OK.

3. Open the Crime Offenses attribute table, and verify that only the 3,924 July 2015 crimes remain.

4. Close the table.

Query a subset of crime types using OR connectors and parentheses
Next, you’ll add clauses to query a subset of crimes that are leading indicators of burglaries. A spatial cluster of
disorderly conduct, vagrancy, or vandalism crimes in July usually will indicate an increase in the more serious
crime of burglary nearby in August. In cases in which you need a subset of classes (crime types here), you will
select crimes by using the OR connector with the connected OR clauses in parentheses. OR conditions can be
difficult so always check the output of queries you build for the first time to ensure that you are getting the
desired information.

1. Open the Definition query property sheet for Crime Offenses. Your two date clauses connected with
AND are still there. You’ll add three clauses, one for each leading-indicator crime, connected by
ORs, and then type parentheses around them using the SQL view of the query.

2. Click Add Clause, and make the selections as shown.

3. Click Add.

4. Add two more clauses for Crime equal to Vagrancy and Crime equal to Vandalism, connected by
OR. If you ran this query without parentheses around the OR clauses, you’d get disorderly conduct
features in July 2015 and then all vagrancy and vandalism in the dataset (and not just in July).

5. Click the SQL button . This step shows you the actual SQL criteria that the query builder built.

153



The SQL is mostly self-explanatory except for the values in red, which are now formatted as needed
for SQL. You rarely need to type values but instead select them from drop lists.

6. Type parentheses as shown next. The SQL first will evaluate the expression inside the parentheses,
which is to select all disorderly conduct, vagrancy, or vandalism crimes. Next, SQL will work from
left to right to select all records in July for the three crime types.

7. Click OK. Open the Crime Offenses attribute table, and verify that the 724 remaining features are for
the three crimes of interest in July.

8. Open the Definition Query property sheet for Crime Offenses, and save the query as
qryDateRangeBurglaryLeadingIndicators. This definition query is useful, because if you need to
query more finely about the leading indicator crimes in July 2015, you can create selection queries
starting with the map layer created by the definition query. Your selection queries will be simpler with
the basic query already done by the definition query.

9. Click the Clear Expression button , and click OK. Now you’re back to having all original features.

YOUR TURN
Create a saved definition query named qryAugustBurglaries.exp for burglaries in August 2015. Open
the attribute table to verify the results. Keep the definition query in effect (don’t clear it).

Query day-of-week range
Next, you’ll use the attribute, DayOfWeek in CrimeOffenses, which identifies the day of week for a crime
(Monday through Sunday). You’ll build a selection query for burglaries during the weekend (Saturday and
Sunday), and get the number of weekend crimes in August. Then you’ll switch the selection so that weekday
days are selected and get the number of weekday crimes in August. You can also easily get the weekday total
by subtracting the number of weekend burglaries in August from the total number of August burglaries, but
you will learn about switching selections in ArcGIS for practice. Finally, you’ll get the average number of
burglaries per day on a weekday versus a weekend day. Which do you think should be higher?
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1. Create the Select by Attributes query (and not a definition query) as shown.

2. Run the query.

3. Save the query as qryWeekend.

4. Close the Geoprocessing pane.

5. Open the Crime Offenses attribute table. Eighty-four out of 273 burglaries are selected.

6. In the attribute table, click the Switch Selection button . You will see that 189 of the 273 features
are weekday burglaries.

August 2015 had 10 weekend days and 21 weekday days. Doing the math, an average of 8.4
burglaries occurred per weekend day and 9.0 occurred each weekday. Burglaries often occur when
residents are away from home, so normally one expects weekdays to have more burglaries than
weekends, although the difference is small in this case.

7. Clear the selection, and close the table. The definition query is still set to August Burglaries, so you
have 273 of them mapped with none selected.

Query time of day
In this case, police work three shifts (with military times in parentheses):

1. Day: 7:00 AM–3:00 PM (0700-1500)

2. PM: 3:00 PM–11:00 PM (1500-2300)

3. Night: 11:00 PM–7:00 AM (2300-2359 and 0000-0700)

Now you can see how many August burglaries each shift had. You’ll query for the PM and nightshifts, and
then get the dayshift by calculating the difference. You will include the query for nightshift as another
example of a query requiring an OR connecter. The data has military time as the numeric attribute,
TimeOccur, which ranges between 0 and 2359 (the kind of time data in a separate attribute that you need for
working with time-of-day queries in ArcGIS). The two SQL clauses for nightshift are TimeOccur >= 2300
OR TimeOccur < 700. These clauses work because the maximum of TimeOccur is 2359 and the minimum is
0. Normally, the right sides of intervals (such as the 700 in the second clause) are not included and use only
less than. The 700 is included in the dayshift.

1. Start a Selection By Attributes query for CrimeOffenses (now all August 2015 burglaries). You can
start with the nightshift.

2. Add the two nightshift clauses (TimeOccur >= 2300 OR TimeOccur < 700) and run the query. Open
the CrimeOffenses attribute table, and see that 82 (30 percent) out of 273 burglaries were during the
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nightshift.

3. Clear the query and table.

4. Build two clauses for the dayshift, which in SQL are  AND 
, run the query, and open the table. Ninety-eight (36 percent) out of 273 are

dayshift burglaries. That means that 273 – 82 – 98 = 93 (34 percent) are in the PM shift. So,
although the maximum (36 percent) are daytime burglaries while residents are at work or away, and
the minimum (30 percent) are nighttime burglaries, following the expected pattern, the percentages
do not vary much. Nevertheless, police find the results useful.

5. Close and clear the table, and clear the expression.

Query person attributes
Suppose an informant told a police officer that a burglary was committed by a white male in his 30s who lives
someplace on Warrington Avenue, and the officer wants to see if a person with those characteristics has
already been arrested. The query will need several clauses all connected by AND because the person sought
must have all the provided characteristics. Also, you must search for a part of text values, namely just the street
name (Warrington) from an address (such as 123 Warrington Av). You can easily do this using SQL.

1. Open the CrimeOffenses table, and start a Select By Attributes query. This time you’ll keep running
the query as you build it and see how the query results are narrowed. Start by excluding all records in
which there was no arrest, which you’ll find by querying for the arrested person’s last name is not null.
“Null” means no value entered, which is the indication for no arrest made, in this case.

2. Add a clause for ArrName is not null, run it, and click the Show Selected Records button on the
lower-left corner of the table. There were 40 arrests made for burglaries committed in August, all of
them now visible and in the selection color. Of course, there are different genders, races, and ages.

3. Add and run an AND clause for . Now there are 34 out of 40 records selected, with
evidently only six female burglars arrested.

4. Add and run an AND clause for . Slightly more than half the burglaries with arrests
remain, 18, being whites.

5. Add and run two AND clauses for  and . You’re down to six white
males in their 30s who were arrested for burglary. You can review the records themselves to visually
apply the last criterion, street name, but for other cases this might be inefficient. So you’ll go ahead
and add the last clause.

6. Add and run an AND clause for ArrResid “contains the text” Warrington, in which you type
Warrington. No one satisfies the last condition, but a bit of digging in the data reveals that street
names are entered with all caps (for example, WARRINGTON), and SQL is case sensitive for
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values. So you must edit the last clause.

7. Point to the last clause, click its Edit Clause button , type WARRINGTON for its value, and
click Update. Editing a clause is useful when you must make several queries, such as modifying parts
of the query as in assignment 4-3 (which you can download from the book resource web page).

8. Click the SQL button to see the command that you just built. A new SQL logical operator is LIKE,
which is used only on text-valued attributes. The value, WARRINGTON, is enclosed in single quote
marks so that SQL learns that it’s a text value, and the % symbol is the wildcard character for ArcGIS
SQL that stands for zero, one, or more characters to ignore. The record that you’ll retrieve has the
value 1005 E WARRINGTON AV for ArrResid. The first % in the query value
(‘%WARRINGTON%’) ignores seven characters at the beginning of the address (1005 E ), where
the blank spaces are counted as characters, and the last % ignores three characters at the end ( AV).

9. Run the command. You now have an arrested person who may also have committed the unsolved
burglary, John Bond.

10. Clear the selection, close the table, close the Geoprocessing pane, and save your project.
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Tutorial 4-5: Data aggregation with a spatial join
In this tutorial, you will count (aggregate) burglaries by neighborhood, providing the “big picture” of crime.
Aggregation of point data requires a spatial join of burglary points to neighborhood polygons. The spatial
join’s algorithm can sense the polygon in which a point lies, enabling the data aggregation. You’ll use the
results to create a choropleth map of burglaries by neighborhood in August 2015. All of this is easy in ArcGIS
Pro.

Open the Tutorial 4-5 project

1. Open Tutorial4-5.aprx in Chapter4\Tutorials, and save it as Tutorial4-5YourName.aprx.

2. Use the Pittsburgh bookmark. The map is the one that you used in tutorial 4-4 with the definition
query yielding burglaries in August 2015. Neighborhood labels have been added and streets removed.
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Build a spatial join

1. Search for and open the Spatial Join tool.

2. Type or make the selections as shown next. In the Output Fields list, starting with Area, point to
each field and click the red x remove button so that only Name (from Neighborhoods) remains.
When skipping over Name to remove Shape_Length, make sure that Name is not also selected before
clicking the red x. Notice that Neighborhoods, the polygon outputs you need, are Target Features.
Make sure that Keep All Target Features is selected so that polygons are output for neighborhoods
that had no burglaries.

3. Click Run.

4. Close the Geoprocessing pane, and open the new map layer’s attribute table. See that Join_Count is
added as a new attribute and is equal to the number of burglaries in each neighborhood.

5. Close the table.

YOUR TURN
Create a choropleth map using Join_Count from August2015BurglariesByNeighborhood. Use five
quantiles and the color scheme of your choice. When finished, save and close your project.
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Tutorial 4-6: Central point features for polygons
If you choose graduated symbols for symbology of a polygon map layer, ArcGIS Pro creates the central points
on the fly and renders them as point features. This choice works well and saves you the work of creating a new
central point feature class from the polygons yourself. However, it is often helpful to create a separate feature
class with central points created from polygon features, so you will create a separate feature class.

Get started

1. Open Tutorial4-5.aprx from Chapter4\Tutorials, and save it as Tutorial4-6YourName.aprx.

2. Use the Pittsburgh bookmark. This map has the aggregate number of burglaries by neighborhood in
Pittsburgh that you created in tutorial 4-5, without the neighborhood labels.

Create a central point feature class for polygons
The centroid of a polygon is the arithmetic mean of all points within the polygon. For most polygons,
centroids lie within their polygons, but for some, such as a quarter-moon-shaped polygon, centroids lie
outside. If you want all center points to lie within their polygons, the remedy in ArcGIS is to use “central
points” instead of centroids. Central points all lie within their polygons. In this tutorial, you’ll use the Feature
To Point tool to create a central point feature class. Although not necessary, for practice you’ll first use the
Add Geometry Attributes tool for adding central point coordinate attributes to the feature class. It’s valuable
to know about the Add Geometry Attributes tool.

1. Search for and open the Add Geometry Attributes tool.

2. Make the selections as shown.
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3. Run the tool.

4. Close the Geoprocessing pane and open the Burglaries By Neighborhood attribute table. The tool
created Inside_X and Inside_Y central point coordinates, in State Plane feet.

5. Close the attribute table.

Create a new point layer
The Feature To Point tool creates a point layer of central points for polygons.

1. Search for and open the Feature To Point tool.

2. Select Burglaries By Neighborhood as Input Features, type BurglariesByNeighborhoodPoints for
Output Feature Class, select Inside, and run the tool.

3. Run the tool, and when it finishes, close the tool.

YOUR TURN
Symbolize BurglariesByNeighborhoodPoints with graduated symbols using Join_Count with five
quantiles. Although not required here, you could have changed the name of the Join_Count field to
Burglaries to make the feature layer more self-documenting. You now have a point layer that could be
used with a choropleth map of some other attribute by neighborhood, such as population living in
poverty, and you could publish both in ArcGIS Online.
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Tutorial 4-7: Create a new table for a one-to-many join
Data in a database commonly has a code field that, by itself, is not self-documenting. For example, crime data
may have as crime type only the FBI hierarchy code, 1 through 7. The meaning of these codes is 1 = Criminal
Homicide, 2 = Forcible Rape, 3 = Robbery, 4 = Aggravated Assault, 5 = Burglary, 6 = Larceny-Theft, and 7 =
Motor Vehicle Theft. To break the code, you need a code table with the seven codes in one field and the
descriptions in a second field. In this tutorial, you’ll create the code table, create a template for its fields, enter
data into it, and join the table to crime data. This join is called “one to many,” because the same code table
record—for example, the one for homicide—is joined to many crime incidents, all of them homicides.

You can use a field domain (see chapter 12) as an alternative approach for adding code values such as
crime type to a table. This alternative is most relevant when the descriptive name of the code is itself the code
(and there are no cryptic code values such as the FBI hierarchy). The code values become part of the table so
that, for example, when responding police officers enter new crime data using Collector for ArcGIS,
Collector’s data entry form automatically has a drop list with all crime types available for selection, rather than
requiring a user to type. A drop list improves data integrity because crime type codes are not typed but
selected from the drop list. This feature eliminates the potential of misspelled words and guarantees that the
user will retrieve all relevant records—for example, after a query of all crimes of a certain type.

Open the Tutorial 4-7 project

1. Open Tutorial4-7.aprx from Chapter4\Tutorials, and save it as Tutorial4-7YourName.aprx.

2. Use the Pittsburgh bookmark.

Create a new table

1. Search for and open the Create Table tool.

2. For table name, type UCRHierarchyCode.

3. Run the tool, and when it finishes, close the Geoprocessing pane.
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YOUR TURN
Open the Fields design view of UCRHierarchyCode, and add two new fields: Hierarchy with the short
data type and Crime with the text data type and length 25. Then open the table, and type seven records
as shown next. Note that ArcGIS Pro automatically enters values for ObjectID, so you don’t have to
type them. Click Edit and then Save when finished.

Make a one-to-many join
You’ll join your new code table to the map’s crime layer to make crime type available for use.

1. Look at the attribute table for PittsburghSeriousCrimesSummer2015, and see that it has Hierarchy
as a field, but not crime type.

2. Right-click PittsburghSeriousCrimesSummer2015, click Joins and Relates > Add Join, and make the
selections as shown.

3. Run the tool, and when it finishes, close it.

4. Look at the crime attribute table again, and see the joined attributes.

YOUR TURN
Symbolize PittsburghSeriousCrimesSummer2015 with unique values and Crime as the value field.
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Although you could improve symbolization of crimes by giving each crime a different shaped symbol,

you’ll not do that work here. The point is that you can see that the code table has benefited, with the
legend in the Contents pane labeled with crime types. When you finish, save and close your project.

Assignments
This chapter has three assignments to complete that you can download from this book’s resource web page,
esri.com/gist1arcgispro:

Assignment 4-1: Investigate the spatial distribution of PhDs in Allegheny County.
Assignment 4-2: Compare serious violent crime with poverty in Pittsburgh.
Assignment 4-3: Query statistics for day and night burglaries and larcenies by month.
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CHAPTER 5

Spatial data
LEARNING GOALS

Work with world map projections.
Work with US map projections.
Work with projected coordinate systems (PCS).
Learn about vector data formats.
Download US Census map layers and tabular data.
Explore, download, and process data from Living Atlas of the World.
Explore sources of spatial data from government websites.
Explore maps from a university’s web service.

Introduction
The most important information that maps and GIS provide is location. Where is an object or event
positioned? Is the object on a major street with good access? Is there a barrier to accessing it, such as a river? Is
it in a certain area? Where are similar things positioned? What or who is near it? These are some of the
questions that maps can answer.

Where you sit right now has two unique numbers, latitude and longitude coordinates that pinpoint your
location precisely on the surface of the earth. In this chapter, you will learn some useful facts about latitude
and longitude coordinates and the geographic coordinate system (GCS) that they are comprised in.

You will learn about map projections, making flat maps from the nearly spherical earth. You can project
maps in at least 100 ways. Sometimes, what projection you choose makes a big difference, so this chapter
provides some guidelines to your choice of projection.

For the world map in tutorial 5-1, you’ll change the geographic coordinate system to a projected
coordinate system by setting the map properties.

For the continental-level map in tutorial 5-2, you’ll change the projected coordinate system to a different
projected coordinate system by setting the map properties.

In tutorial 5-3, you’ll set the projected coordinate system (state plane) for a local-level map by adding a
first layer to the map, and then specifying the display units for the map. You’ll add a second layer, which has
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geographic coordinates, and see how it’s projected on the fly to the state plane coordinates. Finally, you’ll
change the geographic coordinate system for a state-level map to use a projected coordinate system (UTM) by
setting the map properties.

The key input of GIS is geospatial data—digital data that represents, and can be rendered into, maps on a
computer. You may collect some original geospatial data yourself, but more likely, most if not all of your map
data will come from external organizations. Who collects aerial imagery, roads, population, or other map data
that you will use? The answer is that international organizations and federal, state, or local governments
collect the data and will provide it to you at little or no cost, increasingly as a download or service from the
Internet. The Living Atlas of the World, available in ArcGIS Online, is one of the foremost sites for
obtaining such data. You will explore the Living Atlas and other US federal sites in this chapter.
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Tutorial 5-1: World map projections
ArcGIS Pro has more than 5,200 projected coordinate systems (and almost 600 geographic coordinate
systems) that use 100 map projections from which you may choose. Typically, though, you will need only a
relatively few projections for most purposes. Geographic coordinate systems use latitude and longitude
coordinates for locations on the surface of the earth, while projected coordinate systems use a mathematical
transformation from an ellipsoid (spheroid) or a sphere to a flat surface and rectangular coordinates.
Geographic coordinates are angles calculated from the intersection of the prime meridian (which runs north
and south through Greenwich, England) and the equator. Longitude, which measures east–west, ranges from
0 degrees to 180 degrees east and the same to the west. Latitude, which measures north–south, ranges from 0
degrees to 90 degrees north and the same for south. Although you can view 2D maps in geographic
coordinates on your flat computer screen, they will be greatly distorted because their coordinates are from a
sphere. ArcGIS Pro can easily switch between coordinate systems and map projections on the fly. For world
maps, you’ll change the geographic coordinate system to a projected coordinate system by setting the map
properties.

Open the Tutorial 5-1 project
This exercise shows you the distortions caused by displaying a map in geographic, latitude/longitude
coordinates.

1. Open Tutorial5-1.aprx from Chapter5\Tutorials, and save it as Tutorial5-1YourName.aprx.

2. Zoom to full extent. The map has significant distortions. For example, the line running across the top
and bottom of the map should be points, the North and South Poles. Also, Antarctica and Greenland
are far larger proportionately than in reality. Although perhaps not evident, the lower 48 states of the
United States are squashed in the vertical dimension, as are Europe and Asia.
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Examine a world map in geographic coordinates

1. Place your pointer over the westernmost point of Africa, and read the coordinates on the bottom of
the map window (appearing approximately at 17° W, 20° N). The network of lines on the map is
called a graticule, and it has 30-degree intervals east–west and north–south.

Project the map on the fly to Hammer-Aitoff (world)
The projected coordinate system Hammer-Aitoff works well on a world map because it is an equal-area
projection that preserves area. For example, if you want to map population densities (such as population per
square mile), the densities will be correct.

1. In the Contents pane, right-click World Projections > Properties > Coordinate Systems. The current
coordinate system is CGS WGS 1984.

2. Under XY Coordinate Systems Available, scroll down and click to expand Projected coordinate
system > World, and click Hammer-Aitoff (world).

3. Click OK, and zoom to full extent. Note that the map displayed here has coordinates projected on the
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fly and that are not permanent changes to the feature class.

YOUR TURN
Repeat the steps of this exercise, but this time select the Robinson (world) projection in the second step.
The Robinson projection is most accurate at the mid-latitudes in both the Northern and Southern
Hemispheres where most people live, and overall it is appealing visually. This projected coordinate
system minimizes some distortions but still has notable ones such as the lines at the top and bottom that
in reality are points. As a general rule, though, use the Robinson projection for the entire world unless
you have a specific need (such as mapping population densities, in which case use an equal-area
projection). Save your project.
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Tutorial 5-2: US map projections
Next, you will gain experience with projections commonly used for maps of the continental United States.
You can get accurate areas or accurate shapes and angles, but not both, when making a projected coordinate
system. As a rule, use a projection that provides accurate areas (at the price of some shape and direction
distortion), such as the Albers equal area or cylindrical equal area projection. Albers equal area is the standard
projection of both the US Geological Survey and the US Census Bureau for US maps. For a continental-level
map, you’ll change the projected coordinate system to a different projected coordinate system by setting the
map properties.

Open the Tutorial 5-2 project

1. Open Tutorial5-2.aprx from Chapter5\Tutorials, and save it as Tutorial5-2YourName.aprx.

2. Use the Contiguous Lower 48 States bookmark. Initially, the map display is in projected coordinates
using WGS 1984 Web Mercator (auxiliary sphere), which is the preferred PCS for maps to be
published in ArcGIS Online.

Set projected coordinate systems for the United States
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1. In the Contents pane, right-click US Projections > Properties > Coordinate System, and then scroll
up and expand Projected coordinate system > Continental > North America.

2. Click USA Contiguous Albers Equal Area Conic, and then click OK.

3. Zoom into the lower 48 states. Your map is now projected using the Albers Equal Area projection.

YOUR TURN
Experiment by applying a few other projections to the US map such as North America Equidistant
Conic. As long as you stay in the correct group—Continental, North America—all the projections look
similar. The conclusion is that the larger the part of the world that you need to project (small-scale
maps), the more distortion. There remains much distortion at the scale of a continent, but much less so
than for the entire world. By the time you get to a part of a state, such as Allegheny County,
Pennsylvania, practically no distortion is left, as you will see next. Save your project.
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Tutorial 5-3: Projected coordinate systems
For medium- and large-scale maps, you should use localized projected coordinate systems, tuned for the study
area, that have little or minimal distortion. For this purpose, collections of projected coordinate systems are
divided into zones. You must check a reference map to determine which zone your study area is in and select
that PCS for your map. In these exercises, you’ll set the projected coordinate system (state plane) for a local-
level map by adding a first layer to the map, and then specify the display units for the map. Then you’ll add a
second layer that has geographic coordinates and see how that layer is projected on the fly to the state plane
coordinates. Finally, you’ll change the geographic coordinate system for a state-level map to use a projected
coordinate system (UTM) by setting the map properties.

Look up a zone in the state plane coordinate system
The state plane coordinate system is a set of coordinate systems dividing the 50 US states, Puerto Rico, and
the US Virgin Islands, American Samoa, and Guam into 126 numbered zones, each composed of counties,
and with its own finely tuned map projection. Used mostly by local government agencies such as counties,
municipalities, and cities, the state plane coordinate system is for large-scale mapping in the United States.
The US Coast and Geodetic Survey (now known as the National Geodetic Survey) developed this coordinate
system in the 1930s to provide a common reference system for surveyors and mapmakers. Most states use
NAD83, which stands for North American Datum of 1983, the datum used to describe the geodetic network
in North American. That datum in turn was updated from the original North American Datum of 1927 when
satellite geodesy and remote sensing technology became more precise and were made available for civilian
applications. The first step in using the state plane coordinate system is to look up the correct zone for your
area and consequently a specific PCS tailored to your study area.

1. Start a web browser, navigate to www.ngs.noaa.gov, and click Tools > State Plane Coordinates > Find
Zone.

2. With By County selected, click Begin > Pennsylvania, and click Submit.

3. Click |003|Allegheny, and click Submit (leave the option button set to NAD83). Pennsylvania’s
Allegheny County is in State Plane Zone 3702 (Lambert | Southern Zone). A few states changed the
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number of zones when the NAD83 set was defined. For instance, Montana went from three zones to
a single zone.

4. Close your web browser. You can use the same website to find UTM zones that you will learn about
in a later tutorial.

Open the Tutorial 5-3 project
ArcGIS Pro offers two options for setting the map’s coordinate system. One option is to allow the first map
layer added to determine the coordinate system in each map according to its coordinate system. The other
(default) option is to set a default coordinate system for all new maps in the project. In this exercise, you set
the option to allow the first layer added to set the coordinate system for the project, in this case State Plane
Pennsylvania South.

1. Open Tutorial5-3.aprx from Chapter5\Tutorials, and save it as Tutorial5-3YourName.aprx. The
project opens with just a basemap and the default PCS, WSG 1984 Web Mercator (auxiliary sphere).
You will change the option to have ArcGIS Pro set the coordinate system using the first layer added
to the map—in this exercise, the state plane PCS.

Use state plane coordinates

1. On the Project tab, click Options > Map and Scene, expand Spatial Reference, click Use spatial
reference of the first operational layer, and click OK. Note that here is where you can set the map’s
projected coordinate system or geographic coordinate system, using the “Choose spatial reference”
option regardless of what layers you add to it. Next, you will add a layer with a state plane coordinate
system PCS and then a layer using a GCS.
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2. Click the back button , and on the Map tab in the Layer group, click Add Data, navigate to
Chapter5.gdb, and add Municipalities. This map layer for Allegheny County, Pennsylvania,
municipalities uses zone 3702 PA South State Plane coordinates, and the map unit is US survey feet.
Next, you must change the display units to feet.

3. In the Contents pane, right-click Allegheny County State Plane > Properties > General, select Feet as
the display units, and click OK. The x,y coordinates at the bottom of the screen now display as State
Plane feet.
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Add a layer using geographic coordinates

1. Add Tracts from Chapter5.gdb. This layer has geographic coordinates but is projected on the fly in
the data frame to state plane coordinates because you added Municipalities first, which has state plane
coordinates.

2. Change the symbology of Municipalities to No Color, Black outline width 1.5 and Tracts to Color
White, Outline Color Gray 30%, and width 1 pt.

3. Move Municipalities above Tracts in the Contents pane.
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Check a layer’s spatial reference

1. In the Contents pane, right-click Municipalities > Properties > Source, and expand Spatial
Reference. The spatial reference for this layer is NAD 1983 StatePlane Pennsylvania South FIPS
3702 Feet, which uses the map projection Lambert Conformal Conic.
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2. Repeat step 1 to check the spatial reference for Tracts. Its spatial reference is GCS North American
1983.

3. Save your project.

Use UTM coordinates
The US military developed the Universal Transverse Mercator (UTM) grid coordinate system in the late
1940s. It covers the world with 60 longitudinal zones defined by meridians (longitude lines) that are six
degrees wide. ArcGIS has UTM zones available for the Northern and Southern Hemispheres. These zones,
like state plane, are good for areas about the size of a state (or smaller).

Change a map’s coordinate system to UTM

1. Close the Allegheny County state plane map, and open the California UTM map. Note that
CACounties has geographic coordinates. You can look up UTM zones using the same website that
you used for state plane.

2. In the Contents pane, right-click California UTM > Properties > Coordinate System.

3. Expand Projected coordinate system > UTM > NAD 1983, click NAD1983 UTM Zone 11N, and
then click OK. The map coordinates will be degrees, minutes, and seconds. Next, you will change
these coordinates to meters.
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4. In the Contents pane, right-click California UTM > Properties > General, click Meters for Display
Units, and click OK.

5. Use the California bookmark, and hover the mouse in the center of the state. The x,y coordinates at
the bottom of the display will be UTM meters.

YOUR TURN
On the Project tab, click Options > Map and Scene > Spatial Reference. Click Choose spatial reference >
Projected coordinate system > World > WGS 1984 Web Mercator (auxiliary sphere), and click OK.
Insert a new map, add Counties, and then check the coordinate system of the map. It’s Web Mercator,
the preferred format for ArcGIS Online. Save your project.
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Tutorial 5-4: Vector data formats
This tutorial reviews file formats commonly found for vector spatial data, in addition to file geodatabases
covered in chapter 4. Included are Esri shapefiles, x,y data, and Google KML files.

Examine a shapefile
Many spatial data suppliers use the shapefile data format, an Esri legacy format from the early PC computer
days, for vector map layers because it is so simple. A shapefile consists of at least three files with these
extensions: .shp, .dbf, and .shx. Each file uses the shapefile’s name but with a different extension (for example,
Cities.shp, Cities.dbf, and Cities.shx). The SHP file stores the geometry of the features, the DBF file stores
the attribute table, and the SHX file stores an index of the spatial geometry to speed up processing. Next, you
will examine a census tract shapefile in more detail.

1. Open a computer or File Explorer window, and navigate to Chapter5\Data\. CouncilDistricts is a
shapefile for New York City Council Districts provided by the city’s Planning Department. Shapefiles
have three to seven associated files, including the three mentioned previously (.shp, .shx, and .dbf)
and also should have a PRJ file that contains the map layer’s coordinate system.

2. Close the computer window.

Import a shapefile into a file geodatabase and add to a map
You will use a conversion tool to import a shapefile into a file geodatabase, where it becomes a feature class.

1. Open Tutorial5-4.aprx from Chapter5\Tutorials, and save it as Tutorial5-4YourName.aprx. The
project opens with a map zoomed to New York City with a PCS of
NAD_1983_StatePlane_New_York_Long_Island_FIPS _3104_Feet.
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2. On the Analysis tab, click the Tools button .

3. In the Geoprocessing pane, click Toolboxes, expand Conversion Tools > To Geodatabase, and click
Feature Class To Feature Class.

4. Complete the form as shown.

5. Run the tool and close it after it finishes. The shapefile will now be a polygon feature class in
Chapter5.gdb and will automatically be added to the Contents pane. The council districts nicely
overlay on the basemap. Note the state plane coordinates at the bottom of the map.

Add x,y data
GPS units and many databases provide spatial coordinates as x,y coordinates. These are easily added to a map
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as XY Event files. In this exercise, you use x- and y-values from a table to create a point feature class of public
libraries in New York City.

1. On the Map tab, click Add Data, navigate to Chapter5\Data\ and add Libraries.dbf.

2. In the Contents pane, right-click Libraries > Open, and scroll to the right to see columns XCOORD
and YCOORD. These coordinates are in state plane format for New York City. The x,y locations are
often obtained using GPS units and are in longitude and latitude format. In these cases, x is the
longitude and y is the latitude, and the spatial reference should be GCS WGS 1984 or a similar
geographic coordinate system.

3. Close the table.

4. In the Contents pane, right-click Libraries > Display XY Data.

5. In the Make XY Event Layer pane, check to be sure XCOORD is the X Field, YCOORD is the Y
Field, and click Current Map [Vector Data Formats] as the Spatial Reference. The spatial reference
will automatically set itself to NAD_1983_StatePlane_New_York_Long_Island_FIPS_3104_Feet.

6. Run the tool and close it after it finishes. The libraries will appear as points in the map. This layer is
temporary in the project, and the points should be exported as point features.
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7. Export the Libraries_Layer as NYCLibraries to Chapter5.gdb as a permanent feature class. The
library point features will automatically be added from the new location of Chapter5.gdb.

8. Remove the Libraries_Layer and original Libraries.dbf from the Contents pane, and save your
project.

Export to a Google KML file
Google KML (Keyhole Markup Language) is the file format used to display geographic data in many
mapping applications. KML has become an international standard maintained by the Open Geospatial
Consortium (OGC). In this exercise you will export the New York City Council Districts to Google KML
format.

1. On the Analysis tab, click the Tools button.

2. In the Geoprocessing pane, click Toolboxes > Conversion Tools > KML, and click Layer To KML.

3. Fill in the form as shown.
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4. Run the tool and close it after it finishes.

5. Save your project and exit ArcGIS Pro. Although you won’t do it here, you could now open the .kmz
file, the compressed version of a KML file, in an application such as Google Earth.
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Tutorial 5-5: US Census map layers and data tables
A large and ever-expanding collection of spatial data—including vector and raster map layers and data tables
with geocodes—is available for free download from the Internet or for direct use as map layers in projects.
The advantage of downloading spatial data is that you can modify it as you wish. In this tutorial, you will learn
about and use data from the US Census Bureau, a major spatial data supplier.

From the US Census Bureau’s website, you can download census-related map layers with unique
identifiers for polygons such as census tract IDs, but not census attribute data such as population, age, sex,
race, income, and so on. Because there are thousands of census variables, it is impractical to provide them all
in map layer attribute tables. The map layers would be excessively large and cumbersome files. Instead, the
Census Bureau provides the American FactFinder website in which you can build custom collections of
variables for your needs. The Census Bureau continually updates this website, so you might find that some
popular collections of data are already available and that the website’s menus may vary.

In this tutorial, you will download selected census demographic data separately, perform some data
preparation steps, and finally join the data to the corresponding polygon boundary map layer. First, you will
download TIGER (topologically integrated geographic encoding and referencing) shapefiles for tracts and
county subdivisions of Hennepin County, Minnesota, where the city of Minneapolis is located.

Download census TIGER files
In a web browser, go to http://www.census.gov/geo/maps-data/data/tiger.html.

Alternatively, go to www.census.gov, and click Geography > Maps & Data > TIGER products. Here you
will see options for downloading TIGER features, including shapefiles, geodatabases with limited
demographic and economic data already joined, and KML files.

1. Under the heading “Which product should I use?” click TIGER/Line Shapefiles > expand
Download, and click Web interface. If you have trouble finding this site, the direct URL to this link
is http://www.census.gov/cgi-bin/geo/shapefiles/index.php.

2. Select 2010 for year and Census Tracts for layer type, and click Submit. Although there are newer
dates, select 2010 for layers from the decennial census of 2010.
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3. Under Census Tract (2010), select Minnesota; under Select a County, select Hennepin County; and
click Download.

4. Save the compressed file to Chapter5\Tutorials\Downloads\Census, and extract all files associated
with the shapefile here.

YOUR TURN
Download and extract 2010 County Subdivisions and Water (Area Hydrography) features for Hennepin
County, Minnesota, to the Downloads\Census folder.

Download census tabular data
The Census Bureau provides detailed data on education, income, transportation, and other subjects through
its American Community Survey (ACS) tables. In the 2000 and previous censuses, such data was collected in
the census long form randomly from one out of six households, and was called SF3 (Summary File 3) data.
Now, the Census Bureau collects ACS data monthly—approximately 3 million housing units receive a survey
similar to the old long-form questionnaire. Annual, three-year, and five-year estimates produced from ACS
samples are available. In this exercise, you will download commuting-to-work ACS data at the tract level for
Hennepin County, Minnesota. The city of Minneapolis is ranked high in the nation for the quality of its
transportation infrastructure, including bike lanes, according to several groups and publications (including the
League of American Bicyclists and Bicycling). The census is a good starting point to analyze means of
transportation to work by overall percentages, males, and females. You will first select the geography (all tracts
in Hennepin County) and then the topic (commuting characteristics by sex).

1. In a web browser, go to factfinder.census.gov, click Advanced Search (under Guided Search), and the
Show Me All button.

2. Click Geographies > Census Tract-140 as the geographic type > Minnesota as the state > Hennepin
as the county > All Census Tracts within Hennepin County, Minnesota > and click the Add to Your
Selections button.
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3. Close the Select Geographies window.

4. Select the check box on the left of S0801 (Commuting Characteristics by Sex) 2015 ACS 5-year
estimates > Download button > and click OK. The Census Bureau constantly adds data to its
website, so there may be newer datasets for ACS five-year estimates that you could use for updated
studies. This tutorial uses data from the 2010–2015 American Community Survey and will work
nicely with the 2010 Tracts.

5. Click the Download button again, and save the file to the Downloads\Census folder.

6. Extract the contents to the same Downloads\Census folder.

Process tabular data in Microsoft Excel
The census data that you downloaded in the previous exercise as a text table needs some cleaning up using
software such as Microsoft Excel before you use the data in GIS. You will delete all columns except those
needed for joining and the estimate of percentages of males and females who bicycle to work.

1. Navigate to Chapter5\Tutorials\Downloads\Census, and double-click the comma-separated file
named ACS_15_5YR_S0801_with_ann. The file opens in Excel.

2. Select and delete fields C through (and including) BK.

3. In the resulting columns, delete H through (and including) JX. The resulting data columns are the
total percentage of people who bicycle to work, the estimates of males and females, and the margin of
error associated with the estimates. For this exercise, you will delete the margin of error fields and
keep only the percentage estimates.
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4. Select and delete margin of error fields HC01_MOE_VC12 and HC02_MOE_VC12.

5. Rename cell HC01_EST_VC12 as TOT_BIKE, cell HC02_EST_VC12 as MALE_BIKE, and cell
HC03_EST_VC12 as FEMALE_BIKE.

6. Remove the periods from cells A1 and A2, and delete row 2.

7. Highlight columns C, D, and E, and change the field type from General to Number.

8. Rename the workbook BIKE_WORK. Your spreadsheet should look like the one shown next.

9. Save your work to the Downloads > Census folder as a comma-delimited file (CSV) named
BikeWorkData.CSV, and close Excel.

Add and clean data in ArcGIS Pro

1. Open Tutorial5-5.aprx from Chapter5\Tutorials, and save it as Tutorial5-5YourName.aprx.

2. Import your downloaded county subdivisions (tl_2010_27053_cousub10.shp) into Chapter5.gdb as
HennepinCountySubdivisions, census tracts (tl_2010_27053_tract10.shp) as HennepinTracts, water
features (tl_2010_27053_areawater.shp) as HennepinWater, and your comma-delimited file
(BikeWorkData.CSV) as BikeWorkData.

3. In the Hennepin County Bike to Work Study map, navigate to Chapter5.gdb, and add
HennepinCountySubdivisions, HennepinTracts, HennepinWater, and BikeWorkData. You may
need to close and reopen the map document to see the table (BikeWorkData).

4. Open the table for BikeWorkData. Note that GEOid2 is a numeric field.

5. Close the BikeWorkData table, and open the attribute table for HennepinTracts. The candidate
field for joins is GEOID10 and is a text field.
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6. Open Fields View from the Option button of the table, and create a numeric field (whose field type is
double) named GEOIDNUM.

7. Save and close the Fields View.

8. Use Calculate Field to set GEOIDNUM equal to GEOID10. This step is necessary to join tables in
which the join field must be the same type.

9. Close the HennepinTracts table.

Join data and create a choropleth map

1. Join the BikeWorkData table to HennepinTracts using fields GEOIDNUM (Input Join Field) and
GEOid2 (Output Join Field).

2. Export the joined table/features as HennepinTractsBikeWork in Chapter5.gdb, and copy and paste
the layer so there are two copies.

3. Rename one layer % Male bicyclists and the other layer % Female bicyclists.

4. Create a choropleth map using the field Male_Bike, the color scheme Purple (5 classes), and upper
values 1.5 %, 3 %, 6 %, 12 %, and 24.7 %.

5. Create the same map for FEM_Bike, using the color scheme Orange (5 classes) and values 1.5 %, 3
%, 6 %, 12 %, and 19.3 %.

6. Remove the original HennepinTracts layer and BikeWorkData table.

7. Move HennepinCountySubdivisions to the top of the Contents pane, and change its display to No
Color and a black outline width of 1.5.

8. Label this layer using Name10 with a white halo.

9. Move HennepinWater below HennepinCountySubdivisions, and change its display to Water (area).

10. Zoom to the City of Minneapolis, and turn the layers on and off to see the difference in percentage of
males versus females who bicycle to work, and then save your project. Do males or females bicycle to
work in different parts of Minneapolis at a higher percentage?
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Tutorial 5-6: Download data from the Living Atlas
You can access and quickly use content from the Living Atlas of the World. The Living Atlas is one of the
foremost collections of geospatial data around the world. Data includes maps and data on thousands of topics
in the form of imagery, basemaps, and features that can be added directly or saved locally. Examples include
historic maps, demographics and lifestyles for the United States and many other countries, landscapes, oceans,
Earth observations, urban systems, transportation, boundaries and places, and story maps. You can use and
contribute data, maps, or apps to the Living Atlas. Like any other active website, more data is constantly
added, so check livingatlas.arcgis.com often for updates.

In this exercise, you will search for and add a land-use raster map, and then extract it for only Hennepin
County, Minnesota. Whereas vector maps are discrete—consisting of points, lines, and polygons connecting
coordinates—raster maps such as the land-use map represent continuous phenomena and use many of the
same file formats as images on computers, including Joint Photographic Experts Group (.jpg) and tagged
image file (.tif) formats. All raster maps are rectangular, consisting of rows and columns of cells known as
pixels. Each pixel has associated x,y coordinates and a z attribute value, such as altitude for elevation or some
other properties of the earth’s surface. Raster maps do not store each pixel’s location explicitly but rather store
data such as the coordinates of the northwest corner of the map, cell size (assuming square pixels), and the
number of rows and columns, from which a computer algorithm can calculate the coordinates of any cell.

Open the Tutorial 5-6 project
In ArcGIS Pro, you can add data from the Living Atlas using the Catalog pane > Portal (Living Atlas) or by
using the Add Data button.

1. Open Tutorial5-6.aprx from Chapter5\Tutorials, and save it as Tutorial5-6YourName.aprx.

Add a land-use layer from the Living Atlas

1. On the Map tab, click Add Data.

2. Click Portal > Living Atlas.
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3. In the Search Portal: Living Atlas window, type NLCD, and press Enter.

4. Click USA NLCD Land Cover 2011, and click OK.

A land-use map for Hennepin County, Minnesota, with an updated legend shows areas of land use.
Examples include development (red), open water (blue), forest (green), pasture/hay (yellow), and
cultivated crops (brown).

Extract raster features for Hennepin County
A key aspect of raster maps is that they are very large files. So although you may store some important base-
map raster files on your computer, these maps are perhaps best obtained as map services available for display
on your computer but stored elsewhere such as the Living Atlas. If you want to extract a subset of the land use
for one county and store the raster file on your local computer, you must use the Extract by Mask tool to do
so.

1. On the Analysis tab in the Geoprocessing group, click Tools.

2. In the Geoprocessing pane, search for and open the Extract by Mask tool.

3. Select USA NLCD Land Cover 2011 as the Input Raster and Hennepin County as the feature mask
data, and save the output raster as HennepinCountyLandUse to Chapter5.gdb.

4. Run the tool and close it after it finishes.

5. Remove the original land-use map, and zoom to the Hennepin County land-use layer. Notice the
difference in Hennepin County with developed areas on the eastern side of the county and the forest,
pasture/hay, and cultivated crops on the western part of the county.
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YOUR TURN
Search for topics (for example, health or housing) or geographic areas (for example, China). Add and
explore the contents of various Living Atlas layers.
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Tutorial 5-7: Sources of data from government websites
In this tutorial, you will download data from two US government websites: USGS’s National Map Viewer
and Data.gov. Agencies that contribute geospatial data to Data.gov include the US Department of
Agriculture (USDA), Department of Commerce (DOC), National Oceanic and Atmospheric Administration
(NOAA), US Census Bureau (Census), Department of the Interior (DOI), US Geological Survey (USGS),
Environmental Protection Agency (EPA), and National Aeronautics and Space Administration (NASA).
Many other agencies provide other data on federal websites such as Data.gov.

Download elevation contours from USGS
Walkability and bicycling studies often require knowledge of the topography of a city, and elevation contours
are needed. You can get these contours from local GIS departments or the USGS.

1. In a web browser, go to http://viewer.nationalmap.gov/basic.

2. In the Search location box, type Minneapolis MN, and click Go.

3. Select Elevation Products (3DEP) and the check box next to Contours.

4. Under File Format, click Shapefile, and click Find Products.

197

http://Data.gov
http://Data.gov
http://Data.gov
http://viewer.nationalmap.gov/basic


5. Click the Add this item to the cart > the View Cart button, and click Download.

6. Open the compressed downloaded file, and extract its contents to
Chapter5\Tutorials\Downloads\USGS.

7. Open Tutorial5-7.aprx from Chapter5\Tutorials, and save it as Tutorial5-7YourName.aprx.

8. On the Map tab, click Add Data, and navigate to Chapter5\Tutorials\Downloads\USGS and the
subfolder created.

9. Add the Elev_contour shapefile to the map; in Contents, drag it below Minneapolis; and zoom to the
Minneapolis layer. The map zooms to Minneapolis and contours of the southern part of the city,
where you can see areas of the city that are flat. In chapter 7, you will learn how to clip these features
to the city’s boundary.

10. Save your project.
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Download geospatial data from Data.gov
Data.gov is the location of the US government’s open data, where you find many useful datasets to use in your
GIS projects. It also includes links to resources such as cities and other local governments.

1. In a web browser, go to catalog.data.gov, and under Dataset Type, click geospatial. The type of data
(for example, shapefile, Excel, KMZ) is listed below each dataset along with the source (for example,
federal, local, university). You can also search for a dataset.

2. In the search box, type Africanized bees.

3. Click Spread of Africanized Honey Bees in the United States—Direct Download. This is a dataset of
Africanized honey bees (killer bees) spread in the United States from the Agricultural Research
Service, US Department of Agriculture (USDA). The data is saved using the Linux operating system
command called “tar” and is saved as a compressed .tar.gz file.

4. Click the download button, and save the compressed file afrbeep020_nt00218.tar.gz to Chapter5\
Tutorials\Downloads\DataGov. The downloaded compressed file needs special software to extract
the shapefile. The already extracted files, if needed, can be found in Downloads\DataGov\
AlreadyDownloaded. The downloaded shapefile does not have a coordinate system so you will next
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fix this using the Define Projection tool.

5. Close the USGS Elevation Contours map, and open the Africanized Bees Study map.

6. On the Analysis tab, click Tools, and type Define Projection in the search box.

7. Open the Define Projection tool, browse to Downloads\DataGov\AlreadyDownloaded, and select
afrbeep020.shp.

8. Next to Coordinate System Unknown, click the Globe button , and select Geographic coordinate
system > North America > NAD 1983.

9. Run the tool, and close it after it finishes. The map features will be added to your map in the correct
geographic location.

Create a map showing the migration of Africanized bees

1. Symbolize the map using graduated colors; field Year, 5 Classes; break values 0, 1994, 2000, 2005,
and 2010; an orange-red color scheme; and a light-gray (30%) outline for all classes.

2. Type No Africanized Bees Yet for break value 0, and change its color to no color.

3. Type Africanized Bees 1994–2010 as the layer name.

4. Use the Lower 48 US States bookmark, and save your project. You can clearly see the southern states
and the spread of Africanized bees between 1994 and 2010.

YOUR TURN
Explore other datasets on Data.gov, including local government data.
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Tutorial 5-8: Maps from a university web service
Federal, state, and local governments are great sources of geospatial data. Universities and libraries are also
clearinghouses for data. They often use Esri’s ArcGIS map services that allow you to connect to servers to
directly add data. In this exercise, you will connect to Penn State University’s Pennsylvania Spatial Data
Access (PASDA) ArcGIS map service and add imagery data.

Open the Tutorial 5-8 project

1. Open Tutorial5-8.aprx from Chapter5\Tutorials, and save it as Tutorial5-8YourName.aprx. The
project opens with Pittsburgh parks displayed as semitransparent features and a yellow outline.

Connect to ArcGIS server map service

1. On the Insert tab in the Project group, click Connections > New ArcGIS Server.

2. In the Add GIS Server User Connection window, for Server URL, type
http://imagery.pasda.psu.edu/arcgis/rest/services, and click OK. All the data and services provided by
PASDA are free and open to the public without a password.

3. On the Map tab in the Layer group, click the Add Data button > Servers > click arcgis on
imagery.pasda.psu.edu(user).ags > and click Open.

4. Double-click pasda, click AlleghenyCountyUrbanTreeCanopy2010, and click Select.

5. In the Contents pane, expand the AlleghenyCountyUrbanTreeCanopy2010 layer, and select the
check box for AlleghenyCountyUrbanTreeCanopy2010.

6. Use the Point State Park bookmark. The details of the tree canopy in Pittsburgh’s Point State Park
(where the three rivers meet) and parks along the riverfront are visible in the raster map.

YOUR TURN
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Explore other map layers to add from PASDA’s web service. Try and find another university or library
that provides Esri web services. Save your project.

Assignments
This chapter has two assignments to complete that you can download from this book’s resource web page,
esri.com/gist1arcgispro:

Assignment 5-1: Compare heating fuel types by US counties.
Assignment 5-2: Study solar-heated homes by neighborhood.
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CHAPTER 6

Geoprocessing
LEARNING GOALS

Dissolve block group polygons to create neighborhoods and fire battalions and divisions.
Extract a neighborhood using attributes to form a study area.
Extract features from other map layers using the study area.
Merge water features to create a single water map.
Append separate fire and police station layers to one layer.
Intersect streets and fire companies to assign street segments to fire companies.
Union neighborhood and land-use boundaries to create detailed polygons of neighborhood land-use characteristics.
Apportion data between two polygon map layers whose boundaries do not align.

Introduction
Geoprocessing is a framework and set of tools for processing geographic data. Generally, you must use
geoprocessing tools to build study areas in a GIS. In this chapter, you will learn how to extract a subset of
spatial features from a map using attribute or spatial queries; aggregate polygons into larger polygons; append
layers to form a single layer; and use intersect, union, and tabulate intersect tools to combine features and
attribute tables for processing. In this chapter, for example, you’ll process and prepare map layers for
emergency management officials in New York City’s Manhattan borough and one of its neighborhoods, the
Upper West Side.
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Tutorial 6-1: Dissolve features to create neighborhoods and fire divisions and
battalions

Suppose emergency response planners want to know the number of housing structures or units by
neighborhood for planning purposes. New York City neighborhoods are composed of block groups that
include housing data. In this tutorial, you’ll create neighborhood boundaries in the Manhattan borough by
dissolving block groups with common neighborhood names. For each neighborhood, dissolving retains the
neighborhood’s outer boundary lines but removes interior lines. The Dissolve tool can aggregate input block
group attributes to the neighborhood level, using statistics such as sum, mean, and count. In particular, you’ll
sum the number of structures in housing units by neighborhood.

Open the Tutorial 6-1 project

1. Open Tutorial6-1.aprx from the Chapter6\Tutorials folder, and save the project as Tutorial6-
1YourName.aprx.

2. Use the Manhattan bookmark. The map contains Manhattan block groups with housing units and
structures.
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Examine the dissolve field and other attributes
The Dissolve tool needs data—a dissolve field, on which block groups combine into a neighborhood. In this
case, Name is the dissolve field, and that field contains the neighborhood name to which each block group
belongs.

1. Open the ManhattanBlockGroups attribute table, and sort the Name field in Ascending order. As
you scroll, you can see the block group records that make up each neighborhood. The figure shows
some of the block groups for the Battery Park City-Lower Manhattan and Central Harlem South
neighborhoods.

2. Scroll to the right, and examine the remaining attributes. Values are an estimate of the number of
housing units in structures of different sizes, along with the total number of housing units in each
block group. For example, the field TOT1_Detached is a one-family house detached from any other
house. Mobile is the total number of mobile homes in a block group. TOT20_49 includes the total
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number of housing units, for each block group, in structures containing 20 to 49 units (that is, fairly
large apartment or condo buildings). TOT50 is the total number of housing units in structures
containing 50 or more units (mainly high-rise apartment and condo buildings). When dissolving
block groups, you’ll sum these housing unit values by neighborhoods, which will indicate housing
density.

3. Close the table.

Dissolve block groups to create neighborhoods

1. On the Analysis tab, in the Tools gallery, click the Dissolve button .

2. In the Dissolve pane, under Input Features, select ManhattanBlockGroups.

3. Type ManhattanNeighborhoods as the Output Feature Class in Chapter6.gdb., and select Name as
the Dissolve field.

4. Click Add Many from the Statistics Field(s) option, scroll down, click the check box beside each of
the TOT fields, and click Add.

5. Click Sum for Statistic Type for each statistics field.

6. Run the tool, and close it after it finishes. A new neighborhoods feature class appears in the Contents
pane.

7. In the Contents pane, open the ManhattanNeighborhoods attribute table, and click Sort Descending
on the Sum_TOT50 field. For example, on the Upper West Side, there are 41,240 housing units in
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structures having 50 or more units.

8. Close the table and map, and open the Fire Companies Battalions and Divisions map.

YOUR TURN
Other useful map layers for city officials and emergency response teams show populations per square
mile in fire battalions and divisions. The New York City Fire Department, like most fire departments
around the country, is organized in a quasi-military fashion with companies, battalions, and divisions.
Here, you have fire companies but need fire battalions and divisions. Use the Dissolve tool and attribute
FireBN to dissolve fire company polygons to create a new feature class named ManhattanFireBattalions
in Chapter6.gdb. Use the Sum option and attributes Pop2010 and SQMI to sum the population and
square miles for each battalion. Repeat Dissolve to create a new feature class named
ManhattanFireDivisions using field FireDiv as the dissolve field. Symbolize ManhattanFireDivisions as
no color and a thick red outline and ManhattanFireBattalions as graduated colors (blue, 5 classes) and
normalized using Sum_Pop2010/Sum_SQMI. Remove ManhattanFireCompanies, and label the fire
battalions using the battalion number, FireBN. The fire battalion for the Upper West Side
neighborhood is 11. Is this one of the most densely populated fire battalion areas? Save your project.
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Tutorial 6-2: Extract and clip features for a study area
This tutorial is a workflow for creating a study region from map layers that have more features than needed.
Suppose you want to study housing units and streets for just one neighborhood. First, you will create the study
area neighborhood by selecting the neighborhood using the attribute table, and then creating a single polygon
for that study area. Second, you will use the new polygon and select by location to create new features of block
groups in the study area only. Third, you will use Clip, a geoprocessing tool, to clip streets to the study area.

Open the Tutorial 6-2 project
Tutorial 6-1 showed that the Upper West Side is the neighborhood with the highest number of housing units
in structures with more than 50 housing units. In this exercise, you create a study area for this neighborhood
that includes a polygon feature of the Upper West Side neighborhood and block groups and streets for that
neighborhood only. Such a study area is important when you work in geographic areas, such as New York
City, that have many streets and block groups.

1. Open Tutorial6-2.aprx from the Chapter6\Tutorials folder, and save the project as Tutorial6-
2YourName.aprx. The map contains New York City neighborhoods, block groups, and Manhattan
streets.

2. Use the Upper West Side bookmark.

Use Select By Attributes to create a study area

1. On the Map tab in the Selection group, click the Select By Attributes button .

2. Under Layer Name or Table View, select New York City Neighborhoods, click Add Clause and
Name as the Field, is Equal to, Upper West Side, and click Add.
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3. Run the tool, and close it after it finishes. The result shows the Upper West Side neighborhood
selected. Although you don’t have to export the selected feature to do the select by location in the
next section (Select By Location will use the selected neighborhood to select the block groups), you
will export the feature to display and symbolize the Upper West Side neighborhood on a map.

4. In the Contents pane, right-click New York City Neighborhoods > Data > Export Features, type
UpperWestSide as the output feature in Chapter6.gdb, and click Run.

5. Remove the original New York City Neighborhoods layer, and zoom to the Upper West Side.

6. Label the feature using Name.

Use Select By Location to create study area block groups
In the next steps, you will use Select By Location to select Manhattan block groups of the Upper West Side
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neighborhood. After creating a selection set of the block groups, you will create a new polygon feature class
from the selected features. Because block groups are not contiguous with the neighborhood boundary, there
are a few ways to create this selection. Here you will use the block group features whose centers are in the
Upper West Side neighborhood, and then manually select the remaining block groups that are partially inside
the neighborhood.

1. On the Map tab, click the Select By Location button , and type or make the selections as shown.

2. Run the tool, and close it after it finishes.

3. Press the Shift key, and select the remaining block groups on the west (left) side of the neighborhood.

4. Export the selected features as UpperWestSideBlockGroups to Chapter6.gdb.

5. Remove the original New York City Block Groups layer, and move the UpperWestSide layer to the
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top of Contents.

YOUR TURN
Use SelectByLocation to select Manhattan streets that intersect the UpperWestSide polygon. Notice
that many of the streets “dangle,” or extend beyond the polygon boundary. These selected streets, each a
full block long, would be needed for geocoding address data to points, as explained in chapter 8. Save
these as UpperWestSideStreetsForGeocoding, and clear your selected features.

Clip streets
Next, you will use the Clip tool to cleanly create street segments using the Upper West Side polygon.
Clipping Manhattan streets with the Upper West Side boundary cuts off dangling portions of streets for
display purposes in maps.

1. If necessary, turn off the UpperWestSideStreetsGeocoding and UpperWestSideBlockGroups layers.

2. On the Analysis tab in the Tools group, click the Clip button .

3. In the Geoprocessing pane, complete the parameters as shown.

4. Run the tool, and close it after it finishes.

5. Turn off the original ManhattanStreets layer. The result will be cleanly cut streets to the Upper West
Side neighborhood.
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6. Save your project.
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Tutorial 6-3: Merge water features
Sometimes, you must merge two or more layers into a new single layer. For example, you will build one water
feature class from several adjacent water feature classes. New York City is made up of five boroughs, each of
which is also a county whose water features are downloaded separately from the US Census Bureau.

Open the Tutorial 6-3 project

1. Open Tutorial6-3.aprx from the Chapter6\Tutorials folder, and save the project as Tutorial6-
3YourName.aprx. The map, NYC Water, includes separate water features for each borough.

2. Use the NYC Boroughs bookmark.

Merge features
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Next, you will use the Merge Geoprocessing tool to create one water feature class from five separate feature
classes.

1. On the Analysis tab, in the Tools group under Manage Data, click the Merge button . The input
datasets will be the five water datasets as shown, and the Merge Rule will be “First.” The Output
dataset will be NYCWater saved to Chapter6.gdb.

2. Use the Add Many button to add all five water layers.

3. Run the tool, and close it after it finishes.

4. Change the fill color of NYCWater to blue, and zoom to the layer.

5. Open the attribute table for NYCWater. The resulting water feature class has 330 records, one for
each water polygon. Merge does not erase boundaries—the polygon boundaries between water
features (such as the rivers in this data) are still present. The chosen symbology doesn’t draw the
boundaries so they don’t appear on the map. If you want to remove the boundaries (say, to create a
single polygon for the East River—or “East Riv”), you must do a dissolve using the Name field.
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YOUR TURN
Open the NYC Waterfront Parks map, and merge the separate feature classes for each borough into one
feature class named NYCWaterfrontParks, with fill color green, to Chapter6.gdb. Save your project.
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Tutorial 6-4: Append firehouses and police stations to EMS facilities
City agencies might track facility locations in separate feature classes and tables, but an emergency services
official wants them in one feature class for better planning. You will use the Append tool to add features to an
already existing feature class, considering that both have the same attributes (or same schema). In this tutorial,
you will add firehouse and police station points to a feature class named EMS.

Open the Tutorial 6-4 project

1. Open Tutorial6-4.aprx from the Chapter6\Tutorials folder, and save the project as Tutorial6-
4YourName.aprx. The map contains emergency medical service (EMS) facilities.

2. Zoom to the EMS Facilities layer.
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Append features
Here, you will use the Append tool to append firehouses and police stations to already existing EMS points
(EMSFacilities). Each layer has the same table (field) structure.

1. Open the EMSFacilities attribute table. You will see 34 emergency medical facilities.

2. Close the table.

3. On the Analysis tab, in the Tools group under Manage Data, click the Append button .

4. In the Geoprocessing pane, for Input Datasets, browse to Chapter 6.gdb, and add FireHouses and
PoliceStations.

5. For Target Dataset, click EMSFacilities.
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6. Run the tool, and close it after it finishes.

7. Zoom to the EMS Facilities layer, open the EMSFacilities attribute table, and scroll to see the added
fire-houses and police stations.

8. Save your project.

218



219



 

Tutorial 6-5: Intersect features to determine streets in fire company zones
New York City fire companies include engine, ladder, rescue, and squad companies, each tasked with different
roles. For example, engine companies secure water from a fire hydrant, and then extinguish a fire. Ladder
companies are tasked with search and rescue, forcible entry, and ventilation at the scene of a fire. Rescue and
squad companies are highly trained and deal with incidents that are beyond the duties of standard engine or
ladder companies. Squad companies are also highly trained in mitigating as needed hazardous materials that
cover all of Manhattan.

For response planning, each fire company must know the total length of streets they cover by the type of
company (engine or ladder). To summarize streets for each company, streets must have the name and type of
their fire company. The Intersect tool achieves this summary by creating a new feature class combining all the
features and attributes of two input (and overlaying) feature classes—fire companies and streets. The Intersect
tool excludes any parts of two or more input layers that do not overlay each other. Because fire companies have
the same number in different fire battalions, a field that includes both the battalion number and fire company
is used in the calculations.

After streets are intersected, they can be summed by fire company type to determine how many streets are
served by engine, ladder, or squad companies in Manhattan.

Open the Tutorial 6-5 project

1. Open Tutorial6-5.aprx from the Chapter6\Tutorials folder, and save the project as Tutorial6-
5YourName.aprx. The map contains New York City fire companies (polygons) and Manhattan
streets (lines). Fire companies are classified by company type. ManhattanStreets are turned off.

2. Zoom to the ManhattanFireCompanies layer.
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Open tables to study attributes before intersecting
Studying the attribute tables of each feature class will help you become familiar with the attributes before you
intersect features.

1. Open the ManhattanStreets attribute table, and scroll to the right. You will find no data about fire
companies in the ManhattanStreets feature class, but you will find information about street
characteristics, such as the shape (polyline) and length of each street segment.

2. Open the ManhattanFireCompanies attribute table, and sort by FireCoNum (fire company
number). Scroll to examine the attributes and data of this table. Fields of interest are the shape
(polygon) and FireBN_Co_Type, a field that combines fire battalion, company number, and fire
company type fields—for example, ladder company (L), engine company (E), or fire squad (Q) are
fire company types.
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3. Close the attribute tables.

Intersect features

1. On the Analysis tab, click the Intersect button .

2. In the Geoprocessing pane, make or change parameters as shown, saving the output features as
ManhattanFireCompanyStreets to Chapter6.gdb.

3. Click Run, and close the tool when it finishes.

4. Turn ManhattanFireCompanies off.

5. Using the Central Park bookmark, click any of the line features of ManhattanFireCompanyStreets,
and scroll to the bottom of the pop-up window. The result will be street centerlines that include data
about the fire companies serving each street.
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Summarize street length for fire companies
Now that each street segment has fire battalion/company/type information, this information can be
summarized so that emergency planners and fire officials know the total length of streets that each company
and fire type serves.

1. Open the ManhattanFireCompanyStreets attribute table, and right-click FireBN_Co_Type.

2. Click Summarize, and type or make selections as shown.
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3. Save the Output Table as FireCompanyTypeStreetLength.

4. Run the tool, and close it after it finishes.

5. Close the ManhattanFireCompanyStreets table.

6. Open the FireCompanyTypeStreetLength table. You will see the sum (total length) of street
segments for each fire company and type.

YOUR TURN
Join the FireCompanyTypeStreetsLength table to the ManhattanFireCompanyStreets attribute table,
open, and sort descending on the field SUM_Street_Length. Select the record (fire company type) with
the largest amount of street length. Select the next few records to see the location of these fire
companies. Close the table, clear your selection, and save your project.
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Tutorial 6-6: Union neighborhoods and land-use features
The Union tool overlays the geometry and attributes of two input polygon layers to generate a new output
polygon layer. In this tutorial, you will use the Union tool to combine New York City’s Brooklyn borough
neighborhoods and land-use polygon to calculate the total land area of each type by neighborhood. The
output of a union is a new feature layer of smaller polygons, each with combined boundaries and attributes of
both neighborhoods and land-use polygons. You can then use Add Geometry Attributes to calculate land-use
type (for example, residential) in each neighborhood. Such information would be useful for an urban planner
or sustainability director who is interested in learning about house and land-use development in
neighborhoods.

Open the Tutorial 6-6 project

1. Open Tutorial6-6.aprx from the Chapter6\Tutorials folder, and save the project as Tutorial6-
6YourName.aprx. The map contains Brooklyn neighborhood polygons and land use with zoning
types.

2. Use the Brooklyn Zoomed bookmark. The features clearly do not share the same boundary, and you
will see neighborhoods with mixed zoning types.
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Open tables to study attributes
Studying the attribute tables of each feature class will help you become familiar with the attributes before you
use the Union tool. There are 51 neighborhood polygons and 1,295 land-use polygons.

1. Open the BrooklynNeighborhoods attribute table. The table contains no data about land use in the
feature class, but it does contain data about population and housing units in each neighborhood.

2. Open the BrooklynLandUse attribute table. Fields of interest are the land use for each polygon. Both
tables include the length and area for every polygon.

3. Close the attribute tables.

Union features

1. On the Analysis tab, in the Tools group, click the Union button .

2. In the Geoprocessing pane, complete the selections as shown.
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3. Run the tool, and close it after it finishes. The result is a new layer of smaller polygons with combined
neighborhood and land-use data.

4. Turn off the original BrooklynNeighborhood and BrooklynLandUse layers.

5. Click one of the new polygons, and see the values for neighborhoods and land use.

Calculate acreage
A field for the area (acres) of each polygon created by the union is needed before the land use can be
summarized for neighborhoods.

1. On the Analysis tab, click the Tools button, and search for Add Geometry Attributes.

2. Fill out the form as shown, click Run, and close the tool when it finishes.
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3. Open the attribute table for BrooklynNeighborhoodsLandUse_Union, and scroll to the right.

4. Sort Descending by Poly_Area. The top few polygons are parks followed by residential areas.

Select and summarize residential land-use areas for neighborhoods

1. In the Contents pane, right-click BrooklynNeighborhoodsLandUse_Union, and click Properties.

2. Click Definition Query, and create the query: Landuse2 is Equal to Residential.

3. In the attribute table, right-click NTAName, and click Summarize.

4. Fill out the form as shown, click Run, and close the tool when it finishes.

5. Open the BrooklynNeighborhoodsResidentialLandUse table, and sort descending by
Sum_Poly_Area.
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The list will show neighborhood names with the highest to lowest residential land use.

6. Using the NTAName field, join the BrooklynNeighborhoodsResidentialLandUse table to
BrooklynNeighborhoods.

7. Open the table, and sort descending by H_Units. A planner can now compare the neighborhoods
with the highest number of housing units and the number of residential acres.

8. Close the attribute tables, and save your project.

YOUR TURN
Open the Queens Neighborhood Land Use Study, and repeat the processes to summarize residential
land use in the borough of Queens.
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Tutorial 6-7: Use the Tabulate Intersection tool
Previous tutorials in this chapter used the Intersect and Union tools to create new feature classes with
combined features and data. With these tools, the data (for example, number of housing units or population)
is not apportioned (split into parts and allocated) to the new features. For example, if a single neighborhood
crosses more than one land-use zone or more than one fire company, the neighborhood housing data should
be split between polygons.

In this tutorial, you use the Tabulate Intersection tool to estimate the number of disabled persons in fire
company boundaries using census tracts and fire company polygons. By default, this tool makes
apportionments proportional to the areas of split parts of polygons, such as block groups, assuming that the
populations of interest are uniformly distributed by area within polygons.

Open the Tutorial 6-7 project

1. Open Tutorial6-7.aprx from the Chapter6\Tutorials folder, and save the project as Tutorial6-
7YourName.aprx. The map contains Manhattan census tracts classified with the number of disabled
persons (all disabilities) and Manhattan fire companies.

2. Zoom in, and turn the ManhattanFireCompanies layer on and off to see tracts compared to the
borders of fire companies. Tracts and fire companies clearly do not share exact borders as seen in the
graphic.
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Study tracts and fire company polygons
This exercise uses a small study area composed of four fire companies and 20 census tracts in the Upper West
Side to better see the workings of the Tabulate Intersection tool.

1. Close the Disabled Person Fire Company Study (Manhattan) map, and open the Disabled Person
Fire Company Study (Upper West Side) map. Map labels include Fire Companies 22, 25 (ladder),
74, and 76 (engine). Tracts are labeled with tract IDs (white halo) and the number of disabled
persons per tract (yellow halo).

2. Zoom to Fire Company 76. Five tracts (selected in the figure) intersect this fire company polygon.
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Two tracts (019300 and 018900) are completely within the polygon, and their populations will be
entirely in the fire company. Two tracts (019500 and 019100) are within the polygon but extend into
the river, and one (018700) is split between Fire Companies 76 and 22. That tract’s disabled person
population (880) should be split approximately 50/50, with 440 persons residing in Fire Company 76
and 440 persons residing in Fire Company 22.

YOUR TURN
Study additional tracts in the other fire company polygons, and identify tracts that are split between the
fire company polygons.

Use Tabulate Intersection to apportion the population of disabled persons to
fire companies

1. On the Analysis tab, click the Tools button, and in the Geoprocessing pane, search for and open the
Tabulate Intersection tool.

2. Type or make selections as shown, saving the output features to Chapter6.gdb.
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3. Run the tool, and close it after it finishes. Disregard any warning about tolerance settings.

4. Open the DisabledPersonsPerFireCompany table, and for field TractID, choose Sort Ascending.

5. Scroll to and select tract 018700. The population of disabled persons in the tract is indeed split 50/50
between Fire Companies 22 and 76, each with 236 persons. Note that Census tract 019300
(completely within Fire Company 76) has a total population of 1,620 disabled persons.

YOUR TURN
Use Summary Statistics and these settings to calculate the total number of disabled persons in each fire
company. Save your project.
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Assignments
This chapter has three assignments to complete that you can download from this book’s resource web page,
esri.com/gist1arcgispro:

Assignment 6-1: Build a study area for a rapidly growing Texas metropolitan area.
Assignment 6-2: Use geoprocessing tools to study neighborhoods.
Assignment 6-3: Dissolve property parcels to create a zoning map.
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CHAPTER 7

Digitizing
LEARNING GOALS

Edit, create, and delete polygon features.
Extract features from other map layers using the study area.
Create and digitize point and line features.
Use cartography tools to smooth features.
Work with CAD drawings.
Spatially adjust features.

Introduction
This chapter teaches you how to create new vector (point, line, and polygon) map layers using “heads-up”
digitizing by using basemaps on the computer screen. First, you will create a new feature class including table
attributes. Then you will use an existing map layer, such as streets, as a guide or spatial data reference for
locations. Finally, you will use digitizing tools with the pointer on your screen to create new features and enter
corresponding attribute data. Technologies such as lidar and satellite imagery are also references for heads-up
digitizing. You will learn more about lidar data in chapter 11.

You can also use GPS receivers, which collect longitude and latitude data to create new vector features.
Also, computer-aided design (CAD) and building information modeling (BIM) can be imported into GIS
maps to create new feature classes.

In this chapter, you will edit existing features and create new features for a rapidly expanding university
campus, Carnegie Mellon University (CMU), in Pittsburgh, Pennsylvania. New buildings, additions, and
renovations to existing buildings are part of a campus master plan. Changes also include new or modified
streets, sidewalks, parking lots, and so on. Architects, engineers, and planners need updated GIS features for
the campus, and tutorials in this chapter teach the skills to create and edit them.
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Tutorial 7-1: Edit polygon features
In this tutorial, you will move and rotate existing buildings in a map layer. Then you will add vertex points
and split polygons to further edit them to match buildings in a World Imagery basemap. Note that imagery
maps may change over time so the images may be slightly different from those in the tutorial. The user
interface also may look slightly different from the figures you see in this chapter.

Open the Tutorial 7-1 project

1. Open Tutorial7-1.aprx from the Chapter7\Tutorials folder, and save the project as Tutorial7-
1YourName.aprx. Tutorial7-1 contains a map of CMU’s main campus with buildings as
semitransparent features on the World Imagery basemap. A clean copy of CMU’s building features
named BldgsOriginal is located in Chapter7.gdb should you wish to repeat the steps of this tutorial.

2. Use the Main Campus bookmark to zoom to CMU’s main campus and academic buildings.

Move features
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A few buildings on the campus are not in their correct locations and can be moved into exact locations using
World Imagery as a reference.

1. Use the Cohon University Center bookmark and Select button  to select the Cohon University
Center building polygon. By default, a construction toolbar appears in the active map or when you
right-click on the map.

2. On the Edit tab, click the Move button . A yellow dot appears in the center of the polygon
indicating that the polygon is ready to edit.

3. Drag the building polygon to match the building outline in the image.

4. Click anywhere outside the polygon. Continue to drag until the polygon is in the correct location.
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5. On the Edit tab, click the Save button , and in the Save Edits pop-up window, click Yes to save
your edits. Saving edits to features differs from saving ArcGIS Pro projects. If you do not want to
save changes, click the Discard button.

6. Close the Modify Features pane when finished.

YOUR TURN
Use the College of Fine Arts bookmark, and move the building polygon to its correct location. You will
later add and move vertex points to create the U-shaped building. Pan the main campus map to find
other buildings to move to the correct location. Save your edits and project.

Rotate features
Features may be in the correct location but must be rotated. This requirement applies to CMU’s Gates Center
for Computer Science.

1. Use the Gates bookmark, and select the Gates building polygon.

2. On the Edit tab, click the Move button . Selecting the Move button enables edits for move, rotate,
and scale.

3. In the Modify Features pane, click the Rotate button . A yellow dot and green circle appear in the
center of the building, indicating that the polygon is ready for editing.

4. Move the pointer to the green circle, and then click and move and rotate the highlighted outline to
match the approximate location of the building outline in the satellite image. The building might not
align perfectly with the satellite image. You will later learn how to edit vertex points that could fix an
imperfect alignment.
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5. Click anywhere outside the polygon, click the Save button, click Save Edits, and close the Modify
Features pane.

Add and move vertex points
Features are sometimes represented as simplified squares, rectangles, or circles, but vertex points can be added
and modified to reflect the true building shape. The College of Fine Arts building was drawn as a rectangle,
but the building actually has a U-shaped roof. Adding and editing vertex points will fix this problem.

1. Use the College of Fine Arts bookmark, and pan the map to see the entire building.

2. Select the College of Fine Arts building, click the Edit tab, and click the Vertices button . Four
vertex points will appear at the corners of the polygon. You must add four more vertices to make the
U shape.

3. On the Construction toolbar, click the Add button , and click four points on the left (western) line
of the College of Fine Arts building to add four vertex points as shown.
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4. Click the Normal button  and the second of the new vertex points.

5. Drag the vertex point to the inside corner of the building as shown in the figure.

6. Click and drag the third vertex point, making a U shape.

7. Drag the vertex points to the corner of the building, making a U shape.
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8. Click the Finish button .

9. Save your edits, and close the Modify Features pane when you finish.

Split features
Two buildings on the campus are drawn as one polygon because they are connected. However, university
architects and facility planners must identify the buildings as separate polygons, each with a separate record in
the attribute table. The Split tool will accomplish this task.

1. Use the Baker Porter bookmark, and select the building polygon for these buildings. Baker Hall is the
easternmost section of the building, and Porter Hall connects at the western end of the third wing as
seen in the image (on the left). This location where buildings connect is where you will split the
polygon.

2. On the Edit tab, click the Split button .

3. Zoom in, and click on the north side of the small indented areas between Baker and Porter Halls, and
double-click on the south side as shown in the figure. Be sure to click and double-click outside the
border of the building. This action splits the building into two polygons at this location.
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4. Save your edits, and close the Modify Features pane when you finish.

5. Select the new polygon for Baker Hall, and in the Contents pane, open the Bldgs attribute table.

6. Click the Show selected records button.

7. In the attribute table, type 2A for Number, BH for BL_ID, and Baker for Name.

8. Select the Porter Hall polygon, and for its fields, type 2B for Number, PH for BL_ID, and Porter for
Name.

9. In the attribute table, click Clear to clear the selected records.

10. Close the attribute table, and use the Baker Porter bookmark. Two separate buildings are now
labeled for Baker and Porter Halls.

YOUR TURN
Use the Hamerschlag Roberts bookmark to select and split one polygon into two separate buildings. The
rectangular building with two triangles on the left (west) is Roberts Hall, and the building on the right is
Hamerschlag. Edit the Roberts Hall polygon using 23 as the building number, REH as the BL_ID, and
Roberts Engineering Hall as the name. Use the Move and Vertices tools to better match the building
polygons to the World Imagery basemap. Save your edits and your project.
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Tutorial 7-2: Create and delete polygon features
Changes to the CMU campus include a new addition to the Cohon University Center, a new building for the
College of Engineering (Scott Hall), a new quadrangle for the Tepper School of Business (Tepper Quad), and
a new addition to Heinz College, which is Hamburg Hall. A new feature class will highlight these
development areas for communication with the campus community and the university’s neighbors.

Open the Tutorial 7-2 project

1. Open Tutorial7-2.aprx from the Chapter7\Tutorials folder, and save the project as Tutorial7-
2YourName.aprx. The tutorial contains a map of CMU’s main campus and existing buildings.

2. Use the Cohon University Center bookmark, and zoom out twice.

Create a new polygon feature class, and add a field
You can create new feature classes directly in ArcGIS Pro’s Catalog pane and add new attributes using the
attribute table.

1. Open the Catalog pane, and navigate to Chapter7.gdb.

2. Right-click Chapter7.gdb, and click New > Feature Class.

3. For Feature Class Name, type BldgsProposed, and for Geometry Type, click Polygon.

4. Under Coordinate System, click Bldgs.

5. Click Environments, and under Output Coordinate System, click Bldgs.
NAD_1983_StatePlane_Pennsylvania_South_FIPS_3702_Feet will be selected as the coordinate
system.

6. Run the tool, and after it finishes, close the Geoprocessing and Catalog panes. The new
BldgsProposed feature class has been created in the file geodatabase, and a corresponding layer has
been added to the map. The feature class is empty now. Later, as you digitize features, polygons will
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be added to the feature class and become visible on the map.

7. Open the BldgsProposed attribute table, add a field named BLDGNAME, select Text for Data
Type, and type 75 for Length.

8. Save your edits, and close the BldgsProposed table and Fields view. Now your new polygon feature
class is ready for digitizing.

Add a feature class, and create new polygons
Before you start adding features, you’ll change the style for the layer’s symbol.

1. In the Contents pane, change the color of the BldgsProposed layer to Tuscan Red with a White
outline.

2. On the Edit tab, click the Create Features button .

3. In the Create Features pane, click BldgsProposed and the Polygon button.

4. On the Configure toolbar, click the Line button , and drag to draw a rectangle similar
to the figure. Double-click the last vertex point to finish the polygon. If the imagery map has an
updated building footprint, use that as a guide to digitize the building.
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5. Save your edits, and clear the selected polygon.

YOUR TURN
Use the Hamerschlag Roberts bookmark, zoom out a few times, and draw a rectangle to the north of
Roberts Engineering Hall. Use the Tepper Quad bookmark to create a new polygon using the existing
parking lot or building footprint as a guide. Use the Hamburg Hall bookmark, and create a new polygon
between Hamburg and Smith Halls as shown in the figure. Save your edits, and use the main campus
bookmark to see the proposed developments. In the attribute table, enter building names Cohon
Addition, Scott Hall, Tepper Quad, and Hamburg Addition so that they coincide with the names
shown in the figure. Show labels using the building name and a yellow halo. Save your project.

Delete polygons
New development often includes the demolition of existing buildings. As part of the university’s Forbes
Avenue Innovation Corridor, four buildings will be demolished and must be deleted from the GIS buildings
layer.

1. Use the Arts Park bookmark to zoom to this area of Forbes Avenue on CMU’s campus.

2. Select one of the two buildings on the right (east) of the Integrated Innovation Institute, and on the
Edit tab, click the Delete button . You can also right-click after selecting a building, and click
Delete and use the Shift key to select multiple buildings to delete.

3. Repeat step 2 to select and then delete the other building on the right of the Integrated Innovation
Institute building and the buildings on the right (east) of the 4615 Forbes (GATF) building.
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4. Save your edits, and close the Create Features pane.

Create a study area polygon feature
Campus architects and campus planners want to know the square footage of a study area of the main campus
where most of the academic buildings are located. Planners identify five streets (Forbes, Boundary, Schenley,
Tech, and Margaret Morrison) that are used to create the study area. The Trace tool will quickly create a
polygon using these streets as guides.

1. Open the Catalog pane, and expand Databases and Chapter7.gdb.

2. Right-click Chapter7.gdb, and click New Feature Class.

3. Type StudyArea for Feature Class Name, and use Polygon for Geometry Type.

4. For Coordinate System, click Bldgs.

5. In Environments > Output Coordinate System, click Bldgs.

6. Run the tool, and close it and the Catalog pane after the tool finishes.

7. Change the symbology of the StudyArea layer to 50 percent transparency.

Use the Trace tool to create a polygon feature

1. Use the Main Campus bookmark, and turn off the BldgsProposed and Bldgs layers.

2. On the Edit tab, click the Create button .

3. On the Edit tab, click the Snapping button .

4. In the Create Features pane, click the StudyArea layer and the Trace button .
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5. Click the intersection of Boundary St and Forbes Ave, drag the pointer south along Boundary St,
then east on Schenley Dr, north and east on Frew St, north and east on Tech St, northeast on
Margaret Morrison St, and then northwest on Forbes.

6. Double-click on Boundary Street as you near the original point at the intersection of Boundary and
Forbes Streets. The new study area polygon will match the existing street centerlines exactly.

7. Save your edits, and close the Create Features pane.

YOUR TURN
In the Contents pane, open the StudyArea table, and note the Shape_Length and Shape_Area values,
which are in feet.

Calculate campus acreage
It’s useful for campus architects and planners to know the acreage of the campus, and this can be automatically
calculated.

1. On the Analysis tab, click the Tools button and search for Add Geometry Attributes.

2. Fill out the form as follows, and select Bldgs as the Coordinate System.
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3. Run the tool, and close it after it finishes.

4. Open the StudyArea attribute table to see the new calculated POLY_AREA field. The value should
be about 72 acres.

5. Use Fields View to change the field alias name to ACRES.

6. Save your project.
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Tutorial 7-3: Create and digitize point and line features
Point and line features can represent public transportation and pathways on CMU’s campus. In this tutorial,
you create new feature classes for bus stops (points) and directional paths (polylines). You then digitize points
and lines for the bus stops and pathways to two commonly visited buildings on campus, Warner Hall (where
the admissions office is located) and the Purnell Center (location of the School of Drama performances).

Open the Tutorial 7-3 project

1. Open Tutorial7-3.aprx from the Chapter7\Tutorials folder, and save the project as Tutorial7-
3YourName.aprx. The tutorial contains a map of the campus with streets labeled, buildings turned
off, and a light-gray canvas basemap. Also included in the Contents pane is a crosswalk table of bus
stop IDs, stop names, and stop routes.

2. Use the Bus Stops bookmark.

Create a new feature class and attributes in its table

1. Open the Catalog pane, and navigate to Chapter7.gdb.

2. Right-click Chapter7.gdb, and click New > Feature Class.

3. For Feature Class name, type BusStops, and for Geometry Type, select Point.

4. For Coordinate System, click Bldgs.

5. Click Environments, and for Output Coordinate System, click Bldgs.

6. Click Run, and close the tool when it finishes.

7. Open the BusStops attribute table, and create a field named Stop_ID, with Text for Data Type and 5
for Length.
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8. Close the attribute table. A new point feature class is in the file geodatabase and is ready for
digitizing. You will use Stop_ID to join a crosswalk table that contains bus routes associated with
each bus stop.

YOUR TURN
Create a polyline feature class in Chapter7.gdb named Paths whose coordinate system is
NAD_1983_StatePlane_Pennsylvania_South_FIPS_3702_Feet. Create a field named PathName, with
Text for Data Type and 25 for Length. Close the table.

Digitize points

1. Add the new point feature class BusStops, and rename the map layer CMU Bus Stops.

2. Change the symbol to Bus Station, color to Ultra Blue, and size 18.

3. On the Edit tab, click Create Features button .

4. In the Create Features pane, click CMU Bus Stops and the Point button.

5. Working west to east, click points on the map to digitize the following bus stops at the approximate
locations in the order as labeled in the figure.
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6. Close the Create Features pane.

7. Open the attribute table, and type the Stop_ID values as 01, 02, 03, and so on, to match the labels on
the map. This field is used to join the crosswalk table with bus routes associated with each stop. You
will label the map in Your Turn.

8. Save your edits.

YOUR TURN
Join the BusStopCrosswalk table to BusStops using the Stop_ID fields. If you have trouble joining, save
your project, exit Pro, and open the project again. In the map, click bus stop 09 at the intersection of
Forbes and Morewood Avenues to see the stop name and route. Close the Create Features pane and
attribute tables, and clear selections. Label the map using the stop name.

Digitize pathways
Street centerline and sidewalk/curb layers don’t provide internal campus paths to direct visitors from bus stops
or a parking garage. In this exercise, you will digitize paths to commonly visited buildings on CMU’s campus.

1. Add Paths from Chapter7.gdb, and change its symbology to Mars red, 2 pt.

2. Change the basemap to Imagery, and use the Paths bookmark.

3. On the Edit tab, click the Create Features button .

4. In the Create Features pane, click Paths and the Line button.

5. Using the imagery basemap as reference, click a starting point at bus stop 10, Forbes Ave Opp
Morewood (Carnegie Mellon), click points along the path as shown in the image, and double-click to
end the path at the entrance of Warner Hall.
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6. Open the Paths attribute table, and type Bus to Warner Hall under PathName.

7. Digitize the path from CMU’s parking garage to Warner Hall, and type Garage to Warner Hall for
the path name in the attribute table.

8. Save your edits, clear the selection, and label the paths using a font size 12, bold font, and blue halo.

YOUR TURN
Digitize the paths from the bus stop and garage to the Purnell Center building, and enter path names.
Close the Edit and attribute tables, and clear selections. Change the symbology of the legend to unique
values, using bright red for the Warner Hall paths and bright yellow for the Purnell Center paths. Save
your project.
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Tutorial 7-4: Use cartography tools
In addition to edit tools, GIS features can be modified using cartography tools. A useful tool to improve the
aesthetic or cartographic quality of polygons is the Smooth Polygon tool. Organizations such as the US
Census Bureau sometimes digitize lines and polygons at a small scale. The features are digitized with just a
few line segments and don’t match the true geography. Smoothing features can fix this problem.

Open the Tutorial 7-4 project

1. Open Tutorial7-4.aprx from the Chapter7\Tutorials folder, and save the project as Tutorial7-
4YourName.aprx.

2. Use the Flagstaff Hill & Panther Hollow Lake bookmark. This tutorial contains a map with
semitransparent polygon features, a park adjacent to the university’s campus, a golf course next to
campus, and a lake south of campus. The map is zoomed to the park and lake.

Smooth a green space polygon
Flagstaff Hill is part of Pittsburgh’s Schenley Park between Carnegie Mellon University’s campus and Phipps
Conservatory. The Flagstaff Hill polygon was roughly drawn with just a few line segments and can be
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smoothed.

1. On the Analysis tab, click the Tools button.

2. In the Geoprocessing pane, click Toolboxes, and expand Cartography Tools > Generalization, and
click Smooth Polygon.

3. Type or make selections as shown, saving the output feature class to Chapter7.gdb.

4. Run the tool, and close it after it finishes.

5. Turn off the Greenspaces layer. The result is a new feature class of smoothed polygons for Flagstaff
Hill and the polygons for Schenley Golf Course.

6. Use the Schenley Golf Course bookmark to see the new smoothed polygons for the golf course.

YOUR TURN
Use the Smooth Polygon tool to smooth the water feature of Panther Hollow Lake. Save the new
features as WaterSmoothed to Chapter7.gdb. Save your project.
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Tutorial 7-5: Transform features
Administrators, architects, and facility planners often combine GIS map layers and CAD drawings of separate
buildings for strategic planning, including understanding the occupancy and use of every space on campus.
CAD drawings, however, use Cartesian coordinates and are not geographically referenced to GCS, state
plane, or UTM coordinates. CAD drawing units are also different from GIS units. For example, the leading
CAD software, AutoCAD, uses one inch or one millimeter as the unit, and GIS maps generally use feet or
meters as the unit. Transforming features in GIS makes aligning CAD drawings to GIS maps easy, regardless
of drawing or map coordinates and units.

Open the Tutorial 7-5 project

1. Open Tutorial7-5.aprx from the Chapter7\Tutorials folder, and save the project as Tutorial7-
5YourName.aprx.

2. Use the Study Area Buildings bookmark. Tutorial7-5 contains a map of CMU’s campus and the
Oakland neighborhood to the north of campus. Academic buildings for the main part of campus are
included and used to transform CAD drawings.

Add and export a CAD drawing
Next, you will add an AutoCAD drawing that includes polygons for every space on the first floor of
CMU’s Hamburg Hall academic building.

1. Click Add Data, navigate to Chapter7 > Data, double-click HBH1.dwg, click Polygon, and click
OK.

2. Zoom to the HBH1-Polygon Group layer. The drawing unit is one inch, and the drawing will appear
as 12 times its actual size.
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3. In the Contents pane, click the arrow next to HBH1-Polygon Group to expand the layers. CAD
drawings contain layers in one drawing and are color-coded according to the layer color assigned in
the CAD drawing. You cannot edit CAD drawings directly, so you will export the drawing to an
ArcGIS shapefile.

4. In the Contents pane, right-click layer HBH1-Polygon, and click Data > Export Features.

5. In the Geoprocessing pane, for Output Feature Class, type HBH1SpacePlan, which you will save to
Chapter7.gdb.

6. Run the tool, and close it after it finishes. HBH1SpacePlan is automatically added to the map in the
same location as the original CAD drawing. The new layer is used for transformation to its actual
location on the campus map.

7. Remove the HBH1-Polygon Group layer.
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Explore attributes, and classify layers
Before transforming the drawing to the GIS coordinates, you will explore the attributes of the exported CAD
drawing and classify spaces based on their layer assignment.

1. Open the HBH1SpacePlan attribute table. The results of exporting a CAD drawing are that
properties of the drawing are added as fields in the attribute table. The Layer field shows designations
of space use. Every polyline in AutoCAD became a polygon in the new feature class, and the layer on
which the CAD polyline resided became the layer designation (for example, Office, Hallway,
Classroom, and so on).

2. Close the attribute table, and in the Contents pane, right-click HBH1SpacePlan, and click
Symbology.

3. In the Geoprocessing pane, use Import symbology, and click SpacePlan.lyrx from Chapter7\Data\
for Symbology Layer.
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4. Run the tool, and after it finishes, close it and the Symbology pane.

5. In the Contents pane, turn off the World Light Gray Canvas and Streets layers.

6. Zoom and pan the map to see the HBH1SpacePlan and study area buildings.

Rotate a building
The features are now ready for transformation into the GIS units for the map. First, you will rotate the
Hamburg Hall building 180 degrees.

1. In the Contents pane, right-click HBH1SpacePlan > Selection, and click Select All.

2. On the Edit tab, click Tools, and in the lower-right corner of the Tools group, click More Tools.

3. In the Modify Features pane, click the Rotate button .

4. Drag the green circle to rotate the building approximately 180 degrees.

5. Pan the map if necessary to see the entire building.
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6. Move the polygons closer to the study area buildings.

7. Save your edits, and zoom in to see your modified building and study area buildings. Hamburg Hall is
the second building from the top left.

Transform polygons
Next, you will transform the building using eight links that align the floor-plan polygons to the building in
the GIS map.

1. In the Contents pane, right-click HBH1SpacePlan > Selection > Select All.

2. In the Modify Features pane, click the Transform button .

3. In the Modify Features pane, click Similarity for Transformation Method, and click the Add New
Links button.
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4. Click the lower-left corner of the HBH1SpacePlan layer and the corresponding lower-left corner of
the Hamburg Hall building in the campus map.

5. Continue adding links as shown in the figure.

6. In the Modify Features pane, click the Transform button.

7. Wait while the polygons are scaled and moved to the geometry on the map.

8. Save your edits, close the Modify Features pane, and clear selected features.

9. Zoom to the HBH1SpacePlan layer to better see the transformed polygons on the map.
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10. Save your project.

Assignments
This chapter has two assignments to complete that you can download from this book’s resource web page,
esri.com/gist1arcgispro:

Assignment 7-1: Conduct a campus storm water runoff project.
Assignment 7-2: Digitize police beats.
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CHAPTER 8

Geocoding
LEARNING GOALS

Get an overview of the geocoding process.
Geocode using ZIP Codes.
Geocode addresses using streets.
Use alias tables for place-name geocoding.

Introduction
Although much available data is already geocoded, in many situations you will find data in a table that you
want to plot on a map. One example is the survey data from this chapter that lists street addresses, ZIP
Codes, and the home states of the people surveyed. Using these location attributes, you can map (geocode)
their locations. Another example is transaction data collected by organizations (and perhaps you are working
for such an organization). Because transactions, such as delivery of an appliance, often occur at a location, it’s
useful to map these locations to analyze the market served. Another example for transactions is surgery
patients in a hospital. In this case, it’s useful to map the residences of patients to identify the service area of
the hospital.

A geocode is data that identifies a unique location—a point, line, or polygon—on planet Earth. For
example, the geocode 4800 Forbes Ave, Pittsburgh, PA 15213, identifies a unique point. The ZIP Code,
15213, is also a geocode identifying a unique polygon, and Pittsburgh, PA, is a geocode identifying a unique
county subdivision polygon. If you have such source data, you can use ArcGIS Pro’s geocoding algorithm to
map corresponding points by matching to reference data. Reference data is a feature class with existing
locations—for example, street centerlines with street address attributes or ZIP Code polygons with a ZIP
Code attribute.

The source data that you will geocode in the beginning of this chapter is from a survey that includes
residence addresses of attendees taken by an arts organization for its annual art show. The arts organization
wants to analyze locations of attendees to better target future marketing efforts. You’ll first geocode by ZIP
Code only and then by street address.

The problem with geocoding is that source data suppliers (for example, survey respondents for the survey
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data) and data entry workers can write or type anything they want, including misspellings, abbreviations,
omissions, and place-names such as “University of Pittsburgh” instead of an address. Organizations new to
GIS often have typed addresses with notes included in address fields such as “333 W Pine Ave, watch out for
vicious dog” that make geocoding a challenge. Consequently, exact matching of source to reference data is not
possible. Instead, you must use “fuzzy matching” (a kind of matching used in computer science to make
matches that are approximate instead of 100 percent accurate). For example, the address “123 Fleet St” may
be on a street map, and a data entry worker may have typed “123 Fleat” for source data, with a misspelling and
without the “St.” A fuzzy-matching algorithm might determine that address is close enough to the correct
address and plot the residence at 123 Fleet St.

A rule-based expert software system can make fuzzy matches; ArcGIS Pro’s geocoding software is such a
system. The system attempts to use the thought processes and rules that an expert would use to accomplish a
complex and ambiguous task. In this case, the expert system attempts to mimic what a resourceful mail
delivery person would do, using their expert knowledge to get a badly addressed piece of mail to the right
address. These expert system components are used in ArcGIS Pro’s geocoding:

Source table, with attributes of locations including geocodes (in this chapter, street addresses and ZIP
Codes) to be mapped.
Reference data, which has mapped features such as street centerlines or ZIP Code polygons and
attributes such as street names that can be matched (fuzzily) to the source table’s geocodes.
Geocoding tool, with the algorithms, rules, and user interface to perform geocoding.
Locator, a reusable set of three or more files that include all parameter values of the tool that performs
geocoding for a given kind of source data.

To account for spelling errors, an algorithm computes a Soundex key, which is a code assigned to names
that sound alike (for example, “Fleet” and “Fleat” both have Soundex key F43), and identifies candidate
matches on the basis of matching source and reference street addresses. (Look up “Soundex key” in your web
search engine.) The algorithm starts with a score of 100 for each case and subtracts penalty points for each
problem encountered. If the end score is greater than the threshold set as a parameter by default or by the
user, a reference location is a candidate for matching. The candidate with the maximum score is chosen as the
estimated location. If there is a tie, one of the tying locations is arbitrarily assigned as the match unless the
user chooses to not accept ties (50 percent of which are incorrect).

You can geocode with any number of data types. For this chapter, you will geocode using street centerlines
and ZIP Codes. People generally will disclose their ZIP Codes in surveys and get them right, so the results
are complete and accurate, albeit only at the ZIP Code level. You can download a US Census Bureau ZIP
Code map for the entire United States for geocoding nationwide. Often, a ZIP Code may be the only
available data type and will suffice for marketing purposes. Service, product delivery, and other location-based
needs require more precise locations. Street centerlines are sufficient for many purposes (but certainly not for
locating in-ground natural gas and other lines during construction digging). You can easily use geocoding
with ZIP Codes and street centerlines with free map layers downloaded from the Internet (see chapter 5).
However, cities and states perform many other kinds of geocoding, often more precisely, using land parcel
centroids with street addresses provided by many city governments. Note that Esri provides the highly
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accurate and current ArcGIS Online World Geocoding Service. If you are in a class, however, check with

your instructor before using this service, because using the service consumes credits that must be purchased.

Dual-range maps, available from the Census Bureau’s TIGER/Line data and from vendors, are widely
used for geocoding but are limited by only having house numbers on the left and right for the beginning and
end of each one-block-long street segment. Consequently, addresses within blocks are linearly interpolated
(for example, 150 Main St. is plotted halfway along the street segment with ranges 100 to 198 and 101 to
199) and are not exact locations.

Generally, not all source data records are matched when geocoding. A performance measure for geocoding
is the percentage of source addresses that get matched and plotted using the reference data. To compute
match rates, you should subtract all records in source data that are not addresses (records that are blank, do
not start with a house number, are not street intersections, and so on) from the total number of addresses in
the source data used as the denominator for the match rate.

Unfortunately, there is no way to judge if a match is truly correct. Organizations that critically depend on
geocoding (such as 911 emergency calls for services from police, fire, and ambulance responders) review
nonmatches and incorrect matches to improve their maps and procedures for obtaining correct source data
from callers. The sensitivity analysis in assignment 8-3 on the book resource web page offers some insight into
match accuracy. In that assignment, you loosen thresholds in matching rules (changeable through tool
parameters) until matched addresses added to previously matched addresses are identified clearly as errors. In
general, the default settings for locator files perform well in the sensitivity analysis.
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Tutorial 8-1: ZIP Code geocoding
In this tutorial, you will geocode survey data collected by a Pittsburgh arts organization that holds an event
each year attended from across the three-state region of Pennsylvania, Ohio, Maryland, and beyond. To save
space on your computer’s hard drive, these exercises will use only ZIP Code polygons from the three states
mentioned, plus West Virginia (the relevant region for Pittsburgh) instead of the entire country (which takes
0.5 GB of disk space for ZIP Codes).

Open the Tutorial 8-1 project

1. Open Tutorial8-1 from Chapter8\Tutorials, and save the project as Tutorial8-1YourName.

2. Use the Region bookmark. The AttendeesPARegion.csv table is the source data for geocoding,
PARegionZIPPoints (center points of ZIP Code polygons) is the reference data, and PARegionZIP
has corresponding ZIP Code polygons. AttendeesPARegion.csv has a numeric ZIPCode field, and
reference layer PARegionZIPPoints has text GeoID10. Some ZIP Codes of the region start with “0,”
which were not included in the source data’s numeric version, so the remedy was to calculate
ZIPCodeNum from GeoID10 in the reference data, which is a numeric field and drops leading zeros.
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Build a ZIP Code locator
Recall that a geocoding locator is a set of files that stores parameters and other data for the geocoding process.

1. Search for and open the Create Address Locator tool.

2. Complete the tool parameters as shown.
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3. Click Run, and when the tool is finished, close the Geoprocessing pane.

4. Open the Catalog pane, expand Locators, right-click PARegionZIP_CreateAddressLoc, click
Locator Properties, and click Geocoding options. For example, minimum match score was
mentioned in the introduction to this chapter. For each matching problem detected, the geocoding
algorithm subtracts penalty points from a starting score of 100. When the algorithm finishes scanning
for problems, if the score is 85 or larger, as set here by default, the minimum match score rule is
passed. You can change the minimum match score, minimum candidate score, and spelling sensitivity
threshold scores to adjust (tune) the fuzzy-matching process and make the process more conservative
or liberal. High values are conservative (fewer match errors allowed), and low values are liberal (more
match errors). Throughout the tutorials, you’ll leave the properties at their defaults as seen here. You
can change them in the sensitivity analysis of assignment 8-3 available on the book resource page.

5. Close the Address Locator Properties window, and hide the Catalog pane.

Geocode data by ZIP Code

1. Open the AttendeesPARegion.csv attribute table. The table has 1,123 survey responses, and if you
sort by ZIPCode and scroll down, you’ll see no records with missing ZIP Code values. Records with
missing ZIP Codes were deleted.

2. Close the table.

3. Right-click AttendeesPARegion.csv, and click Geocode Addresses.

4. In the Geoprocessing pane, complete the tool parameters as shown.

Important note: Do not select https://geocode.arcgis.com/arcgis/rest/services/World/GeocodeServer or any
other such URL for Input Address Locator unless you have permission from your instructor or employer.
The organizational account that you are using would be billed for using the geocoding service, and you
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might be billed!

5. Click Run. After the tool runs, the completed pop-up window shows that only three unmatched
records remain.

6. In the Completed pop-up, click No for start rematch process, and close the Geoprocessing tool when
the rematch process finishes.

7. Turn off PARegionZIPPoints, and symbolize Attendees with a red circle 3, size 5 pt. Each matched
source address is plotted at a ZIP Code centroid. Although only one point is visible per ZIP Code,
generally many points are on top of each other.

8. In the Contents pane, open the Attendees attribute table. For Status, use Sort Descending. Only
three of the 1,123 records are unmatched with Status, U (yielding a 99.7 percent match rate). The
three records have street addresses, cities, and states, so you can look up ZIP Codes at the US Post
Office website (search for ZIP Code lookup in your web browser). The first unmatched record has an
incorrect ZIP Code value in the survey, 15230. The value should be 15213. The other two records
have correct ZIP Code values, but the reference data, PARegionZip, does not have polygons for
those ZIP Codes. The US Census Bureau’s ZIP Code maps are approximations of US Postal routes,
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and likely the two missing ZIP Code polygons are the result of construction methods for estimating
ZIP Codes (you can search for “zip code maps us census” on the Internet to read about ZIP Code
construction methods).

9. Close the table.

Rematch attendee data by ZIP Code
The match rate, 99.7 percent, is extremely high and well above the threshold for any marketing
decisionmaking or other management purposes, so the Attendees map could be used without any changes.
But for practice, you’ll rematch and match to 100 percent. You’ll correct the ZIP Code in one record, and
then pick approximate points for the two ZIP Codes that are not in the reference data (in practice by looking
them up elsewhere).

1. In the Contents pane, right-click Attendees, and click Data > Rematch Addresses. The first
unmatched record comes up with the incorrect ZIP Code, 15230.

2. In the Rematch Addresses pane, for Complete ZIP Code, type 15213, and press Tab. The new ZIP
Code yields a candidate with a perfect score of 100.

3. Click the Match button . That record is matched and mapped.

4. Turn off PARegionZIP, change the Basemap to Streets, and zoom into the lower-left corner of
Pennsylvania and then into Pittsburgh. There is no problem if you cannot find the location indicated
on the map. Any location will do for the sake of learning how to pick a point from a map for
geocoding.

5. In the Rematch Addresses pane, click the Pick From Map button , and click the map
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approximately at the point directed by the arrow, as shown in the figure in step 4.

6. Click the Match button. The record is matched. If your map zooms out, zoom back in to the location
picked to see that the point was matched and is on the map.

7. Use the Region bookmark.

8. Similarly, match the remaining unmatched record to any location in the Scranton area in eastern
Pennsylvania. This work is just for practice, so it’s not important which point you pick.

9. Click the Save edits button , and in the pop-up window, click Yes.

10. Close the Rematch Addresses window, and save your project.

Symbolize using the Collect Events tool
Now you have attendees’ survey data geocoded to ZIP Code centroids, generally with many attendees at
center points of ZIP Codes. For symbolizing attendees, next you will count the number of attendees in each
ZIP Code and plot size-graduated symbols, with symbol size increasing as the number of attendees increases.
You could do this work manually in a couple of steps, but the Collect Events tool will do the job in one step.

1. Turn off Attendees, change the basemap back to Light Gray Canvas, and use the Region bookmark.

2. Search for and open the Collect Events tool.

3. Select Attendees for Input Incident Features, and leave the output name as the default value.

4. Run the tool, and close it after it finishes.

5. Zoom into the southwest corner of Pennsylvania where Pittsburgh is located. Although you could
change the symbology of the output to better portray the spatial distribution of attendees, Collect
Events has done the hard work of counting by ZIP Code and applying size-graduated symbols. Note:
If the Collect Events tool fails to run, save and close your project, saving all edits. Then reopen and
run the tool again.
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6. Save your project.
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Tutorial 8-2: Street address geocoding
This tutorial starts with the data from tutorial 8-1 but only includes records that have street addresses and are
in Allegheny County, which includes Pittsburgh. Allegheny County is the local market for the arts event, and
more detailed location data on attendees is desirable for marketing there. So you’ll geocode by street address to
place a unique point on the map for each attendee in the county. You’ll use the same workflow as with ZIP
Code matching: build a locator (but this time using street centerlines as the reference data), geocode the
source data of survey respondents, and rematch some of the unmatched records.

Open the Tutorial 8-2 project

1. Open Tutorial8-2, and save the project as Tutorial8-2YourName.

2. Use the Allegheny County bookmark. You are seeing 92,430 blocklong street segments on your map
in Allegheny County.

Build a street locator

1. Search for and open the Create Address Locator tool.

2. Complete the tool parameters as shown in the figure.

Note that the locator you are building is called “dual-range locator” because the address style is dual
ranges. The data records of this address style have the beginning and ending house number for both
sides of the street, both the even- and odd-numbered sides.

The tool automatically finds all but one of the essential fields needed for geocoding (indicated by
*) from the reference data. Select FullName for Street Name. Scroll down in the field map to see that
the tool found ZIPL and ZIPR, ZIP Codes on the left and right side of each street segment. Streets
on the borders of ZIP Codes have different ZIP Codes, hence the left and right ZIP Code fields.
Street names are unique in ZIP Codes and in cities. Allegheny County has many cities, and several of
these cities may have streets with the same street name and street numbers, such as a “100 Main
Street.” Including a ZIP Code in the matching process guarantees that you will find the correct Main
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Street and location.

3. Click Run, and when the tool is finished, close the Geoprocessing pane.

Geocode attendee data by street

1. Right-click AttendeesAlleghenyCounty.csv, and click Geocode Addresses.

2. Complete the tool parameters as shown.

3. Run the tool. A total of 861 of 932 records are matched for a match rate of 92.38 percent. Note that
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ArcGIS software developers often tweak the geocoding algorithm with new software releases so that
your match rate may be slightly different (higher).

4. Click No for Start rematch process, and close the geoprocessing tool.

5. Symbolize AttendeesStreets with a bright-red circle 3, size 5 pt.

6. Turn off Streets, change the basemap to Streets, and zoom into Pittsburgh. There are obvious
clusters of attendees, areas that marketers could turn attention to with billboards, mailings, and so on.

Edit Streets
There are only 67 unmatched addresses to complete (your number may be slightly different depending on
your version of Pro). The match is high enough now for marketing decision-making, but for practice, you’ll
attempt to rematch nine unmatched records. The research for fixing unmatched addresses is already done and
made available in the step 3 table, where Address is the address from the survey data; Comment is the result
of research using the US Post Office’s ZIP Code lookup web page, an online mapping website, and the
TIGER Streets attribute table; and Rematch is the action determined to be taken. As you go through the
tutorial, you will use this workflow and table as references:

1. Edit the TIGER map attributes.

2. Rebuild the locator (to take into account the data revisions).

3. Proceed on a case-by case basis with the Rematching tool to skip bad addresses, edit address data, or
pick from the map.
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4. Open the Streets attribute table, and sort ascending by FullName.

5. Scroll to find Bayard Rd.

This road is only two blocks long. You’ll just edit the first row that has house number ranges 49 to 99
and 2 to 4. Given the survey address of 1 Bayard Rd, it’s reasonable to modify the LFromAdd field
value from 49 to 1 and keep the value 99 for LToAdd. For the same row and RFromAdd and
RToAdd fields, use values 2 and 98, respectively.

6. Make the edits just mentioned, pressing Enter after each typed change to complete entry.

7. Under the Edit tab, click Save > Yes.

YOUR TURN
Make edits for Mary Ann St, Pittsburgh, PA 15203 as noted in the table. Save your edits. Make sure
that no streets are selected.

Rebuild the locator
Considering that you just changed the street attributes used in geocoding with the Streets reference data, you
must rebuild the streets locator to incorporate the changes.

1. Search for and open the Rebuild Address Locator tool.
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2. Select your Streets_CreateAddressLocator locator file, click Run, and close the tool after it finishes.

Rematch attendee data by streets

1. Right-click AttendeesStreets, and click Data > Rematch Addresses.

In the Rematch Addresses pane, the unmatched addresses are presented in the same order as the table
you previously used. First up is 100 Rudolph Lane, which according to the research results in the
table, is a bad address.

2. Click the next button .

3. Because the next two records (1005 Weigel Hill Rd and 1 Frances Drive) are bad, click Next a few
times until you get to 1 Bayard Rd.

This record has a perfect match score, 100, because of the street map editing you did earlier.

4. Click the Match button. The record gets matched, and the next unmatched record is displayed, 1074
Oldgate Rd.

5. Edit the value in the Street or Intersection field to insert a space between Old and Gate.

6. Press Tab (for a perfect match), and click the Match button. The address 1074 Old Gate Rd now has
a perfect match because of your map editing.

7. Press the Match button to match 1117 Mary Ann St, now with a 100 score because of the street
editing you did.

8. Click the Match button for 112 Avenue L. Although the match score is 82, less than the threshold of
85, this is clearly the correct address. The name, “Avenue L,” is confusing for the geocoding
algorithm because the name “Avenue” is also a street type.

9. Match 123Fairfax Road by typing a space between 123 and Fairfax.

10. Click the Save Edits button at the bottom of the Rematch Address pane, click Yes, close the
Rematch Addresses tool, and save your map.
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Tutorial 8-3: Alias tables
You will likely find place-names instead of addresses for some records in a table that is supposed to have street
addresses. For example, instead of typing “15 Federal St,” Pittsburgh, police commonly enter the place-name,
“PNC Park,” the name of the Pittsburgh Pirates’ baseball stadium at that location. For cases with place-
names, ArcGIS Pro’s geocoding algorithm can use an alias table, which you must create to have ArcGIS Pro
replace aliases with street addresses. You can easily data mine unmatched records in geocoded data for place-
names (sort by address and look for place-names). Then, with a number of place-names in hand, you must
look up their addresses and create a table with place-names in one column, addresses in a second column, and
ZIP Codes in a third column. You can use Microsoft Excel or Notepad to do this work.

Open the Tutorial 8-3 project
Suppose that the map you are about to open of Pittsburgh’s central business district (CBD) is for a food-
catering service that delivers lunches to the area’s business employees. The catering service needs a master
layer of its customers’ businesses to create the best routes for cutting delivery costs (you’ll solve such problems
in chapter 13). In this tutorial, you will take the preliminary step of setting up delivery stops. Note that the
data here has relatively few records, so you could edit the source data directly to replace place-names with
correct addresses. Alias tables pay off when you have hundreds or thousands of records to geocode regularly.
In those cases, automatically replacing place-names saves time and work.

1. Open Tutorial8-3.aprx from Chapter8\Tutorials, and save the project as Tutorial8-3YourName.aprx.

2. Use the Pittsburgh CBD bookmark. This map has street centerlines, the same as in Tutorial8-2,
except that they have been extracted for the Pittsburgh CBD neighborhood.
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YOUR TURN
Create a dual-ranges locator, named CBDLocatorNoAlias, using CBDStreets as the reference data and
Clients.csv as the source data. Remember to look down the field map and select FullName for Street
Name. Then geocode Clients.csv to produce a point layer named ClientsNoAliases. A partial listing of
Clients.csv is shown. The selected four records have place-names (names of buildings) instead of
addresses and are the only records that will not geocode at this time, because you’re not yet using an alias
table. Check to see that the four highlighted records are the only ones not matched, as shown.

Build a locator with an alias table
The figure that follows has the contents of Alias.csv. If you geocoded this table, you’d find that all three
addresses match. So you can expect that geocoding with this alias table will result in 100 percent matches for
the client data.

1. In the Catalog pane, expand Locators, right-click CBDStreets_CreateAddressLoca, and click
Locator Properties.
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2. In the left panel, select Place name alias table.

3. For the alias table, navigate to Chapter8\Data, select AliasTable.csv, and click OK.

4. Make the selection as shown, and click OK.

YOUR TURN
Geocode the Clients.csv using the CBDStreets_CreateAddressLoca locator to produce
ClientsAliasTable. You’ll find that 100 percent of the clients’ records match, which is what you’d need
to carry out optimal routing of deliveries. Between doing the research to rematch source records and alias
tables, you can always geocode 100 percent of records that have usable addresses. When you finish, save
and close your project.

Assignments
This chapter has three assignments to complete that you can download from this book’s resource web page,
esri.com/gist1arcgispro:

Assignment 8-1: Geocode grocery stores in Allegheny County.
Assignment 8-2: Reverse geocode a random sample of points representing stops for Meals on Wheels kitchen
siting.
Assignment 8-3: Conduct a sensitivity analysis of parameters for geocoding.
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CHAPTER 9

Spatial analysis
LEARNING GOALS

Use buffers for proximity analysis.
Use multiple-ring buffers to estimate a gravity model of demand versus distance from nearest facility.
Estimate service areas of facilities using ArcGIS® Network Analyst.
Optimally locate facilities using Network Analyst.
Carry out cluster analysis to explore multidimensional data.

Introduction
Maps sometimes require more than a visualization of spatial data for users to answer questions and solve
problems. The right data might be on the map, but analytical methods offer the best answers or solutions to a
problem. This chapter covers four spatial analytical methods: buffers, service areas, facility location models,
and clustering. The application areas include identifying illegal drug dealing within drug-free zones around
schools, estimating a so-called “gravity model” for the fraction of youths intending to use public swimming
pools as a function of the distance to the nearest pool from their residences, determining which public
swimming pools to keep open during a budget crisis, and determining spatial patterns of arrested person
attributes for serious violent crimes.

This chapter introduces a new spatial data type, the network dataset, which is used for estimating travel
distance or time on a street network. ArcGIS Online provides accurate network analysis with network datasets
for much of the world. Because these services require purchase, ensure that you check with your instructor to
see if you have credits. For instructional purposes, this chapter uses approximate network datasets built from
TIGER street centerlines that are free to use.

284



 

Tutorial 9-1: Buffers for proximity analysis
A buffer is a polygon surrounding map features of a feature class. As the analyst, you will specify a buffer’s
radius, and then the Buffer tool will sweep the radius around each feature, remaining perpendicular to
features, to create buffers. For points, buffers are circles; for lines, they’re rectangles with rounded end points;
and for polygons, they’re enlarged polygons with rounded vertices.

Generally, you use buffers to find what’s near (proximate to) the features being buffered. For schools
symbolized as points, 1,000-foot school buffers define drug-free zones. Any person convicted of dealing illicit
drugs within such zones will receive a mandatory increase in jail sentence, which is intended to serve as a
deterrent to selling drugs to children. You’ll analyze drug-free zones in this tutorial.

Another example of spatial analysis with buffers is “food deserts,” which are often defined as areas that are
more than a mile from the nearest grocery store in a city. Often, the persons living in food deserts are poor
and from minority populations, and it’s straightforward to analyze affected populations using selection by
location. You will select the populations within buffers, and then analyze selected features—for example, using
ArcGIS Pro’s ability to summarize data. Additionally, from the book resource web page, you will have the
opportunity to explore this topic further. Assignment 9-2 addresses the analogous problem to food deserts of
“urgent health care deserts” in Pittsburgh—areas more than a mile from the nearest urgent health care
facilities. Assignment 9-4 is a response to food deserts, finding the best locations for additional farmers’
markets in Washington, DC.

Sometimes, buffers are exactly the right tool. One such example are the drug-free zones for which federal
and state laws prescribe a buffer radius, generally 1,000 feet, of school properties. Other times, buffers are less
accurate but provide a quick estimate. One such case is geographic access by youths to public swimming pools
in Pittsburgh, because users of the pools travel the street network to get to the pools. Pittsburgh has an
irregular street network because of its rivers and hilly terrain, so even though some youths appear to be close to
a pool on a map, they may have no direct route to the pool. In this case, you’ll need a network model that uses
travel distance on a street network dataset. Buffers estimated with street networks are called service areas, and
you’ll work with them in tutorial 9-3 to analyze public swimming pools in Pittsburgh.
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Open the Tutorial 9-1 project
In this tutorial, you’ll buffer Pittsburgh schools to find illicit drug dealing arrests within drug-free school
zones—1,000-foot buffers of schools. Drug arrests often occur at the scene of drug dealing, so arrest locations,
which are the same as illegal drug sales violations, are relevant for the analysis of this exercise.

1. Open Tutorial9-1.aprx from Chapter9\Tutorials, and save it as Tutorial9-1YourName.aprx.

2. Use the Northside bookmark. Pittsburgh (and any city) has so many schools that it seems most drug
arrests, as seen here in the Northside of Pittsburgh, would likely fall into drug-free zones. For this
tutorial, persons’ names in the Drug Violations feature class are from a random-name generator and
are not the actual names of arrested persons. Also, dates, exact addresses, and other data have been
changed to protect privacy.

Run the Buffer tool

1. On the Analysis tab, click Tools, and search for and open the Buffer (Analysis tools) tool.

2. Type or make the selections as shown. The No Dissolve option creates a separate buffer for each
point feature. The opposite, Dissolve, dissolves interior lines of overlapping buffers, merging them
into a single buffer. A dissolved buffer gives you distance to the nearest facility (school, in this case).
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3. Run the Buffer tool, and close it after it finishes.

4. Take the color fill out of the buffers, move Drug Violations above Schools in the Contents pane, and
turn off the school labels. Looking at the map alone, you cannot readily determine whether drug-free
zones deter drug dealing near schools in Pittsburgh. So you’ll analyze this issue in the next Your Turn
assignment. Note the overlapping buffers in the next figure. If the buffers were made instead with the
dissolve option, each set of overlapping buffers would be replaced with a single buffer consisting of
the outline of each set.

Select drug violations within drug-free zones

1. On the Map tab in the Selection group layer, click Select By Location.
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2. For Input Feature Layer, select Drug Violations, and for Selecting Features, select Schools_Buffer.

3. Run the tool, and close it when it finishes.

4. Open the Drug Violations table, and see how many violations are selected. Across the city, 222 of
651 drug violations are selected within drug-free zones, 33.8 percent of all drug violations.

5. Close the table, and clear the selection.

YOUR TURN
If drug violations occurred randomly in Pittsburgh, then for any given area within Pittsburgh, you’d
expect the fraction of such crimes to be the same as that area’s fraction of Pittsburgh’s area. Run the
buffer tool again with Schools as input, Schools_Buffer_Dissolved as output, 1,000-foot radius, and this
time with the option, “Dissolve all output features into a single feature.” Then divide the area of the
resulting buffer by the area of Pittsburgh. Both areas are in square feet and so are large numbers. You can
copy and paste them into Microsoft Excel from Shape_Area attributes of the two feature classes to do
the division. You should get 398,645,239/1,627,099,663 = 0.245, or 24.5 percent, but earlier you found
that a substantially higher fraction, 33.8 percent, of drug violations occurred in drug-free zones.
Although not a definitive result, you should be suspicious that drug-free zones are not working in
Pittsburgh. A better estimate, however, than the one you just did uses Pittsburgh’s area with human
activity instead of all of Pittsburgh for the divisor. You’d have to subtract the area of rivers, cemeteries,
steep hillsides, and so on, which for Pittsburgh is about 50 percent of its area. Then you’d expect 49
percent of drug arrests to be in the drug-free zone buffers, which is considerably larger than the 33.8
percent found. So perhaps the law reduces drug dealing near schools. Save your project.

Spatially join school buffers to drug violations
You can get a list of all drug violations within school buffers with the names of the schools included. If a drug
violation is in more than one school buffer, you can get the names of all the schools. You’ll use a spatial join of
school buffers to drug violations to get this information, which could be passed along to police and the courts.

1. Open the Spatial Join tool.

2. Type or make the selections as shown, using your original Schools_Buffer.
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3. Run the Spatial Join tool, and close it when it finishes.

4. Open the attribute table of the resulting spatial join.

5. Sort the table by CCN (the crime ID) ascending. Notice that the first three records are all for the
same CCN number, 2015016991, so the corresponding drug offense is in three school buffers (see the
Name attribute for the names of the three schools). This output is the result of the “Join one to many”
option from the tool: one drug violation possibly in many buffers.

6. Save your project.
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Tutorial 9-2: Multiple-ring buffers
A multiple-ring buffer for a point looks like a bull’s-eye target, with a center circle and rings extending out.
You can configure the center circle and each ring to be separate polygons, thereby allowing you to select other
features within given distance ranges from the buffered feature.

During a budget crisis, Pittsburgh officials permanently closed 16 of 32 public swimming pools. You’ll
estimate the number of youths, ages 5 to 17, living at different distances from the nearest swimming pool for
all 32 pools versus the 16 that were kept open. Youths living within a half mile of the nearest open pool are
considered to have good access to pools, while youths living from a half to one mile from the nearest pool are
considered to have fair access. Youths living farther than one mile from the nearest pool are considered to
have poor access (borrowing from the definition of food deserts). In tutorial 9-4, you’ll make more precise
access estimates based on travel time across the street network of Pittsburgh from youth residences to the
nearest pool.

Open the Tutorial 9-2 project

1. Open Tutorial9-2.aprx, and save it as Tutorial9-2YourName.aprx.

2. Use the Pittsburgh bookmark. The map has all 32 public pools (open and closed) and block centroids
symbolized with youth population, ages 5 to 17. First, you’ll get the number of youths that had good
access when all 32 pools were open.
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Create buffers

1. Open the Multiple Ring Buffer tool, and type or make the selections as shown.

2. Run the tool, and close it when it finishes.

3. Symbolize the buffers to have no color fill with a size 2 dark-green outline. Many Pittsburgh youths
appear to have had fair-to-good pool access before the pool closings. Next, you’ll get the
corresponding statistics.
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Use spatial overlay to get statistics by buffer area

1. Open the Spatial Join tool, and type or make the selections as shown.

2. Run the tool, and close it when finished.

3. Open the resulting map layer’s attribute table to see in the Age_5_17 attribute that 21,833 youths had
good access, and 20,725 had fair access. If you ran the Summarize tool to sum the Age_5_17 field of
PittsburghBlockCentroids, you’d get 48,903 youths who live in the city. Then you can calculate that
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44.6 percent had good access and 42.4 percent had fair access, for a total of 87.0 percent who had
good or fair access. Those results seem to be good.

YOUR TURN
Next, find good or fair youth access for pools that remained open. Select open pools using Select by
Attributes with the criterion Open is Equal to 1. Create the same multiple-ring buffers for open pools.
Perform a spatial join of the block centroids to the new buffers, and get the new totals for good and fair
access. You’ll find that 10,726 youths have good access and 20,450 have fair access, compared with
21,833 who had good access and 20,725 who had fair access when all pools were open. Why do you
suppose that fair access remained so high? Maybe it’s the conversion of good access to fair access, or
maybe it’s because with all pools open, there tended to be access to more than one pool for a given
residence, whereas with pools closed, there’s still fair access but to only one pool. In any event, now only
63.7 percent of the youths have good or fair access compared with 87 percent with all pools open. Save
your project.

293



 

Tutorial 9-3: Multiple-ring service areas for calibrating a gravity model
Service areas are similar to buffers but are based on travel over a network, usually a street network dataset. If a
point, say for a retail store, has a five-minute service area constructed using ArcGIS Pro’s Network Analysis
tools, then anyone residing in the service area has, at most, a five-minute trip to the store. If you have
permission from your instructor to use an ArcGIS Online service that consumes credits or otherwise have
access to your own ArcGIS Online credits, you could use an ArcGIS Online network service, which would be
much more accurate than the free, TIGER-based network datasets that you’ll use in this chapter.
Nevertheless, you will use the PittsburghStreets_ND network dataset provided in Tutorial9-4.aprx so that
your results match the tutorial results.

In this tutorial, you’ll use service areas to estimate a so-called “gravity model” of geography (also known as
the “spatial interaction model”), which assumes that the farther apart two features are, the less attraction
between them. The falloff in attraction with distance is often nonlinear and rapid, as in Newton’s gravity
model for physical objects where the denominator of attraction is distance squared. The application of this
tutorial is a continuation of the pool case study, based on a random sample of youths owning pool tags (which
allow admission to any Pittsburgh public pool). To scale the random sample up to the full population of
youths with pool tags, you will need to multiply estimates by 11.3. With service areas, you could use distance
or travel time to estimate a gravity model. Here, you’ll use time (minutes).

This tutorial uses this multiple-step workflow:

1. Select open pools from the feature layer of all pools (so that the service area of the next step is
applied to only open pools).

2. Create service areas for a given set of travel times (1, 2, 3, 5, and 7 minutes) to produce
nonoverlapping service area rings. The result is the center area and four rings (0 to 1 minute, 1
to 2 minutes, and so on). These times were determined by trial and error to get good sample
sizes in each ring and cover the catchment areas of pools.

3. Count the number of pool tags in each service area. The count is accomplished using a spatial
join of the service areas and pool tag points. When scaled up by multiplying by 11.3, the result is
an estimate of the number of youths owning pool tags who will use pools in each service area
ring.
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4. Sum up the population of youths ages 5–17 in each service area, using a spatial join of the service
areas and block centroids. The result is the target total population for pool use of all youths in
each service ring.

5. Calculate the average use rate for each service area as a percentage using Use Rate = 100 × 11.3 ×
[number of youths with pool tags in sample] / [total population of youths].

6. Plot the estimated use rate of each service area versus the average travel time in each service area
in minutes from the nearest pool (0.5, 1.5, 2.5, 4.0, 6.0). Use rate is expected to decline rapidly
with travel time.

Note for the technically advanced student: You can make more accurate estimates of the average travel
times for each service area ring of step 6 using an origin destination (OD) cost matrix calculated using a
Network Analyst tool (search for “OD cost matrix analysis” in ArcGIS Pro help). You can configure this
matrix to record the shortest-path distance or time between each demand point (origin) and supply point
(destination). In the current problem, block centroids are origins and pools are destinations. Manipulations of
the OD matrix, say in Microsoft® Excel, can yield exact averages (or medians) of travel times for rings instead
of assuming that the midpoints of service area rings are average travel times.

Open the Tutorial 9-3 project

1. Open Tutorial9-3.aprx from Chapter3\Tutorials, and save it as Tutorial9-3YourName.aprx.

2. Use the Pittsburgh bookmark. The map has all 32 public pools (both open and closed) and block
centroids symbolized with youth population, ages 5 to 17, and pool tags. The map also has a network
dataset for Pittsburgh, PittsburghStreets_ND, built from TIGER street centerlines. The network
dataset is calibrated for drive time in a vehicle.
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3. Turn off Pooltags and PittsburghBlockCentroids.

4. Click Select By Attributes, and complete its geoprocessing form as shown, click Run, and close the
Geoprocessing pane. Later, when you add facilities (pools) to the network analysis, only open pools
will be added.

Create multiple-ring service area polygons
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1. On the Analysis tab in the Tools group, click the Network Analysis button  > Service Area. If you
don’t see the Network Analysis button, make your ArcGIS Pro window wider. Because the Contents
pane has a network dataset, PittsburghStreets_ND, the items on the Network Analysis list are
enabled. ArcGIS Pro builds the Service Area group layer in the Contents pane and adds the Network
Analyst service area context menu to the ribbon.

2. On the Network Analyst contextual tab in the Input Data group, click Import Facilities, make your
selections as shown, then run the tool, and close it after it runs. All open pools become facilities
because of their selection.

3. In the Travel Settings group, change Direction to Towards Facilities. Next, you’ll change cutoffs for
the service areas. ArcGIS Pro has detected that the street network, PittsburghStreets_ND, is set up
for travel time in minutes and suggests 5, 10, and 15 minutes. You’ll change these times next.

4. For Cutoffs, type 1, 2, 3, 5, 7.

5. In the Output Geometry group, select Dissolve instead of Overlap, leaving Standard Precision and
Rings selected. By selecting Dissolve, your service areas will provide travel time to the nearest pool.

6. On the Network Analyst contextual tab in the Analysis group, click Run.

7. Symbolize the output Polygons so that 1 is blue, 2 is bluish green, 3 is green, 5 is yellow, and 7 is
orange. Also, turn on labeling for Pools, and move that layer above Service Area. Suppose that a
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travel time of 1 minute or less is excellent, 1 to 2 minutes is very good, 2 to 3 minutes is good, 3 to 5
minutes is fair, and 5 minutes and higher is poor. Then according to estimated street travel time in a
car, areas that are considered fair or poor are clearly visible in yellow and orange with two interesting
results. First, the service areas are much different from circular pool buffers because Pittsburgh’s
streets have irregular patterns caused by its many hills and valleys. Jack Stack and Highland pools are
good examples. Zoom into their areas to see their streets. Second, you will see open pools close
together, such as Cowley and Sue Murray where perhaps one could be closed. Also, closed pools, such
as Fowler, perhaps could be opened to provide better access. The analysis that you just performed was
not available at the time of initial pool closings so these results would have been informative; however,
city officials used criteria in addition to geographic access when closing pools, such as the condition of
pools and historic attendance patterns. After the first year of closings, with location analysis and other
information in hand, some closed pools were opened and others closed to improve overall pool access.

Next are steps 3 and 4 of the workflow—counting youths with pool tags and summing up youth population,
all by service area polygons.

Spatially join service areas and pool tag owners

1. Turn Pooltags on.

2. In the Contents pane, right-click Polygons in the Service Area group layer, and click Joins and
Relates > Spatial Join, type or make the selections as shown, run the tool, and close it when it
finishes. The Count Merge Rule counts pool tag records, and because there’s only one youth per pool
tag, counting records is needed.
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3. Open the resulting Join_Pooltags table, and examine the Join_Count and Name fields to see 377
sampled pool tag holders in the travel time range of 0 to 1 minutes from all pools, 512 tag holders in
the range of 1 to 2 minutes, and so on. Leave the table open. Next, you must change the name of
Join_Count field so that the spatial join you run next on Join_Pooltags does not overwrite the current
Join_Count values.

4. In the attribute table, click the Option button > Fields View, change the Field Name and Alias of
Join_Count to Join_Count_Pooltags, save the changes, and close all tables.

5. In the Contents pane, right-click the Join_Pooltags layer, click Joins and Relates > Spatial Join, type
or make the selections as shown, run the tool, and close it when it finishes. Note that you can specify
the Merge rule for each field in the Output Fields panel as shown in the figure.
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Spatially join service areas and youths
Next are the final steps, 5 and 6, of the workflow—calculating and plotting use rate.

1. Open the attribute table of Join_Pooltags_Blocks.

2. Open Fields View of Join_Pooltags_Blocks, and create two new fields: AverageTime and UseRate,
both with Float data type.

3. Save the results, and close the Fields View table. AverageTime will store the midpoint of each service
area disk—for example, 0.5 for the 0–1 disk.

4. Move the Name column to just before the AverageTime field.

5. Type these values for AverageTime, referring to Name to correspond to travel time ranges: 6, 4, 2.5,
1.5, and 0.5. The final task is to compute estimated use rates for each service area disk = 100 × 11.3 ×
!Join_Count_Pooltags!/!Age_5_17!, where 100 makes the result a percentage, 11.3 is the scale-up
factor from the random sample to the population, Join_Count_Pooltags is the sample number of
youth pool tag holders in each service area ring, and Age_5_17 has the total (sum) of youths in each
ring.
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6. Right-click UseRate, click Calculate Field, and type or make the selections as shown.

7. Run the tool, and close it when it finishes. As expected, use rate declines quickly with average time
from the nearest pool: 91.7 percent of youths within a mile of the nearest pool have pool tags, but the
rate drops to 54.6 percent in the 1–2 minute ring, and all the way down to 25.9 percent in the 5–7
minute ring.

Make a scatterplot
It’s easy in ArcGIS Pro to make a scatterplot of Use Rate versus Average Time to visualize the estimated
gravity model data points.

1. In the Contents pane, select Join_Pooltags_Blocks.

2. On the Feature Layer contextual tab on the Data tab, click Create chart > Scatter Plot. If you don’t
see the Create Chart button, make your ArcGIS Pro window wider.

3. In the Chart pane, for X-Axis Number, select AverageTime; for Y-Axis Number, select UseRate,
and close the Chart pane. You will see that the gravity model curve falls rapidly in a nonlinear way as
expected. Note that you can change the title and axis labels of the chart by using the General tab of
the Chart pane. Automatically included in the chart is a straight-line regression model, which is not
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an appropriate form for the evidently nonlinear relationship.

4. Save your project.
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Tutorial 9-4: Facility location
Suppose that you are an analyst for an organization that owns several facilities in a city, and you are asked to
find the best locations for new facilities. The classic problem of this kind is to locate facilities for a chain of
retail stores in an urban area, but other examples are federally qualified health centers (FQHCs) as studied in
chapter 1 and the public swimming pools earlier in this chapter. In the most general case, your organization
has existing facilities that will remain open, a set of competitor facilities, and a set of potential new locations
from which you want to determine a best subset of a specified size. Another case is where a subset of existing
facilities must be closed, as with the Pittsburgh swimming pools, for which you want to determine the
appropriate 16 of 32 facilities to close. Yet another case is where there are no existing facilities, and you want
to locate one new facility.

ArcGIS Pro’s Location-Allocation model in the Network Analysis collection of models handles these
sorts of facility location problems. Inputs are a network dataset, locations of facility types (existing,
competitors, and new potential sites), demand points, and a gravity model. Demand is represented by polygon
centroids—blocks, block groups, tracts, ZIP Codes, and so on—for which you have data on the target
population, generally from the US Census Bureau, such as youth population. Resistance to flow in the
network, called impedance, is represented by a gravity model and can be distance- or time-traveled along
shortest paths to facilities. Several optimization models are available within the Location-Allocation model.
You’ll use the Maximize Attendance model, which includes a gravity model (for which you supply parameter
values) and a network optimization model that selects a specified number of new facility locations that
maximize attendance.

In this tutorial, you’ll run a model to choose the best 16 out of 32 swimming pools to keep open using
geographic access (distance from the nearest pool) as the criterion.

Open the Tutorial 9-4 project

1. Open Tutorial9-4.aprx from Chapter9\Tutorials, and save it as Tutorial9-4YourName.aprx.

2. Use the Pittsburgh bookmark. This map has the 32 pools, block centroids with youth population, and
PittsburghStreets_ND network dataset. Also included is the PittsburghStreets street centerline layer
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symbolized using a tan color for visualization. Note that the PittsburghBlockCentroids table has an
attribute, Cutoff_Minutes, which has value 10, meaning that any block centroid farther than 10
minutes travel time to the nearest pool under consideration will not be served and therefore has none
of its youth going to a pool.

Calibrate the Location-Allocation model
The Location-Allocation model is straightforward to use, but first you must fit a gravity model to the five
points of the scatterplot at the end of tutorial 9-3. In other words, tutorial 9-3 produced data points, but the
Location-Allocation model needs a gravity-model function fitted to those points as input. Available in the
Location-Allocation model are three functional forms for a gravity model: linear, exponential, and power. The
power form does not work well for cases with short travel times, such as for the swimming pools (a few
minutes), so it’s not discussed further here. The linear form is easy to understand and use and is based on an
impedance cutoff (10 minutes for the swimming pools). It estimates that 100 percent of the target population
that lives at a pool uses it (of course no one lives at a pool, but some are nearby, and nearly 100 percent of the
population uses the pool), 75 percent uses the pool at a quarter of the cutoff (2.5 minutes), 50 percent at half
the cutoff time (5 minutes), 25 percent uses it at three quarters of the cutoff (7.5 minutes), and 0 percent at
the cutoff or beyond—(10 minutes or higher). If C = cutoff in minutes and T = impedance in minutes, then as
a percentage, Use Rate = 100 × (1 – T/C) for T ranges between 0 and C, and is 0 otherwise.

Exponential is the most applicable gravity model for the swimming pool case, because it declines rapidly as
travel time increases, and it generalizes to other cases very well. The Microsoft Excel worksheet,
Exponential.xlsx, available in Chapter9\Data, provides a method of fitting the exponential model to the
results of tutorial 9-3.
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1. Open Exponential.xlsx from Chapter9\Data. Beta, which currently has the value 0.25, is the one
parameter that you must choose (optimize) in the worksheet and provide in the Location-Allocation
model. Impedances are average travel times in minutes. The Gravity Model Use Rate column has the
estimates 9–3 for its multiring service areas, expressed here as fractions instead of percentages. Cost is
an exponential function, eβT, used in the network optimization model to represent system impedance,
and the model uses Pro Use Rate, e-βT, as the gravity model. Your task is to vary beta until you get a
good fit of the Pro Use Rate to the Gravity Model Use Rate. Average Absolute Error is a guide for
choosing beta; you must minimize it by trial and error.

2. Enter the beta values, one at a time, into the worksheet: 0.10, 0.15, 0.20, 0.25, 0.30, and 0.35, and
note resulting average absolute error values. Next are the results, which are also saved in the
worksheet in rows 13 through 19. Beta = 0.25 is the best fit out of the values tried. Note that if you
are comfortable with Microsoft Excel, you can easily modify this worksheet for other case studies or
projects by adding (copying) rows and changing impedances.

3. Save and close the worksheet.

Configure and run the Location-Allocation model

1. On the Analysis tab in the Tools group, click Network analysis > Location-Allocation. ArcGIS Pro
creates the Location-Allocation group layer in the Contents pane.

2. Click the Network-Analyst contextual tab. The horizontal toolbar for this model opens. If this
toolbar ever closes and you want to reopen it, click the Location-Allocation group layer in the
Contents pane.

3. In the Import Data group, click Import Facilities, and make the selections as shown, and then run
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the tool and close it when it finishes. This tool can be run more than once to load different kinds of
facilities. Notice that the default FacilityType under Field Mapping Property is Candidate, which is
correct for this model run. Other values are Required, Competitor, and Chosen.

4. Click Import Demand Points, and make the selections as shown. Under Field Mappings Property,
for Weight, select Age_5_17 (this is the target population), and for the Cutoff_Minutes property,
select the Cutoff_Minutes field.
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It takes a minute or so for ArcGIS Pro to load the 7,493 demand points.

5. In the Travel settings group, select Towards Facilities, and type 16 for Facilities.

6. In the Problem Type group, click Type > Maximize Attendance.

7. In the Problem Type group, select Exponential for f(cost, β), type 0.25 for β, and press Tab.

8. Run the model.

9. In the Contents pane and its Location-Allocation group layer, clear Demand Points, and
resymbolize Lines to have a 0.5 line width and color of your choice. The lines connecting pools and
served demand points constitute a “spider map.” This sort of map is used for visualization; however,
the actual lines connecting pools and block centroids follow the shortest paths along the street
network.
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Analyze the optimal solution
Officials had closed half (eight) of the optimal pools. Remember, however, that officials had criteria in
addition to geographic access for selecting pools to close or keep open, and didn’t have GIS-based location
analysis.

1. Open and sort the Facilities attribute table as descending using the DemandWeight column.
DemandWeight has the number of youths allocated by the Location-Allocation model to each pool.
However, only about 50 percent of Pittsburgh’s youths had pool tags in the study year, so a better
estimate of the number of users for each pool is to divide the DemandWeight values by 2. Then, for
example, you’d expect 3,317/2 = 1,658 users of the Homewood pool.
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2. Open the Pools attribute table. MaxLoad is the capacity of a pool. The Homewood pool has a
capacity of 455, while the model estimate is 3,306/2 = 1,653—more than 3.5 times its capacity. Of
course, not every potential user of the pool will show up at once. Some days, youths would have to
wait or be turned away from the pool, but it seems that attendance would be good.

3. Close the Pools table.

4. In the Facilities attribute table, use the Summarize tool to sum DemandWeight. The total is 27,607
estimated pool users. Dividing by 2, the estimate is that 13,804 youths would use the 16 optimal
pools.

5. Close the Facilities table.

6. In the Contents pane, clear PittsburghStreets and PittsburghStreets_ND, zoom into the southeast
corner of Pittsburgh that has the long lines from the Burgwin pool to demand points near the
McBride pool, and click the longest line you can find. In the resulting pop-up window,
Total_Minutes, 7.239, has the estimated travel time from Burgwin to the farthest point on the map,
within the 10-minute cutoff.

7. Save your project.

YOUR TURN
Remove the Location-Allocation group layer from the Contents pane, and set up a new Location-
Allocation model to estimate pool use from pools that officials left open. First, select open pools with the
clause Open Is Equal to 1. Then start a new Location-Allocation model, and import Pools as facilities
with FacilityType (under Property) being Required. Then import Demand Points just as you did in the
previous steps (Weight = Age_5_17, and Cutoff_Minutes = Cutoff_Minutes). Select Towards Facilities,
and type 16 facilities. Set the problem type to Maximize Attendance and the function to exponential
with 0.25 for beta. Run the model. Sum DemandWeight for Facilities to find 25,044 youths estimated
to use the open pools. Dividing by 2, you get the number 12,522 as the best estimate of pool users,
compared with 13,804 from the optimal solution, only 1,282 fewer (9.3 percent). Ultimately, although
officials chose a much different set of pools to keep open compared with the model-based optimum, not
much was given up in terms of potential users. That’s good news for youths living in Pittsburgh from a
policy point of view.

If you have time, make one more model run, this time using all 32 pools. You’ll find that the model
estimates 30,218 users compared with 27,607 for the optimal solution and 25,044 for the remaining 16
pools. Why do 32 pools only produce such a small gain over 16 pools? The answer is probably because
there were too many pools competing for users when there were 32 pools. So it appears that officials did
not make a bad decision, if the network dataset is accurate enough and travel to pools is primarily driving
on the road network.
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Tutorial 9-5: Data clustering
The goal of data mining is exploration, to find hidden structure in large and complex datasets that has some
interest or value. Data clustering, a branch of data mining, finds clusters of data points that are close to each
other but distant from points of other clusters. If your data points were 2D and graphed as a scatterplot, it
would be easy to draw boundaries around points and call them clusters. You’d perform as well as any
clustering method. The problem is when the points lie in more than 3D space because you can’t see them
anymore, and that’s where cluster methods are valuable. In this tutorial, you’ll cluster crimes using four
attributes/dimensions, including severity of the crime, plus the race, age, and gender of the arrested persons. A
better attribute than race would be to use the poverty status of arrested persons, which is an underlying cause
of criminal behavior, but that data is not collected by police.

A limitation of clustering, however done, is that there is no way of knowing “true” clusters in real data to
compare against what a method determines are clusters. You take what clustering methods provide, and if you
get information or ideas from cluster patterns in your data, you can confirm them or determine their
predictability using additional models or other methods. Clustering is purely an exploratory method. There
are no right or wrong clusters, only more or less informative ones.

This tutorial uses a simple method called k-means clustering, which partitions a dataset with n observations
and p variables into k clusters. You’ll use a dataset with n = 303 observations, p = 4 variables for clustering, and
k = 5 clusters desired. K-means is a heuristic algorithm, as are all clustering methods: it’s a set of repeated
steps that produces good if not optimal results. For this tutorial’s data, the algorithm starts with a procedure
that selects five, four-dimensional (4D) observations called seeds as initial centroids. Then each observation is
assigned to its nearest centroid, on the basis of Euclidean (straight line) distance in the 4D cluster variable
space. Next, a new centroid is calculated for each cluster, and then all observations are reassigned to the
nearest centroid. These steps are repeated until the cluster centroids do not move appreciably. So k-means
clustering is a common-sense, mechanistic method.

K-means assumes that all attributes are equally important for clustering because of its use of distance
between numerical points as its basis. To meet this assumption, all input attributes must be scaled to a similar
magnitude and range. Generally, you can use standardized variables (for each variable, subtract its mean and
divide by its standard deviation) to accomplish scale parity, but other ways of rescaling are acceptable, too. It is
the range, or relative distances between observations, that’s important in k-means clustering. The data used in
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this tutorial includes numerical (interval or ratio), ordinal, and nominal class data for classification. K-means
clustering is intended for numerical data only because of its use of distance in cluster variable space.
Nevertheless, with rescaling, it’s possible to get informative clusters when including nonnumerical data. Next,
the discussion turns to the specific case at hand and how to rescale attributes.

The data used in this tutorial is serious violent crimes from a summer in Pittsburgh, with the data mapped
as points. The crimes are ranked by severity using FBI hierarchy numbers (1 = murder, 2 = rape, 3 = robbery,
and 4 = aggravated assault), with of course murder being the most serious. Clearly, the nature of crimes should
be important for their clustering. So the first assumption you must make is that the distance between crime
types, such as the number 3 between 1 for murder and 4 for aggravated assault (attempted or actual serious
bodily harm to another person), is meaningful for clustering purposes. The criminal justice system agrees on
the order, and for clustering, we can accept the “distances” or change them using our judgment. For this
tutorial, you’ll leave them as listed here.

Next, consider the single numerical attribute that is available, the age of an arrested person. Crime is
generally committed by young adults, tapering off with older ages. For the serious violent crimes studied here,
age varies between 13 and 65 (range of 42) with a mean of 29.7. Together with crime severity, age would
dominate clustering because of its greater range. The remedy is to standardize age, which then varies between
−2.3 to 2.7 with a range of 5, whereas crime severity has a range of 3. So then both attributes are fairly equal
in determining clusters.

Finally, there are two nominal attributes: race (black or white) and gender (male or female). These can be
encoded as binary attributes: race (0 = white, 1 = black) and gender (0 = male, 1 = female). As a binary
indicator variable, race has a mean, which is the fraction of arrestees who are black, and similarly gender has a
mean, which is the fraction of arrestees who are female. These variables as encoded here would have perhaps
lesser roles than the previous two, but not by that much. If you wanted to increase the importance of the
binary variables for clustering, you could encode them as (0, 2) or (0, 4) indicators. You’ll leave them as (0, 1)
variables, which makes interpretation of clustering results easier.

One last point is that you must choose the number of clusters instead of having k-means clustering find an
optimal number for you. That’s the case for most clustering methods. For the crime data, experimentation
with three through six clusters resulted in five clusters being the most informative, so you’ll run with five
clusters.

In summary, each observation is a 4D vector (crime, standardized age, gender, race)—for example, (1, –
0.364, 0, 0) is a murder with an arrested 25-year-old (standardized age 25 is –0.364) male who is white. The
clusters found by k-means exist in the 4D space in which the observations lie. Each cluster is characterized by
its centroid with corresponding means and standard deviations of each cluster variable.

Open the Tutorial 9-5 project

1. Open Tutorial9-5.aprx from Chapter9\Tutorials, and save it as Tutorial9-5YourName.aprx.

2. Use the Pittsburgh bookmark. The map shows the spatial distribution of serious violent crimes by
crime type within police zones. Each zone has a commander, station, officers, and staff. Also shown
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are the poverty areas from chapter 1. Generally, there is a positive correlation between poverty and
crime.

3. Open the attribute table for Serious Violent Crimes, scroll to the last column, Seed, and sort it
descending. These are the five records used as initial cluster centroids as found by k-means clustering
for a given run. Each time you run k-means, the procedure has a chance of choosing different initial
cluster centroids, so you’ll use these initial cluster centroids to get results consistent with the steps that
follow. Hierarchy is the FBI code for crime types and one of the four cluster attributes. ArrAge is the
actual age of the arrested person, and ArrAgeStnd, the second cluster attribute, is the standardized
arrest age. Notice that there is a good deal of variation in the cluster variables of the seed records,
although the clusters that k-means ultimately finds are much different from these starting cluster
centroids, as you will see. The remaining two 0/1 attributes, ArrGender and ArrRace, are the
remaining cluster variables.

4. Close the table.

Run the clustering algorithm
The k-means algorithm is in a geoprocessing tool called Grouping Analysis, which you’ll run next.

1. Open the Grouping Analysis tool.

2. Carefully fill out the tool form as shown, including typing the extension .pdf, for the output report
file. Use the Tab key to move to a new field, and ensure that you do not use the Enter key, because
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doing so may run the tool prematurely. The selection for Spatial Constraints—No spatial constraint
—triggers the use of k-means clustering. In this case, the objective is to cluster crime type and
arrested person attributes, and then observe and interpret the spatial distribution of clusters. For
instance, the cluster analysis finds that older criminals commit crimes in the city’s central business
district, which is interesting. If a spatial constraint is used (for example, that observations must close
in geographical space), a different clustering method is used. Also note that if you are running this
tool for your own data or in an assignment, for Initialization Method you’d use the Find seed location
option instead of Get seeds from field.

3. Double-check the form, and then run the tool. The tool takes a minute or two to complete its
extensive calculations and write its PDF report. When finished, it adds the Clusters layer, which has
the five identified clusters, to the Contents pane. The warning message says that the tool was not able
to read 38 of the 303 crime records, but those are only records that did not geocode successfully in a
data preparation step. Those 38 records are in the attribute table but not on the map, and they are not
a problem in terms of successfully computing clusters for 265 geocoded records.

4. Close the Geoprocessing pane.
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5. Use Windows or File Explorer to browse to and open ClusterReport.pdf. To interpret the clusters,
you must study ClusterReport.pdf, which is in your Tutorials folder. The first page of the report is
shown.

Interpret the cluster report
Each group (or cluster) has its font color matching mapped points for SS_GROUP. Note that your groups
may have different numbers and colors than those reported here, but the statistics and everything else will be
the same. One issue is that the standardized age needs to be unstandardized. The mean of age is 30.3, and its
standard deviation is 12.3. So for the Group 1 (blue) standardized value, which is −0.7242, to get the
unstandardized corresponding age, calculate age = 30.3 + (−0.7542) x 12.3 = 20. Each group’s mean values are
summarized as shown. It’s difficult to find terms to describe the mean crime hierarchy numbers, so the range
from least serious to most serious used in the table are in the context of reporting results in regard to harm
done.

These results have moderately interesting patterns and one anomalous group—Group 2. With a group
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size of only three crimes for Group 2, you can’t rely on that small result. Group 1 represents young black
males committing a range of serious violent crimes. Group 3 is middle-aged persons of either race committing
a range of crimes. Group 4 represents middle-aged persons of either race committing aggravated assaults (FBI
hierarchy 4). Finally, group 5, the largest in size, is composed mainly of young blacks, mostly committing
aggravated assaults.

Next, you can see if there are any spatial patterns for these groups.

1. Turn off Serious Violent Crimes in Contents, and make sure that Clusters is on.

2. Open Symbology for Clusters, and relabel the groups as follows:

1 becomes Young black males moderate.

2 becomes Middle-aged black females highest.

3 becomes Middle-aged either race males moderate.

4 becomes Middle-aged either race males lowest.

5 becomes Young blacks either gender lowest.

3. Keep the same colors, but change the point symbols for the two young groups to Square 1, Size 5.
The cluster results that were judged moderately interesting earlier get more interesting when mapped.
The youth groups clearly are spatially clustered in the poverty areas, while the middle-aged groups are
scattered. Also, various locations on the map show spatial clusters, with a few indicated by arrows.
The central business district’s serious violent crimes (arrow in the middle of the map) are
predominantly by older criminals, as are those at the second arrow in an outlying area. These results
make sense. Youths generally commit crimes near to where they live, whereas older criminals, who
have more ability to travel, travel to the central business district to commit crimes. Certain outlying
areas may have high concentrations of older persons.
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4. Save your project.

Assignments
This chapter has five assignments to complete that you can download from this book’s resource web page,
esri.com/gist1arcgispro:

Assignment 9-1: Study California cities affected by earthquakes.
Assignment 9-2: Analyze geographic access to federally qualified health centers.
Assignment 9-3: Analyze visits to the Phillips public pool in Pittsburgh.
Assignment 9-4: Locate new farmers’ markets in Washington, DC.
Assignment 9-5: Carry out a cluster analysis of tornadoes.
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CHAPTER 10

Raster GIS
LEARNING GOALS

Extract and symbolize raster maps.
Create hillshade maps.
Smooth point data with kernel density smoothing.
Build a raster-based risk index.
Build a model for automatically creating risk indices.

Introduction
Thus far, this book has been devoted to vector feature classes (points, lines, and polygons), except for
displaying the raster basemaps available in ArcGIS Pro, plus an occasional raster map layer. Vector feature
classes are useful for discrete features (such as streetlight locations, streets, and city boundaries). Raster map
layers are best suited for continuous features (for example, satellite images of Earth, topography, and
precipitation). Raster map layers also can be used when you want to display large numbers of vector features
(for example, all blocks in a city, all counties in the United States). In some cases, you have so many vector
features that the features of choropleth and other maps are too small to render clearly. In such cases, as you
will see in this chapter, you can transform vector feature classes into raster datasets that you can easily
visualize. This chapter first presents some background on raster maps before discussing exactly what you’ll be
doing next.

Raster dataset is the generic name for a cell-based map layer stored on a disk in a raster data format. Esri
supports more than 70 raster dataset formats, including familiar image formats such as TIFF and JPEG, as
well as GIS-specific formats such as Esri Grid. You can import raster datasets into file geodatabases.

All raster datasets are arrays of cells (or pixels)—each with a value and location, and rendered with a color
when they are mapped. Of course, just like any other digital image, the pixels are so small at intended viewing
scales that they are not individually distinguishable. The coordinates for a raster dataset are the same kind as
used for vector maps (chapter 5).

All raster datasets have at least one band of values. A band is comparable to an attribute for vector map
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layers but stores the values of a single attribute in an array. The values can be positive or negative integers or
floating-point numbers. You can use integer values for categories (codes), which must have a layer file with
descriptions and colors (for example, 1 = Agriculture, brown; 2 = Forest, green). Raster dataset values can also
be floating-point numbers representing magnitudes (for example, temperature and slope steepness of terrain).

Color capture and representation in raster datasets is an important topic. Color in the visible range is
captured by satellites in three bands (for example, red, blue, and green) that mix to produce any color. Color
in many raster datasets, however, is often represented in one band using a color map, in which each color is
given a code (integer value). Color depth is the term given to the number of bits for code length (on/off
switches in data storage) used to represent colors. So-called “true color” uses 24 bits per pixel and can
represent more than 16 million colors (the human eye can distinguish about 10 million colors).

The spatial resolution of a raster dataset is the length of one side of a square pixel. So if a pixel is 1 meter
on a side, it has 1 meter spatial resolution (which is a high resolution leading to high-quality maps). The US
Geological Survey provides imagery for urban areas in the United States at this resolution or higher with
images capable of being zoomed far into small parts of neighborhoods (for example, with driveways,
swimming pools, and tennis courts being clearly shown when displayed). The current Landsat 7 and 8
satellites that together image the entire Earth every eight days have a resolution of 30 meters for most of their
eight bands, which is good for viewing areas as small as neighborhoods of a city.

File sizes for raster datasets can be very large, requiring large amounts of disk space for storage, and also
taking potentially relatively long times to process and display on a computer screen. Raster GIS uses several
mechanisms to reduce storage and processing time, including data compression and pyramids. Pyramids
provide additional raster layers with larger spatial resolutions for zoomed-out viewing that take less time to
display than the original layer. A mosaic dataset is a data catalog for storing, managing, viewing, and querying
collections of raster datasets, often forming a continuous map when viewed. Although such a mosaic dataset is
viewed as a single mosaicked image, you also have access to each dataset in the collection. A mosaic dataset
also can store raster datasets of the same area for different times, with viewing of any time period’s map and
comparing different time periods.
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Tutorial 10-1: Process raster datasets
The ArcGIS Pro project that you will open has single-band raster datasets for land use and elevation,
downloaded from the US Geological Survey’s website. You’ll extract raster datasets for Pittsburgh from each
original dataset that has extents larger than Pittsburgh’s. Because raster datasets are rectangular, you’ll display
layers using Pittsburgh’s boundary as a mask: pixels in Pittsburgh’s rectangular extent but outside the city’s
boundary will still exist but will be given no color, while those within Pittsburgh will have assigned colors.
Finally, you’ll use the elevation layer to produce a hillshade layer, which is a shaded relief rendering of
topography created by using an artificial sun to add illumination and shadows.

Open the Tutorial 10-1 project

1. Open Tutorial10-1 from the Chapter10\Tutorials folder, and save it as Tutorial10-1YourName.

2. Use the Raster datasets bookmark. National Elevation Dataset (NED) is elevation data, and it will
look like topography after you create a hillshade for it. LandUse_Pgh has land-use categories but
must have its layer file applied to get its color map and code descriptions for interpretation.
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Examine raster dataset properties
Raster datasets have considerable metadata that you can read as properties.

1. In the Contents pane, right-click NED, and click Properties > Source. The dataset is in the
Chapter10.gdb file geodatabase, where the dataset was imported from its original raster format. The
elevation units are in feet above sea level.

2. Click Raster information. The raster dataset has one band with 1,984 rows and 2,106 columns, for a
total of 4,178,304 cells. The cells have roughly 90-foot (30-meter) resolution. The raster has
pyramids for speedy display when zooming out.

3. Scroll down and click Statistics. The average elevation in the raster dataset is 323.7 feet, with a
minimum of 206.9 feet and a maximum of 443.2 feet above sea level.

4. Click Extent. The four values provided are state plane coordinates in feet that you can use to specify
the four corners of the rectangular extent of the raster dataset.

5. Click Spatial Reference. Here you see that the coordinates are in state plane feet for southern
Pennsylvania, which uses a Lambert Conformal Conic projection tuned for southern Pennsylvania.

6. Click Cancel.

YOUR TURN
Review the properties of LandUse_Pgh. Notable are that the raster format is TIFF, a common image
format. Its resolution is 30 meters, with a single band and a color map (which is available in a separate
layer file that you’ll use in an exercise that follows). It has a projection for the lower 48 states (Albers
Equal Area) that distorts direction (which explains why it’s tilted).

Import a raster dataset into a file geodatabase
Next, you’ll import LandUse_Pgh.tif into the Chapter10.gdb file geodatabase.

1. On the Analysis tab, click Tools.

2. In the Geoprocessing pane, search for and open the Raster To Other Format tool.

3. For the Input rasters field, browse to Chapter10\Data, select LandUse_Pgh.tif, and click OK.

4. For Output workspace, browse to Chapter10\Tutorials, select Chapter10.gdb, and click OK.

5. For Raster format, select Esri Grid, run the tool, and close it when it finishes.

6. Remove LandUse_Pgh.tif from the Contents pane, add LandUse_Pgh from Chapter10.gdb, and
move it below NED in the Contents pane. Nothing appears to change on the map, but the source of
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LandUse_Pgh is now the Esri Grid.

Set the geoprocessing environment for raster analysis
Environmental settings affect how geoprocessing is carried out by tools in the current project. You’ll set the
cell size of raster datasets you create to 50 feet, and you’ll use Pittsburgh’s boundary as the default mask.

1. On the Analysis tab, click Environments.

2. In the Environments settings for the Raster Analysis category, type 50 for Cell Size, and select
Pittsburgh for the default mask.

3. Click OK.

Extract land use using a mask
Next, you’ll use the Extract By Mask tool to extract LandUse_Pittsburgh from LandUse_Pgh. The resulting
raster dataset will have the same extent as Pittsburgh and therefore be a much smaller file to store than the
original.

1. In the Geoprocessing pane, search for and open the Extract By Mask tool.

2. Type or make the selections as shown. Note that the Extract By Mask tool has you specify the mask
layer explicitly, in case you want to override the default mask you set in Environments.

3. Click Run, and close the Geoprocessing pane when the tool is finished. ArcGIS Pro applies an
arbitrary color scheme to the new layer.

4. Remove LandUse_Pgh from the Contents pane.

5. Open the Catalog pane, expand Databases and Chapter10.gdb, right-click LandUse_Pgh, and click
Delete > Yes.

6. Use the Pittsburgh bookmark.

YOUR TURN
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Extract NED_Pittsburgh from NED using the Extract By Mask tool. In the Geoprocessing pane, for

Extract by Mask, click Environments and then the Select coordinate system button  on the right of
Output Coordinate System. Expand Projected coordinate system > State Plane, NAD 1983 (US Feet),
select the projection for Pennsylvania South, and click OK. Then on the Parameters tab, select NED as
input raster, Pittsburgh as the mask, and NED_Pittsburgh as the output raster, and run the tool. After
creating NED_Pittsburgh, remove NED from the map and delete it from Chapter10.gdb.

Symbolize a raster dataset using a layer file

1. Open LandUse_Pittsburgh’s Symbology pane, and click the Menu button  > Import symbology.

2. Browse to Chapter10\Data, double-click LandUse.lyr, and turn off NED_Pittsburgh.

3. In the Contents pane, expand LandUse_Pgh to see land-use categories and their colors. The code
values stored in the raster’s band are integers, and you can see them by looking at the layer’s
Symbology pane.

4. Close the Symbology pane.

Create hillshade for elevation
Hillshade provides a way to visualize elevation. The Hillshade tool simulates illumination of the earth’s
elevation surface (the NED raster layer) using a hypothetical light source representing the sun. Two
parameters of this function are the altitude (vertical angle) of the light source above the surface’s horizon in
degrees and its azimuth (east–west angular direction) relative to true north. The effect of hillshade to elevation
is striking because of light and shadow. You can enhance the display of another raster layer, such as land use,
by making land use partially transparent and placing hillshade beneath it. You’ll use the default values of the
Hillshade tool for azimuth and altitude. The sun for your map will be in the west (315°) at an elevation of 45°
above the northern horizon.
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1. Search for and open the Hillshade (Spatial Analyst Tools) tool.

2. Type or make the selections as shown.

3. Run the tool, and close it when it finishes.

Symbolize hillshade
The default symbolization of hillshade can be improved upon, as you’ll do next.

1. Open the Symbology pane for Hillshade_Pittsburgh.

2. Type or make the selections as shown.

3. Close the Symbology pane. The Hillshade looks better, although you can see the 30 m pixels of the
layer.
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Use hillshade for shaded relief of land use
Next, you’ll make LandUse_Pittsburgh partially transparent and place Hillshade_Pittsburgh beneath it to give
land use shaded relief.

1. Move LandUse_Pittsburgh above Hillshade_Pittsburgh, turn on LandUse_Pittsburgh, and turn off
NED_Pittsburgh (if it’s on).

2. With LandUse_Pittsburgh selected in the Contents pane, on the Raster Layer contextual tab, click
Appearance.

3. In the Effects group, move the Layer Transparency slider to 33.0 %. Hillshade_Pittsburgh shows
through the partially transparent LandUse_Pittsburgh, giving the land-use layer a rich, 3D-like
appearance.

Create elevation contours
Another way to visualize elevation data—elevation contours—is with lines of constant elevation, as commonly
seen on topographic maps. For Pittsburgh, the minimum elevation is 215.2 feet and the maximum is 414.4
feet, with about a 200-foot difference. If you specify 20-foot contours, starting at 220 feet, there will be about
10 contours. Note that the output contours are vector line data (and not polygon data).

1. In the Geoprocessing pane, search for and open the Contour (Spatial Analyst) tool.

325



2. Type or make your selections as shown. The Z factor can be used to change units. For example, if the
vertical units were meters, you would enter 3.2808 to convert to feet. We’ll leave the value at 1,
because the vertical dimensions are already in the desired units of feet.

3. Run the tool, and close the Geoprocessing pane when the tool is finished.

4. Turn off LandUse_Pittsburgh and Hillshade_Pittsburgh.

5. Open the Symbology pane for Contour_Pittsburgh, and use Single Symbols for Symbology with a
medium-gray line of width 0.5. Note that you could label contours with their contour elevation values
when zoomed in, but you will not do that in this exercise.

6. Save and close your project.
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Tutorial 10-2: Make a kernel density (heat) map
Kernel density smoothing (KDS) is a widely used method in statistics for smoothing data spatially. The input
is a vector point layer, often centroids of polygons for population data or point locations of individual
demands for goods or services. KDS distributes the attribute of interest of each point continuously and
spatially, turning it into a density (or “heat”) map. For population, the density is, for example, persons per
square mile.

KDS accomplishes smoothing by placing a kernel, a bell-shaped surface with surface area 1, over each
point. If there is population, N, at a point, the kernel is multiplied by N so that its total area is N. Then all
kernels are summed to produce a smoothed surface, a raster dataset.

The key parameter of KDS is its search radius, which corresponds to the radius of the kernel’s footprint. If
the search radius is chosen to be small, you get highly peaked “mountains” for density. If you choose a large
search radius, you get gentle, rolling hills. If the chosen search radius is too small (for example, smaller than
the radius of a circle that fits inside most polygons that generate the points), you will get a small bump for
each polygon, which does not amount to a smoothed surface.

Unfortunately, there are no really good guidelines on how to choose a search radius, but sometimes you
can use a behavioral theory or craft your own guideline for a case at hand. For example, crime hot spots (areas
of high crime concentrations) often run the length of the main street through a commercial corridor and
extend one block on either side. In that case, we use a search radius of one city block’s length.

Open the Tutorial 10-2 project
The map in this tutorial has the number of myocardial infarctions (heart attacks) outside of hospitals
(OHCA) during a five-year period by city block centroid. One of the authors of this book studied this data to
identify public locations for defibrillators, devices that deliver an electrical shock to revive heart attack victims.
One location criteria was that the devices be in or near commercial areas. Therefore, the commercial area
buffers are commercially zoned areas, plus about two blocks (600 feet) of surrounding areas.

KDS is an ideal method for estimating the demand surface for a service or good, because its data
smoothing represents the uncertainty in locations for future demand, relative to historical demand. Also in
this case, heart attacks, of course, do not occur at block centroids, so KDS distributes heart attack data across
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a wider area.

1. Open Tutorial10-2 from EsriPress\GIST1Pro\Exercises\Chapter10 and save it as Tutorial10-
2YourName.

2. Use the Pittsburgh bookmark.

Run KDS
Blocks in Pittsburgh average about 300 feet per side in length. Suppose that health care analysts estimate that
a defibrillator with public access can be identified for residents and retrieved for use as far away as 2½ blocks
from the location of a heart attack victim. They thus recommend looking at areas that are five blocks by five
blocks in size (total of 25 blocks or 0.08 square miles), 1,500 feet on a side, with defibrillators located in the
center. With this estimate in mind, you’ll use a 1,500-foot search radius to include data within reach of a
defibrillator, plus data beyond reach to strengthen estimates.

The objective is to determine whether Pittsburgh has areas that are roughly 25 blocks in area and, as
specified by policy makers, have an average of about five or more heart attacks a year outside of hospitals.

1. Search for and open the Kernel Density tool.

2. Click Environments, and for Cell size, type 50, and for Mask, select Pittsburgh. Note that
environment settings made in the tool apply only to running the tool itself and not to other tools,
such as when you set Environments on the Analysis tab.

3. Click Parameters, and type or make the selections as shown.
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4. Run the tool, and close it when it finishes.

5. Turn off the OHCA and Commercial Area Buffer layers to see the smoothed layer. The default
symbolization is not effective in this case, so next you’ll resymbolize the layer.

6. Change the smoothed layer’s symbology to use Classify as Symbology, Standard Deviation for
method with ¼ standard deviation interval size, and the green to yellow to red color scheme.

7. Close the Symbology pane. The smoothed surface provides a good visualization of the OHCA data,
whereas the original OHCA points, even with size-graduated point symbols for number of heart
attacks, are difficult to interpret. Try turning the OHCA layer on and off to see the correspondence
between the raw-versus-smoothed data. Note that the densities are in heart attacks per square mile
and that the maximum is nearly 1,000 per square mile over five years. Although seemingly large, a
square mile is a very large area in a city. The target area of 25 blocks is only 0.08 square miles. Also,
only a small part of Pittsburgh (and much less than a square mile) has a density of nearly 1,000 heart
attacks per square mile.
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8. Save your project.

Create a threshold contour layer for locating a service
Assuming that target areas will be around a tenth of a square mile in area, suppose policy makers decide on a
threshold of 250 or more heart attacks per square mile in five years (or 50 per square mile per year). Next,
you’ll create vector contours from the smoothed surface to represent this policy.

1. Search for and open the Contour List (Spatial Analyst) tool.

2. Make the selections or type as shown. You’ll create only one contour, 250, for the threshold defining a
target area.

3. Run the Contour List tool, close the tool when it finishes, turn off HeartAttackDensity and Rivers,
and turn on Commercial Area Buffer. Relatively few areas—seven—meet the criterion, and three of
those areas appear quite small. All seven threshold areas are in or overlap commercial areas, so you
can consider all seven as potential sites for defibrillators. Do any of the areas have the expected
number of heart attacks per year to warrant defibrillators? The next exercise addresses this question.
Turn the Commercial Area Buffer off.
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Estimate the number of annual heart attacks using threshold areas
To estimate annual heart attacks, you can select OHCA centroids within each threshold area, sum the
corresponding number of heart attacks, and divide by 5 since OHCA is a five-year sample of actual heart
attacks. You will use the Threshold boundaries in a selection by location query, in which case the Threshold
layer must be polygons. However, if you examine the properties of the Threshold layer, you’ll see that it has
the line vector type and not polygon type, even though all seven areas look like polygons. The tool you ran to
create Thresholds creates lines because some peak areas of an input raster could overlap with the border of the
mask—Pittsburgh, in this case. The lines for such cases would not be closed but left open at the border.
Nevertheless, ArcGIS Pro has a tool to create polygons from lines that you’ll use next.

1. In the Geoprocessing pane, search for and click the Feature To Polygon tool.

2. Type or make the selections as shown.

3. Run the tool, and close the tool after it finishes.

4. Search for the Summarize Within tool, and make the following selections as shown. In effect, this
tool runs the Summary tool several times—in this case, once for each polygon in the ThresholdAreas
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feature class to calculate corresponding statistics in the OHCA feature.

5. Run the tool, and close the tool after it finishes.

6. Open the SummarizeAreas attribute table, and sort it by Sum Total descending. One of the
ThresholdAreas polygons had no OHCA points inside the polygon but was surrounded by points
that contributed its peak density. Clearing the “Keep polygons with no points” check box eliminated
that polygon from being summarized. The best candidate for a defibrillator has an annual average of
104/5 = 20.8 heart attacks per year and is not in the central business district (CBD) but is the large
area on the east side of Pittsburgh. The CBD is in the second row with an average of 68/5 = 13.6
heart attacks per year. The last row’s area is the only one that does not meet the criterion of at least
five heart attacks per year on average, with 4.2.

Next, you will find the ThresholdAreas polygon that has no OHCA points and is not included in the previous
table. The polygon (pink fill color) is about a city block in size and is predicted to be the peak density area on
the basis of contributions from the kernels of nearby OHCA points, but it has no points itself! Given the
polygon’s small size, its 28 nearby heart attacks in the five-year sample, and its distance within five blocks of
the peak area, perhaps the polygon also warrants consideration as a defibrillator site.
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Tutorial 10-3: Building a risk index model
In this tutorial, you learn more about creating and processing raster map layers. You also are introduced to
ArcGIS Pro’s ModelBuilder to build models. A model, also known as a macro, is a computer script that you
create without writing computer code (a script runs a series of tools). Instead of writing computer code, you
drag tools to the model’s canvas (editor interface) and connect them in a workflow. Then ArcGIS Pro writes
the script in the Python scripting language. Ultimately, you can run your model just as you would any other
tool.

The model that you will build in this tutorial calculates an index for identifying poverty areas of a city by
combining raster maps for these poverty indicators:

Population below the poverty income line
Female-headed households with children
Population 25 or older with less than a high school education
Number of workforce males 16 or older who are unemployed

Low income alone is not sufficient to identify poverty areas, because some low-income persons have
supplemental funds or services from government programs or relatives, and so rise above the poverty level.
Female-headed households with children are among the poorest of the poor, so these populations must be
represented when you consider poverty areas. Likewise, populations with low educational attainment and/or
low employment levels can help identify poverty areas.

Dawes1 provides a simple method for combining such indicator measures into an overall index. If you have
a reasonable theory that several variables are predictive of a dependent variable of interest (whether the
dependent variable is observable or not), Dawes contends that you can proceed by removing scale from each
input and then average the scaled inputs to create a predictive index. A good way to remove scale from a
variable is to calculate z-scores, subtracting the mean and then dividing by the standard deviation of each
variable. Each standardized variable has a mean of zero and standard deviation of one (and therefore no scale).

Table 10-1 for Pittsburgh block groups shows that if you simply averaged the four variables, the variable
female-headed households would have a small weight, given its mean of only 36.1, while the means of the
other three variables are all higher than 100. Z-scores level the playing field so that all variables have an equal
role.
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Table 10-1

The workflow to create the poverty index has three steps:

1. Calculate z-scores for each of the four indicators.

2. Create kernel density maps for all four z-score variables. Although you need the kernel density
maps as input to the third step, you should also study them individually to understand their
spatial patterns in relationship to the poverty index.

3. Use a tool to average the four weighted raster surfaces and create the index raster layer.

Experts/stakeholders in the policy area using the raster index can judgmentally give more weight to some
variables than others if they choose. They must only use nonnegative weights that sum to one (1). So if
judgmental weights for four input variables are 0.7, 0.1, 0.1, and 0.1, then the first variable is seven times
more important than each of the other three variables. With different stakeholders possibly having different
preferences, having a macro would allow you to repeatedly run the macro with different sets of weights for the
multiple-step process for creating an index raster layer. For example, some policy makers (educators and
grant-making foundations) may want to emphasize unemployment or education and give those inputs more
weight than others, whereas other stakeholders (human services professionals) may want to heavily weight
female-headed households.

Standardizing the input variables need only be done once, so you’ll do that step manually, but then you’ll
complete parts 2 and 3 of the workflow using a ModelBuilder model for creating indexes.

Open the Tutorial 10-3 project
All input variables must come from the same point layer (block group centroids, in this case) as input to build
the index so that the data standardization and averaging process is valid. You’ll use a 3,000-foot buffer of the
study region (Pittsburgh) for two purposes.

First, KDS uses the northernmost, easternmost, southernmost, and westernmost points of its input point
layer to define its extent. If the inputs are polygon centroids in a study region, the corresponding KDS raster
map will be cut off and not quite cover the study region. The block group centroids added by the buffer yield
KDS rasters that extend a bit beyond Pittsburgh’s border, but the Pittsburgh mask will show only the portion
within Pittsburgh.

Second, in applying KDS, the buffer eliminates the boundary problem for estimation caused by abruptly
ending data at the city’s edge. KDS estimates benefit from the additional data provided by the buffer beyond
the city’s edge.

1. Open Tutorial10-3 from EsriPress\GIST1Pro\Exercises\Chapter10, and save it as Tutorial10-
3YourName.
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2. Use the Pittsburgh bookmark.

Standardize an input attribute
PittsburghBlkGrps already has three out of four input attributes standardized and ready to use in the poverty
index you’ll compute, but FHHChld has not yet been standardized. For practice purposes, you will
standardize this attribute next.

1. Open the attribute table of PittsburghBlkGrps, and scroll to the right to see FHHChld (female-
headed household with children).

2. Right-click the FHHChld column header, click Summarize, and type or make the selections as
shown. Be sure to click on the left of the case field, and click its red X to clear it.

3. Run the tool, close the Geoprocessing pane when the tool is finished, close the attribute table, and
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open the output table, PittsburghBlkGrps_Statistics. Rounded to one decimal place, the mean of
FHHChld is 36.1, and its standard deviation is 41.6.

4. In the Contents pane, right-click PittsburghBlkGrps, and click Design > Fields.

5. Scroll to the bottom of the Fields table, and click to add a new field.

6. Type ZFHHChld for Field name, select Float for Data type, click Save, and close Fields.

7. In the PittsburghBlkGrps attribute table, right-click the ZFHHChld column heading, click
Calculate Field, create the expression  for ZFHHChld, and click Run.
As a check, the ZFHHChld value for the record for ObjectID = 1 is –0.146635.

8. Close the Geoprocessing window and the attribute table, and save your project.

Set the geoprocessing environment for raster analysis
You’ll set the cell size of rasters you create to 50 feet, and you’ll use Pittsburgh’s boundary as a mask.

1. On the Analysis tab, click Environments.

2. In the Raster Analysis section of Environments, type 50 for Cell Size, and select Pittsburgh for the
mask.

3. Click OK.

Create a new toolbox and model
A toolbox is just a container for models (macros). When your project was created, ArcGIS Pro built a toolbox,
named Chapter10.tbx, which is where your model will be saved.

1. On the Analysis tab in the Geoprocessing group, click ModelBuilder.

2. Open the Catalog pane, expand Toolboxes, expand Chapter10.tbx, right-click Model, and click
Properties.

3. For Name, type PovertyIndex (with no blank space between the two words); for Label, type Poverty
Index; and click OK.

4. Hide the Catalog pane.

5. On the ModelBuilder tab in the Model group, click Save.

Add processes to the model
ModelBuilder has a drag-and-drop environment: you’ll search for tools, and when you find them, you’ll drag
them to your model, open their input/output/parameter forms, and fill the forms out.
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1. Search for, but do not open, the Kernel Density tool.

2. Drag the Kernel Density tool to your model.

3. Drag the model and its output to the upper center of the model window, and click anywhere in the
model’s white space to deselect Kernel Density and its output. You’ll need a total of four kernel
density processes, one for each of the four poverty indicators. So, next, you’ll drag the tool to the
model three more times.

4. Repeat step 2 three more times, and then arrange your model elements as shown in the figure by
dragging rectangles around elements to select them, and then dragging the selections.

5. Close the Geoprocessing pane.

6. Search for the Raster Calculator tool, drag it to the right of your other model components, and close
the Geoprocessing pane.

Configure a kernel density process

1. Double-click the first Kernel Density process, type or make the selections as shown, and then click
OK. Fully configured processes and their valid inputs and outputs are given color fill as you see now.

338



The 3,000-foot search radius is a judgmental estimate large enough to produce good KDS surfaces at
the neighborhood level.

2. Right-click Kernel Density, and rename it FHH Kernel Density.

3. Click the ModelBuilder tab, and save your model.

YOUR TURN
Configure three remaining Kernel Density processes, each with PittsburghBlkGrps as the input, a cell
size of 50, and a search radius of 3,000, and with population fields ZNoHighSch, ZMaleUnem, and
ZPoverty. Resize model elements to improve readability. The numbers of the input block groups do not
have to match those in the figure. ModelBuilder just needs the names of all model elements to be
unique. Also, your model may not have separate inputs for each KDS process, but instead may have the
same PittsburghBlkGrps input to more than one KDS process. Resize model objects to make them
readable and well aligned. Review all four KDS processes to make sure that they have correct z-score
variable inputs and a 3,000-foot search radius. Save your model.
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Configure the raster calculator process

1. Double-click Raster Calculator, and type and make your selections as shown (double-click density
rasters to enter them into the expression). The 0.25 weights serve as default values for running the
model unless the user changes them as parameters for each weight that you will add later in this
tutorial.

2. Click OK.

3. Save the model.

Run a model in edit mode
You can run the entire model by clicking its Run button, which you will do next. When you build a model,
however, you can run each process one at a time by right-clicking processes and clicking Run, which gives you
an ability to isolate errors and fix them. When you finish, you’ll run the model in the Geoprocessing pane.

1. On the ModelBuilder tab in the Run group, click Run. The model runs and produces a log as shown
next. If there was an error, the log would give you information about it. Running in edit mode does
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not add PovertyIndex to the map. You’ll have to add it manually. However, when you run the model
as a tool in the Geoprocessing pane, PovertyIndex will be added to the map automatically (when you
make PovertyIndex a parameter). If errors arise, you would need to fix them, and then on the
ModelBuilder tab in the Run group, you would click Validate and run the model again.

2. Close the log file.

3. In the model, right-click PovertyIndex, and click Add to display.

4. Open your map, and turn off PittsburghBlkGrps. You’ll improve symbolization of PovertyIndex next.
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Symbolize a KDS raster layer, and save its layer file
Although vector layers should have a maximum of about seven to nine categories for symbolization of numeric
attributes (to avoid a cluttered map and allow easy interpretation using a legend), symbolization of raster layers
should have many more categories to represent continuous surfaces. You’ll use standard deviations to create
categories and the maximum number of categories with that method. Finally, you’ll save symbolization as a
layer file for automatic use whenever the model creates its output, PovertyIndex, with whatever weights the
user chooses.

1. Open the Symbology pane for PovertyIndex, select Classify for Symbology, Standard Deviation for
Method, ¼ standard deviation for Interval size, and the green to yellow to red Color scheme.
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2. With Poverty Index’s Symbology window still open, change the upper value of the largest category
from 15.358258 to 100. The change in upper value is a precaution so that if the weights used to run
the model lead to a maximum density greater than 15, the higher-density pixels will fall in this
category.

3. Close the Symbology pane.

4. Right-click PovertyIndex, click Save as layer file, and save as PovertyIndex to Chapter10\Tutorials.
You’ll use the layer file to symbolize PovertyIndex automatically in future runs of the model.

5. Remove PovertyIndex from the Contents pane.

Add variables to the model
One objective for the PovertyIndex model is to allow users to change the poverty index’s weights. To
accomplish this change, you must create variables that will store the weights that the user inputs, and then
designate each variable as a parameter input by the user. ModelBuilder automatically creates a user interface
for your model (just like the interface for any tool). The user can enter weights for your model in the interface
as an alternative to the default equal weights.

1. Open your model. Notice that each process and output has a drop shadow, indicating that it’s been
run and is finished.

2. On the ModelBuilder tab in the Run group, click Validate. Validate places all model components in
the state of readiness to run again. The drop shadows disappear.

3. On the ModelBuilder tab in the Insert group, click the Variable button, select Variant for Variable
data type, click OK, and move the Variant variable above the Raster Calculator process. ArcGIS Pro
can determine the actual data type of a variant data type variable from entered values. For example,
when you give the variable the value 0.25 in step 4, ArcGIS Pro will treat the value as a numeric
variable.

4. Right-click the variable, click Open, type 0.25, and click OK. The value of 0.25 is the default value
for running the model if the user does not change it.

5. Right-click the Variant variable, click Rename, type FHHWeight, and press Enter.

6. Right-click FHHWeight, and click Parameter. That action places a letter P near the variable, making
the variable a parameter. In other models you might build, consider making the model inputs (the
four rasters, in this case) parameters if they can change from run to run. Then users could browse for
these parameters when they run the model as a tool.

YOUR TURN
Add three more variant variables, all with value 0.25, and named NoHighSchWeight,
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MaleUnemWeight, and PovertyWeight. Make each variable a parameter. Save your model.

Use in-line variable substitution
In this exercise, you will transfer the weights stored in variables (values that will be input by the user) to
parameters of the Raster Calculator tool. The mechanism is called “in-line substitution” because the variables’
values are substituted for the model’s parameter values.

1. Open the Raster Calculator process in the model.

2. Select and then delete the first 0.25 in the expression, leave the cursor in its current position at the
beginning of the expression, scroll down in the Rasters pane, and double-click FHHWeight to enter
it into the expression where the 0.25 had been.

3. Delete the double quote marks around “%FHHWeight%”.

4. Likewise, select appropriate 0.25 weights for the remaining rasters, yielding the finished expression as
follows:
%FHHWeight% * “%FHHDensity%” + %NoHighSchWeight% * “%NoHighSchDensity%” +
%MaleUnemWeight% * “%MaleUnemDensity%” + %PovertyWeight% * “%PovertyDensity%”

5. Click OK. Your Raster Calculator process and its output will get color, and you will validate the
process in the next step.

6. On the ModelBuilder tab in the Run group, click Validate.

344



7. Save your model.

Use a layer file to automatically symbolize the raster layer when created
You’ll use the layer file you created earlier for the poverty index for this task. To do so, you must make the
PovertyIndex output of the Raster Calculator process a parameter in the model.

1. Make PovertyIndex a parameter.

Making PovertyIndex a parameter also adds it to the Contents pane for display in your map when you
run the model as a tool from the Geoprocessing pane.

2. Open the Catalog pane, expand Toolboxes > Chapter10, right-click PovertyIndex, and click
Properties > Parameters.

3. Scroll to the right, and under the Symbology column heading, click the cell for the row with the label
PovertyIndex.

4. In that cell, click the resulting browse button, navigate to Chapter10\Tutorials, and double-click
PovertyIndex.lyrx.

5. Click OK, hide the Catalog pane, and save and close your model.

Run your model
Congratulations, your model is ready to use.

1. With your map open, ensure that PovertyIndex is removed from the Contents pane.

2. On the Analysis tab, click Tools, and search for and open your Poverty Index model.
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3. Leave the weights at their default settings, and run the model. See that the model computes the
poverty index, adds the index to the Contents pane, and symbolizes it with your layer file.

4. Save your project.

YOUR TURN
Remove PovertyIndex from the Contents pane, and try running your model with different weights
(nonnegative and sum to one), such as 0.7, 0.1, 0.1, and 0.1. See how the output changes a lot. Note that
for a class project or work for a client, you should symbolize PovertyIndex manually to get the best color
scheme and categories for a final model, depending on the distribution of densities produced. To do this
symbolization, you must go to the model properties and delete the layer file. Otherwise, ArcGIS Pro will
not let you change symbolization. When you finish, save your project and close ArcGIS Pro.

Assignments
This chapter has two assignments to complete that you can download from this book’s resource web page,
esri.com/gist1arcgispro:

Assignment 10-1: Create raster maps for the Pittsburgh Almono development area.
Assignment 10-2: Estimate heart attack fatalities outside of hospitals in Wilkinsburg by gender.

1. Robyn M. Dawes, “The Robust Beauty of Improper Linear Models in Decision Making,” American Psychologist 34, no. 7 (1979)
: 571–82.
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CHAPTER 11

3D GIS
LEARNING GOALS

Explore global scenes.
Learn how to navigate scenes.
Create local scenes and TIN surfaces.
Create Z-enabled features.
Create 3D buildings and bridges from lidar data.
Work with 3D features.
Use procedural rules and multipatch models.
Create an animation.

Introduction
This chapter introduces ArcGIS Pro’s 3D display and processing of data and maps. 3D maps provide insights
that are not readily apparent from 2D visualization of the same data. For example, instead of inferring the
presence of a valley from 2D contours, in 3D you see the valley and the difference in height between the valley
floor and a ridge. 3D maps allow you to design, visualize, communicate, and analyze for better decision-
making.

Navigation of ArcGIS Pro in 2D and 3D are similar; however, there are differences when you explore
maps with data, such as raster surfaces, lidar data, and 3D features. ArcGIS Pro uses 3D scenes and one of
these two viewing modes. The first, global, is for large-extent, real-world content where the curvature of the
earth is important. The second, local, is for smaller extent content in a projected coordinate system or cases in
which the curvature of the earth isn’t important. You can easily switch scenes between global and local. You
can also modify a scene’s settings, depending on the scale of the project. Rendering 3D scenes is slower than
rendering 3D maps, and proper computer hardware and configuration is necessary.

This chapter explains procedural methodologies that allow for rapid creation of 3D content. The
methodologies describe how to construct multiple 3D models on the basis of feature attributes—such as
building heights and roof shape types—rather than creating a single, specific 3D model. Procedural rules,
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which define patterns, are authored in Esri® CityEngine® a 3D modeling software for urban environments.
Procedural rules can be reused in other parts of the ArcGIS platform after they have been exported as rule-
package files.

This chapter also explains the use of lidar data and visual analysis tools such as line of sight and introduces
3D animation.
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Tutorial 11-1: Explore a global scene
Global scenes use a default elevation surface, WorldElevation3D/Terrain3D, from an ArcGIS Online map
service. The fixed coordinate system is GCS WGS 1984 and cannot be changed. In this tutorial, you will
explore a global scene’s properties and learn how to navigate in 3D. Advantages of the global scene include
working in large or multiple geographic areas, enhanced illumination and time effects, and publishing 3D
content to a Web Scene.

Open the Tutorial 11-1 project

1. Open Tutorial11-1.aprx from Chapter11\Tutorials, and save it as Tutorial11-1YourName.aprx. The
project opens with a 3D scene using a default elevation surface, Terrain3D, from an Esri map service.
In the Contents pane, 3D Scene is labeled with a globe icon, indicating that it’s a global scene. A
global scene whose extent is not clipped includes the entire surface of the earth.

2. Use the Study Area bookmark. The map zooms to a study area of the City of Pittsburgh, including
the Central Business District, North Shore, South Shore, and Mount Washington neighborhoods.
The map includes no added GIS features yet, just a basemap used as an elevation surface.
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Explore a scene’s properties
The scene’s elevation surface is different from a basemap, and understanding the elevation surface, map units,
and heights are important in a 3D scene.

1. In the Contents pane, right-click 3D Scene> Properties.

2. In the Map Properties: 3D Scene window, click Elevation Surface, and expand Elevation sources.
The scene’s elevation source is visible, showing the elevation Service Name,
WorldElevation3D/Terrain3D, and its location from ArcGIS.com.

3. Click General, and under Elevation Units, click Feet, and then click OK. The map and display units
will remain decimal degrees for now—only the elevation units change.
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Navigate a scene with a mouse and keyboard keys
Next, view the map using a predefined 3D bookmark, and explore using mouse and keyboard shortcuts.

1. Use the Rivers bookmark. The view shows that the terrain is higher in the Mount Washington
neighborhood, on the left of the view.

Sometimes, you can get disoriented in a 3D view, so learning a few useful shortcuts can help return you to
a familiar orientation. Experiment with the keyboard shortcuts, commonly used to manipulate a 3D view,
in the next set of steps.

2. Press and drag the middle mouse button to adjust (tilt) the view.

3. On the keyboard, press the J or U key to move the map up or down.

4. Press the A or D key to rotate the view clockwise or counterclockwise.

5. Press the W or S key to tilt the camera up and down.

6. Press the left, right, up, or down arrow keys to move the view.

7. Press the B key with the left mouse or arrow keys to look around your view.

8. Press the N key to view true North.

9. Press the P key to look straight down at your map.

Change the basemap
Various basemaps can be displayed with the current surface elevation. If you want to see imagery details, they
will be draped to the elevation surface.
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1. Use the Football Stadium bookmark.

2. Change the basemap to Imagery. The imagery drapes to the elevation surface showing the football
stadium, rivers, and trees along the hills above Pittsburgh’s South Shore, and so on.

3. Use the Baseball Stadium bookmark and the mouse or keyboard to see additional views.

4. Change the basemap back to Topographic.

YOUR TURN
Explore another geographic area of the world, perhaps your hometown, your favorite vacation spot, or a
city or an area you have always wanted to visit.

Exaggerate and apply a shade and time to a surface
Sometimes, subtle or important changes in the landscape can be emphasized by adding visual effects to the
layer. For example, you can graphically exaggerate the height of a mountainous area to help it stand out. This
exaggeration does not actually change the elevation but visually makes features more prominent. Another
effect includes adding lighting or illumination sources through shading or time of day.

1. Use the Rivers bookmark, open the 3D scene’s properties, and click Elevation Surface.

2. For Exaggeration, type 1.5, and turn on Shade surface relative to the scene’s light position.

3. Click Illumination, click Date and time, and click OK. The elevation will be exaggerated, and the sun
shadows are visible and depend on the date and time selected.

YOUR TURN
Pan and navigate the scene to see the exaggeration from different views. Navigate to another area you
know is mountainous. Use the Rivers bookmark to return to Pittsburgh. Save your project.
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Tutorial 11-2: Create a local scene and TIN surface
Advantages of local scenes include using your own elevation surface data such as TIN (triangulated irregular
network) or lidar data, using a projected coordinate system, managing features below a surface (for example,
subways or water lines), and perhaps more accessibility to edit data. You can also set the coordinate system for
a local scene to local coordinates (for example, state plane), and use the surface offline. In this tutorial, you will
create a TIN surface from contours, change its symbology, and use it as the elevation surface in a local scene.

Open the Tutorial 11-2 project

1. Open Tutorial11-2.aprx from Chapter11\Tutorials, and save it as Tutorial11-2YourName.aprx. The
project opens with a 3D scene named TIN Surface Scene with 2D layer contours, street curbs, parks,
and rivers draped to the default Terrain3D elevation surface in a global scene. The basemap is Light
Gray Canvas, covering the entire earth. You will convert the global scene to a local scene and clip the
basemap to the study area. Unlike the Clip tool, this process “clips” the layers for display purposes
only.

Set a local scene

1. On the View tab in the View group, click the Local button . The scene switches from a global to a
local scene, and the icon in the Contents pane and on the view updates. Next, you clip the base layer
to the study area using the Contours layer.

2. In the Contents pane, right-click TIN Surface Scene > Properties > Extent.

3. Click Custom extent, and for Calculate from, click Contours.

4. Turn Clip layers to extent on, and click OK.
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5. Use the 3D View bookmark. The basemap will now display only to the extent of the vector features in
the study area in the local scene.

Create a TIN surface
A TIN surface is a vector data model composed of irregularly distributed nodes and lines that are formed from
x-, y-, and z-values and arranged in a network of triangles that share edges. TINs are typically used for high-
precision modeling of small areas, such as in engineering applications, in which they are useful because they
allow calculations of surface area and volume. TIN surfaces are also useful to view underground features or
utilities. Here, you create a TIN from the topography contour map.

1. On the Analysis tab, click the Tools button, and search for and open the Create TIN tool.

2. Type or make the selections as shown.
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3. Run the tool, and close it after it finishes.

4. In the Contents pane, turn off Contours and Light Gray Canvas basemap, and expand PGH_TIN.
The TIN elevation is displayed with elevation heights from high to low.

Change the scene’s surface and coordinate system
The local TIN surface can now replace the surface assigned from the map service.

1. In the Contents pane, right-click TIN Surface Scene > Properties > Elevation Surface > Elevation
sources. The dataset PGH_TIN should be the first surface listed as an elevation source using your
local drive as the location.

2. Click the red X beside elevation source WorldElevation3D/Terrain3D. This step removes this
surface as an elevation source.
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3. Click Coordinate Systems. The coordinate system should be the projected coordinate system NAD
1983 State Plane Pennsylvania South FIPS 3702 (US Feet).

4. Click OK, and remove World Light Gray Canvas Base from the Contents pane. Wait for the scene
to redraw its features. The scene is now set to local coordinates and TIN as the surface data that could
be used offline.

YOUR TURN
TIN units should be in feet or meters, not decimal degrees. Change the scene’s properties for display and
elevation units to feet, the default unit for NAD 1983 State Plane Pennsylvania South.

Change the TIN’s symbology
The symbology of a TIN can be changed to better reflect features that the surface model represents. Next, you
add the contour and slope symbology renderers.

1. In the Contents pane, click PGH_TIN.

2. On the Appearance tab in the Drawing group, click the Symbology arrow  and the Slope button 

.

3. On the Symbology pane, under Draw using, click Simple. Then change the color of the current
symbol color to Land.
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4. Close the Symbology pane, and zoom to better see the features at all elevations.

5. Use the mouse wheel to view the scene from different angles, including below the scene.

6. Save your project.
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Tutorial 11-3: Create Z-enabled features
You can create 3D content in different ways, and the corresponding workflows depend on the type of features
you create. In addition to creating 3D features from scratch, you can import 3D models and symbolize 2D
features as 3D features. You can also specify the source of your z-values when you create new features.
ArcGIS Pro’s Current Z control is used to set the 3D elevation source for drawing or obtaining z-values. This
option is useful if more than one source is defined for a global or local scene or if you have another source not
already included in the map.

In this tutorial, you create a new 3D feature class that is Z-aware. Then you use the Current Z control
tool to set the elevation source for populating z-values. The Current Z control has two modes, constant and
surface. Constant is used to create 3D features at an absolute height by typing in an exact value—for example,
a plane flying at a constant altitude. Surface uses z-values from the active elevation source you choose.

Open the Tutorial 11-3 project

1. Open Tutorial11-3.aprx from Chapter11\Tutorials and save it as Tutorial11-3YourName.aprx. The
map opens with 3D Trees Scene, a local scene using World Topographic as the elevation surface
whose extent is clipped to a Rivers layer and with a Parks layer draped to the surface.

2. Use the Point State Park bookmark. The map zooms to a large park at the confluence of Pittsburgh’s
three rivers.

Create a Z-enabled feature class for park trees
To take advantage of certain 3D editing capabilities, you must ensure an output feature class will have z-
values. The Create Feature Class geoprocessing tool lets you determine these settings. Here, you create a new,
empty 3D feature class, digitize new features, and populate z-values directly from the map’s surface. If you
need to check and see if a layer is Z-enabled, you can verify the data source information listed on the Source
page from the Layer Properties dialog box.

1. On the Analysis tab, click the Tools button, and in the Geoprocessing pane, search for and open the
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Create Feature Class tool.

2. Type or make the selections as shown.

3. Run the tool, and close it after it finishes.

4. Change the ParkTrees symbol to Circle 1 and color to Fir Green.

Digitize trees on surfaces using Z Mode

1. On the Edit tab, in the Elevation group, click the Z control button (Z Mode) . This step will turn
the Z control option on.

2. Click the Get Z From View button .

3. Click a point inside the center of Point State Park as shown in the figure to set the z-value (height).

Depending on where you click, the elevation height should be about 723 feet.
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4. On the Edit tab in the Features group, click the Create button .

5. In the Create Features pane, select ParkTrees.

6. Click about 10 points to digitize trees on each side of the park. It may take a moment to see each
point as you digitize it.

7. Save your edits, and clear the selection.

YOUR TURN
Use the Mt. Washington Park bookmark, set the z-value to various elevations along the large park below
Mt. Washington, and digitize about 20 trees at various elevations along the hill. Save your edits, and
turn the Z control off.

Use 3D symbols with real-world coordinates
3D tree symbols can be displayed as low resolution, high resolution, or thematic trees. Depending on the
number of features and map purpose, you will want to experiment with all three tree types.

1. Zoom to a few trees on one side of Point State Park.

2. In the Contents pane, click the symbol for ParkTrees, click Gallery, click All Styles, type Trees in the
search box, and press Enter.

3. Scroll to 3D Vegetation - Realistic, and click Norway Maple.

4. Close the Symbology pane, and zoom in and out. Trees get bigger and smaller depending on the
zoom. Next, you will set a fixed height using real-world units and turn shading on for even more
realistic trees.

5. In the Contents pane, right-click ParkTrees > Properties > Display, click the box next to Display 3D
symbols in real-world units, and click OK.

6. In the Contents pane, right-click 3D Trees Scene > Properties > Illumination, turn on Display
shadows in 3D, and click OK. Next, enter an exact height for the park trees.
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7. In the Contents pane, click the Park Trees symbol > Properties, and type 20 (m) for Size, click Apply,
and close the Symbology window.

8. Zoom in and out. Your scene is now populated with realistic-looking trees at a consistent height.

Add realistic preset trees using a table of a tree’s genus (type)
ArcGIS Pro provides preset layers for displaying features in a 3D map. For example, if you have a field with
the genus or general type of tree (for example, pine or Pinus), you can display multiple trees by their type.

1. On the Map tab in the Layer group, click Add Preset > Realistic Trees.

2. Navigate to Chapter 11 > Tutorials > Chapter11.gdb, select StreetTrees, and click OK.

3. In the Symbology pane, under Type, click GenusName, and close the Symbology window.

4. Use the Street Trees bookmark. Street trees are draped to various elevations and displayed using the
tree genus type.

5. Zoom out, and pan the map to see more street trees.

6. Save your project.
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Tutorial 11-4: Create features and line-of-sight analysis using lidar data
Lidar uses pulsed laser light from aircraft or drones to provide detailed elevation data and classification of land
cover that you can use to create 2D surfaces and 3D features. Geographic lidar data is commonly available as
lidar aerial survey (LAS) files, the industry standard of the American Society of Photogrammetry and Remote
Sensing. In this tutorial, LAS files were provided by Pictometry International Corporation for a study area of
Allegheny County, Pennsylvania.

The generation of 3D buildings from lidar LAS datasets requires two surface models, a digital surface
model (DSM) and a digital terrain model (DTM) that are then used to create a normalized, nDSM surface,
which is the difference between the DSM and DTM surfaces used to calculate building heights. The
normalized surface (nDSM) is applied to random points that are created for 2D building footprints. These
footprints are used to generate z-values (heights) for each random point. The z-value of the highest point is
the building height. The process finishes by creating a statistics table that selects the maximum z-value of the
random points that is joined to 2D building footprints, allowing for buildings to be extruded using that value.
Lidar data can also be used to determine line-of-sight obstructions between features such as buildings as seen
in the last exercise of this tutorial.

Open the Tutorial 11-4 project with a 3D scene

1. Open Tutorial11-4.aprx from the Chapter11\Tutorials folder, and save it as Tutorial11-
4YourName.aprx. The project opens with a 3D scene and the building footprints displayed as a 2D
layer and a World Light Gray basemap in a local view, with 2D layers for buildings and a lidar
delivery area used to clip the basemap. There is no height value in the building attribute table, so
buildings can be displayed only as flat 2D polygons for now. Additional layers of observer points used
for line-of-sight analysis and a 3D layer for bridges are turned off.

2. Use the 3D View bookmark.
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Create an LAS dataset
LAS files have points classified as bare earth, vegetation, buildings, and so on, and are created from original
large LAS (American Standard Code for Information Interchange, or ACSII) files, which can then be viewed
in 3D or made into raster layers.

An LAS dataset, created from original LAS data, provides fast access to lidar data without the need for
data conversion, making it easy to work with LAS files for a specific study area.

1. In the Geoprocessing pane, search for and open the Create LAS Dataset tool.

2. Under Input files, click the browse button, navigate to Chapter 11 > Data > LASFiles, and select the
six LAS files.

3. Type or make the changes as shown.
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4. Run the tool, and close it after it finishes. The lidar data values are clearly shown as raster points and
their values. The LAS dataset can be symbolized using elevations, slope, aspect, and so on.
Pittsburgh’s tallest building is the US Steel Building, the triangular building on the right side of the
study area.

5. Explore the 3D map from various locations, and then use the 3D View bookmark.

Generate a raster DSM (digital surface model)
DSMs represent the surface of the earth, including buildings, tree canopies, and other obstructions. Before
generating the DSM raster, you first filter lidar points to save processing. You will create a DSM using an
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interpolation type of binning, which is faster for processing, and a maximum cell assignment to find the
highest elevation point within each cell.

1. In the Contents pane, right-click Chapter11_LasDataset.lasd > LAS Filters > 1st Points.

2. On the Appearance tab, click the Tools button, and search for and open the LAS Dataset To Raster
tool.

3. Type or make selections as shown.

4. Run the tool, and close it after it finishes.

5. Turn the Chapter11_LasDataset.lasd and Bldgs layers off. The values of the DSM show the range of
elevations from high to low.

Generate a raster DTM (digital terrain model)
Next, you create the DTM, a bare-earth terrain surface, containing only the topology. In many cases, a DTM
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is the same as a digital elevation model (DEM). Before creating the raster, you filter the ground features.

1. Turn the DSM layer off.

2. Turn the Chapter11_LasDataset.lasd layer on, and in the Contents pane, right-click
Chapter11_LasDataset. lasd > LAS Filters > Ground. This will filter and show only the ground
features used to create the DTM.

3. Search for and open the LAS Dataset To Raster tool, and type or make the selections as shown. This
raster uses a different interpolation type of triangulation that takes a little longer to process but better
interpolates voids found in the earth’s surface.

4. Run the tool, and close it after it finishes. A raster surface of the earth’s features is created.

Create a normalized digital surface model (nDSM) raster
An nDSM surface is the difference between the DSM and DTM surfaces that is normalized to the bare-earth
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surface.

1. In the Geoprocessing pane, search for and open the Minus (3D Analyst Tools) tool.

2. Type or make the selections as shown.

3. Run the tool, and close it after it finishes. You now have a raster surface that can be applied to point
features used for buildings to determine their height.

Create random points for buildings
Randomly generated points are created for each building polygon, and then the nDSM raster surface is
applied to each random point. The point with the highest z-value will be used as the building height.

1. Turn the Chapter 11_LasDataset layer off and the Bldgs layer on.

2. In the Geoprocessing pane, search for and open the Create Random Points tool.

3. Type or make the selections as shown.

4. Run the tool, and close it after it finishes.
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YOUR TURN
Turn all layers off except BldgRandomPoints, and zoom in. Click various random points on each
building. Note that the 100 points for the US Steel Building will have a CID value of 521. Every
building has a unique CID value that you will use later to join to building footprints.

Add surface information to random points
Here, you assign Z (height) values from the nDSM raster surface to each random point by using the Add
Surface Information tool.

1. In the Geoprocessing pane, search for and open the Add Surface Information tool.

2. Type or make the selections as shown.

3. Run the tool, and close it after it finishes.

YOUR TURN
Click on various random points, and note that they now have z-values. The highest value for each
building will be used for the building height.

Assign a maximum value (height) to random points
The Summary Statistics tool will calculate the maximum z-value for all buildings using the building’s random
points. A text file is created that you will join back to buildings using the CID (unique value for each
building) field.

1. In the Geoprocessing pane, search for and open the Summary Statistics tool.

2. Type or make the selections as shown.
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3. Run the tool, and close it after it finishes.

YOUR TURN
Open the BldgHeights table, and sort the MAX_Z field in descending order. Look for CID 521; the
tallest building will be the US Steel Building. Close the table.

Join the maximum z-value (height) to building footprints, and display as 3D
buildings

1. In the Contents pane, right-click Bldgs > Joins and Relates > Add Join.

2. Join BldgHeights to Bldgs using BLDG_ID for Input Join Field and CID for Output Join Field.

3. Turn the Bldgs layer on, and drag it to 3D Layers in the 3D scene.

4. Turn BldgRandomPoints off, and use the 3D View bookmark.

5. On the Appearance tab in the Extrusion group, under Type, click Max Height and
[BldgHeights.MAX_Z] as the field. These steps required a lot of processing, but you now have 3D
buildings! Notice the residential buildings on the left of the view in the Mount Washington
neighborhood as opposed to the taller high-rise buildings in the Central Business District
neighborhood.
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6. Save your project.

Use lidar to determine bridge elevation heights
You can view and select lidar data points to determine the elevation height to draw bridges. Pittsburgh has
more than 750 bridges, but you will use data to find the height and digitize just one.

1. Turn the Bldgs layer off, and use the Fort Pitt Bridge bookmark. Turn the chapter11_LasDataset
layer on, and set the LAS Filters to All Points.

2. On the Map tab, click the Explore button, and click on various lidar points along the bridge to see the
z-values (height). Points at the top of the bridge span are approximately 920 feet, while points at the
bottom deck range from 770 feet to 800 feet. You will use 775 feet as the elevation to draw the base
of the bridge.

3. On the Edit tab in the Elevation group, click the Mode button, and type 775 as the value to set for a
constant elevation.

Draw a bridge using a Z elevation
It’s easier to draw the bridge in a 2D map, and you can do so by setting the Z Mode elevation.

1. On the View tab, click Convert.

2. On the Edit tab, in the Elevation group, click the Z Mode button , and type 775 as the constant
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elevation.

3. Zoom to the bridge as seen in the figure, click the Create button > Bridges layer, and click to digitize
the approximate location of the bridge.

4. Save your edits, and close the 2D map to return to the 3D scene. The bottom of the bridge will be at
the correct elevation. You can also snap lidar points to create 3D features.

5. Click the Create button > Bridges layer, and click to digitize the bridge span as seen in the figure. Pan
and zoom as necessary.

6. Turn the Bridges layer off, and save your project.

Conduct a line-of-sight analysis
Lidar data can be used to determine line-of-sight obstructions between observer points. This information can
be useful for security or development purposes. There are many 3D tools for conducting visibility studies. You
will use two, Construct Sight Lines and Line of Sight. In this exercise, you will use two observer points
already created, one from the top of the US Steel Building (Observer1) and the other at the fountain at Point
State Park (Observer2).

1. Use the Line of Sight View bookmark.
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2. On the Analysis tab, click the Tools button > Toolboxes tab, and expand 3D Analyst Tools >
Visibility.

3. Click Construct Sight Lines, fill out the form as shown, and run the tool.

A sight line appears in the view between the two observer points.

4. Click the back button, and click Line of Sight.

5. Fill out the form as shown, run it, and then close the tool when it finishes.

6. Turn the Chapter11_LasDataset layer off to see the features that are visible (green) and not visible
(red) between the observer points.
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Tutorial 11-5: Work with 3D features
This tutorial will explore a few of the many ArcGIS Pro 3D edit and create tools. Some edit functions work
only with features that are Z-enabled. If your features are not created as 3D features, you must convert them
to 3D before editing using the geoprocessing tools found in the 3D Analyst toolbox. In this tutorial, you will
edit building polygons that are already 3D features to create multiple floors in a building and view floors using
a range slider and manually edit polygons’ heights using Z constraints.

Open the Tutorial 11-5 project with 3D building polygons
The buildings you edit are the Allegheny County Courthouse and the old county jail, designed by architect H.
H. Richardson.

1. Open Tutorial11-5.aprx from the Chapter11\Tutorials folder, and save it as Tutorial11-
5YourName.aprx.

2. Use the Courthouse bookmark. The map zooms to the area surrounding the courthouse, on the left,
and jail with a 3D feature class of the courthouse, its towers, and the jail.
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Extrude floors
First, you will create 3D floors for both the courthouse and jail using the Duplicate Vertical tool. You can also
use this tool to copy points or lines (for example, furniture or pipes) in a positive or negative direction if your
features are above or below ground. You can also select and sketch on each new floor polygon.

1. On the Edit tab in the Tools gallery, click the Duplicate Vertical button .

2. Click the Allegheny County Courthouse polygon, and make the changes as shown.

3. Click Duplicate. There are a total of five floors, and the Preview box will show the building floors as
they are extruded.

4. Clear the selected features, and save your edits.

YOUR TURN
Use the Duplicate Vertical tool to extrude the floors of the old jail (building on the right) an offset of 20
feet, and use 3 for the number of times to duplicate. Clear your selections, save your edits, and close the
Modify Features pane.

Use a range slider to view building floors
Setting range values offers a way to visualize certain floors in a building. This visualization method is
especially useful if a floor contains detailed information or if a building has many floors. You can use this tool
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to visualize numeric values in an attribute table, including property values for parcels, crimes in

neighborhoods, and so on.

1. Use the Building Floors bookmark.

2. Open the Courthouse3D attribute table, and sort by Name.

3. Select each floor of the Courthouse, and in the corresponding FloorNumber field, type 1 for the first
(lowest) floor, 2 for the second floor, 3 for the third floor, and so on. Repeat for the jail floors.

4. Clear your selection, save your edits, and close the table.

5. In the Contents pane, right-click Courthouse3D > Properties > Range >Add Range, click
FloorNumber, click Add, and click OK.

6. Drag the slider to 3, and notice floors 1 and 2 disappear from view. You can use range sliders in 3D
animations, and you can modify range properties on the Map Range ribbon.

7. Drag the slider to 1 to view all floors.

8. On the Range tab in the Active Range group, click <None> for value. This will turn off the range
slider.

Edit a building’s height using dynamic constraints and the attribute table
Buildings are sometimes composed of multiple polygons at different heights. If these heights are not already
derived from lidar data, you can use interactive handles to adjust the building height dynamically using a Z
constraint or by typing building height using attributes.

1. In the Contents pane, turn Courthouse3D off and Courthouse3DTowers on.
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2. On the Edit tab, click the Z Mode button to turn it off.

3. Click the Modify button, and in the Modify Features pane under Alignment, click Scale, and then
click the large tower on Grant Street.

The dynamic constraint icon will appear on the tower polygon. If your icon does not appear, you can turn
on “Show dynamic constraints in the map” by clicking Project, then Options, and then Editing. You can
adjust the map if necessary to better see the tower and constraint icon.

4. Click the green (Z) constraint to scale the tower in the Z direction to the height of the rectangular
part of the tower. If you have lidar data, snap to those points.

5. Click to finish the tower.
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6. Save your edits.

YOUR TURN
Drag the smaller towers to the eastern side of the building. An alternative to dragging features is to
simply type the building heights in the corresponding attribute table. Open the Courthouse3DTowers
attribute table, and type 150 for the smaller tower’s height. Clear your selected features, and save your
edits and your project.
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Tutorial 11-6: Use procedural rules and multipatch models
A CityEngine rule package (.rpk) is a compressed file that contains a compiled rule and all the assets (textures
and/or 3D models) that the rule logic uses for creating 3D content. You can use these packages in ArcGIS
Pro as a procedural symbol that constructs and draws the procedural features on the fly from the source data.
Another method creates 3D models and stores them as a feature class called a multipatch, whose features are a
collection of “patches” that represent the boundary of a 3D object. A multipatch stores color, texture,
transparency, and geometric data in its features.

Here, you will apply a predefined rule package to Pittsburgh’s tallest office building, the US Steel
Building. You will also view multipatch features whose building facades were created in CityEngine using
actual building facades. These features can take a long time to render, so it’s recommended to use a high-end
graphics card and follow the hardware requirements.

Open the Tutorial 11-6 project with a building footprint
When you apply procedural rules, features must be displayed as layers in a 3D scene. The feature class polygon
itself does not have to include z-values but must be in a 3D scene and viewed as 2D layers.

1. Open Tutorial11-6.aprx from the Chapter11\Tutorials folder, and save it as Tutorial11-
6YourName.aprx. The project opens with a 3D scene—US Steel Building—and one 2D building
polygon footprint.

2. Use the US Steel Building bookmark.

Apply building rules using stacked blocks
You can easily apply a procedural rule to a building for a stacked block or more realistic high-rise or office
building.

1. In the Contents pane, click the red symbol for the US Steel Building.

2. In the Symbology pane, click Gallery > All styles, and in the search box, type Procedural, and press
Enter. Procedural rules will update with new software releases and can be downloaded and added
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from CityEngine or Esri’s Living Atlas of the World.

3. Click the Stacked Blocks procedural symbol.

4. In the Symbology pane, click Properties and the Layers button .

5. Under Units, click Feet; under Total Height, click the Container button  on the right of the
current height; click the [Height] field; and click OK. This step sets the building height to a height
field in which building heights are already entered.

6. Fill out the form as shown, click Apply, and drag the USSteelBldg layer to 3D Layers.

The building will now be “wrapped” showing the number of floors.

382



Apply an international building rule
The unit for international buildings is meters, so you will type the height instead of using the building height
field, which is in feet.

1. In the Symbology pane, click Gallery, click the International Building procedural symbol, click
Properties, and then click the Layers button.

2. Fill out the form as follows, and click Apply.

Although the result does not look exactly like the actual US Steel Tower, it is more realistic than a
wrapped, level building.
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3. Close the Symbology pane.

View multipatch models of buildings and street furniture
Smithfield Street is a study area in downtown Pittsburgh using multipatch layers of exported SketchUp
Collada (.dae) files with realistic building images and street furniture. You will turn on these layers to explore
multipatch models.

1. Close the US Steel Building scene, and open the Smithfield Street scene.

2. Use the Smithfield Street bookmark. Wait while the buildings display the building facades with
textures.

3. Turn on Smithfield Furniture, and wait for the view to render. This layer of detailed features such as
planters, garbage and recycling cans, and newsstands might take a while to render, depending on your
graphics card.
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YOUR TURN
Turn off the Smithfield Furniture layer, and turn on the Smithfield Textured 2 layer. View the scene
from various locations, including the Smithfield Street Bridge. Turn on the Smithfield Buildings layer,
and on the Appearance tab, in the Effects group, change the transparency to 50 percent. Save your
project.
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Tutorial 11-7: Create an animation
Animations are created by capturing an ordered set of viewpoints as keyframes and managing how the camera
transitions between them. In this tutorial, you will take advantage of the bookmarks already in the scene to
build a fly-through animation of downtown Pittsburgh. You will then improve the flight path and flight speed
by manually inserting more keyframes and adjusting their timing.

Open the Tutorial 11-7 project, and explore bookmarks

1. Open Tutorial11-7.aprx from the Chapter11\Tutorials folder, and save it as Tutorial11-
7YourName.aprx.

2. On the Map tab, click Bookmarks > Manage Bookmarks, and double-click each bookmark in order,
from Frame1 through Frame8. You will use these bookmarks to create the animation.

3. Double-click the Frame1 bookmark. This bookmark will be the first camera location of your
animation.

Add an animation to the project, and create keyframes
Adding animation to a project enables the animation functions. As soon as you add an animation, you begin
making keyframes manually. You can also import keyframes into an animation on the Animation tab in the
Create group by using the Import function.

1. On the View tab in the Animation group, click the Add button . The Animation ribbon opens,
and an Animation Timeline pane appears at the bottom of the screen. You are ready to make your
first keyframe using bookmarks.

2. In the Animation Timeline pane, click Create first keyframe. A thumbnail image of the starting
location (Frame1 bookmark and the first keyframe) will appear.
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3. On the Bookmarks pane, double-click Frame2, and in the Animation Timeline, click the Append
Next Keyframe button . This step adds the next keyframe to the animation.

4. Repeat step 3 for each of the remaining bookmarks, Frame3 through Frame8.

5. Close the Bookmarks pane. This step adds all keyframes to the animation.

Play an animation, and change the duration
The keyframes have durations of three seconds between each frame for a total duration of 21 seconds. You can
play the animation for this duration or extend the playback time.

1. On the Animation tab in the Playback group, click the Play button . On the Animation Timeline
tab, the spacebar is a keyboard shortcut for Play/Pause.

2. On the Animation tab in the Duration box, type 00:30.000.

3. Play the animation from the beginning. The animation will now play for 30 seconds.

Create a pause
Holding a keyframe will pause the animation at the selected frame. Here, you will add a hold to create a slight
pause between frames 5 and 6 along the Smithfield Street Bridge.

1. On the Animation Timeline, double-click keyframe 5, and click the Hold button .

2. Play the animation from the beginning, and observe the slight pause between frames 5 and 6.

Add and delete keyframes
Keyframes can be moved to adjust the speed of animations, and frames can be inserted in between keyframes
using different camera locations. Here, you will add a new keyframe and manually adjust the camera.

1. On the Animation Timeline, drag the Time Indicator (red vertical bar) to approximately 21 seconds
(about halfway between frames 6 and 7). Moving the Time Indicator “scrubs” through time, and the
location where you move it is where you will adjust the camera and insert a new keyframe.

2. Using the mouse wheel or keyboard keys, adjust the view to a slightly lower focal point.
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3. On the Animation timeline, click the Insert button . Because no keyframe existed at 21 seconds,
when you click update, it will insert a new keyframe to capture the camera change and add a new
keyframe using the current camera location.

4. Play the animation from the beginning.

View an animation’s path, and manually edit a keyframe’s properties
When adjusting animations, it’s useful to see the camera’s path and keyframes so that you can move to a
keyframe and adjust its properties, such as Z elevation (camera location).

1. On the Animation Timeline, double-click frame1, and zoom out.

2. On the Animation tab in the Display group, click the Path button . This step turns the camera
path and keyframes on to better see how the animation plays. Keyframe 2 is a little too high, so you
will edit its properties to lower the keyframe.

3. On the Animation Timeline in the Keyframe Gallery, double-click keyframe 2.

4. On the Animation tab in the Edit group, click the Properties button , expand Camera, and type
1000 for the z-value.

5. Close the Animation Properties pane, and click the Path button to turn off the path.

6. Play the animation from the beginning. Notice that the camera is lower at keyframe 2.

Create a movie from the animation
Now that you have created an interesting animation, it’s time to share the animation with others. To share the
animation, you will export a movie to a file. You have several options, including exporting your movie directly
to YouTube, Vine, Vimeo, and so on, or as a draft animation. You can change the file location and movie
resolution, type, size, and so on in the File Export and Advanced Movie settings.

1. On the Animation tab in the Export group, click the Export Movie button .

2. In the Export Movie pane in the Movie Export Presets group, click the Draft button. This step will
create a smaller file. The resulting quality of the file isn’t high, but it is much faster to produce.

3. Under file name, click the Browse button, navigate to Chapter11\Tutorials, and type
Chapter11Animation3D as the movie name. MPEG4 (.mp4) is the default type.

4. In the Export Movie pane, click Export. Wait while the movie is created. If you use other settings
with higher resolutions or a larger size, the movie can take a long time to render. You can save the
media format as separate .jpg files that you could later stitch together using another animation
software application.
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5. In Windows Explorer, navigate to Chapter 11\Tutorials, and double-click
Chapter11Animation3D.mp4 to play the movie.

6. Save your project.

Assignments
This chapter has two assignments to complete that you can download from this book’s resource web page,
esri.com/gist1arcgispro:

Assignment 11-1: Prepare 3D building and topography features for a 3D study.
Assignment 11-2: Create a realistic 3D scene for a campus study.
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PART
4
Managing operational
systems with GIS
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CHAPTER 12
Operations management with GIS
Graffiti Mapping System
LEARNING GOALS

Get an introduction to operations management systems.
Create tasks to prepare data for an operations management system.
Build a ModelBuilder model to be used in a task.
Share web layers in ArcGIS Online for use in an Operations Dashboard for ArcGIS® operation view.
Create an ArcGIS Online map for use in an Operations Dashboard operation view.
Create and use an Operations Dashboard operation view.

Introduction
Up to this point, the book has dealt primarily with GIS applied to one-time projects in which spatial data is
collected at one particular point in time and used in GIS to help solve a problem or shed light on an issue. For
instance, the GIS in chapter 1 addressed the issue of geographic access to urgent health care clinics in parts of
Pittsburgh with low-income populations. Although the GIS could be updated with new data over time, no
organization or system was envisioned to continue the work.

In contrast with a one-time project, operations management applies to organizations that deliver goods
and services. Operations signifies continuous work to provide goods and services to customers. Such work
generates and depends on demand data for goods and services. Management refers to the oversight function
for efficient, timely, and responsive delivery of demanded services. An operations management system is an
information system with supporting computer applications. A significant feature of such systems is that they
process and use a continuous flow of demand data, in contrast with projects and one-time data collection.
Because demand data is often spatial with point locations of demands, operations management systems often
include GIS.

In this chapter and chapter 13, you will build two GIS-based operations management systems for graffiti.
In this chapter, you build the Graffiti Mapping System to help police identify patterns of serial graffiti artists,
apprehend the artists, and prevent future graffiti. The operations management system you’ll build in chapter
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13, the Graffiti Removal System, is for the public works employees who remove graffiti from public surfaces,
such as buildings, walls, and bridges. The system performs optimal routing for graffiti removal at several
locations during a work shift. Optimal routing determines the sequence of stops at graffiti sites to minimize
travel time.

In this chapter, you’ll create tasks, a ModelBuilder model, and an Operations Dashboard operation view
that police will use as their main tool to prevent graffiti. First, it may be helpful for you to review this
information:

Tasks are stored, reusable workflow guides that load commands and manage map views and layers,
thereby reducing mouse clicks and overhead. Task processing and output are consistent and reliable,
regardless of who does the work, because of the prepackaging and instructional steps of tasks.
Tutorial 10-3 introduced ModelBuilder and models. A model automates a workflow consisting of two
or more geoprocessing or analysis tools that become the processes of the model. Each tool/process is
an algorithm that transforms inputs into outputs. Processes are strung together, with the output of one
process becoming the input of another process. Therefore, instead of searching for and running tools
one after the other on your own, you run a sequence of tools with one press of a button in a model.
Operations Dashboard for ArcGIS is an app for monitoring and reporting operations data over time. An
operation view has one or more maps, plus additional data displays such as statistics, charts, and
queries.

The system in this chapter and the one in chapter 13 use 311 data as inputs. Increasingly, citizens of
American cities request nonemergency public services using the phone number 311, which is also the name of
the one-stop, gateway department for providing such services. Besides calling 311, citizens can often use a 311
website to record calls for service. The 311 system automatically sends service calls to responsible city
departments such as police, public works, building inspection, and animal control to provide requested
services. The reports of citizens asking for graffiti removal are a major kind of 311 data. This chapter uses 311
graffiti call data from Pittsburgh, but specific graffiti locations are random to protect data privacy.

Suppose that police determine that 12 weeks (84 days) of data is sufficient for identifying serial graffiti
artists. For raw data input to the Graffiti Mapping System, assume that the Pittsburgh 311 system exports a
CSV file with the most recent 84 days of graffiti data each time you need to produce a weekly map.

Included in the CSV data are the longitude and latitude of each graffiti location, seen as X and Y in the
sample data that follows. Graffiti artists are not known by their actual names, but rather by monikers such as
Phase III or Tommy T, as seen in the Artist attribute. Graffiti_Type_Code has code values Tag, Throw Up,
and Piece, which are standard categories of graffiti. Tag is the simplest graffiti, with just the sign or moniker
of a graffiti artist, generally with only one color. Throw Up is quickly painted graffiti with some graphic
features in addition to a tag and generally with a few colors. Piece is complex graffiti, a “piece of art,” with
several colors.
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Tutorial 12-1: Create tasks for the Graffiti Mapping System
A task item is the container that has a set of related tasks. Each task has one or more steps.

You’ll create a task item named Prepare Graffiti Data for ArcGIS Online for the weekly preparation of
data for the Graffiti Mapping System. The task item has two tasks, Prepare Data and Publish Web Layers,
and the multiple steps in ArcGIS Pro.

The Prepare Data task has steps to enter a date in a feature class named Heading and create a feature class
named Graffiti. Heading is a point feature class with a single point. The point has a date attribute, also named
Heading, which stores the end date of the 84-day time window of graffiti data to be mapped. Every week,
when you produce a new graffiti map, you must edit this date to be the current end date of the time window.
The dashboard you’ll build will display this date so that the user can learn the vintage of the map’s data. The
second step creates and symbolizes the Graffiti feature class from the 84-day XY data table provided by the
city’s 311 system.

Prepare data
1. The Enter Date step opens the Heading attribute table and guides the user in editing the

Heading date value.

2. The Save Edits step saves the edited date.

3. The Create Graffiti Feature Class step runs a ModelBuilder model that you’ll build in this
tutorial named Graffiti Data Import, which adds raw CSV data as an XY event layer to the
ArcGIS project, creates the Graffiti feature class with projected Web Mercator coordinates from
the XY data, and symbolizes the Graffiti layer using unique values by graffiti type.

Publish web layers
1. The Share Web Layers step publishes the Heading and Graffiti web layers to your ArcGIS

Online account. After you publish the web layers and they are added to an ArcGIS Online map,
you can incorporate them into an operation view for analysis by police and other city officials
who work on graffiti prevention.

2. The Share Heading Web Layer step publishes the Heading web layer.
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3. The Share Graffiti Web Layer step publishes the Graffiti web layer.

You’ll build the model of the Create Graffiti Feature Class step. Then you can create the tasks and steps
of the task item from start to finish with no interruptions.

Open the Tutorial 12-1 project

1. Open Tutorial12-1 from Chapter12\Tutorials, and save it as Tutorial12-1YourName.

2. Use the Pittsburgh bookmark. You’ll build a ModelBuilder model in this exercise for creating and
symbolizing a Graffiti feature class from XY event data. The opening map already has a Graffiti
feature class added because the model needs an existing Graffiti feature class for its symbolization
process to function. Creating a new Graffiti feature class will replace the starting Graffiti feature class
and symbolize it using unique values for different types of graffiti. The current Graffiti layer in the
map is symbolized with a single symbol so that you can see that the model works and changes
symbology to unique values.

Build the Graffiti Data Import model
When you build a model, you search for needed geoprocessing tools and add them to the model, at which
time they are called processes. The model you’ll build in this exercise, as seen in the next figure, has three
processes. The first process imports the raw x,y data for a map into a map layer. The second process projects
the map layer from latitude/longitude geographic coordinates to Web Mercator coordinates that are preferred
for ArcGIS Online. The third process symbolizes Graffiti. Note that Graffiti, Graffiti (2), and Graffiti (3) all
refer to the same feature class, Graffiti. ModelBuilder model inputs and outputs must have unique names in
the model; therefore the (2) and (3) are created by ModelBuilder for Graffiti in different parts of the model.
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1. On the Analysis tab in the Geoprocessing group, click the ModelBuilder button . An empty model
opens in edit mode, ready for you to add tools as processes.

2. On the Analysis tab, click Tools, and in the Geoprocessing pane, search for (but do not open) Make
XY Event Layer.

3. Drag the Make XY Event Layer tool to the top of the Model window.

4. Similarly search for and add the Project (Data Management Tool) tool below the Make XY Event
Layer tool.

5. Search for and add the Apply Symbology From Layer tool below the Project tool, and close the
Geoprocessing pane when finished.

6. If needed, rearrange the tools as shown in the figure.

7. On the ModelBuilder tab in the Model group, click Save.

Configure the Make XY Event Layer process

1. In your model, double-click the Make XY Event Layer process to open its Parameters and
Environments pane.

2. Click the Browse button on the right of the XY Table field, browse to Chapter12\Data, and double-
click Graffiti20160603.txt. Graffiti20160603.txt is the raw CSV data from a 311 system. ArcGIS Pro
automatically identifies and adds the X and Y Fields, X and Y, as well as the correct spatial reference
of GCS_WGS_1984 (geographic, latitude and longitude). Note that Spatial Reference is for the
current coordinates of the x,y data.
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3. Click OK. The process and its input and output diagram elements now have color fill, indicating that
the process is configured, valid, and ready to use.

4. Right-click the input, Graffiti20160603.txt, ellipse, click Rename, replace the existing name by
typing Input XY Data, and press Enter.

5. Right-click the input again, and click Parameter. Making any input or output into a parameter allows
you to search for the input data or name and locate the output when you run the model.

6. Rename the output ellipse Graffiti XY Event Layer.

Configure the Project process

1. Double-click the Project process.

2. Make selections or type the selections as shown. For Output Coordinate System, click the Select

Coordinate System button , expand the Coordinate System tree to Projected Coordinate System >
World > WGS 1984 World Mercator (auxiliary sphere), and click OK.
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3. Click OK.

Configure the Apply Symbology From Layer process

1. Double-click the Apply Symbology From Layer process.

2. For Input layer, select Graffiti.

3. For Symbology layer, browse to Chapter 12\Tutorials\Resources, select Graffiti.lyrx, and click OK.

4. Click OK.

5. Right-click the output of the Apply Symbology From Layer process, Graffiti (2), and click
Parameter. Making process map output a parameter allows you to rename it at run time (which you
will not do in this case) and also adds the output to Graffiti Map when run from the user interface
that ArcGIS Pro provides.
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6. Right-click the same output, and click Add To Display. This option adds the output Graffiti layer to
the map when the model is run in edit mode. You can run models, or parts of models, in edit mode to
debug errors.

7. Save and close your model.

Rename and run the model

1. Open the Catalog pane, expand Toolboxes > Tutorial12.tbx, and rename Model as Graffiti Data
Import.

2. In the Catalog pane, right-click Graffiti Data Import, and click Edit. The model opens in edit mode.

3. Hide or close the Catalog pane.

4. On the ModelBuilder tab in the Run group, click Run. After the model runs, the old Graffiti layer is
replaced by the newly imported and projected Graffiti layer, and the new layer is symbolized with
unique symbols by graffiti type. Also, the process elements in the model now have drop shadows,
indicating that they have been run. If you need to run the model again in edit mode, you must click
the Validate button in the ModelBuilder Run group, which removes the drop shadows. If you are
diagnosing a model, you can run it step by step by right-clicking each process in turn and clicking
Run. Often, it’s useful to add outputs to display temporarily to help diagnose problems.

5. Close the Model pane that has processing information. If there were any errors, they would be in red
font in this window and include diagnostic information. Next, you’ll rerun the model using its user
interface.

6. Review Graffiti Map to see that it has new data and symbolization.

7. Click the Graffiti Data Import tab. On the ModelBuilder tab in the Run group, click Validate.

8. Save and close the Graffiti Data Import model.

9. In the Catalog pane, right-click Graffiti Data Import, and click Open. In this model interface, the
user can browse for the needed graffiti x,y data. By naming the input file with the date in
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YYYYMMDD format, the files can be sorted chronologically, making it easy to find the latest file.

10. Click Run, and when the model finishes, close the Geoprocessing pane. The model runs like any
other geoprocessing tool.

11. Save your project.
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Tutorial 12-2: Create tasks to import graffiti data
Next, you will create the Prepare Graffiti Data for ArcGIS Online task item, its Prepare Data task, and the
task’s three steps, Enter Date, Save Edits, and Create Graffiti Feature Class. The task item has a second task,
Publish Web Layers, which you’ll create after this exercise. You must have completed tutorial 12-1 and built
its Graffiti Data Import model for use in the Create Graffiti Feature Class step.

Open the Tutorial 12-2 project

1. Open Tutorial12-2 from Chapter12\Tutorials, and save it as Tutorial12-2YourName.

2. Use the Pittsburgh bookmark.

Create a new task item for preparing graffiti data

1. On the Insert tab in the Project group, click the Task button , and then click New Task Item. The
Tasks and Task Designer panes open. You create new task items, tasks, and steps in Tasks and
configure them in Task Designer.

2. If the panes are docked, undock them, and move them so that you can see the Contents pane and
map.

3. Type the information as shown into the text boxes on the Task Designer pane for the task item. Type
your name for Author. Note that the document Tasks_Copy_And_Paste.docx in
Chapter12\Tutorials\Resources has much of the text that you are instructed to type. So instead of
typing, you can open the document and copy and paste to save time.
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4. Save your project. Saving the project also saves the task item.

Create the Prepare Data task

1. In the Tasks pane, click the New Task button .

2. In the Task Designer pane for Name, type a. Prepare Data and for Description, type Has steps: 1.
Enter Date 2. Save Edits 3. Create Graffiti Feature Class. Ensure that you press Enter after each line
of the description to arrange the description as shown in the figure.

3. Save your project.

Create the Enter Date step

1. In the Tasks pane, click the New Step button .

2. In the Task Designer pane, for Name, type Enter Date.

3. For the step instructions, type i. Enter a new date to replace the old date in the Heading field in the
Heading attribute table. ii. Press Enter to update the Attribute field. Ensure that you press Enter
after each instruction as needed to place the start of the next instruction on a new line.

4. For Step Behavior, click Auto Run. Auto Proceed will allow the user to run the step to edit data, and

402



then automatically proceeds to the next step to save the edits.

5. In the Task Designer pane, click Actions, point to the command bar, and click the Record button as
shown in the figure.

Step 7 will be recorded for automatic use when you run the task later. Notice that after clicking Record,
when you point to any open user interfaces, the cursor gets a red circle with a center dot indicating that it’s
ready to record a command. After recording a single step (use of a command that accomplishes
something), the cursor will revert to its original form.

6. Move the Tasks and Task Designer panes so you can see the ArcGIS Pro window.

7. In the Contents pane, right-click Heading, and click Attribute Table. The cursor reverts to original
form, indicating that recording is finished with a single command (Attribute Table) recorded.

8. In the existing row, under Heading, type End Date: June 10, 2016, and press Enter.

9. In Task Designer, click the Views tab, and ensure that Graffiti Map is active and open.

10. In Task Designer, click the Contents tab, and turn on layer selection for the Heading layer (click
once) and turn off the other layers (click twice). This step ensures that the Heading layer is selected in
the Contents pane so that the open attribute table command is applied to that layer.

403



11. Save the project.

Create the Save Edits step

1. In the Tasks pane, click the New Step button.

2. For Name, type Save Edits; for instructions, type Click Yes and close the table; and for Step
Behavior, select Automatic.

3. Click Actions, point to the command bar, and click the Record button.

4. In the ArcGIS Pro window, click the Edit tab, click Save, and click Yes.

5. Close the Heading table, and save your project.

YOUR TURN
Try out your new task. In the Tasks pane, click the Options button , and click Exit Designer. In the
Tasks pane, point to the Prepare Data task, click the blue arrow that appears on the right, and follow
your instructions to edit and save the date, entering June 12, 2016, and pressing Enter for the new date.

Create the Add Graffiti XY Event Data step
Adding this step will result in creating a new Graffiti feature class.

1. Click the Options button in the Tasks pane, and click Edit In Designer.

2. In the Tasks pane, click the New Step button.
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3. In Task Designer, on the General tab, for Name, type Add Graffiti XY Event Data.

4. For Step Behavior, select Auto Run.

5. Click the Actions tab, point to the command bar, and click the Edit button.

6. For Type of Command, select Geoprocessing Tool, search for and select Graffiti Data Import, and
click OK.
The Embed option of the task step exposes the model’s parameter, the input x,y data table, so that the
user can browse for the current data.

7. Click Done, and save your project. Note that if your project is closed at some point in time, you can
open it in edit mode from the Catalog pane under Tasks.

YOUR TURN
Repeat all the steps of the Prepare Data task, repeating the Enter Date and Save Edits steps, and
running the new Add Graffiti XY Event Data step. First, change the symbology of Graffiti to Single
Symbol so that you can see the added layer (which is the same as the existing layer) get symbolized with
unique values. In the Task pane, click the Options button, and then click Exit Designer. Point to the
Prepare Data task, and click the blue arrow. Edit the date to be June 3, 2016, which you will need for
further work in this chapter, and save the edits. The Add Graffiti XY Event Data step runs
automatically, resulting in a new Graffiti feature class in the Contents pane. Click Finish.

Share the Graffiti and Heading web layers
The key to building the operation view in Operations Dashboard later in this chapter is to keep the names of
input map layers the same from week to week and run to run. You’ll use “Graffiti Your Name” for the fixed
name of the name of the graffiti map layer and “Heading Your Name” for the layer with the current date.
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Then every time you open a corresponding map in ArcGIS Online, it will open with new data but with the
same name over time so you won’t have to modify the map. The first time that you share (publish) Graffiti
Your Name and Heading Your Name in ArcGIS Online, the command to use is Share As Web Layer. The
second time you share these layers, and every time after that, the command is Overwrite Web Layer, which
allows you to overwrite the previous versions with the new ones of the same name. So as a preliminary step,
next you will use Share As Web Layer interactively. Then when you create a corresponding task, you’ll use
Overwrite Web Layer.

1. Save your project, and close the Tasks pane.

2. In the Contents pane, right-click Graffiti, and click Share As Web Layer.

3. In the Share Web Layer pane, for Name type your name at the end of Graffiti (for example Graffiti
Mary Smith), for Item Summary, type Twelve weeks of graffiti data; for Tags, type Pittsburgh and
Graffiti.

4. Click Publish. Wait a minute or so until the web layer publishes.

5. Likewise, share Heading as a web layer, add your name to Name (for example, Heading Mary Smith),
and for Summary, type Stores end date of graffiti data, and for Tags: Pittsburgh and Graffiti Date.

6. Finally, share the Pittsburgh layer by adding your name to Pittsburgh (for example, Pittsburgh Mary
Smith). Then for Summary, type Pittsburgh’s boundary, and for Tags: Pittsburgh and Boundary.

Create the Publish Heading and Graffiti Web Layers task
Currently, the Tasks and Task Designer panes should be closed. You can open or edit tasks from the Catalog
pane, as you’ll see next.

1. Open the Catalog pane, expand Tasks, right-click Prepare Graffiti Data for ArcGIS Online, and
click Edit In Designer.

2. Click the New Task button.

3. In Task Designer, for Name, type b. Share Web Layers; for Description, type Has Steps: 1. Share
Heading Web Layer 2. Share Graffiti Web Layer.

4. Save your project.

Create the Share Heading Web Layer step

1. In the Tasks pane, with the Share Web Layers task selected, click the New Step button.

2. In Task Designer, for Name, type Share Heading Web Layer. For Instructions, type i. In the
Contents pane, right-click Heading Your Name, and click Overwrite Web Layer ii. Click My
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Content, select Heading Your Name, and click OK. iii. In the warning window, click OK. iv. Click
Publish. v. When publishing finishes, close the Overwrite web layer window. For Step behavior,
select Auto Run.

3. In the Tasks pane, click the back arrow button .

4. Add a new step to the Share Web Layers task using steps 1 and 2 and replacing Heading Your Name
with Graffiti Your Name.

5. Save your project.

YOUR TURN
Repeat both tasks, Prepare Data and Publish Web Layers, of the Prepare Graffiti Data for ArcGIS
Online task item. First, resymbolize Graffiti with a single symbol so that you can see when the Create
Graffiti Feature Class step of the Prepare Data task runs, creating Graffiti again and symbolizing it with
unique values. When you run the Enter Date step of the same task, reenter June 3, 2016. When you
finish, save your project, and close ArcGIS Pro.
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Tutorial 12-3: Create a map for Operations Dashboard
You’ll create a map in ArcGIS Online that will be reused each time new Graffiti and Heading web layers are
shared. To run this tutorial, you must have the Graffiti and web layers published in your ArcGIS Online
account from tutorial 12-2. You’ll add the published web layers to a map, and then create pop-up windows
and bookmarks.

Build the map

1. Go to ArcGIS.com, and sign in to your organizational account.

2. Click Map on the main toolbar.

3. Click the Add Content to Map button  and then Search for Layers.

4. In the Search for Layers pane, for In, select My Content, and using Find, search for and click Add for
Pittsburgh Your Name, Graffiti Your Name, and Heading Your Name. Adding Pittsburgh first
makes it the default extent.

5. Click Done Adding Layers.

6. Change the basemap to Light Gray Canvas. If Light Gray Canvas is not available, select another
simple basemap.

7. In the Contents pane, expand Light Gray Canvas, click World Light Gray Canvas Reference to
expose its More Options button, click the More Options button , and click Remove. The labels of
the reference layer cluttered the map, so you removed them. Users of the map know Pittsburgh well
and do not need the labels.

8. In the Contents pane, drag the Graffiti Your Name layer to the top, drag Heading Your Name below
Pittsburgh Your Name, and turn off Heading Your Name. This step makes the legend that you’ll
build in Operations Dashboard more compact because you can cover up the bottom part that will
have legends for Pittsburgh and Heading, leaving only the legend for Graffiti visible. Also, the
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Operations Dashboard’s pop-up window that you will build automatically shows data for the first
layer in the Contents pane (Graffiti) first, and the user wants to see Graffiti data.

9. Save the map as Graffiti Map Your Name with tags Pittsburgh and Graffiti, and Summary of
Current graffiti map of Pittsburgh.

Add and configure pop-up windows
Operations Dashboard uses the pop-up windows that you will configure in ArcGIS Online.

1. In the Contents pane, click Graffiti Your Name > More Options button > Configure Pop-up.

2. For the Pop-up title, type Graffiti.

3. Click Configure Attributes, select the check box on the left of Display twice to clear all attributes, and
turn on these attributes: Address, ZIPCode, Date_Call, Graffiti_Type_Code, Comment, and
Artist.

4. Use the vertical arrows on the right of the attribute table to place attributes in the order listed in step
3. To order the attributes, you can select a row to be moved up, scroll to the top of the list, and then
click the up arrow.

5. Click OK, and click OK.

6. Save the map.

YOUR TURN
Click a graffiti point on the map to try out your pop-up window.
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Create bookmarks
Operations Dashboard uses the bookmarks that you configure in ArcGIS Online.

1. Zoom in or out so that Pittsburgh fills the map.

2. Click the Manage bookmarks button  > Add Bookmark, type Pittsburgh, press Enter, and close the
Bookmarked Places window.

3. Zoom in to the Central Business District of Pittsburgh.

4. Create another bookmark, this one titled Central Business District.

5. Use the Pittsburgh bookmark.

6. Save your map, and close ArcGIS Online.
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Tutorial 12-4: Create an operation view using Operations Dashboard for
ArcGIS

Install Operations Dashboard for ArcGIS
If you haven’t already installed Operations Dashboard for ArcGIS on your computer, you will need to install
the software now.

1. In your web browser, search for Operations Dashboard for ArcGIS.

2. Open that site, and click the Get Operations Dashboard button.

3. Follow the instructions to complete installation.

Create a new operation view
A particular dashboard in Operations Dashboard is called an operation view. It has one or more maps and, if
desired, one or more widgets. A widget provides additional information about mapped data, such as statistics,
a bar chart, or query to select features of a map.

1. Open Operations Dashboard on your computer (Start > All Programs > ArcGIS > Operations
Dashboard).

2. Click Create a New Operation View > Multidisplay Operation View > Create. The Add Widget
gallery opens with all available widgets and the Map widget selected by default.

Configure a map widget

1. Click OK to add a map to the operation view.

2. In the Choose Map window, select Graffiti Map Your Name, and click Open.

3. In the Configure Map window, on the Data Sources tab, select Graffiti Your Name and Heading
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Your Name. Now you can use the attribute data from these two web layers for queries and other

purposes.

4. On the Capabilities tab, select Show pop-up, Highlight, Pan to, Select, Zoom to, and Feature Pop-
ups. These capabilities will be available for maps in your dashboard.

5. Click OK. The dashboard shows your map with the map’s name on the upper left.

6. Click File. The Save As option automatically opens.

7. For title, type Graffiti Dashboard; for summary, type Graffiti calls in the last 12 weeks, and click
Save.

8. Click the Configure Map Tools button  on the upper left of the dashboard window, and select
Basemaps, Bookmarks, Clear Feature Selection, Layer Filters, Map Contents, and Select Features.

9. Click Close.

YOUR TURN
Try out the Central Business District bookmark and pop-ups you created in ArcGIS Online for the
map.
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Add a List widget
You’ll use a List widget to provide the date of the map from the Heading layer.

1. Click Widgets, click Add Widget, click List, and click OK.

2. In the Configure List window, select Graffiti Map–Heading as the Data source, delete New List
from Title so that Title is blank, change Max count to 1, and click OK. Heading has only one
attribute, named Heading, that must display. The List widget does not display system-generated
attributes such as ObjectID and Shape.

3. Dock the widget on the left side of the Dashboard, and adjust the corresponding pane width so that
End Date: June 3, 2016 fits on one line. You’ll add more widgets and dock them on the left to fully
use that space.

4. Save the operation view.

Add a Legend widget
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1. Click Widgets, click Add Widget, click Legend, and click OK.

2. For title type Legend, and click OK.

3. Drag the top of the legend under the Heading widget, and click the downward-pointing docking
arrow to place the legend below the heading.

4. Drag the legend up to just below the date heading.

Add map queries to select graffiti calls

1. Click Widgets, click Add Widget, click Query, and click OK.

2. For Data source, select Graffiti Map Your Name–Graffiti; for title, type Graffiti queries.

3. Click Add. The Query Definition window opens.

4. Type the selections as shown.

5. Click Add, click OK, and click OK. When you click Add, it moves the query from the design top
pane to the completed bottom pane, readying the query for use. You’ll add another query to Graffiti
queries, but first you’ll use the query you just built.
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6. Move the Query widget out of the way of the map, and click the widget’s Execute button .

7. Use the calendar to find 5/13/2016, which is three weeks before the end date of the data (6/3/2016).

8. Select 5/13/2016, and click Execute. The query finds 67 graffiti calls on or after 5/13/2016.

9. In the Query widget, click Show, and use the Central Business District bookmark if the map is not
already zoomed into that area. You can now see the areas of recent graffiti activity. Because many
serial criminals return to the same area, police make the right decision to patrol areas with recent
graffiti activity.

10. Clear the selection by clicking the back arrow  in Graffiti Queries.

11. Dock the query below the legend. When rearranging widgets vertically, you can cover up the
Pittsburgh and Heading elements in the legend because they do not provide useful information.
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YOUR TURN
Click the Settings button for Graffiti queries, and click Configure. Click Add, and add a new query
named Recent work of a graffiti artist. Add the same Date_Call query criterion that you added in the
previous step 4 (ensure that you select <All types> for Type and “Is on or after” for the operator). Then
while still in the Query definition window and with Date_Call still showing in Field, add a second
criterion with Field changed to Artist, Operator = Contains, and Value = Tommy with the prompt
Enter all or part of an artist’s name. Add the criterion. When you add the criterion, And is selected as
the connector so that both criteria must be true for graffiti calls to be selected. Note that for more room
to run the query, you can pop it out temporarily by clicking its Pop This Window Out button .
Execute the query with start date 5/13/2016, and artist name DKF. Show and zoom to the selected
records. DKF has been active recently painting a tag five times around a Pittsburgh neighborhood. Clear
the selection, use the Pittsburgh bookmark, dock the Query widget under the legend, and save your
dashboard when you finish.

Add a Bar Chart widget

1. Click Widgets, click Add Widget, click Bar Chart, and click OK.
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2. For Data source, select Graffiti Map Your Name–Graffiti.

3. Select or type the values as shown.

4. On the Axes tab, click Display labels and grid lines on value axis.

5. On the Appearance tab, for Layout, select Columns, and select a dark-gray color.

6. Click OK.

7. Dock the chart on the bottom of the left pane of widgets, and adjust the heights of the widgets.

8. Save your operation view.

9. Click Tools > Edit Operation View to take your operation view out of edit mode. Your operation
view is now complete. The queries are especially helpful in learning the patterns of serial graffiti
artists.

417



10. Close Operations Dashboard.

Assignments
This chapter has two assignments to complete that you can download from this book’s resources web page,
esri.com/gist1arcgispro:

Assignment 12-1: Create tasks to publish a choropleth map for the Graffiti Dashboard operation view.
Assignment 12-2: Modify and extend the Graffiti Dashboard operation view.
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CHAPTER 13
Operations management with GIS
Graffiti Removal System
LEARNING GOALS

Build ModelBuilder models to automate an operations management system.
Use Network Analyst to optimize routes for carrying out service deliveries.
Use Python expressions to calculate fields.
Prepare data for use in the Collector for ArcGIS® app.
Prepare a map in ArcGIS Online for use in Collector.
Use the Collector app to update data using a mobile device.

Introduction
This chapter is the second on GIS for operations management. Chapter 12 introduced operations
management and GIS-based operations management systems for providing goods and services. In chapter 12,
you built the Graffiti Mapping System, including tasks to prepare weekly data for mapping and an operations
view using Operations Dashboard for ArcGIS with a map, queries, and bar chart useful for police in
apprehending serial graffiti artists.

In this chapter, you build the Graffiti Removal System for the Public Works supervisor who oversees
graffiti removal and the Public Works employee who removes the graffiti from public surfaces, such as
buildings, walls, and bridges. More specifically, in tutorials 13-1 through 13-3, you’ll build three models that a
Public Works department supervisor will run to schedule graffiti for removal at the beginning of each
workweek:

The Identify Graffiti for Removal model maps all graffiti sites that the supervisor has approved for
removal but that have not yet had graffiti removed.
The Calculate Optimal Route model uses Network Analyst analysis tools to calculate the optimal
route for a set of graffiti sites selected by the supervisor for removal. The supervisor can create one or
more routes for a week with multiple runs of this model. Each time a route is created, its graffiti sites
are automatically removed from consideration in designing additional routes for the week.
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The Record Route Results model saves an optimal route as a feature class. Each time the supervisor
calculates the route to follow, she uses this model to record its results, make a map of the route, and
provide driving directions for the graffiti removal employee.

Note that the work is cumulative, so you must finish tutorial 13-1 to work tutorial 13-2, and you must
finish tutorial 13-2 to work tutorial 13-3.

Before the actual graffiti removal, the supervisor must visit and survey each reported graffiti site. The
supervisor may not approve graffiti removal for several reasons. For example, some 311 calls may give
incorrect locations, some graffiti may have inaccessible locations, and some private property owners may not
allow graffiti removal at their locations. In tutorial 13-4, you will build a Collector for ArcGIS application so
that the supervisor can use a mobile device such as a smartphone to enter data while inspecting a site. The
supervisor classifies graffiti by type, determines a method for removal, estimates the work time, and enters
other data. You can also go to the book’s resource web page to access assignments 13-1 and 13-2 to build
models that create optimal routing for new graffiti site inspections.
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Tutorial 13-1: Build the Identify Graffiti for Removal model
This model resembles the model in tutorial 12-1 but includes new query criteria for sites that need graffiti
removal.

Open the Tutorial 13-1 project

1. Open Tutorial13-1.aprx from Chapter13, and save it as Tutorial13-1YourName.aprx.

2. Use the Pittsburgh bookmark. The map has these layers:

Garage, the location of the Public Works Department garage that is the start and end of every
route

GraffitiCalls, the up-to-date map layer of graffiti calls

Pittsburgh, the boundary of Pittsburgh

PittsburghStreets_ND, a network dataset based on Pittsburgh’s TIGER streets
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3. In the Contents pane, turn off GraffitiCalls.

Build a model to query sites for graffiti removal
The first model identifies two kinds of sites that need graffiti removed:

Graffiti that the Public Works supervisor has approved but not yet scheduled for removal.
Graffiti that has been scheduled for removal but not removed for some reason—for example, because
an employee ran out of time or supplies.

Although it’s possible for you to implement both criteria, for simplicity you’ll only implement the first one
(also the main one).

You will use three attributes of GraffitiCalls to retrieve graffiti for scheduled removal:

Date_Approved is the date that a supervisor approved a 311 graffiti site to have its graffiti removed.
Date_Scheduled is the date that the supervisor assigned to remove graffiti from a site.
Date_Finished is the date that graffiti was removed from a site.

The expression of query 1 for case 1 is:

This compound query expression retrieves graffiti calls that have been approved but not yet scheduled for
removal. If DATE_APPROVED IS NOT NULL, meaning that it has a date entered, the graffiti has been
approved for removal by the supervisor. If DATE_SCHEDULED IS NULL, meaning that no date has been
entered for DATE_SCHEDULED, the graffiti removal has not been scheduled. With the expressions joined
with the AND connector and when both expressions are true, the graffiti is a candidate for including in a
route for removal.

The expression of query 2 for case 2 is:

CURRENT_DATE () has the current date from your computer’s calendar, so the expression
DATE_SCHEDULED < CURRENT_DATE() finds all graffiti sites scheduled in the past. The expression
DATE_FINISHED IS NULL finds all graffiti sites that have not yet had graffiti removed. Together,
connected with an AND, the expression also finds graffiti that was scheduled but not removed.

Queries 1 and 2 are combined with an OR, meaning that if either is true, a corresponding graffiti call is
retrieved for scheduling a new route. As soon as a route is scheduled, its DATE_APPROVED attribute is
given a date value, so that query 1 is false, and the graffiti call is not retrieved for additional scheduling.

You’ll use the Make Feature Layer tool to create a layer for graffiti calls that must be scheduled on the
basis of just the first query expression.

1. Open the Catalog pane, expand Toolboxes, right-click the Tutorial13.tbx toolbox, click New, and
then click Model. The new, empty model opens in edit mode, ready for you to add model processes.

2. In the Catalog pane, rename Model as a. Identify Graffiti for Removal, and hide the Catalog pane.
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3. On the Analysis tab, click Tools, search for the Make Feature Layer tool, drag it from the
Geoprocessing pane to your model, and close the Geoprocessing pane.

4. Click anywhere in the Model window to remove the grab handles from the Make Feature Layer
process and its output.

5. Right-click the Make Feature Layer process in your model, and click Open.

6. For Input features, select GraffitiCalls, and for Output Layer, type GraffitiForRemoval, and create
the query expression as shown in the figure. Alternatively, you can click the SQL button, and copy
and paste the query expression from chapter13\Resources\Tutorial13-1Query.txt.

7. Click OK, and resize model elements as shown. The model elements get color, indicating that they
are ready to run.

8. Right-click the output, GraffitiForRemoval, and click Add to Display. This option adds the
GraffitiForRemoval map layer to the map after you run the model in the current edit mode.

9. Right-click the Make Feature Layer process, and click Run. GraffitiForRemoval is created and added
to the map. If your model has an error, the error will be printed in red text in the message window.
On your map, you will see 14 graffiti sites that must be scheduled with one or more routes.

10. Turn off the GraffitiCalls layer, and close the Model message window.

Symbolize output

1. Add the Apply Symbology From Layer tool to your model below the Make Feature Layer process,
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and open it.

2. For input, select GraffitiForRemoval:1; for Symbology Layer, browse to
Chapter13\Tutorials\Resources, and select Graffiti.lyrx. The Graffiti.lyrx file has unique symbols for
Graffiti_Type_Code, plus labels for GraffitiCallsForRemoval. The labels display work time estimates
(minutes) for graffiti removal at each site.

3. Click OK, close the Geoprocessing pane, and rearrange and resize elements of the model to improve
its appearance. Note that process inputs and outputs must have unique names in a model, even when
they refer to the same feature class or map layer. It does not matter, for example, if your model has
GraffitiForRemoval (3) instead of GraffitiForRemoval (2), as long as the names are unique.

4. Right-click GraffitiForRemoval (2), and click Parameter. This step will cause the new layer to be
added to the map when you open the model to run it from the user interface that ModelBuilder
builds for the model. You’ll use the interface in a Your Turn assignment that follows.

5. Right-click the Apply Symbology From Layer process, click Run, and close the message window
when the model is finished running. The GraffitiForRemoval map layer is symbolized in your map.
The labels, from Graffiti.lyrx, show the estimated time for graffiti removal, provided by the Public
Works supervisor. If the labels do not appear, you can right-click GraffitiForRemoval in the Contents
pane and click Label.
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6. On the ModelBuilder tab, click Save to save your model, and then close it. Note that if you must edit
your model again, you can right-click it in the Catalog pane, and click Edit.

Select graffiti sites for removal
Your map now has 14 sites with graffiti for removal. Next, the supervisor will review the map and decide how
many routes to create and which sites to include in each route. The employee who removes graffiti works 480
minutes per day. The employee can do other work if graffiti removal requires less time or if there are no routes
on a particular day. If the employee doesn’t finish a route, that work will be scheduled in a future route.
Scheduling within the 480-minute constraint takes some expertise and trial and error by the supervisor. After
reviewing the map, suppose that she decides to make two routes for the 14 graffiti sites. The first route will
have the eight sites indicated with arrows in the figure for step 8 that follows.

1. View your map, right-click GraffitiForRemoval, and click Zoom To Layer.

2. On the Map tab, use the Select tool to select the eight sites as shown in the figure. The routing model
that you’ll build in tutorial 13-2 will use only the eight sites you selected in this step.
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3. Save your project.
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Tutorial 13-2: Build the Calculate Optimal Route model
This tutorial has the standard workflow for calculating an optimal route (with minimum travel time) for a
typical problem encountered in sales. In the prototypical problem, a salesperson leaves the office each day, has
a list of customer addresses for stops, and returns to the office at the end of the route. Similarly, in this case,
the graffiti truck leaves its garage, stops at an ordered list of graffiti sites along the optimal route, and returns
to the garage.

Create a route

1. Save your project as Tutorial13-2YourName in Chapter13\Tutorials.

2. In the Tutorial 13 toolbox, create a new model named b. Calculate Optimal Route.

3. Add the Make Route Analysis Layer tool to the model, and open it. This process, when run, creates a
group layer in the Contents pane with standard map layers for the solution of a routing problem. The
process’s elements already have color fill, so you can run the process because it has default input street
network data from ArcGIS.com. While working in this book, however, you will not use the default
street network dataset because it consumes credits that require purchase. To learn more about credits,
search for “Esri credits” on the Internet. Next, you’ll change the input network dataset to
PittsburghStreets_ND, which is available and free in the data supplied with this book but less
accurate than the default data source. Contact your instructor first if you want to use the default
ArcGIS.com network dataset for a project or other work outside this book unless you know you have
Esri credits available for use.

4. Choose the selections as shown for the Make Route Analysis Layer process. “Preserve both first and
last stops” is an option that will create a network problem that resembles the prototypical problem
described at the beginning of this tutorial. The Accumulate Attributes option of Minutes causes route
statistics, including total length, to be reported in minutes (instead of miles).
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5. Click OK.

6. Rearrange and resize inputs, temporarily move the PittsburghStreets_ND input up, delete Network
data source, and rearrange the model elements as shown.

Add locations
You must add the garage as the first location, then add the selected graffiti locations, and finally add the
garage again as the last stop in the route.

1. Add the Add Locations tool to your model three times, lining up the processes vertically.

2. Open the first Add Locations process, and make your selections as shown.
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3. Similarly, configure the Add Locations (2) process with Route (2) as Input Network Analysis
Location and GraffitiForRemoval as Input Locations.

4. Configure the Add Locations (3) process with Route (3) as Input Network Analysis Location and
Garage:1 as Input Locations. As a reminder, every model element must have a unique name, hence
the parentheses with digits after repeating names, such as Route (2) and Garage (2). It does not
matter if the numbers in parentheses are in sequential order or if numbers are skipped, as long as all
names are unique.

5. Rearrange and resize model objects as shown.

Add the Solve tool, and run the model

1. Add the Solve tool to your model, and open it.
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2. As Input Network Analysis Layer, add Route (4), and click OK.

3. Right-click the output of the Solve process, Route (5), and click Add to Display.

4. Right-click Route (5) again, and click Parameter.

5. Save your model.

6. On the ModelBuilder tab in the Run group, click Run. Network Analyst found what appears to be a
good route for the eight stops. If the supervisor does not like this route for any reason, she can remove
it from the Contents pane, select different sites from GraffitiForRemoval, and create a different route
with the Create Route model. To rerun the model in Edit mode, on the ModelBuilder tab in the Run
group, you’d first have to click Validate. Each time you create a route, a new route is saved to the
Tutorial13.gdb file geodatabase with the alias name Route.
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Tutorial 13-3: Build the Record Route Results model
Now that you have a route, you’ll write driving directions for the graffiti removal employee, save the route as a
feature class with a name that includes the route’s schedule date, and write a route name and schedule date in
the master feature class, GraffitiCalls.

Create a model

1. Save your project as Tutorial13-3YourName in Chapter13\Tutorials.

2. In the Tutorial13 toolbox, create a new model named c. Record Route Results.

3. Add tools to your model as shown in the figure. The Directions process will write driving instructions
for the graffiti removal employee. The Copy Features process makes a permanent feature class for a
route. The first Calculate Field process writes the new route’s name in GraffitiCalls. The second
Calculate Field process writes the scheduled date for the route in GraffitiCalls.

Create a variable
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1. On the ModelBuilder tab in the Insert group, click Variable > OK to create a new string data–type
variable. If you do not see the Insert group, you can widen your ArcGIS Pro window.

2. Right-click the new variable, click Rename, and name the variable RouteName.

3. Open the variable, type 20160613, and click OK. The date format, YYYYMMDD, has the desirable
property that sorts chronologically.

4. Right-click the variable, and click Parameter. When this model is open and run from the user
interface created by ModelBuilder, the user can type a new date value.

Configure the Directions process

1. Open Directions.

2. For Input Network Analysis layer, select Route; for the Output File, type Text, and then type
Route%RouteName% as shown. The file name for the Output Directions file uses in-line
substitution of the value stored in the RouteName variable for the text file name that is output from
the Directions process. The percent delimiters around RouteName trigger the substitution, resulting
in the file name Route20160613.txt.

3. Click OK.

4. Right-click and run the Directions process.

5. Open the output text file in Chapter 13\Tutorials to see the driving instructions, and then close the
file when you finish.
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Configure the Copy Features process

1. Open the Copy Features process.

2. For Input features, select Route\Routes; for Output feature class, type Route%RouteName%. The
output feature class’s name uses in-line substitution to include the date of the route.

3. Click OK.

4. Run the Copy Features process.

5. Add the newly created feature class, Route20160613, to your display.

6. In the Contents pane in the Route group, turn off Routes.

Configure the first Calculate Field process
Recall that the source of the GraffitiCallsForRemoval map layer is the GraffitiCalls feature class. So when you
change attribute values in GraffitiCallsForRemoval, the changes are actually made in GraffitiCalls.
GraffitiCalls is a master feature class that must be updated periodically with new 311 graffiti call data, at least
weekly in this case. The updating work is not covered in this chapter, but you could do this work in a model
using the Merge tool, in which update data is merged with the master feature class.

1. Open the first Calculate Field process.

2. Type or make your selections as shown. Ensure that you type the single quote marks around
Route%RouteName%. The Python computer-language expression needs the quote marks to
determine that Route%RouteName% is a string value.

3. Click OK.
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4. Run the Calculate Field process.

5. Open the GraffitiForRemoval attribute table and sort Route_Name descending to see that the
process worked. All eight selected graffiti sites have the route name, Route20160613.

6. Close the attribute table.

Configure the second Calculate Field process
This process needs a Python computer-language code block to reformat the string-value date, 20160613, to a
date value, with the Python format 13/06/2016, for writing into the Date_Scheduled field. You’ll copy and
paste the code block (without having to type it). A version of the code with comments explaining syntax is
available from Chapter13\Tutorials\Resources in the file Tutorial13-3CodeBlockComments.txt. The lines in
that file starting with a hash sign are comments ignored by Python but available for you to read and
understand the code. Note that you can learn some Python programming using free online tutorials from Esri
(search for “Esri training Python” on the web).

1. Open the second Calculate Field process.

2. For Input Table, select GraffitiForRemoval:1; and for Field name, select Date_Scheduled.

3. Open Chapter13\Tutorials\Resources\Tutorial13-3CodeBlock.txt, and copy and paste the text as
shown. The getdate line after Date_Scheduled runs the code block with the input value of
RouteName in format YYYYMMDD. The variable ds in the code block returns a value for
Date_Scheduled in the needed format of MM/DD/YYYY.
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4. Click OK. You will see the completed model next.

5. Run the second Calculate Field process.

6. Open your map, and in the Contents pane, turn off the Route group. You’ll see that the graffiti sites
in the route no longer display for GraffitiForRemoval, because those sites no longer meet the query
criterion that Date_Scheduled is null. Remaining are the graffiti sites for the second route, which
you’ll schedule in the next Your Turn assignment.

7. Open the attribute table for GraffitiCalls, and sort Date_Scheduled descending. With
Date_Scheduled sorted, you can see the eight calls just scheduled for 6/13/2016.

435



YOUR TURN
In your map, in the Contents pane, remove Route, and then select the six remaining graffiti calls of the
GraffitiForRemoval map layer. Then run your b and c models successively by right-clicking and clicking
Open (and not Edit). When you run model b, there are no parameters for you to supply, so just click
Run. When you open model c, type 20160614 for RouteName, and then run the model. Look at your
map and GraffitiCalls’ attribute table for Date_Scheduled and Route_Name, now 6/14/2016 and
Route20160614, respectively.
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Tutorial 13-4: Update data using Collector for ArcGIS
The Public Works supervisor who is in charge of graffiti removal must visit each graffiti site called in to 311
to make several assessments. She inspects graffiti and completes these tasks, including entering data for the
call in GraffitiCalls using Collector:

1. Correct the location of a graffiti call, if in error.

2. Decide whether to terminate the removal process (for example, because no graffiti exists), and if
the call is terminated, entering the date in Date_Terminated.

3. Enter the date in Date_Approved if she plans to schedule the graffiti for removal.

4. Classify and select the graffiti type for Graffiti_Type_Code.

5. Enter an artist’s tag or other identifier if the graffiti and its artist can be identified.

6. Choose the removal method, and select a value of Removal_Type_Code.

7. Estimate the time in minutes for removing the graffiti, and enter the value in
Work_Time_Estimate.

You will create a map to use in Collector that displays only new graffiti calls that the supervisor must
inspect and has a data entry form including the attributes she must enter. The form has drop lists for codes
Graffiti_Type_Code and Removal_Type_Code to use in selecting code values instead of typing them.

Open the Tutorial 13-4 project

1. Open Tutorial13-4 from Chapter13, and save it as Tutorial13-4YourName.

2. Use the Pittsburgh bookmark. The GraffitiCalls map layer is made from the Tutorial13.gdb\
GraffitiCallsForCollector feature class. This feature class does not have certain properties set. Instead,
you will learn to set the properties to enable capabilities in Collector.
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Create a coded value domain
For data input or editing, attributes of feature classes that are codes, such as Removal_Type_Code and
Graffiti_Type_Code, must have their values restricted to unique sets of code values. For example,
Removal_Type_Code must have values from only the set: Paint, Power Wash, Sandblast, Scrape, and
Solvent. Then when querying for graffiti calls, for example, that require power washing for removal, you are
certain that the criterion, Removal_Type_Code = Power Wash, will retrieve all corresponding graffiti calls.
There will be no calls with different spellings of Power Wash, such as “Powerwash.” Furthermore, data entry
and editing are simplified, because instead of typing, you select code values from a drop list in a data entry
form. In ArcGIS Pro, unique code values are implemented using coded value domains. Next, you’ll create a
coded value domain for Removal_Type_Code.

1. Right-click GraffitiCalls, and click Design > Domains.

2. Click in the blank cell at the bottom of the Domain Name column, type RemovalType, and press
Tab. In the next step, you will refer to the upper-right portion of the next figure.
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3. In the pane on the right of the Domains table, for both Code and Description, type Paint, and press
Enter. You don’t need a separate description for removal types because the coded values are self-
descriptive.

4. Type four more codes as shown in the figure. When typing Solvent in the Description column, do
not press Tab or Enter; instead, click Solvent in the Code column to enter the Solvent value in the
Description column. If you press Tab or Enter, a new code row opens, and you must type values in it,
but Solvent is the last code value. If you accidentally add a new row after Solvent, you’ll have to delete
the RemovalType domain and reenter it.

5. On the Domains tab, click Save, and close the Domains table.

YOUR TURN
In GraffitiCalls for the Graffiti_Type_Code attribute, create a second coded value domain, named
GraffitiType. Add the coded values, both for Code and Description: Other, Piece, Tag, and Throw Up.

Apply a coded value domain
Now that you’ve defined domains, you must apply them to the Removal_Type_Code and
Graffiti_Type_Code attributes in GraffitiCalls. If there was another feature class that had either of the codes
as an attribute (there isn’t in this case), you’d apply the corresponding domain to it as well.

1. In the Contents pane, right-click GraffitiCalls, and click Design > Fields.

2. Click in the empty cell at the intersection of the Removal_Type_Code row and Domain column, and
select RemovalType.

3. On the Fields tab, click Save.

YOUR TURN
Apply the GraffitiType domain to Graffiti_Type_Code in the GraffitiCalls feature class, and close the
Fields view.

Rename a feature class
If you are in a class with students all publishing to the same ArcGIS Online organizational account, each
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feature class published must have a unique name across all students. You’ll publish the GraffitiCalls feature
class in the exercise after this one, but first you must give it a unique name.

1. Open the Catalog pane.

2. Expand Databases > Tutorial13.gdb.

3. Rename GraffitiCallsForCollector as GraffitiCallsYourName, substituting your name or ID. If more
than one person has the same first name in your class, you can add a middle name or otherwise make
your name unique.

4. Hide the Catalog pane.

5. Add GraffitiCallsYourName to the Contents pane, and remove GraffitiCalls.

6. Symbolize GraffitiCallsYourName to have a Circle 1 point symbol and blue color and size 1.

Publish a web layer
Next, you’ll publish GraffitiCallsYourName to your ArcGIS Online organizational account. Then, after a few
additional steps, it will be available for use in Collector by the Public Works supervisor in charge of graffiti
removal.

1. In the Contents pane, right-click GraffitiCallsYourName, and click Share as Web Layer.

2. Make or type the selections as shown; for name, select GraffitiCallsYourName.
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3. Click Publish.

4. After you publish the web layer, save and close your project and ArcGIS Pro.

Set the editing option for a web layer in ArcGIS Online
First, you must allow the supervisor to edit the layer so that she can enter data into the GraffitiCalls web layer.

1. Sign in to your organizational account on ArcGIS.com.

2. In My Content, point to the GraffitiCallsYourName feature layer, click its arrow, and click View
Item Details.

3. On the Settings tab, scroll down, turn on Enable editing, turn on Keep track of who created and last
updated features, and click Save. Note that for real use, you’d have to share the map with your
organization to make it available to the supervisor. Here, you’ll keep the map private to you.

Create a map in ArcGIS Online
For this simple map, you will have just the GraffitiCallsYourName web layer and the Streets basemap, but
you will add a filter to select only calls that need the supervisor’s review.

1. Click the Options button  at the top left of the current web page, and then click Map.

2. Click the Add Content to the Map button  > Search for layers.
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3. For In, select My Content; for GraffitiCallsYourName in Results Found, click Add.

4. Click Done Adding Layers.

5. Change the basemap to Streets.

6. Click the Save button, and type the text as shown, substituting your name for Mary Smith, and then
click Save Map. Your folder name will be different from the folder name shown.

Add a filter
For the filter (query), you’ll select records for Date_Approved and Date_Terminated that are Null (blank).
The selected records will correspond to new graffiti calls that have not yet been reviewed by the supervisor and
have not been deemed invalid or duplicate calls.

1. In the Contents pane, for GraffitiCallsYourName, click the Filter button .

2. Make the selections as shown.
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3. Click Add another expression, and make the selections as shown.

4. Click Apply Filter. You will see seven new graffiti calls for the supervisor to review.

Resymbolize GraffitiCalls
GraffitiCalls need a larger symbol for viewing.

1. In the Contents pane, for GraffitiCalls, click the Change Style button .

2. Click Options > Symbols, choose the red circular symbol, and set its size as 30.

3. Click OK, click OK again, and click Done.

4. Save the map.
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Configure pop-up windows
The data entry form for Collector is based on the pop-up window that you configure for
GraffitiCallsYourName (which originally had GraffitiCallsForCollector as its source). The attributes of the
layer that you will choose for the pop-up window are the ones that will appear on Collector’s form, which
Collector automatically generates from the pop-up window.

1. In the Contents pane, for the GraffitiCallsYourName map layer, click the More Options button .

2. Click Configure Pop-up, and then click Configure Attributes.

3. Select Display only these attributes: Address, ZipCode, Date_Call, Date_Approved,
Graffiti_Type_Code, Removal_Type_Code, Artist, Work_Time_Estimate, Date_Terminated, and
Comment. The supervisor can then see and enter or modify these attributes on a form in Collector.

4. Rearrange the order of the attributes to the order as listed in step 3 by selecting lines and using the
vertical arrow buttons. You must use the vertical up arrow several times to move each attribute, which
can be tedious. It is not critically important that the attributes be in the order as stated.

5. Select Edit for the attributes in step 3, but do not select Date_Call.

6. Click OK, and click OK again.
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7. Save your map, and close ArcGIS Online. Your map is now ready to use in Collector.

Get started with Collector for ArcGIS
Collector is a free app available for your Android, Apple iOS, or Windows 10 device (on Google Play, the
App Store, or the Windows Store, respectively).

1. Install Collector on your device.

2. Open the app.

3. Choose ArcGIS Online or http://www.arcgis.com, and sign in using your ArcGIS Online ID and
password.

4. Tap My Maps, and then tap your map, Graffiti Calls for Supervisor Review, to open it. You do not
need to establish location services for this tutorial. Your map opens on your device, displaying the
seven graffiti sites for review. Next, the tutorial breaks into three separate editing sessions, one for
each type of device: Android, Apple, and Windows 10.

Edit graffiti calls using an Android device

1. Tap the northernmost graffiti call point to select it.

2. Click the Options button  in the lower right of your screen, and tap Edit feature. The entry form
based on your ArcGIS Online pop-up for the GraffitiCalls web layer opens in edit mode.

Suppose that this graffiti call not only needs its attributes updated but also needs its location corrected.

3. Tap the Map button  at the top of your screen. The symbol for the point being edited increases in
size.

4. Zoom far in, and tap a new location about a block away from the original location. The point symbol
moves to the tapped location. Notice that you can restore the original location using the Reverse
button at the bottom left of your screen.

5. Click the data entry form button  at the top of your screen.

6. For Date_Approved, tap Enter a date, and select today’s date, and tap OK. Using today’s date for
instructional purposes saves you the time of searching for a realistic date for the case study.

7. For Graffiti_Type_Code, select Tag.

8. Tap Removal_Type_Code, and select Sandblast.

9. Tap Work_Time_Estimate, and type 30.

10. Tap the check mark  at the top left of your screen. The updated attributes are written to your
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GraffitiCalls feature layer in ArcGIS Online.

YOUR TURN
Sign in to ArcGIS Online, and open your Graffiti Calls for Supervisor Review map. The northernmost
point you just edited is no longer displayed. That point no longer meets the criteria of the filter for
graffiti calls that the supervisor has not yet reviewed, given that it now has a value for Date_Approved.

Edit graffiti calls using an Apple device

1. Tap the northernmost graffiti call point to select it.

2. Click the Options button  in the lower right of your screen, and tap Edit. If the Location Required
warning message button appears, click OK to dismiss it. The entry form based on your ArcGIS
Online pop-up for the GraffitiCalls web layer opens in edit mode.

Suppose that this graffiti call not only needs its attributes updated but also needs its location corrected.

3. Tap the Map button  at the top of your screen. The symbol for the point being edited is increased
in size.

4. Zoom far in, and tap a new location about a block away from the original location. The point symbol
moves to the tapped location. Notice that you can restore the original location using the reverse
button at the bottom left of your screen.

5. Click the data entry form button  at the top of your screen.

6. Tap the Date_Approved cell, and then tap Done to use Today. Using Today for instructional
purposes saves you the time of searching for a realistic date for the case study.

7. For Graffiti_Type_Code, select Tag, and tap Done.

8. Tap Removal_Type_Code, select Sandblast, and tap Done.

9. Tap Work_Time_Estimate, type 30, and tap Done.

10. Tap Update. The updated attributes are written to your GraffitiCalls feature layer in ArcGIS Online.

YOUR TURN
Sign in to ArcGIS Online, and open your Graffiti Calls for Supervisor Review map. The northernmost
point you just edited is no longer displayed. It no longer meets the criteria of the filter for graffiti calls
that the supervisor has not yet reviewed, given that it now has a value for Date_Approved.
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Edit graffiti calls using a Windows 10 device

1. Zoom so that you can see all seven points (red circular symbols) in Pittsburgh that the supervisor
must visit.

2. Select the northernmost graffiti call point to select it. The GraffitiCalls pop-up appears.

3. Click the Edit button  at the bottom of the pop-up. The entry form based on your ArcGIS Online
pop-up for the GraffitiCalls web layer opens in edit mode. Suppose that this graffiti call not only
needs its attributes updated but also needs its location corrected.

4. Zoom far in, and tap a new location about a block away from the original location. The point symbol
moves to the tapped location. Notice that you can restore the original location by discarding edits (tap
the Garbage Can icon at the bottom of the edit form).

5. Tap the Date_Approved cell, and then tap Done to use Today. Using Today for instructional
purposes saves you the time of searching for a realistic date for the case study.

6. For Graffiti_Type_Code, select Tag, and tap Done.

7. Tap Removal_Type_Code, select Sandblast, and tap Done.

8. Tap Work_Time_Estimate, type 30, and tap Done.

9. Click Submit. The updated attributes are written to your GraffitiCalls feature layer in ArcGIS
Online.

YOUR TURN
Sign in to ArcGIS Online, and open your Graffiti Calls for Supervisor Review map. The northernmost
point you just edited is no longer displayed. It no longer meets the criteria of the filter for graffiti calls
that the supervisor has not yet reviewed, given that it now has a value for Date_Approved.

Use a hosted feature layer for ArcGIS Pro processing
One step remains to integrate GIS processing in ArcGIS Pro and ArcGIS Online for GraffitiCalls. In a real
operations management system, some GIS processing of GraffitiCalls would be done using both desktop and
online systems. For example, new graffiti calls may be merged with GraffitiCalls using ArcGIS Pro and also
scheduled, as done in tutorials 13-1 through 13-3. Then the supervisor and the employee who removes the
graffiti would update GraffitiCalls records using Collector and ArcGIS Online. You will integrate the
separate processing of desktop and online systems by using the hosted online feature layer as the source for
GraffitiCalls in ArcGIS Pro.

1. Open Tutorial13-4YourName in ArcGIS Pro.
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2. Open Properties for GraffitiCalls, and check its source. The current version of
GraffitiCallsYourName resides on your computer’s hard drive, while a separate updated version
resides in ArcGIS Online.

3. Close the Properties pane.

4. Remove GraffitiCalls from the Contents pane.

5. On the Map tab, click the Add Data button. The Add Data window opens.

6. In Portal, click My Content, then click GraffitiCallsYourName, and click OK. It takes a few
moments for GraffitiCalls to add. When added, GraffitiCallsYourName is a group layer with one
layer, GraffitiCalls, as you’ll see next.

7. In the Contents pane, expand GraffitiCallsYourName to see its GraffitiCallsYourName feature
layer. Now ArcGIS Pro has the version of GraffitiCallsYourName that was updated by Collector.
You could add to or modify the same GraffitiCallsYourName feature layer using ArcGIS Pro. You
would have slightly slower response times if you completed the steps in Pro because of the remotely
located feature layer.

YOUR TURN
In ArcGIS Pro, open the GraffitiCalls attribute table. Find some changes that were made using
Collector. Make a change of one cell’s value in a GraffitiCalls record, note the ObjectID of the changed
record, and then close the table. Open your ArcGIS Online account, go to My Content, select View
Item Details for the GraffitiCalls feature layer, and click the Data tab. Scroll down in the table, if
necessary, to the ObjectID of the record you changed to see the change. Then select the changed cell,
and change it back to its original value or some other value. Finally, view the same record in ArcGIS Pro
to see the new change. Close ArcGIS Pro and ArcGIS Online.

Assignments
This chapter has two assignments to complete that you can download from this book’s resource web page,
esri.com/gist1arcgispro:

Assignment 13-1: Build models for routing the supervisor’s assessment of new graffiti.
Assignment 13-2: Create a Collector map for the Public Works employee who removes graffiti.
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